Microsoft SharePoint® 2007
for Office 2007 Users

Get your team working together using SharePoint's collaboration tools

Martin W. P. Reid

Updates and Wrox technical support at www.wrox.com
Microsoft® SharePoint® 2007 for Office 2007 Users

Introduction

Part I: Microsoft SharePoint Server 2007
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS) .......................5
Chapter 2: Sites and Workspaces .................................................................27
Chapter 3: Lists and Libraries .....................................................................57
Chapter 4: Web Parts .................................................................................101
Chapter 5: SharePoint and You .................................................................135

Part II: From Desktop to Internet
Chapter 6: Microsoft Office Word 2007 .......................................................173
Chapter 7: Microsoft Office Access 2007 ....................................................203
Chapter 8: Microsoft Office Outlook 2007 ...................................................243
Chapter 9: Microsoft Office Excel 2007 ......................................................265
Chapter 10: Microsoft Office Groove 2007 ..................................................297
Chapter 11: SharePoint Add-ins .................................................................317
Chapter 12: SharePoint Designer 2007 .......................................................331
Chapter 13: Records Management ............................................................361

Command Reference .................................................................................383

Appendix B: Useful SharePoint Links .........................................................405

Index ........................................................................................................407
Microsoft® SharePoint® 2007
for Office 2007 Users
Microsoft® SharePoint® 2007
for Office 2007 Users

Martin W.P. Reid
This book is dedicated to my father,
William Robert Reid

“I’m a part of old Ardoyne–And Ardoyne is me
I’m a part of the old ways–A part of the old days
I’m a part of Ardoyne–And Ardoyne is me.”
About the Author

Martin W. P. Reid is a systems analyst for Queen’s University in Belfast, one of the leading universities in the United Kingdom. He is in the process of implementing a 30,000-user Microsoft Office SharePoint 2007 Services rollout. Previously he worked with end users teaching Microsoft Office applications, database design, programming, and web development. He has authored 13 technical books since 2002, including Professional Access 2007 published by Apress. Martin is particularly interested in using SharePoint as a tool to help information workers get the job done without having to wade through technical manuals. Martin is a regular contributor to the Microsoft Office SharePoint blog Get the Point (http://sharepoint.microsoft.com/blogs/getthepoint).
Credits

Acquisitions Editor
Katie Mohr

Development Editor
Brian Herrmann

Technical Editor
Todd Meister

Senior Production Editor
Debra Banninger

Production Editor
Kathleen Wisor

Copy Editor
Foxxe Editorial Services

Editorial Manager
Mary Beth Wakefield

Production Manager
Tim Tate

Vice President and Executive Group Publisher
Richard Swadley

Vice President and Executive Publisher
Barry Pruett

Associate Publisher
Jim Minatel

Project Coordinator, Cover
Lynsey Stanford

Proofreader
David Parise, Word One

Indexer
J & J Indexing
Acknowledgments

A lot of authors begin their acknowledgements by saying, “You can’t write a book on your own.” As this is a single-author book, to tell the truth, I did write this book on my own — at least the first draft of every chapter. Once that was done, other people then came on board and helped craft the book you have in your hands now. Without these people, this book would not exist. To those people I extend grateful thanks: to Katie Mohr, who believed in the project; to Brian Herrmann, who guided me through the development process and provided an endless amount of suggestions and improvements to this text; and to the technical editor, Todd Meister, for his effort and suggestions.

But that’s just the book. Lots of people are involved in everyone’s experience, and I would like to thank all those individuals on the Internet who give freely of their time and effort to teach the rest of us how to use SharePoint in all its forms.

I would also like to thank Queen’s University Belfast. Particularly the management of the Learning and Teaching division, who granted me permission to use their MOSS installation for many of the examples in this book. Without this access, the book would not have been written.

Finally, I would like to thank my family (even Grumpy) for their patience and support when writing this book, especially for being there when my father died. I am proud of this book; it took time and effort to write, especially toward the end stages of the project. This book is for my father, who never used a computer in his life. I miss you!
Contents

Introduction xxiii

Part I: Microsoft SharePoint Server 2007

Using SharePoint 2

Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS) 5

Why All the Hype? 5
Site Structure 6
What Is MOSS 2007? 7
Web Parts 8
Windows SharePoint Services (WSS) Version 3 9
Blogs 11
Wikis 11
Project Management 12
Surveys 12
Web-Based Discussions 12
Calendars 12
Offline Access 13
Integration with Microsoft Office 14
Alerts 14
Item-Level Security 14
Customization 15
Mobile Device Access 15
Email Updates 15
Workflow 15

Microsoft Office SharePoint Server 2007 16
Enterprise-Level Search 16
People Search 17
MySite 17
Audiences 17
Excel Services 18
Forms Server 18
Business Data Catalog 18
Presence Management 19
Reporting 19
Document Center 19
## Contents

### Security
- Site Owner Permissions 20
- Site Member Permissions 20
- Site Visitor Permissions 20
- Document-Level Permissions 21

### Comparing WSS and MOSS Features 21

### On the Other Hand 22
- Accessibility 22
- Navigation 22
- Microsoft Solution 22
- Browser Support 23

### Desktop to Internet 25

### Summary 25

---

### Chapter 2: Sites and Workspaces 27

- A Little Planning 27
- Creating a Team Site 29
- **Site Owners** 31
  - Create Menu 31
  - Edit Page 32
  - Site Settings Menu 32
- **Quick Launch** 34
  - Default Quick Launch Links 35
- **Global Menu** 37
- **Site Templates** 37
  - Team Site 38
  - Blank Site 38
  - Document Workspace 38
  - Wiki Site 40
  - Blog 40
- **Meeting Workspaces** 41
  - Basic Meeting Workspace 41
  - Blank Meeting Workspace 41
  - Decision Meeting Workspace 41
  - Social Meeting Workspace 42
  - Multipage Meeting Workspace 42
- **Creating a Meeting Workspace** 42
  - Create a Meeting Workspace from an Event 43
  - The Enterprise Tab 43
  - Publishing 46
- **Free Application Templates** 46
  - Site Administrator Templates 47
Chapter 3: Lists and Libraries 57

Shared Documents Library 58
Exploring the Default Items 58
Shared Documents 58
Working with Document Libraries 61
Uploading a Document 61
Datasheet View 62
Settings Menu 65
Create a View 67
Document Library Settings 70
Library Columns 71
Library Management 72
Document Edit Menu 74
Workflows 79
Alerts 84
Form Library 84
Picture Library 85
Lists 86
Communication Lists 86
Tracking 89
Custom Lists 97
Key Performance Indicators Lists 98
Summary 99

Chapter 4: Web Parts 101

Web Parts in Relation to MOSS 2007 and WSS 101
Web Parts in SharePoint 102
Creating Web Pages in SharePoint 103
Adding a Web Part 104
Contact Details 106
Business Intelligence 121
Additional Web Parts 123
Search Web Parts 127
Summary 133
Contents

**Chapter 5: SharePoint and You** 135

- MOSS 2007 MySite 135
  - Social Networking 136
  - MOSS 2007 MySite 138
  - Blogs 146
  - Adding Web Parts to MySite 148
  - My Profile 149
  - Managing Your MySite 150
  - Customize MySite 155
  - Personalization Using MOSS Audiences 156
  - Personalization with Team Sites 159
  - Personalization Sites 162
  - Alerts and Regional Settings 163

**Summary** 163

**Part II: From Desktop to Internet**

- Office as a Desktop Application Set 166
  - Microsoft Office Groove 2007 167

- Information Management 168
  - Business Knowledge Management 168
  - The Web Browser as an Information Delivery Tool 169
  - Access to Corporate Data 171

**Summary** 171

**Chapter 6: Microsoft Office Word 2007** 173

- What's New in Microsoft Word 2007? 173
  - New Menus 174
  - Microsoft Office Word 2007 and Document Libraries 175
  - Using Metadata and Content Types within Word Documents 188
  - Document Check-In and Check-Out 189
  - Working with Document Versions 191
  - Document Management Task Pane 192
  - Adding Tasks 194
  - Interacting with Colleagues 195
  - Workflow from Word 2007 196
  - Blogging with Microsoft Word 2007 198
  - Office Live Workspace 201

**Summary** 201

xviii
## Chapter 7: Microsoft Office Access 2007

### What’s New with Access 2007
- A Brief Database Design Primer
- Multi-value
- Attachment
- Append Only Fields
- Data

### General Access Advice

### Access Objects
- Tables
- Queries
- Forms
- Reports
- Lookup Values

### SharePoint and Access
- Create the Contact List
- Creating Access Views with SharePoint
- Changing Data in Access and Synchronization to SharePoint
- Exporting Lists to Access

### Working from Access 2007
- Creating a Database in Access and SharePoint
- Importing a SharePoint List from Access 2007
- Creating an Access Database on SharePoint
- Moving a Database to SharePoint
- Keeping an Object in Access
- Access 2007 and Workflows
- Building Basic Access Objects
- Common Gotchas

### Summary

## Chapter 8: Microsoft Office Outlook 2007

### What’s New in Outlook 2007
- Lists and Libraries
- Linking Your Documents to Outlook 2007
- Opening a Document in Outlook 2007
- Using and Linking Calendars
- Tasks and Outlook 2007
- Contacts
- Managing Your SharePoint Alerts from Outlook
- Planning a Meeting
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlook 2007 and Workflow</td>
<td>257</td>
</tr>
<tr>
<td>Saving Emails</td>
<td>258</td>
</tr>
<tr>
<td>SharePoint and RSS</td>
<td>260</td>
</tr>
<tr>
<td>Discussion Lists and Outlook 2007</td>
<td>261</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>263</td>
</tr>
</tbody>
</table>

### Chapter 9: Microsoft Office Excel 2007

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What's New in Excel 2007</strong></td>
<td>265</td>
</tr>
<tr>
<td>New Menus</td>
<td>267</td>
</tr>
<tr>
<td>Importing Your Excel Worksheet to a Custom List</td>
<td>268</td>
</tr>
<tr>
<td>Export an Excel List to SharePoint</td>
<td>269</td>
</tr>
<tr>
<td>Export a SharePoint List to Excel 2007</td>
<td>270</td>
</tr>
<tr>
<td><strong>Excel Services in MOSS 2007</strong></td>
<td>271</td>
</tr>
<tr>
<td>Limitations</td>
<td>272</td>
</tr>
<tr>
<td>Publishing Excel 2007 Files</td>
<td>273</td>
</tr>
<tr>
<td>Using a Pivot Table in the Browser</td>
<td>275</td>
</tr>
<tr>
<td>Using SQL Server Data and Publishing to SharePoint</td>
<td>277</td>
</tr>
<tr>
<td>Moving the Connection to SharePoint</td>
<td>281</td>
</tr>
<tr>
<td>Excel Web Part</td>
<td>283</td>
</tr>
<tr>
<td>Excel Web Part Menu</td>
<td>286</td>
</tr>
<tr>
<td>Using Filters with Excel Services</td>
<td>286</td>
</tr>
<tr>
<td>SharePoint Reporting Site</td>
<td>292</td>
</tr>
<tr>
<td>Key Performance Indicators</td>
<td>293</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>296</td>
</tr>
</tbody>
</table>

### Chapter 10: Microsoft Office Groove 2007

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Groove 2007 Feature Set</strong></td>
<td>298</td>
</tr>
<tr>
<td>SharePoint Features with Groove</td>
<td>298</td>
</tr>
<tr>
<td><strong>Getting Started with Microsoft Groove 2007</strong></td>
<td>299</td>
</tr>
<tr>
<td>Creating a Workspace</td>
<td>300</td>
</tr>
<tr>
<td>Inviting Colleagues</td>
<td>302</td>
</tr>
<tr>
<td>Workspace Properties and Permissions</td>
<td>303</td>
</tr>
<tr>
<td>Workspace Tools</td>
<td>304</td>
</tr>
<tr>
<td>Meetings Tool</td>
<td>307</td>
</tr>
<tr>
<td>SharePoint Files</td>
<td>309</td>
</tr>
<tr>
<td>Local Files and Folders</td>
<td>312</td>
</tr>
<tr>
<td>Using Instant Messaging in a Workspace</td>
<td>312</td>
</tr>
<tr>
<td>Issue Tracking</td>
<td>313</td>
</tr>
<tr>
<td>Other Tools</td>
<td>315</td>
</tr>
<tr>
<td>Downloadable Tool Templates for Groove</td>
<td>315</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>315</td>
</tr>
</tbody>
</table>
Chapter 11: SharePoint Add-ins 317

Free SharePoint Software 318
  Community Kit for SharePoint 318
  SharePoint Learning Kit 318
  Podcasting Kit for SharePoint 319
  Document Library Tree View 319
  Telerik RadEditor Lite 320

Commercial Web Parts 324
  Calendar Plus 324
  SharePoint Forum Web Part 325
  Wiki Plus 326
  InfoPath Form Viewer 326
  SharePoint List Aggregator 326

Other Useful Software 329
Summary 329

Chapter 12: SharePoint Designer 2007 331

Skills Required 332
  HTML 332
  CSS 333

Getting Started with SharePoint Designer 2007 335
  Folder Pane 336
  Getting Started with Customization 338
  Site Administration with SharePoint Designer 2007 344
  Workflows with SharePoint Designer 346
  Edit a Workflow 352
  Working with Data Sources 352
  Displaying SQL Server 2005 Data 353
  Connecting Data From Web Parts 355
Summary 359

Chapter 13: Records Management 361

Planning for Records Management 362
  Retention Plan 364
  Information Management Policies and Auditing 365
  Content Types and Information Management Policy 372
  Creating a General Site Collection Policy 372
  Moving on to Full Records Management 375
  Record Center Structures 375
## Contents

Records Center Process 376  
Record Routing 376  
Moving Up Market 380  
**Summary** 381  


**Appendix B: Useful SharePoint Links** 405  

Index 407
Introduction

Microsoft Office SharePoint Server, or simply SharePoint, is the new buzzword around Microsoft software. I first used SharePoint some years back simply to store documents and access them from home via the Web. Over time, I came to realize that this software offered an opportunity to totally change the way I work with documents in that it blurred the distinction between the local PC and the Internet. But, being honest, I was an amateur user of SharePoint and it quickly became simply an extension of the usual file server I used every day.

When I was using the beta of Microsoft Office 2007 was the time that I really sat up and looked at SharePoint, and at MOSS 2007 in particular. I realized that simply using Microsoft Word 2007 and a few mouse clicks I could make information available via the browser to whomever I wanted to, with no need to use third-party software to upload files to the web. Just use the software I was already familiar with and the job was done. Not only that, but security of the information was taken care of for me. Now SharePoint has really taken off and is perhaps one of the biggest-selling products in the Microsoft stable.

This book is designed to teach you how to use SharePoint and Microsoft Office 2007 integration features to get your job done in this new environment. So why did I write this book? I have written and contributed to several books, and each time I always say to myself that I will never do it again. There is no money in books — not for the author anyway. I wrote this book on SharePoint and Office 2007 because I discovered that there is very little in the way of user materials available to the average SharePoint user. Most of the materials available on the web, for example, are aimed at the technical user or aimed at a user who would possess high-level permissions within a SharePoint environment. It’s highly unlikely that the majority of SharePoint users would ever be given such permissions. I wanted to write a book that you could leave on your desk and refer to when required, a book that would show you, in basic, nontechnical terms, how SharePoint and Office 2007 fit together. For example, I wanted to show you how to save a document directly into your SharePoint site from any of the Office 2007 applications and have all interested parties emailed with details of the upload.

Who This Book Is For

I hope anyone using Microsoft SharePoint would find something of value in this book. The book is written for those actively using SharePoint, either those new to the software or existing users of the previous version. I assume nothing at all about your experience with SharePoint and its interaction with Microsoft Office 2007 and cover everything from that standpoint. You can feel free to read the book cover to cover or dip in and out for information as you need to.

How This Book Is Structured

This book is structured into two distinct areas: Microsoft Office SharePoint Server and Microsoft Office 2007. I did this because, in order to take full advantage of the features in SharePoint, you do need to understand how it works and what exactly is available within SharePoint. SharePoint is a huge bit of
Introduction

software and does take some time to learn all of the available features, not counting all of the add-ins and extras you can have installed. Chapters 1–5 deal with SharePoint-specific areas, while Chapters 6–13 look more at integration with Microsoft Office 2007. In a book like this, it’s difficult to decide when to introduce specific topics — there is a lot of “chicken and egg” about working with SharePoint. In the end, I think I have succeeded in breaking this topic up in a way that you can get the most out of the software without repeating myself too much.

However, ultimately, all SharePoint really is is a tool to help you get your work done in as efficient a way as possible without wading through heaps of technical manuals and web sites to try to work out the easy way to do something. This is something I think that many technical gurus forget. To the majority of users, software is only a tool used to get their work done, and I hope this book helps you do that. If you are comfortable with SharePoint, you can skip the first five chapters, but I would advise you to check them out anyway. Given the nature of this software, it’s always possible to miss some small feature that you might need, and you might find out something you don’t already know. What follows is a brief preview of each chapter in the book.

❑  Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS) — This chapter provides you with some background on SharePoint, what it is, and what it is used for. It is aimed at new users to SharePoint, but existing users may want to read over it because there is always something to learn with SharePoint.

❑  Chapter 2: Sites and Workspaces — This chapter begins to explore SharePoint in terms of its sites and site structures, taking you from a beginner’s position to having a fully working team site running within the browser. You will examine and create various types of sites within SharePoint, and be introduced to how permissions work in this application. At the end of the chapter, you will have an appreciation of the various types of objects that can be created for you. This chapter also delves a little bit into site design and how you can use free templates from Microsoft to enhance your team sites to meet various business conditions.

❑  Chapter 3: Lists and Libraries — This chapter introduces you to the fundamental objects within SharePoint: lists and libraries. You will look at the lists and libraries available to you, how they are created and managed, and how you can create custom lists of your own. The chapter also introduces you to the world of SharePoint workflows and how they are created and executed.

❑  Chapter 4: Web Parts — This chapter discusses the basic building block of SharePoint web sites, the Web Part. You will work with almost all the built-in Web Parts available to you in SharePoint, including those used for searching.

❑  Chapter 5: SharePoint and You — Chapter 5 takes you into the world of SharePoint personalization, using the MySite feature in SharePoint to create your own personal SharePoint sites. You will also look at how to manage your personal site and how you can create a personal view of a standard SharePoint team site.

❑  Chapter 6: Microsoft Office Word 2007 — This chapter starts to explore the interaction between the Office 2007 applications and SharePoint, beginning with Word 2007. You will see how documents are published to a team site, how to create and manage metadata associated with your documents, and how the documents themselves are enhanced by SharePoint functionality.

❑  Chapter 7: Microsoft Office Access 2007 — This chapter discusses and demonstrates the integration between Microsoft Access 2007 and SharePoint. You will discover how to link your Access database to SharePoint, use Access 2007 to report on SharePoint list data, and work offline using Access 2007 as the client.
Chapter 8: Microsoft Office Outlook 2007 — This chapter discusses how Outlook 2007 is used with SharePoint, again looking at offline access to SharePoint data, and working with calendars both from Outlook 2007 and from within SharePoint itself.

Chapter 9: Microsoft Office Excel 2007 — This chapter looks at using Microsoft Excel 2007 to work with data — both from within Excel and directly from SharePoint — using the Excel Services.

Chapter 10: Microsoft Office Groove 2007 — This chapter introduces you to another new product, Groove, a client-based tool used for collaboration and integrated into SharePoint. The chapter provides you with a solid grounding in this software, including how to take SharePoint data offline and initial discussions regarding security. As well, the chapter discusses other areas of Groove 2007 that can assist you in your work.

Chapter 11: SharePoint Add-Ins — This chapter outlines some of the more useful add-ins I have personally used to enhance SharePoint in my own installation.

Chapter 12: SharePoint Designer 2007 — This chapter discusses SharePoint Designer and how it also can be used to enhance your SharePoint sites. The chapter provides grounding in using this tool to change the design of a standard site and also looks at creating workflows from the design surface and attaching them to lists within your team sites.

Chapter 13: Records Management — This final chapter discusses what records management is and how it works in the SharePoint world. At the end of this chapter, you will have a solid understanding of how to use records management to your benefit from day to day, and how to enable it within your team sites.

What You Need to Use This Book

You will need either access to Microsoft SharePoint Server 2007 or Windows SharePoint Services version 3. To follow along with some of the examples, you will also need Office 2007. Office 2003 users shouldn’t be put off by this, as there is still a fair degree of interaction between Microsoft Office 2003 and MOSS 2007. Some menu options may not be available to you in the Office applications, but the basic functionality is there, so you too will get something out of this book.

Conventions

To help you get the most from the text and keep track of what’s happening, we’ve used a number of conventions throughout the book.

Notes, tips, hints, tricks, and asides to the current discussion are offset and placed in italics like this.

As for styles in the text:

- We highlight new terms and important words when we introduce them.
- We show keyboard strokes like this: Ctrl+A.
Introduction

- We show filenames, URLs, and code within the text like so: persistence.properties.
- We present code in two different ways:
  - We use a monofont type with no highlighting for most code examples.
  - We use gray highlighting to emphasize code that’s particularly important in the present context.

Errata

We make every effort to ensure that there are no errors in the text or in the code. However, no one is perfect, and mistakes do occur. If you find an error in one of our books, such as a spelling mistake or faulty piece of code, we would be very grateful for your feedback. By sending in errata, you may save another reader hours of frustration, and at the same time you will be helping us provide even higher quality information.

To find the errata page for this book, go to www.wrox.com and locate the title using the Search box or one of the title lists. Then, on the book details page, click the Book Errata link. On this page, you can view all errata that has been submitted for this book and posted by Wrox editors. A complete book list, including links to each book’s errata, is also available at www.wrox.com/misc-pages/booklist.shtml.

If you don’t spot “your” error on the Book Errata page, go to www.wrox.com/contact/techsupport.shtml and complete the form there to send us the error you have found. We’ll check the information and, if appropriate, post a message to the book’s errata page and fix the problem in subsequent editions of the book.

p2p.wrox.com

For author and peer discussion, join the P2P forums at p2p.wrox.com. The forums are a Web-based system for you to post messages relating to Wrox books and related technologies and interact with other readers and technology users. The forums offer a subscription feature to email you topics of interest of your choosing when new posts are made to the forums. Wrox authors, editors, other industry experts, and your fellow readers are present on these forums.

At http://p2p.wrox.com you will find a number of different forums that will help you not only as you read this book but also as you develop your own applications. To join the forums, just follow these steps:

1. Go to p2p.wrox.com, and click the Register link.
2. Read the terms of use, and click Agree.
3. Complete the required information to join as well as any optional information you wish to provide, and click Submit.
4. You will receive an email with information describing how to verify your account and complete the joining process.
You can read messages in the forums without joining P2P, but in order to post your own messages, you must join.

Once you join, you can post new messages and respond to messages other users post. You can read messages at any time on the web. If you would like to have new messages from a particular forum emailed to you, click the Subscribe to this Forum icon by the forum name in the forum listing.

For more information about how to use the Wrox P2P, be sure to read the P2P FAQs for answers to questions about how the forum software works as well as many common questions specific to P2P and Wrox books. To read the FAQs, click the FAQ link on any P2P page.
Part I: Microsoft SharePoint Server 2007

Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

Chapter 2: Sites and Workspaces

Chapter 3: Lists and Libraries

Chapter 4: Web Parts

Chapter 5: SharePoint and You
Part I: Microsoft SharePoint Server 2007

The first part of this book looks in detail at Microsoft Office SharePoint Server 2007 and how you can use it to help you organize and control the huge amount of information you are faced with each day. This part is also aimed at those of you who are not using Microsoft SharePoint Server (MOSS) 2007 but perhaps using Windows SharePoint Server (WSS) version 3. Much of the content in this section and the following section will also apply, so do not be put off if you don’t have MOSS.

From Microsoft Word documents to dealing with large corporate database systems, everyone is increasingly inundated with information, and it is becoming harder to organize and classify this information, not to mention simply find it when you need it. You are also faced with increasing legal requirements for the safeguarding and retention of information, and this can also be a difficult process to manage, not only on your own PC but also across corporate networks. This is where collaboration software such as Microsoft SharePoint comes in. It can help you organize, communicate, and share information and data across and outside your organization.

For the Microsoft Office 2007 user, SharePoint can be a huge program to come to grips with, and it can take some time to understand all of the features available to you. Not only that, but you then need to learn how it all fits together with Microsoft Office 2007 and perhaps Microsoft Office 2003. Again, this can be a confusing experience for many people. This part of the book focuses on those areas of SharePoint that you will need to understand in order to make full use of the software from within Microsoft Office 2007 in particular. For Office 2003 users, much of the interaction is the same, but the ease of use you will get with Office 2007 is just not there.

Using SharePoint

In this first section of the book, you will read about SharePoint and all of its various features, including working with and creating team sites, lists, and document libraries, and interacting with corporate data. Each area of the software is discussed, and many of the basic objects you need to understand will be demonstrated with lots of practical walkthroughs to help you understand how they work. Chapters have been designed to take you from the basics of understanding SharePoint to personalizing the software to bring the information and data you need to the front by using the highly customizable interface available to you.

Part I begins by looking at SharePoint, providing you with a detailed overview of the software, how it is structured, the features available, and more general information about the skills you will need to develop to take advantage of its many features. You then move on to look at each of the core areas in Microsoft SharePoint Office Server 2007 and Web Parts: what they are, how they can be configured, and how to use them to present information and documents to yourself and your colleagues. Each core feature is introduced to provide you with a general view of what’s available when you start using SharePoint.

Following this, many of the core features are examined in greater detail in the next four chapters. You create your first SharePoint team site, examining and working with its many features. You will look at the basic structure of the sites, including lists and libraries, providing you with a solid understanding of not only what they are but also how they can be used to help you in your work. Chapter 4 brings you into the world of SharePoint Web Parts. Every core Web Part that you will find in SharePoint is discussed and demonstrated with full working examples and walkthroughs, ensuring that you have a full understanding of how they work and when they are used—again, central to your understanding of SharePoint.
Part I: Microsoft SharePoint Server 2007

Finally, Part 1 of the book ends with a deep dive into SharePoint and customization—how you can configure the various areas of SharePoint to provide information directly of use to you, from creating personal views of SharePoint web sites to working with your own personal web space on the SharePoint server. You will also look at using SharePoint Designer 2007, which will enable you to extend and enhance many areas of SharePoint, including how you can begin to design the interface to your sites and access corporate information held in database systems. You will look at the additional workflow features of SharePoint Designer and how they can be used within your business environment to improve and enhance the software.

You will look at some of the social networking aspects of SharePoint and how they work in a business environment, such as how SharePoint will suggest associations between people you interact with in the SharePoint site.

All these areas are covered and plenty of walkthroughs are provided to give you some hands-on experience in trying out the various features.

Later in the book you will learn how to customize the basic design of your sites and work with SharePoint Server’s record management features to help you meet your auditing and legal requirements in terms of document auditing and retention. Straightaway, SharePoint will do a fair job in the record management area, but with additional free downloads available from Microsoft, it can become the record management repository for an enterprise, doing more than helping you meet your legal responsibilities. The chapter on record management will provide you with a great start in setting up and managing this area of the software.

SharePoint is a huge program, but sense this book, and specifically the way in which it is structured, will help you out on the road to learning how SharePoint works and how it fits together with Microsoft Office 2007. One of my favorite sayings is “from desktop to Internet:” the ability to take a document or other file and simply save it into the Web. SharePoint 2007 and Office 2007 make this a reality. I say throughout this book that no third-party software is needed to take your documents from the desktop to the Internet, and, indeed, that is the case within the SharePoint environment. All that is required is a simple File Save As for your Office 2007 application, and you’re done. True integration between your desktop application and the Web.

For the programmers out there, it will also help to get a user’s view of how this software actually works and is used on a day-to-day basis by the people that matter: the people who have to use it. For the IT professional, SharePoint provides a huge opportunity to build applications that meet business needs; that is, the tools required by you to do your work. SharePoint provides almost all the tools you need within a business environment when you first install it but is extensible by professional development teams to be almost anything required to specific needs.
Microsoft Office SharePoint Services 2007 (MOSS)

According to some web sites and blogs, MOSS is the fastest-selling Microsoft software released in many years. Large numbers of blogs and support sites have grown up over the web, and many companies are now investing in this cure-all software.

Reviews of MOSS on the web range from the best thing to hit the IT industry in years to the worst bit of viral software in the world. From an IT perspective, MOSS is a little bit of both. Improperly planned and implemented it can be a huge problem to business, as web sites and portals can easily grow out of control. However, with proper planning and control it can be used with great effectiveness within almost any business. In this chapter, you will discover what MOSS is and how it works, and by the end of the book you will have a firm grasp of how to take full advantage of its capabilities.

The book is divided into two parts. Part 1 provides you with information on SharePoint, looking at many of its features. In Part 2, you will be concentrating on interaction with Microsoft Office 2007. MOSS also works with earlier versions of Microsoft Office, so don’t be put off if you are an Office XP or Office 2003 user. MOSS can still provide you with some great tools and applications to help you in your day-to-day work.

Two of the best sites for end user support are http://sharepoint.microsoft.com/blogs/GetThePoint/default.asp and www.endusersharepoint.com. Both sites provide lots of useful information and tips aimed at the amateur SharePoint user.

Why All the Hype?

Microsoft Office is perhaps the most widely used desktop application package in the business world. It’s available on virtually every desktop in every business. Over the last couple of years, there has been a general move toward making information available without regard to its location,
and the access vehicle of choice for this has been the Internet. For example, Google Documents and Google Apps can be accessed via a browser. In the Microsoft world, Office Live allows you to save and store information, with the browser being the tool of choice to provide the interface to these web storage locations.

In the business world, documents and other information tend to be stored on file servers to which staff are given access, emails contain a huge amount of corporate information in terms of both content and file attachments, USB keys are widely used as a storage medium, and of course the hard drives of the PCs are in use every day. All of these spaces and devices contain useful business information that, by their nature, they lock away.

This wide variety of document and information storage locations also makes it difficult to see the whole range of information available within a company. Not only is information hard to find, but there are many legal requirements with respect to business documents, and it can be difficult if not impossible for a company to meet its responsibility with regard to data regulations when information is spread all over the place with few controls over its management in place. For example, how do you ensure that documents required to be retained by your company for legal reasons are actually stored centrally? How do you find all the required documents if you are subject to litigation? When documents are stored in a multitude of places, it is difficult to get a global picture of any particular activity, as the information could be located on a hard drive, in an email, or even on a USB stick. Software like SharePoint is an attempt to pull all of these diverse storage locations together and allow you to get a picture of all the information about a particular topic or organization. To SharePoint, it doesn’t really matter that you have information stored on file servers, other hard drives within an organization, or inside large databases — SharePoint, once configured, can discover it all.

SharePoint also makes it easier for teams within an organization to work together on common projects and tasks and share information. SharePoint’s core function is to enable you to work without others to meet business goals in the most efficient way possible. All of the features are there to assist you to achieve this goal — to work with, create, manage, and discover information.

While MOSS and WSS work in other web browsers (such as Firefox) they do work best when using Internet Explorer 7. However, the limits are few and it is possible to successfully run sites for users of Apple Macs and Firefox with little trouble. Browser support is discussed later in this chapter.

Site Structure

It helps when working in this environment to at least have a basic understanding of how a SharePoint web site is structured. For example, my organization is split up into multiple divisions, each of which has a MOSS site. In technical terms this is known as a site collection. Within the site collection each distinct business area has a team site, below which each team is free to create additional sites. The site collection itself is managed by an administrator, who has full control of the area. Each divisional site also has a site owner, who is responsible for the individual site. Basically, each business area has its own self-contained and -managed intranet site with overall management of the entire structure and services falling to system administrators. For example, the finance division would have an overall intranet site called Finance. Within that site would be a set of subsites for Purchasing, Income, Salaries, Fees, and so on. The system administrators manage the more technical aspects of SharePoint and ensure that the service is maintained.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

The vast majority of readers of this book will be users of SharePoint who simply need to get a job done in the least technical way possible, and how it all works in the background is of little concern. Most people’s main concern is being able to turn on their computer each morning simply to get their job done. The same should be true of SharePoint. Once it’s installed and up and running, you should not have to bother with how it all happens — unless, of course, you find that area interesting.

Each area is responsible for the security of its own information. It owns the information and is in the best position to decide who has access to it. For information that needs to be shared across business divisions or rolled up across the whole organization, customized tools can be provided to achieve this. For example, internal HR documents that should be available to everyone can be made available at the top-level sites without permitting staff access to the more confidential areas of the HR sites. In the real world, it’s more likely that you will interact with SharePoint by using a team site to collaborate with other colleagues.

What Is MOSS 2007?

As you may already know, MOSS 2007 is a browser-based collaborative environment into which people save information, interact with business systems, and work with custom business applications. As this book explores MOSS, you will discover how it provides a more or less open-ended range of possibilities to assist you in doing your job. One of the first things that attracted me to this product was the ability to, with a couple of mouse clicks, make information available to almost anyone who has access to a web browser and permissions to use that information. No third-party tools required, no major technical skills needed, just a simple File Save As directly from Microsoft Word and the job is done. The sting in the tail — there’s always one — is that, once you get into the MOSS software itself, there is such a large range of features that it can, at times, be like looking for a needle in a haystack. The rest of this chapter digs into the software and shows you what’s there and how you can use it.

For the majority of its users, SharePoint is essentially a document storage and collaboration platform. It allows you to place documents onto a secure Internet site and share those documents with authorized colleagues both inside and outside an organization. It can also be much more, as you shall see as this book progresses, and it can provide a fully integrated Internet-based environment that brings documents to life using the Internet and a web browser.

MOSS is actually two distinct products, Windows SharePoint Services version 3 (WSS v3) and Microsoft SharePoint Server 2007 (MOSS). WSS v3 is a free component to the Windows Server 2003 operating system and can be downloaded from the Microsoft web site (search for Windows SharePoint Services 3.0 with Service Pack 1), while MOSS 2007 will cost you — a lot! This book will refer to MOSS 2007 and WSS as SharePoint. If a feature is only available with MOSS 2007, this will be explicitly stated. Otherwise, all features discussed will work with both MOSS and WSS v3.

The essential feature of SharePoint is document management. Regardless of all the hype and marketing bluster out on the web, the vast majority of end users will use MOSS to save and share documents, mainly Microsoft Office documents. As you will see, this is only one side of the software, and you can do a whole lot more with it. In order to take advantage of many of the topics discussed, you will need access to a MOSS server or at the very least a WSS version 3 installation.
Part I: Microsoft SharePoint Server 2007

If you do not have access to a MOSS site, you can request that your system administrator create one for you, or, as you will see later, you can use your own personal MOSS 2007 site for training purposes. Many books on MOSS talk about creating your own web sites for testing purposes, using management tools available with MOSS. In the real world of business, it's highly unlikely that you will have access to such high-level areas of the server, and your personal space on the server is where you will have most privileges. There is an alternative for the technically minded reader. You can download a fully functioning MOSS 2007 virtual machine from Microsoft. Install the virtual machine using Windows Virtual PC (free software) and use that to practice with. To download the virtual machine, do a search at www.microsoft.com for Microsoft Office SharePoint Server 2007 VHD. Because of the technical requirements involved in running a full SharePoint environment on Virtual Disc, it is worthwhile to check with your in-house systems people before installing this on a company computer.

Before looking at the SharePoint in more detail, one concept you will need to become comfortable with is Web Parts. MOSS is composed of Web Parts, and there is really no escaping them.

Web Parts

A Web Part can be equated to a small application embedded into the web page. It provides some functionality required by you, the end user. For example, if you wanted to see a list of all the staff authorized to use your SharePoint site, you would add a Web Part that, once configured, would display this information. Note the word “configured”; in many cases, you need to set the Web Part up to return the information required. In many other cases, the Web Part will simply perform the required function. Web Parts can be added to almost any page within a SharePoint site, and several Web Parts are provided for you. Web Parts are really at the core of SharePoint, and in addition to those supplied, developers can create Web Parts that reflect their own organization’s business processes and information. In general, once you can program Web Parts, your ability to present applications and information to end users is endless. This is where the power of SharePoint lies — in the ability of an organization to take the huge number of out-of-the-box features and extend them and add additional features specific to their needs.

Web Parts do not need to stand alone; they can be connected. You can filter Web Parts by passing information from one Web Part to another. Take the standard customer and order situation. A Web Part can be used to display customer details, and once a customer name is clicked, a related order Web Part can display the associated orders. Once the Web Parts have been configured to supply the correct data, they are a powerful tool within SharePoint sites. They can also be reused within other areas of the same site. One common use for Web Parts with SharePoint is an internal phone directory. Using information from the system, custom-built Web Parts can display staff contact details directly on a web page. This information is usually pulled directly from an organization’s HR system or security infrastructure and is generally more up to date than paper-based systems, which must be continually updated.

Every web page within a SharePoint site is composed of Web Parts contained within Web Part Zones. Web Parts and Web Part Zones can be viewed once the page is put into design mode. Other Web Parts available within SharePoint allow you to query information held within databases and present it to you on a web page. If you have the required permissions, you can add and remove Web Parts from almost any page within your SharePoint site. Chapter 4 looks at SharePoint Web Parts in more detail.
Windows SharePoint Services (WSS) Version 3

WSS is the web-based interface containing the tools and features that you will interact with. It provides almost all the features required by many small- to medium-sized organizations. The next section provides a high-level overview of some of the out-of-the-box features available to you when using WSS v3. Don’t worry if you don’t know what they are or what they do at the moment. By the end of this book, you will have tried out almost all the features you will require on a day-to-day basis. All of the collaborative tools in SharePoint are generally provided by WSS v3. The next section looks at the various components and features that are provided by WSS.

Sites

One feature you will use every day to interact with SharePoint is the web site. It is within the individual SharePoint web sites that the main SharePoint features are exposed to you. It is worth noting that, depending on the level of access you have been given to a particular site or collection of sites, some features outlined in the following sections may not be available.

SharePoint web sites provide the core interface (though not the only interface) to your information and services. WSS allows you to use and, if you have the appropriate permissions, create many different types of web sites within your organization. Such sites can be permanent — such as a divisional web site — or indeed temporary — such as a web site to host a meeting. Sites can be created by individuals or can be created centrally upon request, depending on how WSS has been rolled out within an organization. Sites can also be created directly from other Office applications. Later, in Chapter 9, you will discover how to create a meeting site directly from within Microsoft Outlook 2007. Other Microsoft Office 2007 applications, such as Microsoft Access 2007, have been enhanced to improve how they interact with MOSS web sites. In Chapter 8, you will work with MOSS directly from Microsoft Access 2007.

Because you can create web sites yourself (if you have the permissions) SharePoint can easily grow out of control.

Therefore, it’s important that you work with your IT staff to manage sites. Temporary sites can lead to some of the biggest problems. Individuals can create multiple meeting sites and workspaces and then, once the meeting is done, forget about them. Such sites simply take up space on the servers and serve little purpose. It’s important that such sites be archived or deleted once you are finished with them. Care is required, as some of the information hosted within such sites may be required for legal purposes and must, therefore, be retained. SharePoint can be configured to notify you if a site has remained out of use for a specific period. You can then take the appropriate action: deletion or archiving.

Document Libraries

Document libraries are one of the core features of SharePoint and something you will use everyday. They equate, in a small way, to shared network folders used in almost all business. One of the major differences you may find when using SharePoint document libraries is that you may be responsible for some of the security surrounding documents. Usually in a file share the security is set for you centrally. However, while this is also the case in SharePoint, it is also possible for you to have permissions to set security on your own document libraries and individual documents. This is something that some people overlook and can lead to security issues when documents meant for a restricted audience are posted to an “open” document library. In giving presentations on SharePoint in the business environment, it can be stated that SharePoint brings documents to life as opposed to documents simply sitting in a file share folder. The added value SharePoint brings — email alerts, records management, information management policies, and workflow among other things — is of great benefit to those of us who spend all day dealing with
Part I: Microsoft SharePoint Server 2007

documents. The ability to take advantage of such SharePoint features requires no great technical skill and little training. Other features of SharePoint, such as being able to start an automated workflow to route a document for approval directly from a single program, are great time savers.

Document libraries also allow you to create views (depending on your permissions) on documents contained within the libraries, a huge advantage when you are dealing with large numbers of business documents. Document library views provide you with a way to create subsets of documents that meet certain criteria. However, when working with large numbers of documents, forward planning really pays off. Giving some thought to the information you are going to place into SharePoint really pays off over time as your document libraries grow. Consider some the following questions: How might you classify documents, — by type, author, subject, or date created? If the classification is to be by subject, what are the subjects? One term you will hear over and over with respect to SharePoint and documents is “metadata.”

**Metadata**

While not strictly a feature, metadata is an important concept you will need to be aware of when working in a WSS environment. Metadata is simply information about information. For example, when storing a customer document you may want to add additional information such as an “Order Status” classification. Why do this? There are many reasons you may need to classify information, including helping to organize large amounts of documents based upon their classification — for example, by grouping yearly or monthly invoices together — thereby improving your colleagues’ ability to find documents using SharePoint search features. Once you begin a classification process within SharePoint Server 2007, you can begin to add the categories to the SharePoint search interface, making targeted searching by category possible. Later in the book, you will learn about the record management features available to you when working with SharePoint.

It is really worth stressing that information classification is a huge topic and should always play a part in the deployment of technologies such as SharePoint. If you have never heard of metadata, you can be sure you have already used it. When working with Microsoft Word, have a look at the document properties (File Properties), which are in fact metadata providing you with additional information about the document such as author and date created. Referring back to the real world, document classification is an area that I have found individuals have some problems with. While WSS and MOSS make it easy to share information, they also bring changes to the way people work. Rather than simply saving a document, you may be asked to also add a classification, and, being honest, some people find this an additional burden. Implemented correctly, however, adding classification rarely involves more than one mouse click.

The current release of MOSS also gives you the ability to associate your own in-house document templates with SharePoint. SharePoint content types and templates provide a powerful way to manage documents and other content across an organization. Content types and document templates are examined in detail in Chapters 3 and 7.

Document libraries also provide you with the ability to meet both in-house and external legal requirements with respect to document and record management. Information and record management is, again, something that an organization must think through before beginning to use SharePoint. The information management policy should be put in place in partnership with your organization’s technical staff.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

Do not let technical staff impose an information management policy without your input. You can be sure they will get it wrong. At the end of the day, no one knows the information like you, and you are best placed to help to define requirements over and above those legally required by an organization. In my view, an information management policy and record management should be seamless, and you should be unaware of their implementation in a technical sense. Once a document is loaded into the correct SharePoint area, record management should run in the background without needing constant input by the user. Information management is a large and vital topic when it comes to SharePoint and is something that should not be overlooked. It is really vital to the success of a SharePoint rollout that this area not be forgotten in the rush to have staff use the latest bells and whistles. Many SharePoint projects have failed because of this one detail. SharePoint sites can grow out of control and, instead of having an organized business information resource, a business can find that things don’t improve because information may be held within unused SharePoint sites and libraries, virtually removing any benefits SharePoint brings.

As mentioned previously, a new and highly valued feature of SharePoint document libraries is the concept of content types. A content type is, as you may have guessed, a specific type of information: a customer contract, an invoice, or an application type. MOSS supports the use of multiple content types within a single document library, and this is a very powerful feature when used in an information policy setting. A content type can describe the document being created (an invoice, for instance), its associated information management policy, and any automated workflows that are associated with that particular type of document. Using this book as an example, if this chapter were saved into SharePoint as a Book Chapter content type, the system could pick up the document and route it to the appropriate editor for approval, using an out-of-the-box SharePoint workflow. When it was approved, I would receive an email telling me the approval process was complete. Should the chapter need more work I can be automatically informed as well. The process would be managed by SharePoint with the editor receiving an email letting her know the document was ready.

Other information management features of MOSS include the ability to create labels that contain information about a document. When the document is printed the label is also printed. It is also possible to generate barcodes and associate them with specific types of documents. Both labels and barcodes are tightly integrated into Microsoft Word 2007 via SharePoint information policy features. Record management in MOSS 2007 is covered in more detail in Chapter 13.

**Blogs**

A blog site allows you to present ideas and topics to other users on the company intranet and, of course, via public Internet sites. Blogs can be used to post notices, develop an FAQ on your area of expertise, or keep colleagues up to date on the status of the latest department news. A blog is also a useful vehicle for delivering a new company-wide system or strategy. As well, team members can post updates available to anyone with access. Unlike a wiki, readers cannot add to a blog.

**Wikis**

A wiki is a web page or set of web pages that almost anyone can add content to and that can act like an online encyclopedia. For example, [http://en.wikipedia.org](http://en.wikipedia.org) is the most popular online wiki, which, coincidentally, includes an entry on SharePoint Server. Within a business environment a wiki could be used to enable staff to share experiences of SharePoint — a sort of online SharePoint self-help group where issues and resolutions to problems could be added by you and colleagues. Taken to another level, a wiki can be used within a business environment to enhance in-house discussions between members of
Part I: Microsoft SharePoint Server 2007

the staff, either within specific business areas or across an entire organization. In an educational environment, wikis can be used to support instructing students with pages created by teaching staff and contributed to by students.

**Project Management**

Used in a loose sense, in terms of project management, SharePoint provides you with the ability to assign and manage tasks and projects via the Internet. Information on progress can be monitored using a Gantt chart view within a SharePoint site. Tasks can be managed by SharePoint using email to notify others of the assignment of a task or its completion. For more advanced use, SharePoint can be integrated with Microsoft Project Server if required. Two types of task lists are provided by SharePoint, a standard task list and a Project Tasks list. Chapter 2 looks at both types in more detail.

**Surveys**

SharePoint surveys offer you a quick way to carry out a poll of colleagues or external users. Surveys can be as simple as a few questions or can contain branching questions, whereby the respondent’s answers are used to branch off to a different set of questions. Surveys are quick to set up and provide a useful, if somewhat basic, tool that you may require. Responses to the survey are presented in a graphical format and can be exported to other applications for further analysis.

**Web-Based Discussions**

Depending on the environment you work in, web-based discussions may or may not prove useful to you. For example, in the environment in which I am working, higher education, web-based discussions are a great tool that can be used to engage students in various topics. In fact, sometimes grades depend on the quantity and quality of student interaction with web-based discussion forums. While not as sophisticated as some web-based discussion groups, SharePoint discussions are an excellent tool. Discussions can be used in a formal, controlled sense within a company to discuss company proposals or documents, they can be used within project or business teams, or even opened up to external users, for a quick customer survey for example. Discussions in SharePoint lack some of the basic features found in more sophisticated online forums, but they do get the job done, and like a lot of SharePoint features, they can be replaced by third-party tools or improved by using free add-ins downloaded from the web.

**Calendars**

SharePoint calendars are useful animals and can be used to manage any date-based information. With Outlook 2007, they can be updated directly within the SharePoint site, or if linked into Outlook 2007, from within Outlook 2007. For users of earlier versions of Outlook, the SharePoint calendars can only be updated from within SharePoint.

SharePoint calendars are a great way to keep members of a team informed about important business dates (for example, report due dates). They can be customized within SharePoint to restrict the information shown. Information they contain can be rolled up across sites to display aggregate information, but another SharePoint object must be used to achieve this. The default graphic calendar cannot be used to display information from multiple calendars located on other sites or even within the same site. However, third-party tools can be used for this, as they provide better functionality than standard SharePoint aggregation tools. SharePoint calendars can be presented in a graphical form or as a standard list. Which format you choose depends on the amount of screen real estate you have available, as a graphical
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

calendar can take up a lot of screen space. In the real world, presenting data-based information as a simple SharePoint list view and the option for the user to view it as a graphical calendar works out well and doesn’t take up as much space on the screen.

Offline Access

In many organizations, there is a requirement for staff to work off-site, and SharePoint deals with this in a number of ways. In later chapters, you will be looking at working with Microsoft Outlook 2007, Microsoft Office Access 2007, and another program called Microsoft Groove to take SharePoint documents “out on the road.” Microsoft Groove is a program that can be used to extend the reach of SharePoint into, for example, a supplier company without providing full access to your SharePoint sites or internal security systems.

Both Outlook 2007 and Microsoft Access 2007 have been enhanced to enable the use of SharePoint information while disconnected from the server. Access 2007 in particular has had multiple features added to the interface to make working with SharePoint lists easier and more efficient.

Microsoft Office Groove 2007

Groove 2007 is another bit of software that works with SharePoint and is discussed in more detail in Chapter 10. It can be downloaded and installed locally on the PC from http://office.microsoft.com/en-us/groove/default.aspx. Groove allows you to extend the reach of SharePoint outside your business. Using Groove you can give permissions to outside users (such as suppliers) to access files from your SharePoint installation without giving them direct access to the SharePoint site. The main advantage in this is that you can create and control the Groove environment yourself without having to worry about adding the outside contacts to your organization’s security systems. In order to use Groove, you must first create an account. Once this is done, you simply sign in, create a workspace, and invite other Groove account holders to your workspace. Within the workspace you can share documents, hold online meetings, and share resources. Groove is capable of synching changes made to documents in the Groove workspace with those held on the SharePoint Server. To do so, it will use your credentials on SharePoint, which means that you, as the Groove workspace manager, retain control over what is copied from the workspace to the server. One thing you do need to be careful of is that other individuals you invite to the Groove workspace can invite others as well. This could cause problems, depending on the nature of the documents being shared.

It is also worth noting that, in many organizations, in order for external staff to access materials within SharePoint, they must be added to the organization’s internal security system. This is what my job entails. All users wishing to access SharePoint materials must be held within our Active Directory, and procedures are in place to deal with this requirement. However, without direct permissions on the SharePoint site, Groove users cannot directly access the documents on the server. They are restricted to only those copies stored within the Groove workspace.

Groove is an option that you may want to investigate if you need to interact with individuals outside your organization who cannot (for whatever reason) be added to your SharePoint security system. Outside its connection with SharePoint, Groove may also be useful for those times when you need to communicate and share files with other people, as its use is not limited to SharePoint. Any file stored on the PC or to which you have access can be shared using the Groove workspace. Groove is simply another collaboration alternative.
Part I: Microsoft SharePoint Server 2007

Integration with Microsoft Office

The subject for most of this book, integration with Office is at the heart of SharePoint, and as you will see, SharePoint is the glue that brings together almost all of the applications that make up Microsoft Office 2007 and makes them accessible from the desktop or the Internet. It is also safe to guess that this interaction will feature more and more with future releases of the Office application suite and SharePoint. Many of the features of SharePoint are available from within the Office applications and can be used without ever opening a web browser.

Of course, the major functionality is available in SharePoint, but many SharePoint users only interact with the software using, for example, Microsoft Outlook 2007. Each application in the Office suite has been revamped to increase its interaction with SharePoint and make it easier to interact with it. Some of the more noticeable changes have taken place in Excel 2007, Outlook 2007, and Access 2007, and chapters are devoted to these applications later in this book.

Referring back to metadata, Microsoft Word 2007 makes use of Document Information panels to display the associated metadata from SharePoint. If your SharePoint document has metadata associated with it, the Document Information panel will open, allowing you to supply this information directly from within Microsoft Word 2007. It is also possible to create customized Document Information panels to request additional information about a document from the users.

Alerts

If you need to know when a document has been saved to your SharePoint site or has been updated, SharePoint can tell you by using email alerts. Alerts are a powerful feature of the software and can push information out to you, removing the need to constantly check for changes or updates. Alerts are a feature of document libraries, and all items within them are switched on by your site administrator. You can choose to receive alerts or alerts can be set for you by the administrator. For task-based items, the system will alert you when a task has been assigned to you, and upon completion, the originator of the task will receive an email informing them of that completion.

Email alerts also form part of the out-of-the-box workflows available within document libraries. You can configure alerts to be sent right away when a new document is placed into a library, when a document is changed, or you can sign up for a weekly or daily summary of changes. You can also specify at what time your summary alert report is issued.

Alerts are another SharePoint feature that enables you to push information out to colleagues rather than having to continually check online to see if a document has been saved to a library or edited.

Item-Level Security

Access to a SharePoint web site is secured by using a username and password. In addition, the built-in security system in SharePoint can work right down to the individual document level. If colleagues do not have permission to view a document, they will not even be aware of it in the interface. SharePoint uses security trimming both in its menus and at the file level. If you don’t have security permission to use a particular menu or file, then you will not see it. This removes the hassle of clicking on something only to be told that you have no permission to use it. Security is discussed as required as you progress through the book. A high-level overview of SharePoint security is provided at the end of this chapter.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

**Customization**

Customization requires special permission within SharePoint as it is likely that the ability to change the look and feel of a site is tightly controlled. Many organizations restrict this ability to a select group of web designers or developers, and system users seldom get the opportunity to change the look and feel. However, designers and developers can extend the default design of SharePoint sites by using built-in templates or creating more business-focused ones. Tools like SharePoint Designer and Visual Studio 2008 are commonly used for this. Expression Studio is another web development tool offered by Microsoft, but it is not as closely integrated with SharePoint as SharePoint Designer 2007. Expression is designed to build more traditional interactive web sites as opposed to SharePoint sites. Chapter 13 looks at using SharePoint Designer to change the look and feel of a basic SharePoint Team site.

For higher-level customization, SharePoint also provides you with the ability to create a web site or sites in the true sense of the web. In this book, you will be working mostly with web sites that only permit internal company access — that is, intranets. SharePoint — or to be precise, MOSS 2007 — also allows you to create publishing sites. Another component of MOSS is the capability to create and publish web pages for internal and external use, using the content management features of MOSS 2007. You can create web pages directly within the SharePoint interface, which inherits the standard look and feel of the rest of your web site, and also create pages in site and application tools like SharePoint Designer and Visual Studio. Once you leave the confines of the SharePoint interface, some skills in HTML, web page development, and some of the .NET languages will be useful to take full advantage of such tools. For the majority of staff within an organization, the SharePoint interface will allow some freedom to create additional pages and page content within their web sites.

**Mobile Device Access**

In addition to using a standard web browser with SharePoint, each site can also be accessed using a mobile device (such as a cell phone or PDA). If you access a site via cell phone all graphics are removed, and you are presented with a simple hyperlinked list of items. Accessing web content from a cell phone (and viewing the content on the phone’s tiny screen) is less than ideal but improving all the time. When working with a mobile device view of a SharePoint site, you lose all of the graphical interface and are presented with a simple hyperlink lists of materials, resources, and links to your site. However, with mobile devices becoming more powerful and with better screens, it is possible to view a SharePoint site on a device such as an iPhone in all its graphical glory. For example, iSharePhone, a new application for the iPhone, is currently in development, with the promise of full interaction with SharePoint sites on this device.

**Email Updates**

When enabled, it is also possible to send documents directly to a SharePoint library simply by using email. This is a huge improvement for SharePoint and removes the need to use Microsoft Exchange public folders. You need to work with your system administrators on this one, as it’s not something that you can set up. Once it is set up, it does provide another way to make information available.

**Workflow**

Workflow is the automated control of a particular business process such as the approval process for a document. If you are required to draft a document for someone else, the usual process is to email the document as an attachment to the approver. Using SharePoint, you would simply place the document into a library and begin an approval workflow. SharePoint will handle the routing of the document to
the approver based on information you supply to the process. SharePoint provides three workflows out of the box, and complicated real-world business processes can also be created as workflows using tools like Visual Studio 2008. Generally, such tools are the domain of professional programmers. However, if you have access to SharePoint Designer, you can build workflows on a per-site basis that extend those available by default.

The previous discussion shows that WSS provides almost all the day-to-day features and interaction that you will use within this environment. In fact in the real world, there are many features that you will not use. For example, in a corporate environment, blogs and wikis may not be needed. Again, in the real world of business, you will spend a great deal of time working with the document management and collaboration features of WSS. As your use of and expertise in SharePoint grows, you will find that you move into the other areas such as blogs and wikis over time. Initially, it is recommended to concentrate on the document collaboration features. You will have more than enough to learn!

**Microsoft Office SharePoint Server 2007**

If your organization decides to invest heavily in SharePoint technology, then it’s possible they will purchase MOSS 2007 as opposed to using the free WSS version 3. MOSS is WSS with some additional features geared to the enterprise; that is, support for the large-scale use of SharePoint scaling up to thousands of users and huge amounts of information. MOSS also includes features that allow you to personalize your SharePoint experience and provides a sort of business social networking area known as MySites. The coverage in this section is limited to the more user-focused features available with MOSS only. Not covered are the more technical areas, such as indexing content, which have little interest for most day-to-day users. It’s sufficient to say that MOSS includes technologies to ensure that information is searchable in an efficient way.

**Enterprise-Level Search**

Given that you will, hopefully, be storing large amounts of information in SharePoint, it’s important that this information can be retrieved when required. MOSS provides a very powerful search tool to help you discover not only documents but also other information, including people within the organization. You can search for documents by type, document names, or even content.

The search tools are very powerful and can be customized to search for particular categories of information across the entire installation or restricted to individual sites. Search scopes can also be created, limiting the search to a particular topic (only search customer invoices or orders, for example). Search scope creation can be carried out by system administrators working with you to identify the best way to return content in a business environment.

Of course, it is also possible to ensure that some information is not returned by a search. SharePoint allows you to do this as well. Searching within certain areas of the server is part of the ability of MOSS, and it is possible to turn off the searching feature on a site-by-site basis.

Search is not restricted to your SharePoint site, as it is also possible to search outside the web sites across your organization — for example, into file shares and other areas where your organization stores information. The search will return this information via a single MOSS interface. Microsoft has also recently released a set of search plugins (federated search), which enables searching of specific areas (such as searching MSN or Google).
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

**People Search**

Ever wondered who in your organization was qualified to administer first aid? If that information is included in a user’s profile, SharePoint will find that person for you; you simply search for people with that particular skill. Many organizations hold such information on paper copy or listed on individual web pages. Others simply post the information on a notice board. MySite and your personal profile can provide up-to-date information like this either by permitting you to update your profile yourself or by populating this information automatically from directory records held centrally. It’s more likely that you will enter this information yourself, as many central directories do not go to this depth of detail nor are they always up to date. After all, individuals move around within a company or upgrade their skills. In some organizations, this feature of MOSS is used as a self-promotion tool, allowing individuals to expose skills they have that would otherwise go unnoticed.

*For those using WSS, Microsoft has released Search Server Express 2008, a free add-in to WSS to extend its searching capabilities to almost match those of MOSS 2007.*

**MySite**

MySite is a great feature in SharePoint and can serve as your single point of entrance to the entire system. MySite is your personal space on the server and provides you with access to virtually everything located within a company SharePoint environment. Any document that you have written and that is stored on the server can be presented to you via MySite. This gives you a single point of reference to access materials from all web sites to which you have access. Within your MySite you can enable access to your Outlook email inbox, tasks, and calendar with a few mouse clicks. You can customize the MySite area to just show you things that are of immediate interest to you and ignore much of the rest. MySite can also function as a useful business social networking tool, as it contains items that can list your colleagues and all sites of which you are a member. You can create and update a personal business profile that will be available to any user accessing this site, and this in turn can be personalized according to which category the user falls into; for example, your immediate line manager can have a different view of information in your MySite than another colleague. MySite also allows you to add information to your public profile such as skills held and responsibilities.

This information can then be searched by colleagues within the organization.

MySite is also useful as a training tool. You can customize the pages, add different features, and generally play with layout of information without actually doing any of this on your business sites. In my organization, MySite is used to demonstrate SharePoint features to staff, who use their own MySite to try out new approaches to organizing and sharing information.

**Audiences**

In many organizations, information is put up on the web in the expectation that, using some sort of magic, other people will automatically know it’s there and available. In many cases, the magic fails and people remain unaware that the latest information is available. In turn, this system also relies on individuals searching for the information in the first place. MOSS and the use of its Audience feature permit you to push information out to selected groups of people. Only those individuals who are members of the MOSS audience will receive the information. It’s worth noting that this is not a secure feature and should not be used as such. Anyone who knows the URL to information can simply type it into a browser and open the documents.
Part I: Microsoft SharePoint Server 2007

Audiences can provide you with a quick way to target content. For example, you could create a Finance Audience using an Active Directory Finance Group. Any information you want to target specifically at this group of staff can simply be aimed at that audience when created. Once again, in the real world, systems administrators and site administrators may be the only people who have the required permissions to create audiences.

**Excel Services**

Microsoft Excel has perhaps seen the greatest change — but a change that is purely server-based. Microsoft Excel Server is now available with MOSS 2007. This server is not available with WSS version 3. Excel Server permits you to interact in a controlled way with Excel workbooks and spreadsheets within a web browser. While neither quite the same nor as full featured as using Excel 2007, the Excel Server and SharePoint provide a great way to make information available throughout an organization, even if all users do not have Excel 2007 on their desktops. Excel Server can also be used to provide access to key performance indicators via the browser. This allows you to create visual, graphics-based indicators that can supply at-a-glance access to valuable management information.

Information can also be provided in the form of pivot tables or standard workbooks that can be filtered by other users to provide more relevant information to other colleagues. Access to this information, just like everything else in SharePoint, can of course be restricted.

If data is held within a large corporate database or even a Microsoft Access 2007 data connection, it can be stored with SharePoint and exposed using Excel Services. This provides you with immediate up-to-date access to corporate data, again in a controlled and secure fashion.

**Forms Server**

MOSS 2007 contains an additional component to allow you to use electronic forms created using Microsoft Office InfoPath 2007. InfoPath 2007 allows you to create electronic forms on the desktop and transfer the forms to SharePoint, where they can be viewed and completed within the web browser using Forms Server. This is a great tool for basic forms that almost anyone using Office 2007 and SharePoint can create. However, for more complex forms (for example, forms that communicate with large corporate databases), you will require the programming skills of developers and permissions to store and execute the forms within SharePoint.

**Business Data Catalog**

The Business Data Catalog (BDC) provides MOSS with the capability to communicate with a large variety of back-end corporate database systems. In many organizations, data is held in a variety of places and the BDC provides a way to access different systems and present the information via a single interface, MOSS 2007. Working with the BDC can range from a simple connection to a database to return data to complex mappings to retrieve data from large systems like Oracle and SQL Server. Once you go beyond the basics of simple data access, you will generally need the services of a programmer. However, tools are available that make the process a little simpler, and these will be discussed in Chapter 11. However, it’s more likely that you will make use of preconfigured BDC Web Parts rather than creating your own, as specific permissions may be required on multiple corporate systems in order to access the required data structures.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

Presence Management

When you see a colleague’s name in SharePoint, you may also notice a smart tag, which can be used to communicate instantly with them. For example, voice or video communication is possible if Microsoft Live Communications Server is also being used, but even without this you can use the smart tag to add the colleague to your outlook contacts, instant chat using MSN messenger, or send an email using Microsoft Outlook 2007. The smart tag itself serves as a status indicator, changing color depending on whether the user is currently online, busy, or free. If you are not using Live Communications Server, then only those contacts you have in your MSN Messenger will appear, with their presence indicated in SharePoint. In a large geographically dispersed organization, presence information can be a great tool, allowing you to instantly communicate with colleagues anywhere in the world. Many people are already familiar with instant messaging technology and can pick up and use it with ease.

Reporting

MOSS also contains a Report Center, which is used to display commonly needed reports for you. Reports can be created using SQL Server Reporting Services and displayed in specific Reporting Service Web Parts. The Reports Center provides a single point of information to colleagues looking for corporate reporting. A sample dashboard is supplied with SharePoint, which can give you an idea of how reports can be displayed.

The Report Center can also be used to display key performance indicators (KPIs) and progress against them. This area is covered in Chapter 10 when you will create and display some KPIs.

Document Center

Just like the Reporting Center, a Document Center can provide colleagues with access to corporate information in the form of documents, again as a single point of reference for an entire organization. The Document Center also contains a default Web Part that displays documents that you have been involved with. The Document Center is designed to store large numbers of documents well in excess of a standard document library. The center can be a good target location for users to send documents to when they need to make them available across the organization while maintaining the security of their individual sites.

Security

Security in SharePoint follows one of two common paths: either using a company’s Active Directory or using forms-based authentication. (It is also possible to use both.) Both systems rely on you entering a username and password before being granted access to the system. Once you have been granted access, what you do in terms of MOSS web sites is governed by security features inside the software. You will usually be associated with a SharePoint security group and that group will have certain permissions associated with it. SharePoint sites usually contain three default groups: Site Owners, Site Members, and Site Visitors. Each group will have a default set of permissions, which can be customized by system administrators to meet individual requirements. Permissions are usually grouped into permissions on lists, permissions on the site itself, and permissions to personalize items within the site. At a higher level, there are also permissions associated with Site Collection administrators and of course the SharePoint Server administrators. This section only discusses permissions as they will affect you. You can be granted permissions directly or placed into a group to which permissions have been given. Using group-based
permissions makes it much easier to manage them. Just think of trying to manage permissions on an individual user-by-user basis for a large organization with hundreds of employees. It would be horrendous task!

It is also possible to permit anonymous access to SharePoint sites. This is commonly used with public-facing Internet sites as opposed to intranet or internal sites. Anonymous access does not require a username or password and provides direct access to web pages.

However, when it comes down to individual document permissions, it’s highly likely that you will assign permissions to individual users, thus giving you total control over who has access to your documents. Almost all SharePoint user permissions are based on a standard set of permissions set at the server level by your system administrators:

- **Full control**: Can do almost anything within a particular site
- **Design**: Can view, add, update, delete, approve, and customize
- **Contribute**: Can view, add, update, and delete
- **Read**: Can view only
- **Limited access**: Can view specific lists, document libraries, and list items, folders, or documents when given permissions
- **Approve**: Can edit and approve pages, list items, and documents
- **Manage hierarchy**: Can create sites and edit pages, list items, and documents
- **Restricted read**: Can view pages and documents, but cannot view historical versions or review user rights information

When you create a SharePoint site you can either inherit the permissions of the parent site or create your own site permissions. If you inherit the parent site permissions, all users who have access to the parent site will also have access to the new site. Generally, when you break this permission inheritance SharePoint will offer you three permission groups based on the previous list.

### Site Owner Permissions

The site owner usually has full control over the SharePoint site and has the full range of available permissions. Essentially, the members of this group will be responsible for the maintenance of the site within the assigned permissions.

### Site Member Permissions

Members of a site can read content, add content, and update content.

### Site Visitor Permissions

Colleagues or other site users who require read access to content. A visitor cannot add or edit content.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

As well, the site administrator can create custom groups into which you may be added. Custom groups can have different permission levels associated with them, again to meet particular business or security requirements.

In addition to the standard groups, several other groups exist into which you can be placed, depending on your SharePoint role. These include:

- **Designers Group**: Users who contribute content to the site and work with its look and feel
- **Hierarchy Managers**: Users can create and manage subsites
- **Approvers**: Users who can edit, create, and approve content within the site
- **Restricted Readers**: Can read content but not historical versions

**Document-Level Permissions**

Permissions can also be applied at the document level. This is useful if you are working on documents in a public site and wish to restrict access to the document while it is in draft form. Another approach is to store the document in your private file area with MySite until it is ready to be moved to a MOSS or WSS site.

Ensuring the security of your sites and documents is vital within almost all business organizations, and it is advisable to read up on how to secure sites and documents. Appendix B provides some links to articles and Microsoft materials aimed at the end user interested in looking at site and document security in more detail.

**Comparing WSS and MOSS Features**

The following list highlights the major features available in MOSS 2007 but not in WSS v3. As you can see, some major features — such as MySite — are not available to you with WSS only. However, for the smaller business the fact that WSS is free has a huge attraction.

- **MySite personal web site**
  - Site Directory: Listing of all sites on the server
  - User Profiles: Information about all the site users
  - Audiences: Ability to target content
  - Rollup Web Parts: Summarize information
- **Membership and Colleague Web Parts available within MySite**
- **Site Templates**: Web page design aids
- **Ability to search multiple data stores**
  - Search Tools: For example, indexing and exclusion from results
  - People Search: Search for colleagues
  - Business Data Searching: Integration with corporate systems
Part I: Microsoft SharePoint Server 2007

- Page Layouts
- Slide Libraries: Microsoft PowerPoint slides
- Information Management Policy
- Electronic forms using InfoPath in the browser
- Excel Services
- Data Connection Libraries: Saved connections to corporate systems
- Business Data Catalog
- Business Data Web Parts
- Dashboards: Summary management information
- Report Center: Site that displays reports and key performance indicators

On the Other Hand

Of course, like every bit of software released, it’s not all roses and sunshine. There are many problems with SharePoint — including with this release. In this section, you will look at some of the main areas where issues have arisen.

Accessibility

Accessibility, particularly for those using assistive technology, is not the greatest. However, Microsoft has made efforts in this area and has released (in conjunction with third parties) accessible templates that can be used with your sites. The templates are designed to make it easier for those using assistive technology to access content, but as of writing, it is not easy to make a SharePoint site fully accessible in that it meets all of the W3C guidelines.

Navigation

Navigation within large SharePoint installations can still be confusing to many people given the number and depth of web sites that could be created. It’s in this area that searching and MySite really help out by discovering content that relates to you. However, you are not restricted to using the built-in navigation tools provided with SharePoint and can develop your own in-house. Navigation in busy sites is something that you need to pay attention to. There’s not much point building complex business structures if you find it hard to reach any of them.

Microsoft Solution

It is, of course, a total Microsoft solution from the desktop to the Internet in that in order to run SharePoint (MOSS or WSS) you need to use a combination of Microsoft-only software. In the background, the web servers and databases used by SharePoint are all Microsoft technology. This causes some problems for those who believe more in the open source model of computing or simply hate Microsoft.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

Open source alternatives to SharePoint are available and, of course, are free. But like everything in life, there is no free lunch and at some point you will be required to spend money either implementing these options or getting enterprise-level professional support. My own personal view is that I want software that will do a particular task or serve a particular purpose. If that’s from Microsoft, then that’s fine. If something from the open source community can do the job as well, that’s fine, too. In my view, open source software that provides the functionality, features, and integration with Microsoft Office that SharePoint does is just not there at the moment.

**Browser Support**

There are some issues in terms of cross-browser support. In my environment, there has been nothing that has not been resolvable using third-party add-ins. Browser support is essentially IE version 6 and above (preferably version 7) at the top of the list with everything else classified as a level 2 browser. I have successfully used SharePoint with Firefox, Safari, Opera, and Google Chrome all with some success. Of course, some features are not available but nothing that was show stopping. For the standard user the browser has not been a hindrance. It is important, if you are responsible for site administration, to use Internet Explorer to have access to the full range of admin features required. In terms of users, in many corporate environments the browser used can be centrally dictated. However, if others are accessing the sites, you cannot force them into using a level 1 browser such as Internet Explorer. In that case, you must ensure that they can make full use of the sites and are not disadvantaged as a result of using another browser. As stated, when using Internet Explorer you will have access to all the functionality of SharePoint. Support for other browsers, classified as level 2, is slightly different depending on the browser. The following features are not available on browsers other than Internet Explorer 6 and above:

- Edit in Datasheet
- Edit in Office Application
- Multiple File Upload
- Web Part Connections
- Rich Text Toolbar
- Slide Library
- Open Snapshot
- Sorting and Filtering Excel Services
- InfoPath Rich Text


The following list shows those features in SharePoint that are either not supported or have limited support in other browsers — mainly Firefox and Safari. It is adapted from a Microsoft TechNet list available at [http://technet.microsoft.com](http://technet.microsoft.com).

- Edit in Datasheet view.
- Edit in Microsoft Application. You will be unable to open a document directly for edit using Firefox or Safari. You will need to download the document locally and save changes back to the server.
Part I: Microsoft SharePoint Server 2007

- Explorer View is not available.
- Multiple File Upload is not available.
- Web Discussions may not function correctly in early versions of Firefox but does work with limited support in later versions. In the case of Firefox, you will need to hand-code the HTML within the discussion. See Chapter 11 for a solution.
- Date Picker Control. Used to select a date to insert into a text field. You must manually enter the date.
- Slide Library is not available.
- Excel Web Access. You will be unable to sort or filter Pivot tables.
- Open in Excel is not available.
- Open Snapshot is not available.
- Sorting and filtering in Excel Services is not available.
- Rich Text is available but is read only. If you try to edit the text you will lose all the formatting. A workaround is available and is discussed in Chapter 11.

Generally speaking, any web browser that does not support ActiveX will result in a degrading of SharePoint features.

### Changing Minds with SharePoint

You might be wondering why I have added this section, but one of the issues I have come across is getting people to change the way they think about information and documents in general. Everyone is used to owning documents and information, and sometimes they are reluctant to share this information. You may be unaware of many of the legal guidelines required in today’s business world with regard to information and see the use of records management and information management policies as an additional burden. Often people tend to resist the use of software such as SharePoint because of the initial burden it places on an already busy business work environment. Individuals are creatures of habit, and it can be difficult to change how someone saves a file if for the past two decades they have saved it into My Documents on the PC. Users need to be convinced of the benefits of change and this, again, can be difficult.

It can also be difficult to actually get different business divisions to share information. Again, it is viewed as the personal property of the area concerned. It can be hard to get different areas to adopt, for example, the same Word templates when dealing with customers. Every area wants its own identity within a corporate identity.

Just as with any major computer-related project, it’s important that you provide your input to the SharePoint development teams. At the end of the day, software is supposed to help you, not the other way around. If it makes it harder for you to do your job, then something somewhere has failed and usually it’s down to people.
Chapter 1: Microsoft Office SharePoint Services 2007 (MOSS)

One of the most important things to insist on as a user of SharePoint is training, either formal training courses or online training. Free online training is available from Microsoft and a downloadable SharePoint training site can be installed either locally on your PC or as a full SharePoint web site to which all staff can be given access. In my own case, I used a combination of all of the above: materials made available globally across the sites, formal short training sessions, and the installation of the Microsoft training site. However, there is no substitute for actually rolling up your sleeves and using the software — the best way to learn is to actually do it.

Desktop to Internet

When set up with the appropriate security permissions, it is also possible to access your intranet sites when users are not in the office, directly via the browser. In my own organization all sites use HTTPS, a standard Internet security protocol. That way, anyone with permission can log in from anywhere. This is a great improvement over previous systems, where it was possible that staff had to sign in to multiple systems before reaching the documents required, or use third-party software to move documents into the corporate environment from home. Once logged in to the site, all that is required is to save a file in Word. Indeed, access to information has been one of the major selling points of the software. SharePoint really allows you to extend the desktop out to the Internet!

Given the huge array of features and capabilities in MOSS 2007, there is still more under the covers. In addition to the major collaboration features, MOSS is also a web publishing environment. MOSS contains a fully featured web publishing system called a content management system, which can be used to publish standard web pages and web sites within and outside your organization. Pages can be created and held until authorized for publishing.

Summary

In this chapter, you have read a broad overview of the features available to you when using WSS Version 3 or MOSS 2007. In the rest of this book, you will look again at many of the features and get some hands-on practice in actually using them. You will cover almost every out-of-the-box tool available to you using MOSS and Office 2007. The book’s later chapters will look in more detail at MOSS and its interaction with each of the Microsoft Office 2007 applications, showing you how to take full advantage of one of the most powerful software packages to hit the business world in a long time. In Chapter 2, you will look at the different types of sites available to you with SharePoint, how to create them, and how to change their look and feel, using only the browser.

All of the features discussed so far are available out of the box, which should go some way to letting you begin to see the breadth and power of this software. In many cases, in order to meet specific business requirements, additional features are created in-house by developers to further extend the capabilities of the software.
In this chapter, you will look at the default out-of-the-box web sites and workspaces available to you in SharePoint. You will create a team site and examine the various site templates provided by SharePoint. You will also look at over 40 templates available free of charge from Microsoft that may be useful within your SharePoint sites and as learning tools.

In Chapter 3, you will look at the structures behind the sites and learn how to add and remove features you may not require on the site. In Chapter 12, you will see how you can customize some areas of the site at a deeper level using SharePoint Designer 2007.

It is important to know that you may not have the required permissions to carry out all of the instructions in this chapter. The functionality available to you depends on the level of access you have been granted by your SharePoint Server administrator or site administrator. If you do not have permission to create the actual team site, you can request that your systems administrator do so for you. Once you have access to the site, you can continue with this chapter. Chapter 3 will examine the individual lists and libraries within the sites in greater detail, and you will get direct, hands-on experience working with these objects.

This chapter, on the other hand, is a little like the chicken and the egg in that, in order to create a team site, you will need access to a SharePoint site, but it is assumed that you need to create a site and have the permissions to do so. If you don’t, you will need to request a site and the appropriate permissions for this example.

A Little Planning

Before you run off to create sites within your SharePoint installation, it really does pay, from both the information discovery and management points of view, to actually sit down and plan the sites and site collections you will require. You will need to work out who will have access to your sites, what level of access they will have, and if anyone needs read-only access to the site.
Part I: Microsoft SharePoint Server 2007

Microsoft has made considerable effort in trying to help those planning to deploy, deliver, and use SharePoint sites. In addition to a wide range of self-training materials, Microsoft has published many downloadable books on SharePoint, including information and worksheets used to plan almost every aspect of interaction with SharePoint. The worksheets will require you to carry out some work with those who will be using your site — for instance, looking at the type of information you will be storing and how that information will be secured. The following worksheets will be useful to you when planning your team sites and security:

- Planning for Document Management
- Document Libraries
- Information Management
- Site and Content Security
- Planning for Sites

The worksheets are available by going to www.microsoft.com and searching for “Planning worksheets Office SharePoint.” For example, the document management worksheet covers such questions as:

- Is there any metadata associated with the documents?
- In addition to the document itself, what other information do you need to store?
- Do you require specific content types for documents?

*Content types are discussed in detail in Chapters 3 and 13.*

In terms of sites, you will need to know:

- What type of sites do you require?
- Will users be able to create sites and subsites? If so, who will be responsible for them?
- Will you permit everyone with a business area to create sites and subsites?
  - If so, who will manage this process?
  - If not, who will create sites, and how will they be created?
  - What procedures will you put in place to request sites?
  - Can you create personal sites using MySite? Will you make MySite available to everyone?
  - What levels of access should staff have?
    - Who will have access to your team site and its documents?
    - How will this be managed and who will manage the process?
    - What is the information management policy with respect to documents and information in this library?

All fairly standard questions, but in the rush to get SharePoint installed and in use they are often overlooked. In a corporate environment with perhaps millions of documents, you can’t escape this part, and planning at the team site level will help you understand and make more effective use of SharePoint.
Another important question to remember to ask, particularly in a larger business, is which type of documents will you mostly be storing? Word documents? If so, which version of Word will the majority of your colleagues use? This book is aimed at Office 2007 users, but don’t forget that many people are still using Office 2003, so you need to consider this when setting up your document libraries. What happens if someone opens your Word 2007 document with Office 2003? You can find the answer to that question in Chapter 6.

SharePoint provides you with several ways to store and work with documents, and the way you choose depends on the target for the library and the type of content you place in it. For example, the document library in your team site would be used to store and share documents within a team or perhaps some invited colleagues from elsewhere in your organization. However, it would generally not be used to store documents required by every member of staff within an organization. If you required all staff to have access to a document or documents, you would place them into a Document Center located on the top-level site within your environment. Of course, you can copy documents from your team site up to the higher-level library as required. However, this ability should be built into your document library from day one as opposed to being added later. Chapter 3 looks at how you can configure this feature within a team site library.

This section can only touch on planning and design requirements for SharePoint. If you download the Microsoft materials, you will see that this is huge area, but it really does pay to plan ahead before starting to create your sites and workspaces.

Creating a Team Site

This example assumes that you have either access to a team site or permission to create one. To create a team site, follow these steps:

In the real world of corporate security and control it’s likely that only a few individuals will have access to the Site Actions menu. The majority of users may not even be aware that the menu option exists. If members of a business unit require a new site, they will apply for it from one of the site administrators. In other organizations, all control will be devolved to the business unit, which can implement controls and security as it sees fit and permit all staff to have high-level access to SharePoint within that business area.

1. Click Site Actions
2. Click Create. This opens the SharePoint create.aspx web page. In this chapter, you will concentrate on sites and workspaces. You will look at all the other options in Chapter 3.
3. To continue creating the site, click Sites and Workspaces.
4. To create the site, you need to provide SharePoint with some basic information. This is done by filling out the New SharePoint Site form. Complete the following information:

   Title and Description: The title and description will appear on the home page of your new site. It helps to make this descriptive, but you can change it once the site has been created.

   Web Site Address: The URL for the team site. The URL should be descriptive but short, so it is easy for other people to remember and type into the browser. You will normally only be required to enter a partial URL specific to the site you are creating. The remainder of the
URL will have been defaulted in for you. For example, if your SharePoint site has a URL of http://yoursharepointsite, this will be presented to you. All that is required is for you to enter the new site URL section. In the previous example, YourTeamSite is the text added, giving a URL of http://yoursharepointsite/YourTeamSite. This becomes the address of your new team site.

- **Template Selection:** In this section, you select which type of web site you require. Each site is based on an existing SharePoint template that can be added to as required and customized by you. For this example, you can select the team site in the Coloration tab.

- **Site Permissions:** Chapter 1 looks at some of the permissions used in SharePoint. In this section of the new site form, you must indicate how permissions will work in your new site. The permissions will cover who can access your site and what they can do once there. As you saw in Chapter 1, in addition to the overall permissions, you can fine-tune permissions to the document item level. When creating your new team site, you have two options:
  - **Use the same permissions as the parent site:** For example, if you worked in a purchasing office, it is likely that there would be a SharePoint site to which you and your colleagues would have access, which would be the parent site of all sites created below it. In this case, colleagues who had permissions on the parent site would have permissions on your new site. Permissions are said to be *inherited* down into the new site. A user who is a member of the Owners group in the parent site would have the same permission set within your new team site. This is the default permission set in SharePoint, and on many occasions this will handle most of your needs.
  - **Use unique permissions:** This breaks the permissions between your parent site and the new team site. Your new team site will have a unique permission structure, and you must add the site groups and users and manage the site security yourself. In the case of this example, select Use Unique Permissions to look at how permissions are set within a site.

5. Click Create.

At this point because you have chosen unique permissions, you will need to establish the three default groups into which you will place the users for your site. Initially when the screen opens, you will note three default groups: Visitors, Members, and Owners.

*If required, you can reuse existing groups from elsewhere in your site structure by clicking the use existing groups radio button and selecting a group from the drop-down list. This is useful for cross-team collaboration. If you are working on a project with members from another group or division, they can be quickly added by selecting their group in the add users dialog. By default, the site creator will be assigned into the Member and Owner groups, giving you the full range of permissions on the new site.*

In the Visitors category, click the radio button titled Create a New Group.

This will create a new site Visitors group with no members, which is fine for the moment. The Member and Owner group categories should have already been created for you. You will also be added to the Member and Owner groups by default. At the moment you are the only member (provided you have not added additional users or groups) with permission to access the team site. In Chapter 3, you will add members to the site with different levels of permission.

Accept the default of inheriting the top link bar from the parent site.
Chapter 2: Sites and Workspaces

Once the security groups have been created, Click OK at the bottom of the page to create the new site.

Once the site provisioning process is complete, you will be taken to the home page of the new team site.

Figure 2-1 shows a typical new SharePoint Team Site.

![Figure 2-1](image-url)

**Site Owners**

If you are a user with site owner permissions, your web page menus will be a little different from that of a user with standard permissions. One of the most important menu options you will see is the Site Actions menu. There are three options available to you using this menu: Create, Edit, and Site Settings. However, again, the options available on and within each menu can differ depending on permissions. The following sections cover the most common options available to site owners.

**Create Menu**

The Create menu allows you to create new lists and libraries within the team site. You will be looking at the options within each category in detail during Chapter 3. The options available are:

- Libraries
- Communications
Part I: Microsoft SharePoint Server 2007

- Tracking
- Custom Lists
- Web Pages

**Edit Page**
Allows you to edit the current page. This option is examined in Chapters 3 and 5.

**Site Settings Menu**
This is the management menu for the team site and contains the following categories:

**Users and Permissions**
This submenu facilitates management of access and permission levels to the SharePoint site.

**Look and Feel**
Using the options within this group you can change the title and description of your team site, customize the navigation by adding a tree view navigational structure (a bit like Windows Explorer).

**Galleries**
The site galleries are not sites or site templates but contain reusable objects that you can use on multiple sites within your site collection. Three galleries are available within Site Settings Galleries:

- **Master Pages**: Master Pages are templates used by the system to lay out the design of the web pages used. Master Pages and templates are discussed in Chapter 12.

- **Site Content Types**: Special content types are used within your site to describe the information. For example, a document is a specific content type that can comprise one or more additional objects, a specific Microsoft Word template, an information management policy, and perhaps a workflow. The ability to use content types, and specifically the ability to create your own, is a huge feature of SharePoint, as you will see.

- **Site Columns**: Columns available to be used by any of the libraries in the site. Site columns are grouped by category to help you organize what can be quite large lists of columns. In addition, you can create custom columns that can be used across the SharePoint site. Chapter 3 looks at creating and working with new site columns.

**Site Administration**
Facilitates management of almost every area of your SharePoint site including the following features:

**Regional Settings**
These are used to set up your local date and time formats — for example, change the world time region used by your team site.
Chapter 2: Sites and Workspaces

Site Libraries and Lists
These provide a listing of lists and libraries within your SharePoint site to allow quick customization of each object.

Site Usage Reports
If enabled, the usage reports provide you with information about activity on your team site. It is useful to have logging turned on by your administrator. Otherwise, you will be unable to tell how and if the sites are actually being used by your colleagues. Site usage reports allow you to see if there are areas of your sites that are being heavily used.

User Alerts
Manage the alerts that have been set up by users on the team site so that they are kept informed about changes to the content. Using SharePoint 2007, you can also create alerts for other users of your sites. This is a useful feature if you would like to ensure that other users receive information.

RSS
RSS allows you to be updated with changing information without the need to constantly check web sites. RSS is built into many SharePoint lists and libraries. You can use Microsoft Outlook 2007 as your RSS reader with SharePoint. RSS for your site collection is enabled or disabled using this option. You will find the RSS option on many of your SharePoint lists and libraries.

Search Visibility
It is possible to ensure that your site is not included in the SharePoint search process. This is useful when you have information within the site that you want to be sure is not discovered by the powerful SharePoint searching tools. To remove your site from search visibility and ensure that it is ignored by search tools, click Search Visibility.

If you want to exclude your team site from the search engine, you can set the Allow this Web Site to Appear in Search Results radio button to No. Bear in mind that if someone does not have permissions to a particular item, they will not see it returned in search results anyway. This is a sort of failsafe option that I always turn on anyway.

The second available option on the page refers to searching text within your web pages, which may also be discovered by the search tools.

Sites and Workspaces
This link allows you to manage the top-level sites and workspaces below the current team site. The link also allows you to change the site creation permissions for default SharePoint permission groups.

The management screen shows you the site name and when the site was last modified, and provides the capability to delete the site. It’s worth checking with the site’s creator before you delete a site just to ensure that information can be retrieved or moved before the site is deleted. More robust deletion tools are available to the SharePoint administrator, who can automatically monitor sites that have not been active in a particular amount of time. The administrator can then take action to ensure that the site is either used or deleted.
Site Features

Features are blocks of functionality available within a SharePoint site and can be turned off and on via this option. The features available to you depend on the installation either WSS or MOSS 2007. You can also install additional features on your servers, which again need to be activated within your sites. Features are installed by your SharePoint administrator. The default features on my team site are:

- **Office SharePoint Server Enterprise Site Features**: Included with this feature set is Excel Services, Forms Server, and the Business Data Catalog.
- **Office SharePoint Server Standard Site Features**: This includes user profiles and search.
- **Team Collaboration Lists**: This feature provides your document libraries and other WSS features.

You could have many different features installed on the server and if you do install some of the free Microsoft Application Templates (discussed later in this chapter), you will find that they also install some features onto your sites that need to be activated before you can use the functionality provided by the template.

Inhouse developers can also create features for you that reflect your business process and company needs. Features can also be downloaded from the Internet and installed on the server for you to activate on your sites. A feature will show as either active or deactivated. Turning a feature on is simply a matter of clicking the button beside the feature description.

Delete This Site

Deletes the current site; you will of course be required to confirm the deletion. Make sure that you want to do this before accepting the prompt. Deleted sites are not captured and stored within the site Recycle Bin. Once it’s gone, you will need to request that it be restored by your SharePoint administrator.

Content and Structure

This option provides you with a quick way to work with all of the sites within the current collection of sites available to you. You can use this option to move sites around in your web site, delete sites, go to the site setting menus for individual sites, and work with site permissions.

In Chapter 3, you will look at permissions in more detail in the context of lists and libraries and review setting permissions for the site itself.

_Site collection administrators (users responsible for the entire site structure) will have an addition menu link that will take them to the overall setting for the entire web site as opposed to settings specific to the team sites._

Quick Launch

This is the menu at the left side of the team site and contains links to all of the default lists. You shall see later how you can remove and add items to and from the Quick Launch menu to make it more relevant to your own team needs. The main content on the new home page comprises an announcement list, a calendar list, a links list, and a site image that will default to a Windows SharePoint Services logo on the
Chapter 2: Sites and Workspaces

In Chapter 3, you will work with the default lists and look at the other libraries available within SharePoint. Figure 2-2 shows the default Quick Launch menu in a newly created team site.

![Figure 2-2]

At the top of the Quick Launch menu is the View All Site Content link, which will open a web page listing all objects within the particular web site. This gives you a quick way to navigate to any area within the team site.

One of the great things about SharePoint is that if you don’t like what’s on screen, with the correct permissions you can change it. You can personalize any of the templates either to make the information more relevant to you — for example, by only showing documents you are involved with, or by removing information that you do not require. Personalization is discussed throughout the book and in Chapter 5 specifically.

Default Quick Launch Links

Once you have the team site created, the set of objects detailed in the following sections is initially created for you to enable you to get up and running right away with your team site.

Shared Documents

This is the main document library used by the team to add and manage documents within the site. You can think of this area as a little like a folder on your PC, and you use it in a similar way. If you want to save a Microsoft Word document in the shared document library, the process is identical to that used to save a file into a PC folder, that is, use File ➔ Save As from the application menu and then simply navigate to the SharePoint library. This familiar process is one of the strengths of SharePoint that reduces the learning curve.

Calendar List

This is used to add any date-based information to your team site. A link to the list is created in the left menu and Quick Launch menu, and the calendar list itself is placed onto the home page. Usually, at the top level, the calendar is used to add events that are of interest to the team as a whole. More specific calendars can be added to lower-level sites within the structure to display information relevant to that specific area. In Chapter 11, you will see how, using a third-party add-in, you can roll up date-based information from lower-level sites into a single calendar located on the home page. This feature is currently not available using the built-in calendar within SharePoint.
Part I: Microsoft SharePoint Server 2007

**Task List**

As you add and assign tasks to site members, this list will display the tasks assigned to site users. Once a task has been assigned, SharePoint will inform the user via an email containing a link back to the task within your SharePoint site. When creating a task, you can of course assign it to more than one person by using a group.

**Team Discussion**

The initial getting-started discussion board, Team Discussion can be useful to allow team members to discuss any issues they are having with the site. The discussion list is a good way to encourage staff into the SharePoint environment. Rather than use email to discuss issues they may be having with SharePoint colleagues, they can use the discussion lists for immediate feedback.

**Sites**

Web sites created below the current team sites will be added automatically to this menu for you. In addition, you can use the View drop-down list to filter the display to show the following objects.

- Document libraries
- Lists
- Picture libraries
- Discussion boards
- Surveys

This is much the same as clicking the View All Site Content link, which differs only in that it provides access to all objects on a single page.

**People and Groups**

People and Groups is used to manage the security of the team site. It is here that you will:

- Add new users and groups to your sites
- View which users have access to your site and the permissions they have
- Create new site groups as required
- Email selected site users or all site users
- View site user’s contact and other information
- Manage the settings for your groups
- Edit group membership

Adding users will usually take the form of selecting them from your organization’s Active Directory.
Chapter 2: Sites and Workspaces

Recycle Bin

Items deleted from your site are added to the Recycle Bin, where they can be retrieved. How long an item stays in the bin depends on the settings made by your site administrators. Once an item is removed from your site’s Recycle Bin, it can be retained in the site administrator’s Recycle Bin for a number of days. For example, the Recycle Bin in my own sites keep items for 30 days, after which items are moved into the site administrator’s Recycle Bin.

If you don’t see a Recycle Bin displayed on your SharePoint site (it should be there by default unless turned off), it is advisable to request that it be enabled. This is a really useful feature to have enabled, as it often happens that you never need a deleted document until you actually delete it.

Global Menu

In addition to the Quick Launch menu, SharePoint also provides you with a global menu, which stays with you wherever you go on the SharePoint site. This menu, located at the top of the web page, contains the following objects, working from left to right:

- The Global Navigation breadcrumb menu, which, if enabled, can also contain a direct link back to the main corporate home page for your SharePoint installation.
- Your own personal Welcome link, which, when clicked, allows you to:
  - Sign out of the site
  - Sign in as another user
  - Update your personal settings
- Link to your MySite (MOSS 2007)
- My Links navigation (MOSS 2007), which, when clicked, allows you to:
  - Add the current site to your own personal list of sites
  - List all SharePoint sites of which you are a member

Links created using this option will be available to you no matter where you access the SharePoint site. In Chapter 3, you will look at the menu options available within individual SharePoint lists and libraries, including permissions required to carry out specific actions.

Site Templates

When you created the team site, you may have noticed that a wide range of site templates are available to you, categorized according to function. Other tabs may be available if additional templates have been added to your installation of SharePoint. Custom inhouse templates appear under a Custom tab. Microsoft released 40 application templates for SharePoint, and these templates, if installed on the server, will be available within an Application template tab. The actual site creation process is almost identical no matter what type of site you are creating.
Part I: Microsoft SharePoint Server 2007

The range of templates and sites available depend on the security permissions you have, the type of SharePoint site your administrators have installed, and any customization that has been done. You may find in your environment the range of templates has been restricted by the system administrator. The templates under the Collaboration tab are discussed in the following sections.

This tab contains the site templates for web sites designed to allow you to work with other colleagues via the Internet. It contains the following site templates:

**Team Site**

You have just created your first team site and looked at some of the basic features of libraries. As you have seen, a team site is basically the web site in which you will do most of your work in SharePoint.

**Blank Site**

As you have seen, the initial team site contains some structures by default. If you want a totally empty team site, you can choose the Blank Site option. In this case, you must then add in all the required lists and libraries yourself. In Chapter 3, you will work with a totally blank team site, adding in various lists and libraries via the SharePoint interface.

**Document Workspace**

At times several individuals may need to cooperate on a single document or a set of documents related to a large project. A document workspace allows you take this work outside the main team site and isolate the document until it has been completed. Once it has been completed, you can copy the final document back into the team site document library overwriting the original copy. You can also create the workspace directly from the document context menu in any document library. The workspace also contains specialist lists that can be used to assign tasks to other members of the team and assist you in managing the document development process. The document workspace is one of those areas that can lead your site structure to sprawl and grow out of control. You can guess how it would be if you and your colleagues opened a document workspace on every document you needed to work with others on. Workspaces such as this need to be managed and, if possible, removed from the server once the project is complete. You can arrange to have the site backed up if you require historical records to be retained. It is also likely that documents used within a document workspace may need to be retained for record management purposes. If that is the case, the document can be moved into a record management site and the workspace can be deleted. To create a document workspace, follow the instructions to create a team site given earlier and select Document Workspace from the Collaboration tab. Figure 2-3 shows the initial document workspace with a single document uploaded and a task assigned to me.
SharePoint Document Workspace

The elements within the following list are immediately available within the document workspace to allow you to begin work on a document:

- **Announcements**: The announcements list can be used to leave global messages for members of the document revision team.
- **Shared Documents**: A document library in which to store the document currently being worked on.
- **Tasks**: A tasks list to assign and manage tasks associated with the document.
- **Members**: A list displaying the groups who have access to this area or the individual membership.
- **Links**: This is a Web Part that can be used to display hyperlinks of use to the team.

A document workspace is a perfect tool for those who may need to work on meeting minutes which can undergo several revisions before being marked as final. Management of the revision process can be tracked and managed by using an approval workflow also available in this area.
Wiki Site

It’s hard to escape wikis and blogs on the web today, as they seem to be pervasive. Wikis have been around on the web for a long time, but it’s only recently that they have been used within the business world. A wiki is, in essence, a web page that anyone can edit. Of course, in a corporate environment, permission to the wiki site will be required before colleagues can edit the page or site. A wiki is used to permit the free flow of ideas and expression. How this will fit into a corporate culture where big brother is always perceived to be watching is difficult to say, and the jury is most likely still out. In some areas, particularly education, a wiki could be a great tool when working with students to present ideas and ask for comment. Figure 2-4 shows a newly created SharePoint wiki site. A link on the Quick Launch menu, How to Use this Wiki Library, will take you to the initial instructions to get you up and running with this tool.

![Figure 2-4](image)

The initial home page of the wiki is an explanation of what a wiki is and there is a link to a short set of instructions. Clicking the View All Pages link in the Quick Launch menu will open up the wiki list, where you can view all existing pages and create new pages. Once you have created a new page within the site, it is added to the Quick Launch links. The wiki will maintain versioning for each page, and it is possible to view the history of a page in terms of deletions and additions by clicking the History tab on the top right of the page.

Blog

Unlike a wiki, which can be edited by anyone with permission, a blog is intended to be an expression of the ideas and thoughts of an individual or small group. In a corporate environment, blogs can be used internally to outline strategic decisions, brainstorm with colleagues, or simply discuss the organization in general.
Chapter 2: Sites and Workspaces

In an educational setting, a blog can be a useful teaching tool that staff can use to outline ideas, courses, and assignments, and blogs can be used to keep students informed about current policy, thinking, and other items.

For areas like blogs and wikis, many businesses may still be wondering about the business value of such tools. In almost all business sectors, there is a huge wealth of knowledge trapped within people. Blogs and wikis — if used properly — are one way to expose that knowledge to everyone else in a controlled way.

Meeting Workspaces

Workspaces are designed to allow you to perform a specific task or handle a specific business process, such as organizing and managing a meeting or dealing with document management of a specific subset of documents. In addition to creating sites, you can also create workspaces directly within the SharePoint environment.

The meetings tab contains a set of site templates that can be used to assist you in organizing meetings. They contain a specialized set of Web Parts to allow you to organize meeting. You can add agenda items, create a meeting objectives list, organize attendance, and place meeting papers into a document library. The Create tab is not the only place from which you can create a meetings workspace. If you create a Calendar item, you can also create a meeting workspace to manage the event. You can also create meeting workspaces directly from Microsoft Outlook 2007 as part of the meeting invitation process. You can also create a meeting workspace when adding a new event to a SharePoint event list via the calendar or directly. Meeting workspaces can also be created for recurring meetings, such as monthly management meetings. If this option is selected, then a meeting workspace will be created for each monthly management meeting, using the meeting date as the link to the meeting site in Quick Launch. The following sections outline the workspaces available to you within the Meetings tab:

Basic Meeting Workspace

The basic meeting workspace is used to assist you in planning and maintaining meetings. Within the workspace, you can record and store minutes, agendas, load documents required for the meeting, set objectives, and assign meeting-related tasks. This is one of the most useful SharePoint sites available to you and integrates well with Microsoft Outlook 2007.

Blank Meeting Workspace

The blank meeting workspace is useful if you need to start from a clean slate. You will be left with a web site that does not contain anything, and you are free to add whatever features you require. This is useful if you have created custom Web Parts to deal with inhouse meeting requirements.

Decision Meeting Workspace

Use the decision meeting workspace to store and review meeting documents. A list is also provided to store decisions reached at a meeting. You could, of course, just customize a general meeting site into which you add this feature.
Part I: Microsoft SharePoint Server 2007

Social Meeting Workspace

The social meeting workspace can be used to organize and publicize company events. It contains a SharePoint picture library, a things to bring list, and the capability to add a custom logo.

Multipage Meeting Workspace

This is similar to the meeting workspace; the main difference in the multipage meeting workspace is that it contains multiple blank pages (maximum 10 pages) that you can customize.

In the real world, the basic meeting workspace is likely to cover almost all the requirements for business meetings and events, and you may not need the additional meeting workspaces.

Creating a Meeting Workspace

From within your main team site follow the instructions used in the section “Creating a New Team Site.” On this occasion, select the Meetings tab and select the a basic meeting workspace template. If you require unique permissions for the Meeting workspace, remember to click the radio button “Use unique permissions” when you are creating the site. This will ensure that only those invited into the meeting will have access to the site. This should create the basic empty site for you, all ready to add meeting items. Figure 2-5 shows the workspace once it has been created.

![Figure 2-5](image)

The meeting workspace will contain an objectives list, an attendees list, an agenda, and a document library.
Each item on the home page contains a hyperlink shortcut enabling you to quickly add an item to the list. Adding items to the workspace is as easy as clicking the hyperlink below each section. To add an objective:

1. Click the navigation link Add New Item below the objective list.
2. Complete the form, entering the details of the objective.
3. Click OK.

The meeting objective will now be available on the home page displayed in the objectives list. Clicking the title of the list on the home page will bring you directly into the objectives list itself, where you can add additional information by clicking the New button.

It is also possible to add one or more attachments to your objectives by clicking the attachment icon when creating your objectives. For example, if an objective requires associated paperwork or further information must be made available to those attending the meeting.

Within the objectives list, there are some standard list actions available from within the Actions menu, including the ability to change the order of objectives, which is useful if the list is in priority order.

With the other available lists the process is the same other than the shortcut to the document library. In this case, the shortcut will only permit you to upload one or more documents rather than going directly to the document list itself. In the case of the document library and the other meeting lists, you can click on the list title to go directly to the individual list.

**Create a Meeting Workspace from an Event**

It is also possible to create a meeting workspace directly from an event list. For example, if you are creating an entry in your site calendar and would like to associate this with a meeting workspace, you can do so. When creating the new event, there is a check box at the bottom of the New Item form entitled “Use a Meeting Workspace to organize attendees, agendas, documents, minutes, and other details for this event.” To create the meeting workspace and associate it with the event, check the box and save the new event item.

As part of the process, you will be offered the opportunity to either create a new workspace or create a link to an existing workspace. The URL to your new meeting workspace will be the title of the new event you have created. You can change this and it’s usually advisable to do so. Note that the following information will be added to the new meeting workspace: title, subject, date and time, location, and a link back to the calendar list containing the associated event.

In Chapter 9, you will create a meeting workspace using Microsoft Outlook 2007 and see how you can combine a large part of the meeting organization task into a few mouse clicks.

**The Enterprise Tab**

The Enterprise tab contains site templates that are designed to be used across an entire organization rather than by individual business units or teams. Of course, there is little to stop you from using these templates deeper in your SharePoint sites as required. For example, if a business division had a
Part I: Microsoft SharePoint Server 2007

requirement to publish large numbers of documents to its own audience, then this would be possible using the Document Center. The following templates may be available:

**Document Center**

As already discussed, the Document Center is designed to store large numbers of documents and provide central access to them. The default Document Center contains three Web Parts when first created, each of which is personalized to return information relevant to you. They are outlined in the following subsections:

**Announcements**

The announcement list can be used to post notices or events for site members. Announcements can be created and removed from the list automatically, that is, once an end date has passed.

**Upcoming Tasks**

The upcoming tasks list is used to display tasks that have been assigned to you on the site and that have not yet been completed.

**Relevant Documents**

As you might expect, the relevant documents list contains documents related to you on the current site. The documents displayed can be documents created by you, modified by you, or currently being edited by you. It is also possible to configure this area to include a direct link to each document retrieved.

Navigation within the Document Center is slightly different in a team site. A Document Center uses a tree view menu, a bit like Windows Explorer’s, to allow you to navigate what can be a complex document structure.

**Records Center**

Almost all organizations are required to manage information to meet legal and business rules. The Records Management Center in MOSS 2007 provides the features to achieve this. Record management is a very complex area and is well beyond the scope of this book, but Chapter 13 looks at record management, the Records Center, and how it can be used to manage information in your organization. When the Records Center has been implemented, it is then possible for you to declare a document within a document library as a company record and submit it to the Records Center for management and storage. Usually, a record management staff oversees management of the Records Center because of the complex nature of this area.

**Personalization Site**

SharePoint is all about you and information. As stated previously, SharePoint can be highly personalized to make information more relevant to you, and using the personalization site is one of the ways this is done. A personalized site is designed to work with your MySite and push information out to you. Personalization sites need to be enabled by your SharePoint administrator and can then be created and attached or pinned to your intranet’s MySite.
Chapter 2: Sites and Workspaces

For example, if you are part of a finance group, a personalization site can be created containing information that is only relevant to the finance division. Each member of staff within the finance division will have access to the site via their MySite. Again, information is presented to you from a single source, and you do not have to search large numbers of web sites to discover it.

**Site Directory**

Each SharePoint site collection can have its own site directory — basically a listing by category of the web sites it contains. The main overall company SharePoint site or portal can also contain a site directory — in this case, it can be used to list the subsites within the portal. When you create a site it can be added automatically to the directory if this feature has been turned on by your SharePoint administrators. There is an out-of-the-box structure in place that can be customized to make it more relevant to your own organization.

**Report Center**

The Report Center is a web site used to distribute corporate reports and other information. The Report Center can display reports created using SQL Server reporting tools and Microsoft Excel 2007 workbooks. It also contains tools and Web Parts that allow you to create key performance indicators (KPIs). KPIs allow you to measure performance against target and to highlight areas where perhaps performance is not what it should be.

The Report Center provides the organization with a single site to enable users with appropriate permission to view company reports and other live information.

**Search Center with Tabs**

The search center allows you to search your SharePoint sites using a simple search engine-like interface. The search center with tabs also allows you to search for individuals within your site, using the People tab. This is a MOSS 2007 feature only. This is a great feature, as it acts just like an internal telephone directory with the added benefit of giving you the ability to search for site members with specific skills. Using the MySite and profile features you and your colleagues can update skills and responsibilities which can then be discovered using the MOSS 2007 people search.

**Search Center**

The MOSS search center is a site within your main SharePoint site structure from where you search and view search results. MOSS 2007 SharePoint enterprise search can find documents within the SharePoint site structures, within your organization’s file servers, within Microsoft Exchange, and from within large corporate databases. It is really an attempt to make where information resides irrelevant. WSS will only return results from local sites and out of the box is not capable of searching other data stores. With MOSS it is possible to search for documents using document metadata — such as document author, document title, particular site, or type of file (Word, Excel, or PowerPoint). You can also configure the search tools to search for your own custom metadata — if you wanted to search for customer invoices only, for example. Of course, this depends on you using the metadata when you create the documents in their respective libraries.

**Search Server Express 2008**

In addition to WSS, if you require enterprise search within your organization, you can download and install Microsoft Search Server 2008. This software brings more of the enterprise search features of MOSS to those of you who may only have WSS installed. The people search and business data searching will
Part I: Microsoft SharePoint Server 2007

still be unavailable to you but you do get almost all the other features of MOSS searches on your sites with the added bonus that the Express version is free. Server Express 2008 can be downloaded from www.microsoft.com/enterprisesearch/Downloads.

Publishing

The areas within the Publishing tab relate to publishing sites and are commonly used when you want an Internet-facing site as opposed to an intranet. However, as you will see later, the Publishing tab contains features that are useful in both intranet- and Internet-facing web sites.

Publishing Site

A publishing site works in a different way than your standard SharePoint team site. It is designed to allow you and your colleagues to create web pages. Within a publishing site, you will find additional document libraries specific to creating web pages. A pages library used to store web pages for the site and document library, and an images library used to store image files for use on your web pages. If you are a site administrator, you will also see many more items available to you on the Site Actions menu, including a range of reports, a site-editing toolbar, and a direct link to allow you to manage the site and its structures.

It is possible to enable the Publishing features within a standard SharePoint site if required. In fact, many SharePoint experts suggest you do this as a matter of course to extend the capabilities of a team site into the page-publishing world.

Publishing Site with Workflow

Similar in nature to the standard publishing site, this site has the addition of workflows, which permit you to submit pages for approval prior to their being published. A workflow is a business process modeled using software, and they can range from complex business processes to fairly basic processes like a document approval process. This is a useful feature in a public-facing site when you may want to cast an eye over content before your customers have access to it. Once you are happy with a page or document, you simply approve it for publication. The approval process is handled using SharePoint workflows.

News Site

The news site is, again, designed to be used by the entire organization as opposed to business divisions or groups. It can be used as a single information point for all staff enterprise-wide.

As you can see, there are a wide range of site creation possibilities available out of the box with SharePoint (Both WSS and MOSS), which will meet the general requirements for almost any organization. However, Microsoft has also made some application templates available for download. The next section looks at the templates and provides an overview of many of them.

Free Application Templates

Over 40 application templates are available from Microsoft, and it is worthwhile to install some, if not all, of them. For some of the templates, you may be able to install them yourself. Other templates, because of their nature and additional requirements, need to be installed by a SharePoint server administrator.
Chapter 2: Sites and Workspaces

The templates available are listed below in two groups: site administrator templates, which can be installed by your site administrator, and server administrator templates, which can only be installed by the SharePoint server administrator. A short section on each template’s functionality is provided here, and the templates can be downloaded from http://technet.microsoft.com/en-gb/windowsserver/sharepoint/bb407286.aspx.

The templates work well and are a useful starting point for many team-site-based activities. Not all of the more than 40 available templates are covered here. The templates listed in the following sections are templates I have used for both live sites and training courses and that provide a good starting point for your own sites. They can also, in some cases, be useful learning tools that allow you to see some of the more advanced features of SharePoint and how they are used. You can see how most of the templates are created by opening any of the sites in SharePoint Designer and looking at the structure, workflows, and any code they may contain.

If you do need to install the templates on your site; one thing that has caught many people off-guard has been a file known as application core. This file must be installed before any of the templates, as it installs required features.

Site Administrator Templates

Site administrator templates can be installed by your site administrator and will then be available for general use within a new tab named Application. Once they are installed you use the templates to create sites in the same way as any standard SharePoint site. Some of the site administrator templates are explained in the following sections.

Business Performance Reporting

The Business Performance Reporting template is basically a reporting team site that has been set up to report on customer satisfaction using surveys and discussions. This site is a good demonstration of how SharePoint survey results can be displayed within a site.

Case Management for Government Agencies

This is one of the more interesting templates made available. It is designed to manage caseloads within a government agency but can be used in any organization where case management is required. One of the nice touches when using this template is the way in which it automatically generates a set of core documents when you create a new case. This is a useful trick to learn if you work in an environment where standard documents are used for particular business tasks, for example raising an invoice, a tender or a sales order. Standard tasks are also created again when you create a new case record. Both documents and tasks are automatically created using a series of workflows to create and assign the required documents to a particular case. The system also will send emails to the person a case or a task has been assigned to.

Figure 2-6 shows the screen in SharePoint once a new case has been created. Note the already assembled core case documents and tasks.
Part I: Microsoft SharePoint Server 2007

Figure 2-6

Classroom Management
This template is designed to allow instructors to manage classes and assessments in a training or educational environment. You can enter students, add in key event dates, and allocate assignment due dates. The site also contains online discussions and the ability to track tasks assigned to students.

Competitive Analysis Site
The competitive analysis site is an interesting template, as it demonstrates the use of Excel workbooks and SharePoint. It also contains some useful workflow examples which can be used as a learning aid. Specific templates for this area are also included such as Company and Product profiles, SWOT analysis, and market share graphs.

Discussion Database
The general discussion lists within SharePoint are usually on a per-site basis. This template can be used to create a SharePoint site solely for discussions. Rather than your being required to open each individual discussion, team site discussions are made available on the site’s home page. This particular template could be used with a team site to make large scale discussions more manageable.

Disputed Invoice Management
This template uses Microsoft InfoPath forms to capture information about withheld invoices. In addition, it also uses Microsoft Excel workbooks to demonstrate how SharePoint and Excel can work together.
Chapter 2: Sites and Workspaces

**Employee Activities Site**

This template can be used as designed to help organize and maintain company events for staff, or used by staff to manage company-sponsored organizations. It contains several lists and libraries to help you manage events and other activities. Just like other areas of SharePoint, when you log in to the site, it can be personalized for you, for example, to display any events or activates you may have signed up for.

**Employee Self-Service Benefits**

This template is used to display company benefits available to staff and to permit staff to sign up to company benefit schemes. When you use this site, six benefit plan types are created for you, including medical, dental, and 401(k); you can also add types as required. Staff can sign up or enroll in specific benefit plans as required, using features of the site.

**Employee Training Scheduling and Materials**

This template is a nice example of a training course booking application. Administrators can load the site up with available courses and materials, and you can then book courses directly online. Again, the interface is personalized for you. When you log in as a normal user, you will see any classes or courses you have signed up for, courses you have already attended, and in the case of training staff, any course you teach or have completed. SharePoint’s survey features are also used to allow those attending courses to provide feedback. While not in the same league as a dedicated course management system, it again provides you with an indication of how SharePoint may be used within a business.

**Timecard Management**

The timecard management template is designed to allow project teams to record the time spent on projects. Members of the site sign in and out of the system, recording hours spent on various projects. Several lists are provided to allow both staff and managers to view the time-based information.

**Equity Research**

Equity research is basically a site template that will allow you to manage the research process involved in equity purchased. The site also contains an up-to-date news feed from various equity-related web sites.

**Product and Marketing Requirements Planning**

This template demonstrates the use of a wide range of custom templates within SharePoint, including Word, PowerPoint, and One Note.

**Sports League**

The sports league is a basic template for all you baseball fans out there. This template will let you manage an inhouse baseball team, including recording player stats, creating teams, assigning and trading players, and scheduling games.

**Team Work Site**

This template is similar to the standard team template you have already created. It has one or two additional features that you may find interesting, such as the ability to tag a document to a particular
Part I: Microsoft SharePoint Server 2007

subteam within the overall team. Members of the subteam can then view all documents associated with them rather than having to search through all team documents. Additional templates available are:

- Integrated Marketing Campaign Tracking
- Manufacturing Process Management
- New Store Opening
- Request for Proposal

The templates provided give you an opportunity to look at some of the ways SharePoint can be customized in ways that may prove useful in your own sites. While no programming knowledge is required to understand how many of the templates work, a little background in code would be helpful. You will find that many of the custom features of the templates have been created using SharePoint Designer 2007 and make extensive use of workflows. These are all skills you will pick up as your experience with SharePoint grows, so do not be put off at the beginning. If SharePoint is anything, it is an opportunity for you to learn as little or as much about how it works as you want to. The next set of free templates is the server administrator templates.

Server Administrator Templates

Unlike the previous templates, this set of free templates must be installed by your SharePoint server administrator. In general, the group of templates enables more sophisticated sites using code than those above and also interact with some of the Microsoft Office applications, such as InfoPath. Once the templates have been installed, they are available to you in the normal way.

Absence Request and Vacation Schedule Management

This template can be used by a team to request and record absences. The template provides the ability to leave approval requests for a manager. It is also possible to use the site features to assign your own job responsibilities to another member of staff when you are on vacation or otherwise absent. The template is a good example of how to restrict information by user. For example, pending leave requests are only viewable by the person making the request and the person who must approve it.

Budgeting and Tracking Multiple Projects

This template allows team members to maintain progress and budgets for projects they are involved in. A summary form is provided for project managers providing information on percentage completed, progress within budget, and a filtering capability per project.

Bug Tracking

The bug-tracking template is an error-logging site that can be used by both professional software developers and end users to record problems with software. It could be useful in a new SharePoint install to provide the simple recording of issues and their resolution.

Call Center

The call center template is designed to record and deal with external issues from customers. This template could also be used as a problem/resolution site for new SharePoint installs within business areas. It could also be used inhouse to service requests from internal customers.
Change Request Management
This is another template that is useful when testing SharePoint with users, as it contains a nice template that can be used by Microsoft Word to generate and then store requests for changes to be made to the site.

Contacts Management
Contacts management is a central site that can be used by teams to share a common pool of business contacts, which can also be linked to Microsoft Outlook.

Document Library and Review
The major difference between this template and the standard document library template is the ability to associate discussions with documents. Discussions can be made available to Microsoft Outlook 2007 via a RSS feed. This provides the ability to discuss documents in the context of the document itself, as opposed to a standard document library, where a discussion can be created but in a separate library.

Event Planning
The event-planning template represents a personalized event registration and information site, which could be used internally for event management.

Expense Reimbursement and Approval
This template allows staff to complete and submit for approval expense reports, using electronic forms based on InfoPath 2007.

Help Desk
This template is used to allow staff to log problems and issues they may be having with SharePoint (or any other issue if required). It contains frequently asked questions and a knowledge base that can be used as a self-support tool. You can also create a listing of subject experts and provide contact details for direct contact. This is a useful feature, which can take some of the pressure off a busy help desk. From a management point of view, a reporting system is also available that will display resolution times, support calls, and other performance-related information.

Inventory Tracking
Inventory tracking represents a basic site that can be used to track inventory items. It offers basic quantity-on-hand calculations and a small number of other features.

IT Team Workspace
This workspace is a combination of the help desk, project management, and bug-tracking templates and is a good example of how you can, in theory, combine multiple template features into a single slightly more complex site.

Job Requisition and Interview Management
This template is designed to allow you to manage the job requisition process, including:

- Add job requisition and candidates
- Assign responsibility to staff for jobs and candidates
Part I: Microsoft SharePoint Server 2007

- Approve or cancel requisitions
- Schedule interviews
- Receive feedback

Knowledge Base

This is designed to permit teams or divisions to create a self-support site containing answers to common questions or articles. In fact, this can be a useful tool when first working with SharePoint, as members of a team can add training documents or other information to assist colleagues to become familiar with SharePoint. I have used this template myself for just that purpose — to add information for staff on some of the more common issues with SharePoint.

Physical Asset Tracking and Management

Most everyone is required to account for equipment within a business environment. This template can be used to track such assets.

Project Tracking Workspace

This is a basic template to allow project managers to assign and manage tasks, and it contains a management dashboard presenting projects and their statuses.

Room and Equipment Reservations

This template is most often used by a team or small business units to book meeting or conference rooms and equipment. It is not designed for large-scale use but can be useful in a smaller business environment — for example, a business division with a need to manage small room and equipment booking.

GroupBoard Workspace

This is one of the first free site templates made available for SharePoint 2007, and it really is worth downloading from Microsoft. If you visit www.microsoft.com and search for “download GroupBoard Workspace,” you can download a copy of this great template. It contains many features that can be used by a small business division or larger team. This template is far ahead of the other templates released by Microsoft in terms of functionality, interaction, and usefulness. It is actually based on a free site template made available by Microsoft Japan. It can be used to:

- **Schedule and reserve rooms and equipment:** You can add conference rooms and individual equipment into the lists and reserve rooms or book equipment. The system will even check for double booking, though this is a manual process. When adding individuals to the meeting or conference, the system will also indicate their free/busy status provided the workspace has that information. For example, if free/busy status is held elsewhere, then it will not be available to this workspace.

- **Create circulators to individuals or groups of staff:** Notices or memos can be created and sent to your colleagues. Using the organization chart, you can select a particular group of staff, an individual, or a whole business unit to receive the memo or circular. The system records when a member of staff opens a memo. The user’s What’s New list will log the memo and display it when that user logs in to the system.
Create personal timecards: Simple timecards are available to allow you and colleagues to sign in and out of the office.

Record who is in or out of the office (and where they are): This information can be automatically pulled from the timecard feature and added to the site.

List any circulars or memos you may have waiting: Officially called the What’s New list, this list will roll up information aimed directly at you from throughout the GroupBoard site and present it in a single list. This makes it very easy to stay up to date with information and saves you from having to navigate different lists within the site.

Create an organizational chart reflecting the structure of your business group: This is the only part of the template that requires some work. In this case, you need to manually create your organizational structure within the workspace. Once this is done, using the chart becomes the main means to send memos and work with other features of the system. This is perhaps one of the main limiting features of the template, in that if you wanted to apply it across a large organization, this section alone would take some time to update manually.

Record phone memos and leave them for a colleague on the system: Memos are added to the colleague’s What’s New list.

The GroupBoard workspace is more than worth having a look at, but it will require installation by your SharePoint administrator. The room and reservation lists and features are more advanced than those provided by the room and reservations WSS template discussed previously, and if you have a requirement for this feature, then you should check out this application template.

**Preconfigured Document Library Templates**

In addition to the site templates, Microsoft has also released a set of document libraries that contain Microsoft Word templates specific to a particular business task. At the moment, the following are available for download by visiting [www.microsoft.com](http://www.microsoft.com) and searching for “preformatted document libraries for Windows SharePoint:”

- Invoices
- Press releases
- Specifications
- Customer site visit reports
- Meeting reports

Just like the application templates, the library templates are a useful learning aid for those who may be new to using SharePoint. You will be looking at the library templates in detail in Chapter 7, as they contain some good examples, showing interaction between Microsoft Word 2007 and data help within SharePoint libraries.
Basic Site Customization

If you have the required permissions (design or site administrator), it is possible for you to change the
general look and feel of your team site by changing its theme. A theme is a file or set of files that deal
with the look and feel of a SharePoint site, in this case mainly the color scheme and image files used.
Themes and SharePoint in general make extensive use of Cascading Style Sheets (CSS) to set the colors
and images used on sites. One of the best sites to get more information on SharePoint and CSS is
www.heathersolomon.com, which provides comprehensive reference materials on how CSS works in
SharePoint. Heather also provides a great CSS listing for SharePoint, which really is worth its weight in
gold. Chapter 12 provides you with an introduction to some of the techniques used to customize
SharePoint sites.

If you are serious about customization in SharePoint, CSS is one of the first things you will need to
learn. However, even for existing experienced designers, CSS and SharePoint can be a nightmare, as
things get complex fairly quickly. You will be looking at using Microsoft SharePoint Designer 2007 in
Chapter 12 to make some changes to SharePoint sites.

SharePoint contains several themes that can be applied to your site. Themes are available in the Look
and Feel section, using the Site Setting menu under the Site Themes link. There are 18 themes available
for you to choose from, ranging in quality and usability from good to fairly awful (the Petal theme is
particularly bad, unless you want your team site to have a nice pinkish glow). You need to remember
when selecting a theme in SharePoint that if you find it difficult to read or hard on your eyes, then so
will everyone else. Simple web design standards apply, the most obvious one being to make sure that the
theme colors do not clash with text colors, making your information difficult to read. For example, bright
pink or orange menu headings do not, in my opinion, make sites look good or professional. To change
the theme used by your team site:

1. Click Site Settings.
2. Select Site Themes under the Look and Feel title.
3. Select a theme (note that a preview of the selected theme is provided on the page, which you can
   view before you apply it).
4. Click Apply.

If you don’t like the theme applied, you can return to the settings page and change it back to the default
theme: blue. For more comprehensive customization or branding of your site, you will use a combination
of CSS, HTML, one of the .NET Languages, XML, and Master Pages. As you may guess, this is not a
trivial matter and requires some skill not only in web design but also in programming. However,
SharePoint designer 2007 will assist you with making basic changes to sites, and when you become more
proficient you can make larger systemwide changes. Just as with everything else in SharePoint, you will
require sufficient permissions to work in this area, and in the real world it’s likely that this role will be
performed by experienced web developers and programmers.
Chapter 2: Sites and Workspaces

Summary

In this chapter, you started off by creating a team site. This is the most common site you will be using in SharePoint. Then you looked at each of the site templates that may be available to you when working with SharePoint — may be available because templates can be added and removed from this area as required. You also read an overview of some of the over 40 templates available from Microsoft. Once again, you were introduced to some of the security features available in SharePoint, a topic revisited in later chapters.

In the next chapter, you will look in detail at the features available to you in lists and libraries in SharePoint sites. You will get practical, hands-on experience at working with each object.
In this chapter, you will look in more detail at the range of lists and libraries available with SharePoint. You will examine each library’s structure, what it is used for, and how it can be customized. In addition, you will investigate creating custom lists to match your own business requirements. After you become familiar with lists, libraries will be discussed — especially the SharePoint document library, which is the place you will save your documents. You will try your hand at creating new document libraries, adding columns to the library list, and creating different views of the information contained within the library. You will also see how you can use workflows to automate some processes and how you can customize SharePoint’s built-in workflows to meet your own needs.

In SharePoint, your data is held in a list, and everything in SharePoint is a list no matter how it looks visually. From lists of Word documents, Excel files, and event calendars, all of your data is held in lists. In the background, all of your data is actually stored in a large database: Microsoft SQL Server. As users we don’t need to worry about SQL Server other than knowing it’s there and it works. Those of you who are familiar with databases like Microsoft Access and applications like Microsoft Excel will find lists very familiar in structure and should find working with default lists, and creating your own custom lists, very similar to creating tables in Access and spreadsheets in Excel. In general, a list contains the data you put into it plus the metadata — additional information you need to store in order to describe or enhance the list. For example, a customer list could contain a customer’s name, address, zip code, phone number, and email address — all the bits of data you need to store about the customer.

In addition to this data, you may want to store metadata such as the name of the person who created or changed a document or other list item. In the case of SharePoint, a lot of metadata is automatically added for you. For example, Created By and Modified By will be recorded for every document in a document library. When you add a document to a library, you will find that the “modified by” and “modified” dates are already completed for you. Once you have a team site created, SharePoint will provide, by default, the lists and libraries discussed in the following sections. However, this can change if your SharePoint installation has been customized to reflect your own business process.
Shared Documents Library

The Shared Documents library is the initial main document library available to you. It is used to store any type of document, including Word and Excel files, and is not limited to Office 2007 file types. In the majority of cases, you will come across Office file types most often when working in a business environment, although you can store PDF files, text files, images, and even Microsoft Access database files within the Shared Documents library. You are only limited in the type of file you can save into the library by the file types allowed by the system administrators. For example, it’s unlikely that you would be allowed to save an executable file (.exe) in a SharePoint library because of the dangers of having executable code running on the servers or being available for download on your computer. Your Shared Documents folder contains the following default columns:

- Type
- Name
- Modified
- Modified By

You can, of course, add new columns to the library at any time, but it’s worth thinking about the columns you need before you begin to use the library. If you leave adding columns to the library until after it has been populated, you will need to go back and add the required information. This particularly applies to areas like information management and document classification, which are best implemented from day one and not left as an afterthought. Another area you should give some thought to is the use of content types, which are touched on in this section but will be discussed in more detail in Chapter 6.

Exploring the Default Items

When the team sites are created, you can see links to your document libraries and other lists created on the site, and some lists are presented to you within the web page itself as embedded Web Parts. For example, the announcement list is contained within a Web Part at the top of the page. This home page is really a getting-started page designed to let you begin to explore and use the features of SharePoint. In this next section, you will look at each of the default items in some detail, but once again your ability to use the items or even see them will depend on the permissions you have been assigned within your site.

Shared Documents

To open a library, you simply click the link available in the Quick Launch menu. Notice how the Quick Launch menu remains located on the left side of the screen. The first thing you need to become familiar with in a document library is the menu system available to you. Figure 3-1 shows the menu bar from a MOSS document library.

![Figure 3-1](image)
Chapter 3: Lists and Libraries

If you hover the mouse over the menu items, you might notice that some items have a split bar to the left of the downward-pointing arrow. This indicates that the menu contains a list of choices accessible (via a drop-down submenu) by clicking the black arrow. Clicking the main menu option (such as New) will open the default choice (in my case, a Microsoft Word 2007 document), and clicking the arrow will open the submenu, allowing you either to create a new document or a new folder. If you do not have permission to create documents or folders, then this menu option will not be visible. This is one of the strengths of SharePoint: security trimmed menus and navigation. This stops the system from showing you items and options you do not have access to.

The other menu options available are outlined in the following sections.

Upload Menu

This is used to move files from other locations into your SharePoint document library. You can move single or multiple files to SharePoint using the library. You will upload some files shortly.

There is an option to upload multiple files, which you will do next. Before continuing it’s worth pointing out that the multiple upload feature is not available to you if you are not using Internet Explorer. Those not using IE will only be able to upload single documents via the document library.

Actions Menu

The Actions menu contains numerous options that begin to move you away from the traditional file share approach to documents. The options available in the Actions menu are discussed in the following sections.

Edit in Datasheet

The Edit in Datasheet option allows you to switch the view of the library to a datasheet, which is actually a Microsoft Access Web component. This component is installed when you install Microsoft Office 2007. The datasheet view is useful when you need to make changes to multiple items in the library. It is also possible to sort and filter items to meet specific criteria.

Open with Windows Explorer

This is a great option that opens the library in a Windows Explorer — a little like My Computer. This is an alternative approach that can be used to upload or download multiple files to or from the server. You should be familiar with using Windows Explorer and should have little trouble using this option to move items from your local PC or file store to SharePoint.

Connect to Outlook

Connect to Outlook allows you to connect the current document library to Microsoft Outlook 2007. This is really useful when you need to go offline and work on files from outside the office. Files can then be synchronized back to the server upon your return.

Export to Spreadsheet

This option allows you to export the current information to Excel 2007, and it is a useful tool if you are dealing with numerical data within SharePoint (such as the results of a SharePoint survey). Simply export the data out to Excel 2007 for further work.
Part I: Microsoft SharePoint Server 2007

View RSS Feed
An RSS feed allows you to subscribe to information published by a web site. A common and popular example is podcasting, where you can subscribe to be updated with current podcasts as they become available.

Alert Me
One of the best things in SharePoint is the ability to be notified by the system when something of interest happens and you would like to be informed. For example, when the latest sales figures are released into the library, setting up an alert will enable the system to send you an email.

Settings Menu
The Settings menu is basically the management menu for the library and offers the options discussed as follows.

Create Column
When you look at the library, several columns are already defined for you: Type, Name, Modified, and Modified By. However, you can also create additional columns to reflect your own business requirements.

Create View
This option allows you to create a custom view of the contents of the library. This is useful when you have large number of documents stored and would like to restrict them to a specific subject or category.

Document Library Setting
This is the management area for the library and contains links to many of the management features you will use to customize, manage, and secure the document library. As with a lot of stuff in SharePoint, you will need permissions to manage the library, and these should be restricted to a small group of colleagues.

View Menu
Views provide you with a way to gather like information together. Rather than the document library displaying every document, you can restrict the documents lists to only those you may be interested in. For example, you could create (and set as the default) a view showing only documents that you have modified. You would still have access to all other documents, but your default view would be of your own documents. The menu provides quick access to view options, including changing the current default view, creating a new view, and switching to Windows Explorer view.

As you begin to work with other SharePoint lists and libraries, you will find that the menu options and features do not change a great deal and most of the options discussed in this section remain the same. For example, if you open a calendar list, you will find the Action menu much like discussed previously.
Chapter 3: Lists and Libraries

Depending on your permissions within SharePoint, you may or may not have access to many of the menus and options discussed in this chapter. If you do not have permissions to access the View menu, for example, you will not even see it available within your team site. In addition to managing sites and libraries, the majority of your time will be spent actually working with information within the various SharePoint lists and libraries, particularly document libraries.

Working with Document Libraries

Much of your time spent working with SharePoint will be in this area, adding files, managing files, and creating views within document libraries. Just as when working with a PC, your document library needs to be looked after and one of the important areas you will be responsible for is the security of documents within the library. Before looking in detail at this library, you will need to add some content.

Uploading a Document

Initially the Shared document library will be empty, so the first thing you will do is upload a Microsoft Word document. To upload a single document to the Shared Documents library using the main menu bar from within the library:

1. Click Upload.
2. Click the Browse button.
3. Navigate to the folder and file required.
4. Select the individual file.
5. Click Open.
6. Click OK to upload the document to the library.

Once the document is uploaded, you will be returned to the document library, where you will see the file uploaded with a little New icon indicator located to the right of the filename. An icon at the left the document indicates the file type. If you have uploaded a Microsoft Word document, a Word icon is used. Additional information available to you at this point shows the modified date and time and the Modified By information. This is an example of the metadata associated with a document. To follow along with the examples that follow, it will be useful to upload several files of different types. To upload multiple files:

1. Click Upload.
2. Click Upload Multiple Files.

A form will open showing the file structure on your PC on the left and individual files and folders on the right. Figure 3-2 shows the upload form presented to you within SharePoint.
Part I: Microsoft SharePoint Server 2007

Multiple uploading is not available if you are not using Internet Explorer.

3. Expand a folder on your PC.

4. In the right-hand window, select the files required by checking the box beside each file.
   Note the “Overwrite existing files” check box on the screen. This will be checked by default. Leaving it checked means that, if any of the files you wish to upload already exist in your library, they will be overwritten. Be absolutely sure that this is what you want before uploading. If not, remember to uncheck the box before uploading your files.

5. Click OK.

6. Click Yes in response to the dialog box.

Your files will then be uploaded to the library.

Now that you have some files to play with, you can begin to look at the menu options in more detail.

**Datasheet View**

Click Actions ➪ Edit in Datasheet to change from the standard list view to Datasheet view. Datasheet view presents your list or library view very much like an Access table or an Excel spreadsheet and offers you some additional features over those available in the standard SharePoint list and Library.
In order to use datasheet view, you must be using Internet Explorer version 6 or above, and you must have the ActiveX controls installed when you installed Office. With Office 2007 the controls should install automatically. If you are not using a Windows PC, you will also have problems using this view. If you do not have support for the view, you will be kept in standard list view. To follow the example, you will also need a set of documents in the library, which you should now have from the previous example.

**Filter Documents in Datasheet View**

When working with a large number of documents, you may only want to see a subset of the documents or to apply filters to see documents of interest. Datasheet view allows you to do this. It is possible to create a filter on any column in the list, and this option is available by clicking the downward pointing arrow beside each column name. Figure 3-3 shows the datasheet view with the filter menu available.

![Figure 3-3](image)

To open the menu and create a custom filter:

1. Click the arrow beside the column entitled Name.
2. Select Custom Filter.
3. In the drop-down directly below the title Name, select “begins with.”
4. In the drop-down list directly to the right enter “a.”
5. Click OK to close the dialog.
Multiple filters can be used based on And and Or. If you are using And filters then all the values must be True in order to get a value returned. For example, All Customers living in Belfast and New York would only return results when a customer had a home in both cities. Replacing And with Or would return customers who had a home in either Belfast or New York. This gives you a powerful way to build complex filters in datasheet view.

Filters really come into their own when dealing with numeric columns. You can also create filters on the modified column. For example, you could view all documents where the modified date is between two values. To create this filter:

1. Click on the arrow beside the Modified column and select Custom Filter.
2. Select is less than or equal to from the drop-down list beneath the word Modified.
3. Select a date in the right-hand drop-down.

This filter will filter your library to only show those documents where the Modified date is less than or equal to the date selected. When you have applied a filter to a column, the black arrow to the right of the column name will change color to blue. To remove previously applied filters simply choose Select All from the filter menu, which will remove the filter and return all the records. In addition to using the filter options, you can also sort the columns in Ascending or Descending order, and if you have a filter applied, choose the option Select To View All Documents (the default view on most lists) to return all documents to the view.

Once you change to datasheet view, you will find that additional options are available from the Action menu including:

- **Show in Standard View** allows you to switch back to the usual document library view.
- Selecting **New Row** allows you to add a new row to the data sheet, if this is allowed. This doesn’t really apply to document libraries, where the content will be mostly read-only.
- The **task pane** gives you a quick way to interact with the list items using Microsoft Office 2007 applications. The following options are available and will be discussed in later chapters where they are most relevant:
  - **Track the List in Access**
  - **Export to Access**
Chapter 3: Lists and Libraries

- Report with Access
- Query List with Excel
- Print with Excel
- Chart with Excel
- Create Excel Pivot Table Report

- **Totals** provides a total count of the items within the list.
- **Refresh Data** reloads the list to provide the latest view. For example, if your colleagues have added documents while you were working in the library, the documents will be available to you.

Another interesting feature of datasheet view is the Presence Pawn icon beside the name of the person who modified the documents or record. Clicking this icon will permit you to send an email to the individual, schedule a meeting, go to their MySite, add them to your Outlook contacts, or check their Outlook properties. If full presence management is available you can also instant message your colleague.

You may find that when you switch to datasheet view the list is read-only (as the documents list used in this example will be). Check out the bottom right of the status bar for this information. If the documents list is read-only, you will be unable to add a new row. However, if you changed the view of a task list, you would find that the list would be fully updatable in datasheet view.

**Settings Menu**

You have already had a brief look at the settings available to you when working in a document library. In this section, you will look at these options in more detail. The Settings menu provides the options discussed in the following sections.

**Create Column**

Each library, including document libraries, is made up of columns that contain the information you require. For example, the document library you are currently looking at has several columns already created: Type, Title, Modified, and Modified By. In addition, many more columns are not visible, but you can turn them on if required. On many occasions, you will want to add columns to the library you are working in that are not provided for you. Such columns can help you to describe the information or hold additional information about the document or list item. These custom columns tend to be more specific to your business needs. To create a new column within your Shared Documents library:

1. Click Settings ➔ Create Column; the Create Column form will open.
2. Enter the name of the new column as Department.
3. For the Department column, accept the default.
4. Select single line of text for the type of information to be stored in the column.
5. Choose the type of information the column will store — it can be text, a date, or something else. This is generally referred to as the data type of the column. Take an example of an invoice: the columns would include Order Date with a data type of date, Customer Name with a data type
of text, Address with a data type of text, and so on. It is important to get the data types correct, especially with data like dates when you might want to calculate values based on them, such as days taken to fill an order or a person’s age based on date of birth.

6. Enter a description for the column.

7. Accept the default value of No for the radio button entitled “Require that this column contains information.”

8. Accept the default of No Default Value.

9. Accept Add To Default View that will checked by default. This will ensure that your column is available in the default view used by SharePoint and your library.

10. Click OK to save the new column.

This topic is a little like designing a database using Microsoft Access 2007. When designing a database, it always pays to sit down and think about what it is you want that database to do before you actually touch Access. The same is true of SharePoint. A list reflects a business need, and you need to understand that business need if you are to capture all the required data, which in turn will become information you will share with your colleagues and base business decisions on.

As this example demonstrates, you are free to add additional columns to your SharePoint lists and libraries as required to meet your own business needs. It is also possible to use columns within your list or library to look up values held in another SharePoint list or library. For example, in your Shared Documents library, you may want to look up which manager was involved in a particular report or document draft. The next section discusses Lookup columns and how they are created within your SharePoint site.

Adding a Lookup Column

As already discussed, the Lookup column allows you to look up a piece of data held in another SharePoint list. To follow this example, you will need a SharePoint list that you can look up to provide the values to the column in the Shared Documents Library. Lookup columns are very useful if you need to associate a document or other list item with information already on your SharePoint site. This is a generic example, which you can use to create a lookup that meets your requirements. To create the Lookup column from within the Shared Documents library, click Settings ➤ Create Column:

1. Enter a name for the column.

2. Click the radio button lookup (Information already on this site).

3. In the Additional Column Settings Group, enter a description.

4. In the drop-down list “Get Information from,” select the list containing the value you require.

5. Select the column you require from the In This Column drop-down list.

6. If you need to allow the user to select more than one value from the drop-down list, ensure the check box “Allow multiple values” is checked.

7. Accept the “Add to default” view default of checked.

8. Click OK to save the new column to the library.
Multi-Valued Values

You can also choose to allow the selection of more than one value from the list item; this is known as a multi-valued selection. If you were looking up a meeting list and needed to select all those who attended, then you would set this value to be multi-valued. You need to be careful at this point, as some client programs, including Access 2003, cannot deal with multi-valued columns. This would be a consideration if you wanted to link the list to Access. Access 2007 does not have this problem and can manipulate multi-valued columns. For example, you can change the case used for the text displayed in a column by creating another column and using a built-in function. To follow this example, you will need to create a contacts list within your SharePoint team site containing the following column.

Calculated columns are columns created using values based on columns already held within a list or using some of the built-in functions available to SharePoint. Calculated columns allow you to reuse existing information within SharePoint lists and libraries to create new information within your list or to perform simple calculations. For reference, www.endusersharepoint.com provides an excellent set of papers on creating and using calculated columns within SharePoint, and they are more than worth downloading.

As you work with SharePoint, you will create various lists, views, and libraries. You will begin to see that columns are used many times within different libraries and lists. SharePoint provides you with these columns, and they are commonly referred to as site columns, columns you can use anywhere in your web site. You will create some site columns later in this chapter and make them available to your lists and libraries.

Create a View

When you open a document library, you are presented with a list of documents, also known as the default view of a list or library. It is created by the software, but like everything else in SharePoint, you are not restricted to this view and can both modify the default view and create your own custom views. A view is simply a way of telling SharePoint that you want to see certain documents or items under certain conditions. A document library will usually have two views available upon creation: the All Documents default view and Windows Explorer view, which is not strictly a view at all. The Library View menu is where you open existing views and from where you can amend or create new views. You can also create a new view directly from the Settings menu of the library. In this next example, you will create a new view within your Shared Documents library and make it available.

1. Click the Settings menu.
2. Select Create View. You now have a number of options:
   - Standard View, which is the one you will select shortly.
   - Calendar View, which allows you to view list data as a SharePoint calendar.
Datasheet View, which, as already discussed, is a spreadsheet-like view of the library comprising columns and rows.

Gantt View allows you to view information using a Gantt chart, which is useful for any task or project-type list. A Gantt view is mostly used with Project date information, giving you a graphical view of progress according to date.

3. To continue with the example, click Standard View. The Create View page will open, and you are now required to define the view. Having some idea of what you want before you reach this point will help.

4. Enter a name for the view.

The name should always be descriptive. You may not be the only person using the view, and it will help other colleagues understand the view if the name is descriptive. You can also make your new view the default view, that is, the view that all users of the library or list will see when they enter the library. This replaces the current default view, which will not be deleted but will become a simple view.

5. Select an Audience for your view. In this case select Public, as you want it to be available to anyone using the library. You can also create a personal view that is only available to you. Anyone using the list or library can use the public view.

6. Select the columns you would like to appear in your view, or deselect the columns you want to remove from the view. Simply check and uncheck the box beside the column name.

7. Select Title from the First sort by column.

8. Click OK to save the view.

As you will have seen when creating the view in the preceding example, there are a number of different categories that allow you to configure how the information in the view is presented within the document library. The categories are:

- **Sort** — allows you to apply one or more sorts to the list of data being displayed by SharePoint. To add a sort, select the column you would like to sort by from the drop-down list. A sort can also be in ascending order (A to Z) or descending order (Z to A). Check the radio button to choose the sort order. You can sort by up to two columns within your list or library.

- **Group By** — allows you to group similar list items together, such as all documents created within the same department or all orders for a specific customer. In an event list, you could group by date, displaying all events for a specific date. The Group By is very useful if you would like to show a large amount of information on screen but not present it all at once. When you use Group By, records can be displayed in their individual groups by expanding the group. You expand a group by clicking the plus symbol beside the group header.

- **Totals** — allows you to provide summary information about the document, that is, a total showing you at a glance how many documents have been produced by department A, B, and C.

- **Style** — allows you to choose how the library will look. In order to see the effect of some of the styles, you may need to remove the Group By in the view. Styles like Preview pane are not available if you use a Group By. Several styles are available:
  - Basic table
  - Document details
Chapter 3: Lists and Libraries

- Newsletter
- Newsletter no lines
- Shaded
- Preview pane
- Default

The most interesting option in terms of style is the Preview pane. This is not available when you are using a Group By, but for short lists of documents it is a useful presentation tool. When enabled, the preview pane gives you quick access to many of the document properties when you hover your mouse over the document name. In larger lists it can help you to quickly scan for information rather than continually clicking to open the properties form. Figure 3-5 shows a document library with the preview pane turned on.

![Figure 3-5](image.png)

- In general, initially most people are simply interested in finding the document they require as opposed to a fancy presentation. It is a more effective use of SharePoint to classify documents by, for example, using custom columns and creating views instead of creating a fancy screen layout.

- **Folders** allows you to choose to display documents within their containing folders or simply choose to list all documents within the library. For example, if you had subfolders within the document library, you could simply turn off the display of the folders and list all the documents. There are really two schools of thought on the subject of folders and subfolders. One school likes the idea of organizing documents by subfolder just as in a traditional file server system; the other school feels that views should be used to filter documents. I have a foot in both camps. Coming from a traditional file store background I am comfortable with the subfolder approach but also find creating views of the data very easy to do. One of the major pluses of using the subfolder approach is that you may already be familiar with working with folders and subfolders, and therefore may find the transition to SharePoint easier if you take this approach. In the real world, you will be maintaining your own document library, and it's really up to you to use whatever layout you feel most comfortable with.

- **Item Limit** allows you to specify the number of documents returned by the library to a maximum amount (100 per page) or set a paging limit. It is useful to set a limit that does not require you to scroll down the page too much in order to view all documents. The default is 100.
documents. If you have more documents to be displayed, a set of navigation buttons will be placed at the bottom of the list, allowing you to move forward and back between the various pages.

- **Mobile**: The URL for the library for users who may be using a mobile device to access the site. You can make any list or view a mobile view.

Views are a great way to organize information and make it easier for you and your colleagues to find information. When you combine views with custom columns, you can make very complex views containing Group Bys and multiple Order Bys, again to make it easy to find the information required.

**Document Library Settings**

Selecting Settings ➔ Document Library Settings will open the Customize Library page form, where you will find a large number of settings that can be applied to your document library, organized into groups. The settings discussed in the following sections are available if you have the required permissions.

**General**

Under General, you will find settings that affect the general look and feel of your document library. In this group you will find:

- **Title, Description, and Navigation**: This setting allows you to change the title of the library. For example, you could change the current document library title to Departmental Documents, making it more relevant to your colleagues. Under Navigation, you could also turn off the displaying of this library on the Quick Launch menu simply by changing a single setting. Again, this is a useful feature if you find that the menu items are scrolling off the page.

- **Versioning settings**: Within this area there are several settings that deal with document version history and its availability. Versioning allows SharePoint to maintain copies of your document as they are changed by you or your colleagues and permits you to revert back to a previous document if required.

- This section also includes options to check out documents and set permissions for who can see draft copies of documents. When you place a document into a library, you may find that more than one user would like to edit it at the same time. Check Out and its opposite Check In help to reduce the possibility of your colleagues’ overwriting each other’s (and your) documents. If Check Out is enforced, you must check the document out before you can edit it. Once it is checked out, a green arrow will appear beside the document and any of your colleagues wishing to download the document for editing will be informed that it is currently checked out to you.

- If a document is still at the draft stage, that is, if it has not been approved for publication into the library, you can restrict who can see it to any user who has read permissions for the library, only users who can edit items, or only document approvals or the authors of the document.

- **Audience Targeting** is an area of SharePoint I really like, as it provides the capability to target content at a specific audience or group of your colleagues. An audience is a group of users within your site that shares something in common. They might, for example, all work in finance, processing accounts payable. The capability to push information out to your colleagues in a very targeted way is very useful within SharePoint and is one of its more powerful features. The only catch is that audiences must be enabled by your server administrator and then enabled on a site or library. Once this is done, you have a very powerful information distribution tool available to you.
Library Columns

The columns section within the Customize Library form lists the available columns in your library, and by clicking on a column name, you can edit the column’s values.

Do not change the name of the Title column. This is widely used in SharePoint, and in fact it is available on almost every list and library. If you do a quick Google on this, you will find that changing the Title column has caused many a headache for SharePoint administrators.

The columns category allows you to create new columns and reuse existing ones. This is a more flexible approach than creating columns within a library or list, but you will need the permissions to work at this level. You have already created a custom column for the library. However, in this page you also have access to all the columns already existing within your site. In this way, you can add any existing site column to your SharePoint library. SharePoint contains several hundred columns used in its lists and libraries, and they are classified by group according to functionality. For example, the Core Contact and Calendar groups contain all the columns used by the Contact and Calendar lists within SharePoint. The categories available are:

- Base columns
- Core Contact and Calendar columns
- Core Document columns
- Core Task and Issue columns
- Extended columns
- Key Performance Indicators
- Page Layout columns
- Publishing columns
- Reports

From the Document Library settings page, you can add one or more columns from any category to your library. To add an existing column to the Shared Documents library:

1. Click Add from existing site columns.
2. Select Core Document columns from the Select columns drop-down list.
3. Click on the Comments column.
4. Click the Add button to move the selected column to the Columns To Add box.
5. Click OK.

When you return to your document library, you will find the additional column added. Of course, you can select multiple columns from more than one column category to add to your list.
Column ordering allows you to change the position of a column in the list. Simply change the numeric value using the drop-down list beside the column name.

Indexed columns are more in the realm of technical users and refer to a way to speed up the performance of large lists.

There is another reason why custom columns are really useful in SharePoint searching. While the instructions on how to configure the SharePoint search features to pick up your custom columns are fairly straightforward, they are beyond the scope of this book and likely beyond your SharePoint permissions. But all you need to do is to tell your SharePoint server administrator that you have created a custom column and you would like it added to the SharePoint search. He or she will sort it out from there.

**Views**

A view is a custom set of information based on a more complete list within SharePoint. This category shows the views currently available within the document library and which view has been selected as the default.

**Library Management**

Just like everything else in SharePoint, your lists and libraries will need to be managed in terms of both available functionality and security. This section deals with permissions and management features for the library, including the ability to delete the library with a couple of clicks. The security and management options in this group are discussed in the following sections.

**Save Document Library as a Template**

If you have a document library that you want to reuse within the site you can save it as a template. When you are creating a new document library the template will be available with the rest of the SharePoint library templates. To save the Shared Documents library as a template:

1. Click Save Document Library As A Template.
2. Enter a filename for the template.
3. Enter a name for the template. This will be the name shown on the Create page in SharePoint.
4. Enter a description for the template.
5. You can also choose to include the existing libraries content with the template. To save the list content to the template, check the Include Content check box.
6. Click OK to save the library as a template.

**Permissions for This Document Library**

As already discussed, in addition to permissions to the site, you can also assign permissions to the document library. The document library will inherit the permissions of the site, and if you want it to have unique permissions you must first break this link. To do so from the Document Library settings page:
Chapter 3: Lists and Libraries

1. Click Permissions For This Document Library Link.
2. In the Permissions form, click Actions ➤ Edit Permissions.
3. Click OK in response to the warning dialog.

You can now remove existing users and add new users to the document library. To remove all permissions:

1. Check the check box below the New menu to select all the users.
2. Next click Actions ➤ Remove User Permissions.
3. Click OK in response to the dialog.

The permissions for existing users will be removed. Now you will need to add the users you would like to have access to the library and specify the permissions they will have. You can add individual users or groups of users to the library. If you would rather edit existing permissions, then select Edit Permissions to edit the permissions each user or group of users have.

If you make a total mess of things, you can always reset the library permissions back to inherit permissions from the parent site. To reset the permissions back to those of the parent site, click Actions ➤ Inherit Permissions.

This is another very powerful security tool in SharePoint, giving you the ability to secure information right down to the document level. The features available to you within the Document Library settings page also help protect information, and they are discussed in the next section.

**Manage Checked-Out Files**

This option allows you to manage any documents within your library that do not have a version checked in. Even when you have check-in enabled it is possible to drag files into the library using Windows Explorer. This is particularly true of files that require additional metadata to be added when they are saved to the document library. In that case the files may not be checked in. The only way to manage such files is by using the Manage Checked-out Files form to take ownership of the documents and check them in on behalf of the users. This is really a role for the site administrator, but it can be confusing for you when you know you have uploaded documents but you cannot see them in the library.

**Workflow Settings**

Workflow settings allow you to enable the out-of-the-box SharePoint workflows for this library. You will look at workflows shortly.

**Information Management Policy Settings**

Information policy is discussed in detail in Chapter 13 and you will return to this setting then.

**RSS Settings**

A document library can also be exposed via an RSS feed. You can subscribe to an RSS feed using Outlook 2007. This is discussed in Chapter 8.
As you can see, there are a multitude of settings and options available to you with a document library. As you progress to other objects, you will find many of the settings identical — the main difference being the type of list or library you will apply them to. Of course, you will need permissions to use many of the features outlined so far, and in reality it is likely that only a small number of your site users will be granted permissions to manage libraries to this level.

**Document Edit Menu**

The Document menu is available by moving the mouse over an item in a library and clicking the downward-pointing arrow that appears. Figure 3-6 shows this menu for a document in the Shared Documents library.

![Figure 3-6](image)  
*Figure 3-6*

The menu offers you the options discussed in the following sections.

**View Properties**

This option allows you to view the properties of the document, such as title and name. The name of the file is just that: the name you used when you created the document. The title is a SharePoint property and can be used as a single line of descriptive text to identify the document. As you add properties to the documents, they will become available in this view. Several properties are of use to you when working with libraries other than those that deal with metadata, but generally the properties available reflect the other options on the Document menu.

**Edit Properties**

This option allows you to change the default properties of the documents and any custom properties you have added.

**Manage Permissions**

As discussed previously, permissions in SharePoint can be applied down to the document level. You can change permissions for the individual document within the library. By default, a document will inherit permissions from its parent site, and before you can create unique permissions you must break the inheritance link. To break the link:
Chapter 3: Lists and Libraries

1. Select Manage Permissions.
2. Click Actions.
3. Select Edit Permissions.
4. Click OK in response to the warning message.

Existing permissions will still be listed within the page, and generally you need to remove them or remove those permission groups you do not require. To remove all permissions:

1. Click the check box below the New menu. This will select the check boxes beside each group with existing permissions.
2. Click Actions.
3. Click Remove User Permissions.
4. Click OK in response to the warning message.

Note that all existing permissions have now been removed from the document. You will now be required to add the new permissions to the document. To do this:

1. Click New.
2. Select Add Users to open the Add Users form.
3. In the Add Users group, enter the user you require or use the lookup features to search your Active Directory for the user or users.

Once the user is selected, you must then grant that user specific permissions. You can, if required, select a SharePoint group to give permissions to, but bear in mind you just removed all groups from access to the document. In this case, you will give direct permissions to the user:

1. Check the radio button titled Give Users Permissions Directly. This may be defaulted for you as you have removed all group access to the document.
2. Check the appropriate permission from the list of available permissions.

Figure 3-7 shows the permissions available for a document in the Shared Document library.
Part I: Microsoft SharePoint Server 2007

Document-level permissions are important if you are not setting permissions at the folder level. It is easy to forget about permissions and leave a document unsecured. As with most things computer-related, you can be sure that if you leave a document unsecured, the colleague you least want to view it will open it first!

**Edit in Microsoft**

This option opens the document for editing in the source application. For example, if the document is a Word file, the menu will read Open for Editing in Microsoft Office Word; if an Excel document, it will read Open for Editing in Microsoft Office Excel.

**Delete**

This option will delete the currently selected document. If you have a site Recycle Bin activated, the document will be removed from the library and placed into the Recycle Bin just in case.

**View in Web Browser**

For documents that are web-enabled (such as Microsoft Excel 2007), if you are running MOSS 2007 with Excel Services, you can open the document directly in the browser as opposed to in the client application. Excel Services will need to be activated and configured by your server administrator. Figure 3-8 shows a workbook open in the browser. This area is discussed in detail in Chapter 9, “Microsoft Office Excel 2007.” In addition, the setting in the Library Settings, Advanced Setting → Open browser enabled documents, will display such “web” documents within the browser. However, in Office 2003 documents this feature will not work, and the document will open in the client application.
Chapter 3: Lists and Libraries

Send To

This option is another of those useful SharePoint shortcuts. It enables you to send a copy of the document to another location within your site structure, such as a public document area outside the team site that all staff members have access to. To send a copy of the document to another location:

1. Select Send To.
2. Select Other Location. This opens the Copy form, and in steps 3 and 4 you will complete some options.
3. Set Destination URL to the document library within your SharePoint sites to which you would like to copy the document.
   Normally, you could go to the destination library and copy the URL from the browser and then simply paste it into the text box. There is one thing that will catch you out, however, when using this approach. Make sure that you remove the following part of the URL when you paste it into the text box: Forms/AllItems.aspx. If you leave this text in the URL, you will receive an error.
4. Enter a filename for the document copy. A default name is provided for you, and, normally you could leave this default name but add the prefix copy.
5. The update section is important. How will you handle updates to the copy when the original document is changed? In this section, you can choose to:
   - Prompt the document author to update the copy document or not depending on your requirements.
   - Sign up for an alert to be issued should the document change.

Custom Send to Destination

It is also possible to hard code a Send To destination into this feature. This is useful if you will always send documents to a specific area, for example up to a top-level document library. To customize the Send To option from the document library:

1. Click Settings.
2. Click Document Library Settings.
3. Click Advanced Settings.
4. Scroll midway down the page until you reach Customize Send To destination.
5. Enter a name for the Location like Public Documents. Make the name obvious so other colleagues using this option know where their document will be copied to.

6. Enter the URL to the document library you wish to send the document to.

7. Click OK to close the Advanced Settings form.

8. Return to your document library.

Figure 3-9 shows the new location in the Document menu; note that this custom location is added as an extra Send To option and the original option is still available.

![Figure 3-9](image)

Now that you have copied the documents, check out the Send To option on the original document. Notice that a new item is available on the menu, Existing Copies. Choosing this option is useful when you edit the original document. In that case, selecting Existing Copies opens the Update Copies form where you can choose which copies you would like to update with the changes. If you cannot remember where copies are or even have forgotten you have copies in other areas when you select View Properties from the Document menu, there is a Manage Copies option. This form will show you all your copies on which Update Copy is enabled and all copies where it is not. In addition, it will list the locations of all copies you have made. From the Update form you can also update all or some of your copies from a single point. The best way to remember if you have copies of a document out on the server is to simply look for the Existing Copies link of the Document menu.

In the library into which you copy the document, another item is also added to the Document menu: Go to Source Item. The idea behind this is that a colleague who wants to edit the document can go to the original file as opposed to editing the copy.

The drawbacks to this method are mainly that you can only have one custom Send To per document library and you have to type the URL to the location library in the text box. As stated, the easy way around the URL issue is to simply go to the destination library and copy the URL from the browser and then paste it into the Send To text box.

**Check Out**

Once you have documents within your library, you want to be sure that they cannot be overwritten easily. Check Out and Check In are an attempt to stop this from happening. One of the first things you should do when creating a document library is to go to the Versioning setting and enforce the Checking
Out of documents. Once this has been enforced for the library, documents must be checked out before they can be edited. When you open a document from within SharePoint, you will be prompted to check it out either directly within the application (Word, Excel, and so on) or you may download a copy to your local draft folder located within My Documents. Only then can you edit the document. In Vista this folder will be named SharePoint Drafts and will contain any documents you have downloaded. Using this method, you can work on documents while disconnected from the server and upload them later.

When uploading or saving a document back to the library, you will be prompted to check the document back in. To check out a Microsoft Word 2007 document:

1. Open the Document menu.
2. Click Check Out.
3. Remove the check mark at Use My Local Draft Folder.
4. Click OK. Note the Check Out icon that has been added to the document.
5. Select Edit in Microsoft Office Word. The document will open in the client application and can be edited. You may receive a warning message about harmful files. In this case it’s OK to ignore it and click OK to continue.
6. Once you have completed the edit, click the Office button in Word and select Server.
7. Select Check In. Microsoft Word 2007 will check in the document, and you may be prompted for additional metadata, such as version information. Once checked in, you should see a dialog in Word 2007 telling you that you will need to check out the document again if you would like to continue to edit it, as once it is checked in, the document becomes read-only.

Now this all sounds fairly foolproof, but it is possible, using My Network Places, to create a connection to your document library and simply drag and drop documents onto the PC. Once there, they can be edited and dropped back into the SharePoint library, bypassing the check-in/check-out process.

**Workflows**

Workflows in SharePoint could take up an entire book on their own. In this section, you will examine the default workflows available within a document library.

**What Is a Workflow?**

A workflow is a set of instructions that will follow a business process. Take document approval, the first workflow you will look at. The basic workflow would be:

1. Document draft.
2. Document sent for approval to one or more individuals.
3. Document is approved or not.
4. If not approved, the document is redrafted and resubmitted for approval.
5. If approved, the document can be published to your library or issued.
Part I: Microsoft SharePoint Server 2007

In business, many people simply email the document to their colleagues or manager for approval. In SharePoint this process is automated for you and SharePoint deals with the routing and tracking of the document. To follow this example, you will need a Microsoft Word 2007 document and access to your email account. You are going to create an Approval Workflow for a document.

Creating an Approval Workflow

To create an Approval Workflow on a document with your Shared Documents library:


2. The Start Approval form will open. Figure 3-10 shows the Start Workflow form.

3. Click the Approvers Button.

4. Enter the names of the approvers for this document, and click find. In this case, simply assign the approval to yourself.

5. Select the approver from the search list, and click OK.

6. Enter a message to be sent to the approver.
7. Enter the due date, which can be in days or weeks. In this case, enter one day.

8. If you have email working on your SharePoint server, the approver will receive an email if the task is not completed by the due date. In this case, the due date will be today plus one.

9. If required, you can copy other members of staff about this approval process without actually assigning them a task.

10. Click Start to end the workflow configuration and start the workflow.

The approvers will immediately be sent an email informing them that an approval task has been created for them, containing a link to the document requiring approval. In addition, a new task will be added to the site’s task list containing the workflow’s due date and other relevant information. You will use the task form to approve or reject the request.

When you receive a request, you can redirect it back to the requestor or pass it on to a more appropriate member of staff. Again, you use the task list to manage this process. To reassign workflow task to another member of staff, you can click the Reassign Task link at the bottom of the task form.

Reassign a Workflow Task

Sometimes you may not be able to provide information or complete a workflow. In that case, you can reassign the workflow to another colleague for completion. To reassign a workflow to another colleague:

1. Click the task list to open the task approval form.

2. Locate the Reassign Task link at the bottom of the form.

3. You can return the task with comment to the person who created it, or send it to someone more appropriate, to reassign the task.

4. Click the radio button labeled Another Person.

5. Click the Assign To button.

6. Search for the colleague to reassign the task to.

7. Click OK to select the individual. You can, if required, update the task instructions and the due date, which will show the due date of the task.

8. Click Send to reassign the task.

When you return to the task list, note that the original task assigned to you has been marked as completed and a note added to say that you have delegated the task to another member of staff.

The task will be reentered into the task list as a new task assigned to the reassigned approver. The second type of workflow that you can create is Collect Feedback Workflow. In one of my previous roles I worked as an IT trainer. Part of the job involved creating training materials, and it was useful to have feedback on draft materials before they were published. This is where the Collect Feedback Workflow would have been useful, as it allows you to request feedback on a document from your colleagues and records that feedback for you.
Part I: Microsoft SharePoint Server 2007

Create a Collect Feedback Workflow

Just like the Approval Workflow, the Collect Feedback Workflow is also available by default in a document library. The initial process is just like starting an approval workflow. To begin the workflow:

1. Click Workflows on the Document menu (hover the mouse over a document name).
2. Select the Collect Feedback Workflow.
3. Enter the name of the reviewers or click the Reviewers button to search for colleagues.
4. Enter a comment to the reviewers.
5. Enter a due date.
6. If required, you can also click the Notify button to inform other colleagues that the process is started.
7. Click Start to begin the workflow.

Just as with the Approval Workflow, a task is added to the task list for the reviewers, emails are issued and, again, when you return to your document library you will notice a new Workflow column with the text “In Progress” showing.

On the task list, reviewers can click to add a review of your document. When they select Edit Item using the Document Edit menu in the task list, they are taken to a review form. This form contains a link to the document to be reviewed and an area for comments. Once this has been completed, the reviewer can click Send Review to submit their comments on the document. Once the review has been completed, you can return to the Workflow status page to view the reviewer’s comments.

Customize Workflows

It is also possible to customize workflows within your document library. From within a document library:

1. Select Settings.

You may notice that there are two additional workflows available in the Select a Workflow list box. These will be addressed shortly.

4. Select Collect Feedback Workflow to open the first page of a multi-step form.
5. Enter a more appropriate name for the workflow, something like Training Materials Feedback. This makes it much more obvious to your colleagues what the workflow is actually for.

6. As you have seen, the workflow is added to the standard SharePoint Tasks list. At this point, you can also request a new Task list be created for this workflow. In this case, accept the default list Tasks.

7. You can select an existing Workflow History list or request a new one be created. The workflow history list is not visible in the SharePoint interface. Again, accept the default.
8. The last section allows you to specify when a workflow can be started. Select the option “Start the workflow when a new item is created.”

9. Once you have completed the form, click Next.

10. Accept the defaults shown in the Workflow tasks section. You can assign the workflow to all participants at the same time or have the workflow wait until one colleague has completed his or her assigned task by completing the workflow before assigning it to the next person in the chain. You can choose to stop workflows from being reassigned or to stop people from requesting a change in the workflow before it is completed.

11. The next section in page two of the form, Default Workflow Start Values, allows you to assign default individuals who will receive the workflow. This is useful if you have a set team or group who is responsible for the review of documents. You can also set up a default due date and due days to complete the workflow, and finally create a default group of people who need to be notified when the workflow is started.

12. To complete the customization, click OK.

You are then returned to the Workflow Settings page. Note the additional options available to you:

- **Add a workflow**: Allows you to create another customized workflow using the default set provided. The process is identical to that outlined in the previous example. This is useful to create different workflows that may change slightly. For example, you may want another workflow that has a different set of reviewers based on the document type; for example, a contract document may need to go to a specialist team of reviewers.

- **Remove a workflow**: Removes the association that a workflow has with the library. This does not delete the workflow. You can, at this point, choose to allow any instances of the workflow to be completed or cancel them immediately.

- **Delete a workflow from the library**: Deletes the workflow from the library.

- **View workflow reports**: View a set of reports that provides extensive information about the operations of your workflows. These reports are useful particularly if a workflow does not work as expected. Each workflow has two associated reports: Activity Duration, and Cancellation and Error reports.

The workflows described so far are usually available by default in your document library. There is an additional workflow called a Disposition Workflow. You will return to this workflow when you look at information management in Chapter 13, as it is closely related to records management.

Workflows, even those supplied when you install SharePoint, offer you an automated toolset that can be used to help organize and process mundane tasks, such as document approval. In Chapter 12, you will see how you can create more complex workflows for lists and libraries using SharePoint Designer. The true power of workflows is available to those who can program using development tools like Visual Studio. However, even for the mere mortals among us, workflows can be created that help get the job done in a more efficient manner. The only drawback to workflows is that they are restricted to the list in which they are created. You cannot create a workflow in your document library and then reuse it in your contacts list. In order to achieve that feat, you will need the services of a SharePoint developer or .NET programmer. But that negative aside, they are worth using when you have a need for them.
Part I: Microsoft SharePoint Server 2007

**Alerts**

Alerts are a great way to keep your colleagues informed about what is happening within a document library or another list with SharePoint. Alerts are the responsibility of the site users, and they can create and manage their own within the site. Alerts can be set at the library or individual document level. The alert creation process is the same whichever type you are creating. To set up an alert for a document, from within a list or library:

1. Open the Document Edit Menu.
2. Select Alert Me.
3. In the New Alert screen enter the following information:
   - **Alert Title:** You should make this meaningful as you will be receiving email alerts, and this will help you understand the content. A default title will already be available based on the document name.
   - **Send Alerts To:** In this case, your name will appear in the user dialog. A neat trick here is that you can add additional users to receive the alert by using the Browse button to find their details.
   - **Send Alerts for These Changes:** Alerts can be sent when anything changes: someone else changes a document, someone else changes a document created by me, and someone else changes a document modified by me.
   - **When to Send Alerts:** Alerts can be sent via email immediately, a daily summary, or a weekly summary.

Unless it is vital that you be informed about a document change, a weekly summary alert is probably sufficient. If you request a lot of alerts and your site sees a lot of editing, your Inbox could be hammered by email alerts, and it will not be long before you begin to ignore them. If you select a daily or weekly summary, you can specify the day and time to send the alerts. In addition, you will find that the range of alert settings can differ depending on the list you are setting the alert up on. The task list, for example, will offer you a wider range of notification settings specific to tasks.

4. Once you have the alert configured, click OK to close and save the setup.

As stated, you need to be careful when creating alerts so that you and your colleagues do not get overloaded with email and then begin to ignore the alerts.

Up to this point in the chapter, you have been looking at a document library, as this is the most common object you will interact with on a day-to-day basis in SharePoint. Several other libraries are available to you in SharePoint, and in this section you will look at all of them.

**Form Library**

If you have installed Microsoft Office 2007 Professional, you will have a copy of Microsoft InfoPath on your PC. InfoPath is an application used to create electronic forms, which can be as simple as a fill-in contact sheet to a complex form that interacts with corporate databases. MOSS 2007 contains a forms server that will allow you to display and interact with InfoPath forms within the browser. In this way, your colleagues do not need to have InfoPath installed in order to use your forms. However, if your
colleague does have InfoPath installed, the form will open using the InfoPath Application. In order to use InfoPath forms on your SharePoint site in this way, InfoPath must be activated by your site administrator before you can use this feature. It is my own view that, other than for basic forms, it is likely that most if not all SharePoint users will use forms created by designers and programmers. This will be particularly true in business when many forms, in order to be of practical business use, must interact with back-end database systems. Information from databases is used to part-populate forms or used to insert the results of people completing forms. In addition, some forms need specific permissions to be installed within SharePoint, and it is not likely that standard system users will have such permissions. However, in saying that, InfoPath forms do offer you a way to create electronic forms, helping you to deal with some of the more mundane aspects of business tasks.

**Picture Library**

This library is actually useful in a business sense in that it can be used to store product images or images required by students for courses. You create a picture library in the same way as a document library. Once created, however, there are specific options available to you for management of your images. The following sections explain the additional menu options.

**Upload**

You can, as in other libraries, upload single or multiple image files. In this case, the upload is specifically for images and will default to your Pictures folder (Vista) and will use Microsoft Picture Manager as the uploading tool.

**Actions Menu**

The options in the Actions menu will also change to reflect the file type chosen. In addition to the standard Action menu items you have:

- Edit your images in a picture editor
- Delete selected pictures
- Download selected images to your PC
- Send the images to a document or email message
- View Slide Show

**View Menu**

The View menu, in addition to allowing you the standard view you have already seen, has three built-in views specific to images: thumbnails, details, and filmstrip. To view these options, click the All Pictures submenu item to open the submenu.

The remaining options are standard document library items. The Picture Library is worth looking at if you have a requirement to store large numbers of image files within your site.

Three other libraries are also available:
Part I: Microsoft SharePoint Server 2007

- Translation Management Library, which is used to manage the process of translating SharePoint content into multiple languages.
- Report Library, which is used to provide access to company reports and key performance indicators.
- Data Connection Library, which is used to provide access to common connections to business systems. This library will be covered in Chapter 9 when you look at Microsoft Excel 2007.

You have looked at document libraries in some detail in this section of the book and have also had an introduction to some of the other types of libraries available with SharePoint. Libraries are something you will use every day to work with SharePoint and the other major object you will see a lot of is the SharePoint list. The Site Actions menu will give you access to the Create form used in SharePoint where, in addition to the libraries you have already worked with, you can create a wide range of Lists.

**Lists**

In addition to the libraries, SharePoint also provides multiple lists for you to use. Lists are grouped on the Create page into four main categories: Communications, Tracking, Custom Lists, and Web Pages. In this section, you will look at each of the lists options available to you.

**Communication Lists**

These lists are all about getting information to and from you and your colleagues. The list choices are outlined in the following sections.

**Announcements**

The announcements list is used to pass information to your team. It is usually placed on the home page of your site and is commonly used to present news and other events to your colleagues. When you created your team site in Chapter 2, you saw that an announcement was already created by the system for you. One of the first things you should do is remove that announcement and replace it with one more specific to your team. To remove the announcement:

1. Click on the announcement titled “Getting started with Windows SharePoint Services.”
2. Click Delete Item in the management form.
3. Click OK to confirm the deletion.
4. Once the default announcement is deleted, you will now create a new item.
5. Click on the list title Announcements.
6. Open the list for editing by clicking New.
7. Add a title for the new item.
8. Enter the actual news item text. Note that, when you click inside the text box, an editing tool bar opens to allow you to format your text. You need to be careful with this, as the rich text may not work in Firefox.
9. If required, you can enter an expiry date. If you do enter this date, your announcement will be removed on that date. This is useful to ensure that announcements are always current and up to date.

10. Click OK to save the announcement.

You can also go directly to the new announcement creation page by clicking the Add New Announcement link. When you return to the home page of the team site, you should see your new announcement on the home page.

**Contacts**

The contacts list allows you to provide a central list of contacts that you and your colleagues may find useful. In many businesses, contacts are held by individuals and are not generally available to everyone. Use of the contacts list overcomes this problem allowing you to build up a general shared list available to all team members. Because a contact list is a SharePoint list, it is useful to be able to build views on this particular list. This is one of the more popular lists to customize by adding in an additional column like business categories, position information, and anything else specific to the contacts that would allow you to display them in a manner more relevant to you. You can also create views based on the existing columns. For example, the column Job Title would allow you to create multiple views based on what people actually do such as Managing Directors, HR staff, and so on. This, again, gives you and your colleagues quick easy access to information. To create a contacts list:

1. Click the Site Actions menu and click Site Settings.
2. Click Contacts.
3. Enter a Name for the list — something like Company Contacts.
4. Enter a description to assist your colleagues to identify the list’s purpose.
5. Choose to display the list in Quick Launch.
6. Click Create.

Once you have the list created, you are going to add a custom column to record the business category of the individual. With the list open:

1. Click Settings.
2. Click List Settings.
3. Scroll down the page, and click on Create Column.
4. Enter Business Category as the name.
5. Select Choice as the type of information.
6. Scroll down the page until you see the section Additional Column Settings. In the “Type each choice on a separate line” list box, delete the default list and enter the business categories of interest to you; for example, Sales, Research, Colleague, SharePoint.
7. In the “Display choices using group,” accept the default drop-down menu. If you want people to select more than one selection you can select “Checkboxes (allow multiple values).”
Part I: Microsoft SharePoint Server 2007

8. Accept the remaining defaults, and click OK to add the new column.
9. Return to your Contact list, and click New to add a new contact. If you scroll to the bottom of the Contact form, you will see you now have a drop-down list of business categories from which to select. You should also see a new drop-down column in the Company Contacts list, called Business Category.

When you create a new contact, you will now have a drop-down list of categories to select from. Once you have added some records to the Contacts list, you could create a view on the list. To continue using the View menu:

1. Select create View.
2. Select Standard View.
3. Enter a view name.
4. Accept the default audience as public.
5. Accept the default columns selected.
6. Scroll down the page to the filter section.
7. Click on the option “Show items when the following is true.”
8. Using the “Show the items when” column, select Business Category.
9. Leave the next list set at “is equal to.”
10. In the final text box, type in one of the business categories you created.
11. Click OK to save and create your new Contact view.

You will now have a list of contacts specific to the business category you entered into the view filter. This is a useful technique when you have large lists of contacts and you need a way to help your colleagues find information quickly. Instead of scanning a long list they can simply choose a view.

Discussion Board

You may already be familiar with discussion boards, but if you’re not, a discussion board is simply a place for people to leave a message and for others to respond to it. They are very useful in an educational setting and for business project groups. For project groups, a discussion board can be a central place that all members of a team can have access whatever their location. Follow the instructions above to create a discussion board within your site. From the sites Quick Launch, open the Discussion. The first thing you will need to do is to create a discussion topic. To create a new discussion, open the discussion list and:

1. Click New.
2. Enter a subject.
3. Enter the text of the discussion.
4. Click OK.

This will add your topic or message to the list. To view the discussion in the discussion list, click on the Subject link. This will open the discussion forum itself from where you can reply to messages. To reply:
1. Click Reply on the menu.
2. Enter your response at the top of the Reply form.
3. Click OK.

You will be returned to the Discussion screen, and you should now see your reply. If you would like to see the text in the original posted message, click the Show Quoted Messages link within your message body. Figure 3-11 shows the Discussion List.

![Figure 3-11]

The discussion list in SharePoint is functional and simply allows you to create fairly basic discussion groups on your sites. For greater functionality, it’s likely that you would require a third-party list if you need to provide the type of features seen on a standard Internet discussion list.

**Tracking**

The Tracking group deals with lists that you can use to track items like appointments, events, tasks, issues, and projects. This group also contains the Survey list, which is useful if you would like to create an ad hoc survey of staff or other system users. Surveys could also be used if you permit outside individuals or organizations access to your sites. The tracking lists are outlined in the following sections.

**Links**

The Links list is designed to store web site addresses that would be useful to your team. You can enter a URL and a description, and associate some notes. As usual with SharePoint, some of your settings options will change depending on the type of list you have created. The Links list is an example of this, and you can check this out by looking at the advanced settings. Depending on your requirements, there are several settings that can prove useful. To view the advanced settings from within the Links list, click Settings → List Settings → Advanced settings.
Part I: Microsoft SharePoint Server 2007

The two settings of interest are:

- **Item-level Permissions**, which allows you to set up the list so that each user can read either their own links, that is, those they add to the list or all links.
- **Enable Attachments to the List**, which if enabled, allows you to add file attachments to your links in the list.

**Calendar**

The calendar list is used frequently within SharePoint to provide access to event, meetings, and any other time-related information to your team. When you create a new team site, a new calendar is created for you and is displayed on the home page of your site as a simple list of events and dates. However, if you click the list heading (Calendar) on the home page, you will be taken to the calendar list, which does actually look like a calendar. Figure 3-12 shows a typical SharePoint calendar.

![Figure 3-12](image)

The easiest way to add an item to the calendar is to click New when viewing the calendar to open the New Item form. You are required to enter a title and start and end times. Optionally, you can enter a location or an event description, or you can choose to make the event an all-day event.

The event can also be set up to be a repeating event that takes place daily, weekly, monthly, or yearly. You also have options to end the recurrence after a set number of days or by a specific date. Figure 3-13 shows the recurrence options.
If required, you can create a meeting workspace to help organize the event. You will return to this list in Chapter 8.

**Tasks**

The Tasks list provides a simplified approach to project management. It is similar in many ways to the Tasks feature available in Microsoft Outlook 2007 and indeed can be tightly integrated with Outlook. On this occasion, you will work with the default tasks list created when you built the team site. To open the list:

1. Click Tasks in Quick launch.
2. Click New.
3. Complete the details in the New Item form:
   - **Title**: Enter a title for the task.
   - **Priority**: Use the drop-down list to select Normal (the default), High, or Low
   - **Status**: Select the project task status, Not Started (default), In Progress, Completed, Waiting on someone else, or Deferred.
   - Enter a percentage completed if required.
4. The Assigned To field takes a little more work. The task can be assigned to anyone whose details are held within the system and not just restricted to users of your site. To select someone to assign the task to, click the book icon, which opens the Select People and Groups dialog with which you can search for individuals within your SharePoint installation. Figure 3-14 shows the Select People and Groups dialog.
5. Enter the name of the user you require.
6. Click on the user name once it is found within the dialog.
7. Click OK to return to the New Item screen.
8. Enter a description for the task.
9. Complete the Start and End dates.
10. Click OK to save and assign the task.

When you return to the Tasks list in the site, click on the View menu to see the default views already created for you. They include:

- All tasks, the default view
- Active tasks, the tasks currently not completed
- By Assigned To, the tasks by individual
- By My Groups, the tasks assigned to groups
- Due Today, the tasks due today
- My tasks, the tasks you’re responsible for

The Tasks list and the way in which it integrates with Outlook 2007 provides you with a great tool that can be used to manage basic projects and work projects.
**Project Tasks**

Figure 3-15 shows the Project task list, which contains a Gantt chart at the top of the screen and a list of associated tasks at the bottom. In this case, two tasks are visible in the chart and the corresponding text related to the task is shown at the bottom of Figure 3-15.

![Gantt Chart and Task List](image)

**Figure 3-15**

One of the great things about the menu system in lists and libraries is that once you work out what each item does for a particular library or list, the same menu options are generally available in other types of lists. This reduces the learning curve when you are new to SharePoint. One of the cool things about the Chart view is that you can click on an item and drag it to another date within the screen. In Figure 3-11, two items are available. Note that the first item is displayed using a black diamond. This indicates that this task has no due date. The second item indicated by the longer bar shows a start and End date. Both items can be dragged in the form to change the dates. You can also view the detail of any item by clicking on its title within the Gantt chart or the list of items at the bottom of the screen.

**Issue Tracking**

The issue tracking list is slightly more complicated than the standard SharePoint list and will require some additional configuration before you can use it. Creating the list is identical to creating the lists you’ve already seen. Once the list is created, it will appear as a link on the Quick Launch. To continue and create the list:

1. Click Actions ➤ Create.
2. Click on the Issue Tracking list link in the Tracking category.
3. Enter a name for the list, for example Computer Tracking.
4. Accept the rest of the defaults, and click OK to create the list.
5. Click the Issue list link on Quick Launch to open your Issues list. The first thing you need to do is update one of the list columns, as it contains some default values. The column category is designed to allow you to categorize issues.
Part I: Microsoft SharePoint Server 2007

6. To customize the column, click Settings ➔ List Settings.

7. Scroll down the screen to the Columns category.

8. In the columns category, click the Category column to edit it.

   Note that this column is a drop-down menu containing three default values, which you need to replace with categories that are relevant to you.

9. Click OK to close and save the column.

Now that you have created the Issue Tracking list, you can add a new record. To continue from within your issue list, click New and complete the Title, Assigned to, Issue Status, Priority, Description, and Category fields. Category should now display your new categories.

1. Add comments for this issue.
2. Enter a due date if required.
3. Click OK to save and close the item.

When creating the new list item, you will have noticed the item-related issues. Since this was your first item this box will be blank. As you add items to the list, the first list box will become populated with the issue titles. When adding another issue, you can relate it to an existing issue by selecting an issue title in the first list and clicking the Add button to move it to the second list. You can associate multiple existing issues with a new item. This is useful when you want to find out if issues are related, as they would be in a computer help desk, where one issue could be connected to another. In Chapter 7 you will be returning to the Issues list and looking at it in more detail.

Survey

The Survey list is actually quite useful if you want to quickly survey groups of staff or customers who may have access to your SharePoint site. While not on the scale of commercial survey software, SharePoint surveys can have a place in your business. As with the Discussion lists, you can also use Survey when you first begin to use SharePoint, to find out how other staff are coping with the software, what they find hard to use, additional services they require, and how they feel about the design of the sites. Unlike other lists in SharePoint, with a survey you don’t get a “getting started” set of columns. With a survey you create everything from scratch by creating your questions. In addition to the simple questions where someone simply responds with an answer, you can add branching to your survey. For example, if the survey was to find out how other staff felt about SharePoint, it would be important to know if they were a standard user, site administrator, or belonged to another group. Based on their answer to that initial question, you could take each group to a set of dedicated questions, as opposed to having them read every question even if they don’t need to respond to them all. This branching question allows you to build some basic logic into a SharePoint survey. To create a survey:

1. Click Site Actions ➔ Create.
2. Click Survey in the Tracking Group. The New Survey form will open, and you will need to provide the following information:
   - Name for the survey
   - Description of the survey
Chapter 3: Lists and Libraries

- If you want to display the survey in the site’s Quick Launch menu
- If you want to record the respondents’ names with the survey results.
- If you want to allow respondents to complete the survey multiple times.

On occasion, members of staff may feel more disposed to complete a survey if they know their names are not available. They will tend to be more open about comments they make if the survey can be anonymous.

3. Once the New Survey form is complete, click Next. As this is a survey, you are then required to add the questions. This is another occasion when you will need to have planned what you want to do before actually starting the creation process.

4. To add a question, enter it into the Question text box.
5. Select the type of response required form the choices offered. The choices are:
   - Single line of text
   - Multiple lines of text
   - Choice
   - Rating Scale
   - Number
   - Currency
   - Date and Time
   - Lookup (information already on your site)
   - Yes/No
   - Person or Group
   - Page Separator
   - Business Data

Most of these are self-explanatory, but some are not:
   - Rating Scale will create a main question and a set of subquestions from which the user can respond. For example:
     - How do you rate SharePoint?
     - Excellent
     - Fair
     - Not too bad
     - Terrible
   - Lookup will allow you to lookup information already on your site. For example, a list of departments from which the survey responder can then choose the department they are a member of.
   - Page will insert a page break into a survey.
Business Data allows you to display information help in your business systems or corporate databases. When you choose this data type, you are required to supply additional information such as the type and location of the business data source you would like to use. The screen will refresh, and you will be requested to provide this input. This process will also apply to text and other data types that offer you additional options. For example, text will allow you to use plain text, rich text, or enhanced rich text, which will permit the use of images.

6. Once you have created the question and set the appropriate type, you can then make it compulsory using the Require Answer radio buttons. (Branching logic is added to the survey later in the process.)

7. To continue and add questions to the survey, click the Next Question button. Continue to add questions until the survey is completed. Add at least four questions to the survey, as you will need them to complete this example. Make sure that at least one of the questions is a Choice type. (For example, What is your Grade? Manager, Administrator, Clerical, and so on.)

8. Click Finish to end the survey creation process.

You will be returned to the Survey settings page, where you can complete the customization of the survey if required. For this example, you are going to add some branching logic. To add branching to your survey:

1. Click on the Choice question in the settings page.
2. Scroll to the bottom of the page to the branching section.
   Note the options now available. Based on the choice someone makes, you can select a question to direct them to.
3. Use the drop-down list to select the correct branching question for each of the choice values you have. You can, of course, leave a choice with its default of No Branching, in which case the user will be required to complete the rest of the survey.

The next area you will have to configure is who this survey is aimed at. You do this in the normal way with SharePoint by using its permissions. If you create the survey within your team site and you are inheriting its permissions, then the survey will be available to all site members. If you need this survey to be available to others, then you will be required to break the permission inheritance and create new users for this object. You can check and break permissions by clicking Permissions for this list in the list settings page.

Completing the Survey

Figure 3-16 shows the “Respond to this Survey form” as it would be seen by a colleague with permissions to complete it.
To complete a survey, click the “Respond to this survey” link, which will appear beside the survey in your SharePoint list. Once you have all the survey results, you will want to analyze them. The SharePoint survey page will show you a graphical result, but for proper analysis you will need to export the results to Excel 2007 or another application. You can export the survey to Excel by clicking Survey Actions Export to Spreadsheet.

While not as complex as some of the third-party software available, SharePoint surveys do allow you to gather information — particularly from your site users and from users elsewhere on the system. In Chapter 8, you will also use Microsoft Outlook 2007 to carry out surveys and save the results back to SharePoint.

So far you have looked at the lists SharePoint makes available to you and that you can then customize. In addition to these lists, it is also possible to create your own list, which can reflect your particular business. Next, you will look at creating custom lists in SharePoint.

**Custom Lists**

A considerable number of lists are available out of the box with SharePoint, and in addition you can create your own list that reflects your individual business needs. Creating a custom list is just like adding custom columns to an existing list. Only this time you are on your own and SharePoint will not supply a starting point for you. Once the custom list is created, there will be one visible column: Title. In the background Created By and Modified By are also available but they are not shown. You can also create a custom list in Datasheet view, which again, opens like a Microsoft Access table or Excel Spreadsheet. Custom lists should present no problem to you at this point. Once you have worked with existing lists and created custom columns, you will find custom lists work in the same way and use the same menu options. To create a custom list:

1. Click Site Actions ➔ Create ➔ Custom List.
2. Enter Sales Regions for the list name.
3. Click Create.
4. Click Settings ➔ List Settings.
5. Scroll down to the Columns group, and click Create Column.
6. Change the default text field size from 255 to 25.
7. Click OK to save the column.

Repeat this procedure for each column you require in the Sales Regions list. As you can see, once you get a handle on working with standard lists, it is fairly easy to begin to create your own business lists as the same principles apply.

**Key Performance Indicators Lists**

Key performance indicators (MOSS 2007) are a different kind of list all together, and you will find several new menu options. A KPI measures performance against a target and the KPI list is used to manage this process. Information can be provided to the list from several sources. In this example, you will add the data manually; in Chapter 9 you will feed the list from a workbook. To continue and create the KPI list:

1. Click Site Actions ➔ Create ➔ KPI list.
2. Enter Sales KPI as the list name.
3. Accept the rest of the defaults.
4. Click OK to save the list.

The new menu on a KPI list is different from that of a standard SharePoint list. It contains options that allow you to specify the data source for your KPI data:

- Data held in a SharePoint list
- Data Held in Excel
- Data from SQL Server 2005 Analysis Services
- Manually Entered Data

For this example, you are going to manually enter data.

5. To continue, select Indicator using Manually Entered information.

This KPI will relate to sales. You have a sales goal of 10; anything below 10 is poor, and anything above 10 is excellent.

6. Name the KPI “SalesKPI.”
7. Enter a description. Again, this should tell your colleagues all they need to know about the KPI.
8. Enter comments for the KPI, such as “Sales goal is 10; below 10 is poor and above 10 is good.”
9. Enter an Indicator Value. This is the current value for Sales. Enter 7. There are three icons: green light, yellow triangle, and red. Green light means you have met or exceeded the goal. Yellow triangle means you are short of the goal. Red means that you are in danger; that is, you are off the target that has been set and you should investigate the causes.

10. Select Better Values are higher.
11. Enter 10 for the green indicator.
Chapter 3: Lists and Libraries

12. Enter 5 for the yellow indicator.
13. Click OK.

What you have done is really set a target of 7 sales. If you get 10, all is wonderful, if you get 5 you’re in danger. When you return to the list, you will see the results of the example. Once you get the general idea behind this and hook your lists up to real corporate data help in Excel or SQL Server, then you can see the true power of KPIs. This section introduced the concept, which will be explored further in Chapter 9.

**Import Spreadsheet**

If you already have a set of data you would like to add to SharePoint, you can import it from Excel. To do so:

1. Click Site Actions ➔ Create.
2. Click Import from Spreadsheet.
3. Enter a name for the list.
4. Click the Browse button to locate the spreadsheet.
5. Click Import. Microsoft Excel will open in the background, and you will be asked to specify the range of cells to import.
6. Select the cell range to import.
7. Click the Import button.

Your data will be imported as a new list within SharePoint. You will return to this topic in Chapter 9.

The final category is the “Create page as Web pages.” Within this category are standard SharePoint web pages, Web Part pages, and Sites and Workspaces. You have already seen Sites and Workspaces in Chapter 2 and you will be looking at Web Part Page and Web Parts in Chapter 4 when you will also cover web pages.

**Summary**

In this chapter, you looked at almost all of the lists available within SharePoint, how to create lists, how to customize lists by adding columns, and how to create views. You saw KPIs and importing data from Excel. Almost all of these areas will be expanded on in Part 2 of the book when Microsoft Excel is examined in detail. When looking at lists and libraries, some settings were overlooked because you will return to them in the context of the Office 2007 applications where they are more appropriate and easier to apply and understand.

All the way through this chapter you used the Site settings menu, and surely some of you have clicked the Edit Page link. In the next chapter, you will look at editing pages and Web Parts, what they are, and how you can use and customize them with the single aim of helping you get the job done.
In this chapter, you will investigate another of the core features of SharePoint, Web Parts. A *Web Part* provides a discrete function or a set of functionality to you via a web page. Web Parts are an integral feature of SharePoint, and they are one of those areas you need to be comfortable with to get full use of the software. There are many SharePoint Web Parts provided for you, and with a team of skilled developers, any company can create and customize its own Web Part. In this chapter, you will review each of the available parts, add and remove Web Parts from the page, and modify them to meet your own requirements. Of course, no programming skills are required for much of this, but again the true power of Web Parts lies in the flexibility of the technology in the hands of skilled developers.

In Chapter 3, you learned that everything in SharePoint was a list that contained your data. The same is true of Web Parts. Almost everything you see in front of you on a SharePoint page is a Web Part, and one of the neat features is that, when you create document libraries and other lists, they become available in your team sites as Web Parts and you can then add them to other pages as distinct objects, removing the need for your colleagues to navigate directly to a document library, for example. If you don’t like a Web Part, you can remove it from the page; if you want additional Web Parts, you add them yourself. However, as with everything else in SharePoint, you will need the proper permissions to be able to do all of this. This chapter concentrates on the out-of-the-box Web Parts; later you will look at other Web Parts, both commercial and free, that can help you within your business environment handle the large amounts of information you deal with each day.

**Web Parts in Relation to MOSS 2007 and WSS**

It’s with Web Parts that some of the major differences between Microsoft Office SharePoint Server (MOSS) and Windows SharePoint Server (WSS) version 3 really become apparent. Put simply, you get more Web Parts with MOSS. That may not seem a big deal, but the Web Parts you get really
Part I: Microsoft SharePoint Server 2007

add to the feature set of SharePoint and are worth having. Before examining Web Parts in more detail, you need to look at a web page within SharePoint and see how it is put together in terms of Web Parts. A standard SharePoint page has areas containing Web Part Zones, and in each zone you can add and remove Web Parts. Each Web Part in turn provides a bit of functionality to you. How this all works and is put together behind the scenes really doesn’t matter. You need to know how to add and remove Web Parts, how to modify them to meet your needs, and how to secure them. Of course, as with everything related to computers, you will need to understand a little technical stuff, but you will return to that later. The next section looks at all the Web Parts available to you in SharePoint, WSS version 3, and MOSS 2007. (When required, Web Parts unavailable with WSS are pointed out.) You will look at the standard Web Parts you will use from day to day, and you will also cover Web Parts available on your personal SharePoint site — MySite if you have MOSS 2007. You will need a SharePoint team site and permissions to edit and update the site to begin to examine the tools available to you. Figure 4-1 shows a SharePoint team site in Edit Mode. The remainder of this chapter will use a default team site to demonstrate and discuss the features available.

Web Parts in SharePoint

When you created your team site in Chapter 2, you opened a web site that had been populated for you based on a SharePoint template. In most of this book’s discussions about the sites, you focused on using terms like lists and libraries. However, you have already encountered Web Parts when you tried out some of the examples. Think of the announcements list from Chapter 2: a list that contained news and event messages for your colleagues but appeared on the front page of your team site in a little box. This little box was a Web Part configured by SharePoint to display the information held within the announcements list. Behind the scenes, all the work to create this connection was done for you, and this will still be the case with the majority of Web Parts you use. The internals of how the Web Part does what it does are not visible to lesser mortals nor need it be. You just need to be able to put it to use, and that’s the purpose of this chapter: to put Web Parts to use to help you organize, present, and classify your business information. Because some Web Parts are more complex than others, you will look at the easier ones first, leaving the more complex types until the end of this discussion. Once you have a sound idea

Figure 4-1
of what Web Parts are available, you will then add them to a web page and configure them. However, before looking at Web Parts, it is perhaps useful at this point to look at how you can create additional web pages in MOSS.

**Creating Web Pages in SharePoint**

As already mentioned, Web Parts are placed into Web Part Zones within the web page. In addition to the pages already available in SharePoint, it is also possible for you to create your own pages based on templates available in your site. Using the Site Settings menu, you have already seen how to create web sites, but there are two additional options within the Web Pages group: Basic Page and Web Part Page. The Basic Page allows you to add a simple web page to the site into which you can add text and images just like any standard web page. The second option is a little different and contains layouts to create pages that will contain Web Parts. From the Site Actions menu:

1. Click Create ➤ Web Part Page, and enter a name for the new web page.
2. Select an appropriate layout, such as Full Page Vertical, which is a useful layout for a Page Viewer Web Part. The Layouts group offers you a choice of templates. As you click on a layout template notice how the graphic to the left of the list changes to reflect the new position of the Web Part Zones in the selected layout.
3. Select the Save Location, using the drop-down list. This list will be populated with existing document libraries from your site.
4. Click Create.

Figure 4-2 shows part of the Create Web Part Page form in SharePoint. Your web page will be created and opened in Edit Mode ready for you to begin to insert Web Parts. At this point, you can also click the hyperlink Edit Title bar properties to change the heading for the page and to add in a descriptive caption. Save and close the new Web Part.
Part I: Microsoft SharePoint Server 2007

More Than One Way to Skin a Cat

As is the case with a lot of Microsoft software, there are usually several ways to do everything. The same is true when adding Web Parts to your SharePoint pages. You may notice when adding Web Parts a link at the bottom of the Add Web Part dialog to the Advanced Web Parts Gallery and options. Clicking this link will open the gallery and give you access to the Web Parts. One of the neat features in using this gallery to add Web Parts is the ability to filter the Web Parts being displayed. This is useful as there can be large numbers of Web Parts available, including document libraries you create with a site. To filter the list of available Web Parts, click the filter icon, which will reveal a drop-down list from which you can select a category of Web Parts. This is useful as some Web Parts may not be available in the Add Web Part dialog, in particular Web Parts that display your libraries and lists.

Adding a Web Part

Adding a new Web Part or editing an existing one is one of the more straightforward tasks within SharePoint. To add a Web Part, you must first put the web page into Edit Mode and have the required permissions to actually carry out the edits. You may also not have permissions to add Web Parts on your main SharePoint team site, but you should have these permissions within your MySite if you use MOSS 2007. To begin the process, you can use the new page created in the previous section or create a new test page based on one of the Layout templates. To continue, with the page open in the browser:

1. Click Site Settings.
   You can also click the View All Site Content link on the top of the Quick Launch menu. Personally, I always remove this link from the sites I create, as at times I don’t want to make a full list of site content available.

2. Select Edit Page.
   Your web page will be refreshed and be in Edit Mode. Note that the design of the page is now available, and rather than looking at Web Parts displaying data, you are looking at the Web Part Zones and the Web Parts they contain. Each Web Part Zone is placed in a specific position in the page, and in a standard team site you should have two zones: Left and Right. All Web Parts must be added to one of the Web Part Zones; indeed, you will be unable to add them anywhere else using the web browser. The zones will already contain some standard default Web Parts, entitled Left and Right, which you can see in Figure 4-3. In this case, a team site, the Announcements, Calendar, Site Image and Links Web Parts are already available on the page.
Even in design mode you can still see the data each Web Part is designed to display and, in fact, interact with that data as if you were not in design mode. However, if you do click on a live link while in design mode, you will be returned to standard view and taken to the list page requested.

Each Web Part also contains a title, an Edit menu, and a Close button. The Web Part Zone itself contains a link at the top to allow you to add Web Parts to that specific zone.

3. To add a new Web Part, decide which zone you would like it to be placed into and click the Add a Web Part link located in the header of the Web Part Zone.

   This will open the Add Web Parts dialog from which you choose the Web Part or parts you would like to add to the zone. In this case, select the Contact Details Web Part located in the miscellaneous section of the dialog.

4. Check the box beside the Contact Details Web Part.

5. Click Add to add the part to the page.

Once you add the Web Part to the page, you need to configure it. In the next section, you will look at the configuration options available for many of the standard Web Parts you will use. Many Web Parts have a common set of properties that can be set when designing the page, and these will be highlighted. Just to be sure, you will need to have your page in Edit Mode in order to add the Web Parts. The following discussion assumes that you have added the Contact Details Web Part to the page, and you are ready to continue.
Contact Details

This Web Part pertains to MOSS 2007 only. The Contact Details Web Part allows you to add the details of a support contact to the web page. This Web Part is usually added to the home page of a site to provide a point of contact for any issues related to SharePoint. It is always good practice to provide your details if you are the site manager. This gives your colleagues an immediate point of contact should something go wrong.

Configuring Contact Details

Contact Details is a fairly simple Web Part that displays your details or the details of the named contact for the team site. With the Web Part on the page in the correct Web Part Zone, click the “Click here to add or modify a contact” hyperlink.

This will open the Web Part tool pane located to the right of the page. From this tool pane, you configure all Web Parts within SharePoint. The first step is to add the contact name; if you know the name of the contact, you can enter it directly into the Contact text box and click the Check Names icon (which displays a person and a check mark). This will check that the name entered is a valid user on your system. If you do not know the valid name for the contact, you can search using the Browse icon (a book) to open the Search dialog. Once you have selected the individual required, you can complete the rest of the Web Parts configuration.

There are several groups of options, outlined in the following sections.

Miscellaneous

In this category, you can choose the position of the contact’s image, display the actual image’s file, and show the contact’s job title. You can add a descriptive label for the contact.

Appearance

This category is common to all Web Parts and allows you to:

- Change the default title of the Web Part. This is usually done to make the Web Part more descriptive of your colleagues.
- Set a fixed height and width for the Web Part. A Web Part is dynamic and will grow or shrink depending on the content being displayed.
Chrome State

The chrome state refers to the Web Part itself, and you can minimize the Web Part. It will appear on
the page showing the title bar but will not be open, or you can choose the default and leave the
Web Part open.

Chrome Type

This refers to the border around the Web Part and the title bar, and the options are:

- **Default**: Leave everything as is.
- **Title and Border**: Display only the Web Part title and border.
- **None**: Remove the border and title bar.
- **Title only**: Display only the Web Part title bar.
- **Border only**: Display the Web Part border only.

Both chrome state and chrome type are standard options across all Web Parts.

Layout

Using one of the options in the Layout group, a Web Part can be hidden, which is useful if you need a
Web Part on the page but do not want it to be visible. Hidden Web Parts are often used to pass data
between Web Parts on the page or to contain some code you would like to execute, for example
JavaScript. Passing values between Web Parts is discussed later. Layout also concerns the direction of the
content within the Web Part. Content can, for instance, be left- or right-aligned according to your needs.

Zone

A Web Part page contains Web Part Zones into which your Web Part is placed. Using this option, you can
quickly move a Web Part between the available page zones. This list will default to the Web Part Zone
you added the part to, but you can select another zone by using the drop-down list. Zone Index indicates
the position of the part within the zone. The first Web Part in the zone will have an index of 1, the next 2,
and so on.

Advanced

The Advanced category is also common to the majority of Web Parts. In this category, you can set
options that will apply to your colleagues when they try to manipulate the Web Part. The options are:

- **Allow Minimize**: Allow the Web Part to be minimized in the web page.
- **Allow Close**: Allow individuals to close the Web Part.
- **Allow Hide**: Allow individuals to hide the Web Part.
- **Allow Zone Change**: Allow individuals to move the Web Part to another zone.
- **Allow Connections**: Allow this Web Part to receive connections from other Web Parts.
- **Allow Editing in Personal View**: This will allow individuals to edit the Web Part when they
  create a personal view of the page. This area, personal view, will be covered later.
Part I: Microsoft SharePoint Server 2007

- **Export Mode:** Indicates if the Web Part can be exported from SharePoint. This is a useful feature, and you can export and import a useful Web Part between sites.

- **Title URL:** This is a separate web page that contains additional information about the Web Part. For a complex business-driven Web Part, this could be a small help page that would open in the browser.

- **Description:** A tooltip description of the Web Part and is useful as a quick guide to those using the Web Part as to its function. The description is also used when you are searching for Web Parts to apply to a page.

- **Help URL:** The web address of a more complete help page about the Web Part.

- **Help Mode:** Opens a browser window containing the help page and this window remains open until closed. The third option, Navigate, will open the browser window in the current window. This last option does not apply to SharePoint help files, which will always open in another window.

- **Catalogue Icon Image URL:** Like everything else, Web Parts are listed in SharePoint and this URL indicates the icon to use in the list to identify the Web Part.

- **Title Icon Image URL:** An image to use with the title of a Web Part.

- **Import Error Message:** Custom error message if the import of the Web Part fails.

- **Target Audiences:** The audience for this Web Part (MOSS 2007 only).

Generally, the advanced options are available to all Web Parts you place on the page. For the remainder of the Web Parts, only those properties that are specific to the Web Part being discussed will be described.

**Image Web Part**

The Image Web Part allows you to add an image to your web page and most standard image file formats are supported. It is important for accessibility reasons that you always provide a text alternative when you are using images on your sites, and the Image Web Part contains properties that allow you to do this. To add an Image Web Part to the page with the page in Edit Mode:

1. Click Add a Web Part.
2. Check the Image Web Part in the Miscellaneous group of the dialog.
3. Click Add.
4. Once the Web Part has been added to the page, you will need to configure it for use.

**Configuring an Image Web Part**

The first thing you need to do is to add in the URL or path to your image file. This can be a full URL or a location on the server where you have placed an image. You can also link to image files within your own team site. For example, if you have a picture library within your site, you can specify the path to one of the image files. As an example, `/username_parts/Pictures/logo.png` would load the image `logo.png` from the sites library into the Web Part. The remaining settings are:
Chapter 4: Web Parts

- **Alternative Text:** As stated, you should also provide alternative text that describes the image file. If you’re adding a logo, the alternative text could be “Company Logo.” You should always add this text every time you place an image or other non-text content on the web page. This single action can help those using assistive technology such as screen readers make better use of web sites. This applies to all sites, not just SharePoint sites.

- **Image Vertical Alignment:** This can either be Top, Middle, or Bottom and refers to the location of the image file with respect to its position within the Web Part.

- **Image Horizontal Alignment:** The horizontal alignment of the image with respect to the Web Part. This can be Center, Left, or Right placement within the Web Part container.

- **Web Part Background Color:** There is a color picker icon beside the text box that you can use to select the background color for the image. The default is transparent.

The other nice thing about the Image Web Part is that you can connect it to another list. Later in this chapter you will do just that.

**Page Viewer Web Part**

The Page Viewer Web Part allows you to insert a page into your web page using an HTML Iframe, which is a container for another web page and is a standard HTML element. One reason you might want to display the contents of another web page inside your SharePoint page is to provide external web content inside SharePoint, while keeping your staff inside the SharePoint site. You can also use it to display useful pages from external sites such as a supplier or a list of external contacts. Iframes have also been used to present a login page from another system, making the second system appear as if it were inside the SharePoint site in an attempt to create a seamless experience for the user.

The Page Viewer Web Part can also display files and folders located elsewhere on the SharePoint server or your company network.

**Configuring a Page Viewer**

With the tool pane open, you can begin to configure the Web Part. The first item is to tell the Web Part what it is actually displaying. A web page being displayed should actually reside within its own dedicated SharePoint page as opposed to being added to an already populated page. This is because, for the most part, you want to display the entire web page, and this is usually not possible if you have other populated Web Parts on the same page. You have three options with respect to resources to display: Web Page, Folder, and File.

If the item is a web page, you need to provide the full URL to the site, including the `http://` section. A folder and file simply require a path to the resource. You can use the Build button located to right of the text box to open a larger text editor if required. Connections to a Page Viewer are not possible via the browser. The following instructions will take you through adding a new web page to your site, adding a Page View Web Part, and configuring it for use.

Exit from editing the page (Click Exit Edit Mode located above the task pane) if required as you are going to add a new page to the site. From the site settings menu click Site Actions then:

1. Click Create.
2. Click Web Part Page in the Web Pages group.
Part I: Microsoft SharePoint Server 2007

3. Enter a name for the page, such as MyPage Viewer.

In the next list box is a set of web page template layouts that contain Web Part Zones of varying numbers and placement. For this example, select Full Page Verticals.

4. Accept the default storage location of Shared Documents. You can create a specific document library for your pages, and if the SharePoint publishing features are enabled, a specific library will be available, called Pages.

5. Click Create. You should now be looking at your new Web Part page in Edit Mode; it should contain a single Web Part Zone located at the top of the page.

6. Click Add a Web Part.

7. Select the Page Viewer Web Part from the available Web Parts.

8. Click Add.

9. Click on the Open the Tool Pane hyperlink to open the tool pane and set up the data.

10. Accept the default of Web Page.

11. Enter a full URL to a web site of your choice.

12. Click Apply.

At this point, you should see the resulting Web Part within the Web Part. All that remains is to resize the Web Part to accommodate the full page being displayed.

13. Return to the task pane, and expand the Appearance Group by clicking the plus symbol beside the group name. At this point, setting the height and width properties is really a matter of trial and error until you are happy with the result.

14. Click OK.

15. Exit Edit Mode. Figure 4-4 shows the results before resizing the Web Part.

![Figure 4-4](image-url)
Chapter 4: Web Parts

**Relevant Documents**

The Relevant Documents Web Part allows you to present documents that are directly related to the user logged in. It will display documents created by, modified by, checked out by, or owned by the logged-in user. This is a great Web Part to use to make items on the web page of immediate use to you. As soon as you log in, your own documents are visible to you.

**Configuring Relevant Documents**

This Web Part contains a new section for configuration of the data category. Some options are already set for you when you install the Web Part, which is why you will see documents related to you once you place the Web Part on the page. The data options are related to the documents returned by the Web Part and are:

- Include document last modified by me.
- Include documents created by me.
- Include documents checked out to me.
- Display a link to the containing folder or list.

In addition, you can set a limit on the number of documents returned to the Web Part, and this is really worth doing in a site that may contain thousands of documents. This Web Part is used to inform users not overwhelm them with a never-ending list of documents.

**Site Users**

The Site Users Web Part is used to display a list of users of your site. This, again, is useful to have on the home page of a site, as it will show those logged in who is also a member of the site and provide a link to individuals’ contact details or MySite. It is also possible to display the presence status of the site users if you have presence management software installed such as Office Live Communications Server. To add the Site Users Web Part to a page, switch to Edit Mode (Site Actions ⇒ Edit Page) and:

1. Click Add a Web Part.
2. Check the Site Users Web Part in the miscellaneous group.
3. Click Add to add the Web Part to your page.

**Configure Site Users**

The Site Users Web Part can display a list of names of site users from and on your web sites. The Web Part will display all site users and all groups with permissions to the site when it is first added to a page. Usually, you will need to change this. To configure the Web Part, click Edit ⇒ Modify Shared Web Part. Within the Site Users tool pane, the main option is to select exactly which group of users the part will display. You have the following options:

- **Show people and groups with direct permissions on the site** will list all individuals and all group names. To see further information about the group or individual, you would simply click the name.
- **Show people in this site’s member group** will allow you to restrict display to only those people in the member group for the site, ignoring all other individuals and groups.
- **Show people in the group** allows you to search for a specific group to display.
Part I: Microsoft SharePoint Server 2007

Normally, the member group for a site contains everyone of interest to a team or project and is usually sufficient. Once the option is set, a list of member names will be placed into the Web Part and displayed on your page. If another member of the site needs to find contact details, he or she can click on a member name to be taken to the information about that user. Click the radio button entitled “Show people in this site’s member group,” and click OK to see the results.

Issues with the Site Users Web Part

There appears to be a bug in this feature, which applies anywhere you click on another user’s name and is not just restricted to this Web Part. What is supposed to happen is that, if you are using MOSS 2007, when you click on a user’s name, you are taken to that user’s MySite. In many cases this does not work when the URL to your company site is not the same as the URL to your MySite. It is common practice for MySite to have a different URL. The other issue with this, at least on my server, is that when you close the user details page, you are not returned to the site page you originally clicked on but instead to the group membership page for the site users. I believe that Microsoft is working on a resolution for these issues. These issues have been reported on many SharePoint blogs and many also include technical solutions to the issues. If you do a quick Google search for “userdisp.aspx issues,” you will find links to several blogs discussing this issue.

User Tasks

The User Tasks Web Part displays a list of tasks currently assigned to the logged-in user. When the Web Part is placed on the page, the default setting will display the type of task, a link to the task itself, a link to the task item, such as an associated Microsoft Word document, and the task’s due date.

Configuring User Tasks

The only additional configuration options are the ability to turn off the item link and to set the limit of the number of tasks shown by the Web Part. These options are available in the Data category in the Web Part Modification pane.

As with displaying relevant documents, you should set a limit on the number of tasks displayed to avoid information overload.

Announcements

Announcements is a Web Part that will be used to display data held within your site’s announcements list. The Announcements Web Part is always created by default when you create a team site.

Configuring Announcements

The Announcements Web Part displays a new option: the ability to configure the default view displayed within the Web Part. By default, the following columns are displayed:
Title: Provides a link to the announcement.
Body: Your actual announcement.
Modified: Date the announcement was created.
Attachments: Displays any attachments associated with the announcement. For example, an announcement could be used to make the latest company HR document available to your colleagues. In that case, the document could be attached to the announcement.

You can change this view in the task pane and add columns to be displayed if, for instance, you have added custom columns to the lists. In addition, it is also possible to change the default view to another view that you have created on the list. In the Selected View drop-down list, you will have three default choices: Default View, All Items, and Summary View. If you have created a view on the list, it will also be displayed in the Select View drop-down, and you can choose and apply them to the Web Part. To change the current view:

1. Click on the Edit the Current View link in the task pane.
2. You can remove or add columns of interest in the Edit View form. Columns added or removed will become part of the default view. For example, if you add the additional column named Edit (link to edit item), this will place a link in the Web Part, which will allow you to edit the Announcement directly if you have the required permissions. You can add columns as required from those available to have them appear in addition to those already used within the current view of any list within SharePoint.
3. Click OK to save the changes.

Calendar

The Calendar Web Part is used to display events and other date and time-based information from your site’s calendar list. The Calendar Web Part, which is created on the front page of your team site, is usually configured as a list. This is done because the graphical calendar takes up a lot of screen space, which at times is required for other objects and information.

Configure the Calendar Web Part

You should already have a calendar within the web page — it’s part of the creation of the team site. The default view is a table listing any items held within the calendar list. This is a popular view, as it does not take up as much screen space as the actual graphical view of the calendar. Open the Modify task pane to view the available configuration options. To open the task pane for a Calendar, select Site Actions from the main site menu, then click Edit Page. To continue, click Edit and select Modify Shared Web Part within the Calendar Web Part itself.

From the task pane for the Calendar Web Part, you can change the selected view again by choosing from a list of views. The initial choices are:

- Current View
- All Events
- Calendar
- Current Events
- Summary View
Part I: Microsoft SharePoint Server 2007

If you have created additional views on the list, they will also be available within the drop-down list. For example, you could create a view for a management site that only displayed management meetings. This is where you come back to setting up the initial lists properly and trying, when possible, to add specific business-related categories to your lists because they will not be available by default. In the case of a Management Meeting site, you would add a custom category called Meeting Category, and when a meeting was added to the list, it would be placed into a specific category. Adding a category like this would make it easier when you come to create views of lists, as you could filter the views by using the various categories of meetings. This type of view allows people to easily find the information they require. Instead of scanning a long list, they can simply choose to look at a specific view of the list.

**Links**

The Links Web Part displays web links that your team may find useful. When creating a team site, a Links Web Part is usually created for you as part of the default site design. All that is required is for you to add the required web sites to the list via the Web Part. The links displayed are held within a links list, which is also created on your team site. You can manage links directly from the list. If, for instance, you need to delete or edit a link, you will have to do so directly in the list.

**Configure Links**

As with the Links Web Part, the only configuration option is the ability to change views of the information displayed. The remaining options are as per the common groupings available to all Web Parts. As stated previously, management of the list items must be carried out directly in the list itself.

**Summary Links**

The Summary Links Web Part gives you more flexibility when adding links to page. It permits the grouping of related sites and provides more styling options.

When you place this Web Part on the page, you will see several options immediately available to you within the Web Part itself via a menu of hyperlinks. The options available within the Modify Web Part pane are the standard options available to other Web Parts. From the Web Part itself the options are:

- **New Link:** Allows you to add a new link or URL for display.
- **New Group:** One of the nice things about this is that you can create groups to contain related links, for example by subject. To create a group:
  1. Click New Group.
  2. Enter a name for the Group Header.
  3. Click OK.
  4. Your new header will be added to the Web Part, and you can now add your links to the group.
  5. Click New Link.
  6. The New Link dialog will open, and you will be required to complete the form. At this point, you can add a link to an item in your site, a URL, or even a link to an individual within your organization. For this example, accept the default, “Create a link to an item,” and enter a title and a description.
Chapter 4: Web Parts

- **Link URL:** The web address of your link. You can click the browse button to navigate to content within your site.
- **Open Link in New Window:** This can be checked and will result in your link being opened in a new browser window. This is useful if you link to an external site but want the user to keep the SharePoint page open.
- **Tooltip:** Text displayed when the user moves the mouse over the link.
- **Image URL:** The web addresses of the image file to be displayed with the link inside the Web Part.
- **Image Description:** A text description of the image file being used. This is the alternative text discussed earlier.
- **Group:** Select which group you would like the link added to. Select the new group created earlier.
- **Style:** How do you want the link to look? There are several style options available to you, and most of them refer to the placement of image files selected by using the Image URL option above.

Once you have made your choices, click OK to close the dialog.

The new group and the link created will be available within the Web Part. Also note the addition of the Edit icon to the left of the link and within the group. This will allow you to return to the dialog and make any required changes. The Configure Styles and Layout option within the Summary Link Web Part also allows you to change the general look and feel of the information presented. You will have options similar to the Style drop-down with respect to images, and you can set the style of the Group Headers — say change the size of the text used for the header, which is usually set to a smaller font to save space on the screen. You can also change the number of columns used to present the groups inside the Web Part, a useful option when you need to present a lot of information within the Web Part.

**Shared Documents**

The Shared Documents Web Part displays a list of documents from your site’s initial document library. This is another useful Web Part that brings information up to the front of a web site. This way users do not have to search for documents, as they are immediately presented to them. The cool thing about this Web Part is that, once you get it configured, you will then know how to configure any document library list you make available as a Web Part.

As with other Web Parts, Shared Documents Web Parts share a common set of properties that can be modified. The majority of the time you will be working with Views via the tool pane. The options are:

- **Current View:** The view currently in use by the Shared Documents Web Part.
- **All Documents:** Lists all documents available in the library.
- **Explorer View:** This is a particularly useful view of a document library, as it lets you filter documents by date; enables you to sort by date modified, document type, and name; and allows you to group documents by name, type, date, and folder. This gives you a very flexible way to present information. The options become available when you click the downward-pointing arrow that appears beside each header (Name, Date Modified, and Type) and select the option you require. Filters are also available in other views, but they do not have the ability to present
Part I: Microsoft SharePoint Server 2007

documents in the same way as the Explorer View. For example, if you change the view to All Documents, you can filter on each column by clicking the column header. The Shared Document Web Part allows you to present documents that apply to your entire team. For large libraries, the Explorer View can help you organize the presentation of the documents, again making information easy to find and use. To create a group in Explorer View:

- **Summary View**: Display only the type, name, and modified by data for each document within the Shared Documents library.

1. In the Modify Web Part tool pane, select Explorer View, using the Selected View drop-down.
2. Click OK to dismiss the warning message if it appears. But be careful if the Web Part passes connection information, as it is possible that columns within the original view may not be available once you change views to Explorer View.
3. Click Apply at the bottom of the tool pane.

Once the change has been applied to the Web Part, you will see that the content has changed and folders and documents will be displayed. In the All Document view, only documents are displayed and folders are ignored. However, the content of a folder is still displayed in the list of documents. You can:

- Group by document type.
- Click the downward arrow located to the right of the Type column header.
- Select Group, and your documents should display by file type. Also note that you can check a box to restrict the file types returned.
- Click the arrow to the right of the Type header, and select Group to group your documents by name. There is also an option to restrict the files displayed alphabetically.
- Click the arrow beside Date Modified and select Group, and your files will be grouped by date. Note that there is a calendar available to filter files according to date. You also have a quick filter, Last Week, which you can apply. Once you apply a filter or grouping to a column header, a check mark will be placed into the header column to indicate that this column has been filtered or grouped.

**Tasks**

The Tasks Web Part will display currently assigned tasks from the sites task list. It will generally default to all uncompleted tasks.

In common with the other Web Parts, it is possible to change the view used by this Web Part. The default views available from the Select View drop-down are:

- **Active Tasks**: Tasks that are currently ongoing.
- **All Tasks**: All the tasks available within the list.
- **By Assigned To**: Grouped by the individual the task has been assigned to.
- **By My Groups**: Tasks assigned to groups of which you are a member.
Chapter 4: Web Parts

- **Due Today**: Tasks due on the current date.
- **My Tasks**: Tasks assigned to you.

If you have created additional views on the task list, they will also be available within the list. This is a good opportunity to demonstrate how to connect two Web Parts and pass information from one to the other. To begin place the Task page into Edit Mode:

1. Add a Form Web Part to the same page as the Tasks Web Part.
2. Using the Form Web Part, click Edit Connections Provide Form Values To.
3. Select the Tasks Web Part.
4. On the first page of the dialog that opens, select the value T1. This is the name of the text box in the form.
5. Click Next.
6. Select the value Assigned To from the Column drop-down list.
7. Click Finish.

To test it, type in a name you know a task was assigned to and click the Go button. The task list will then only display tasks assigned to the user you have entered. Figure 4-5 shows this approach used in a standard SharePoint Tasks page, where the task list has been filtered for tasks assigned to the author. This simple example demonstrates how you can pass a value from one Web Part to another and have the second Web Part display filtered records. This demonstrates some of the possibilities when working with Web Parts. There is one drawback to this basic example: when you leave Design view, the task list will be blank. That’s because it only works when you type a value into the form text box and link the Web Parts. However, it serves the purpose of demonstrating the ability of Web Parts to communicate.

![Figure 4-5](image)

If you know a little HTML, you could actually change the Form Web Part to display check boxes, radio buttons, or even drop-down lists, further demonstrating the flexibility of Web Parts.
Team Discussion

The Team Discussion Web Part can be used to display discussion groups from within the web site. This Web Part is rarely used on the home page of a team site, as many users prefer to keep this information with the discussion web that they use.

You can configure the standard Web Part settings (Appearance, Layout, and Advanced) for discussion groups. You can change the current view used by perhaps adding the body column. This can result in a lot of text on the screen, as some replies to discussions could be quite long. It is perhaps better to simply show the title of the discussion and replies and leave it up to the user to click to view the full discussion.

RSS Viewer

The RSS Viewer is used to display the input of RSS feeds from within SharePoint or from other web sites. Many web sites use RSS to provide dynamic, text-based access to the latest information. For example, the BBC provides an RSS feed from almost all of its news-related sites. Internally, many organizations make RSS feeds available that may escape their own internal audience such as press releases. Using the RSS Viewer Web Part, you can make much of this information available to your colleagues.

Once you add the RSS Viewer to a page, it will contain text telling you that it is not bound to a feed. The first thing you need to do is assign the RSS feed URL to the Web Part. For example, the BBC produces many news feeds available from http://newsrss.bbc.co.uk/rss/newsonline_uk_edition/front_page/rss.xml. In terms of SharePoint, you do not subscribe directly to the news feed itself. All that is required is the URL, which is then placed into the Web Part. To add the BBC World News feed to the RSS Viewer:

1. Click Open the Tool Pane from within the RSS Viewer Web Part.
2. In the RSS Properties section, enter the URL to the RSS feed of your choice. Simply copy the URL from the browser and paste into the text box.
3. Leave the default feed limit set to 5. This will restrict the number of headlines to 5. You can increase this if required.
4. Check the box entitled Show Feed Title and Description.
5. Click Apply.

Your RSS Viewer should connect to the RSS feed and display the results. Figure 4-6 shows the results when you add the BBC RSS feed to an RSS Viewer Web Part.

---

RSS Viewer

<table>
<thead>
<tr>
<th>BBC News</th>
<th>News Front Page</th>
<th>UK Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small business loan plan unvailed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Israel pursues Gaza offensive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jaguar Land Rover cuts 450 staff</td>
<td></td>
<td></td>
</tr>
<tr>
<td>North arrest over fatal shooting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU warns of legal action over gas</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-6
There are a couple more technical options that you can set, including the ability to customize the display of the RSS news feed itself and to change the layout and styles. Using these options requires the ability to code in XML and XSL.

**This Week in Pictures**

The This Week in Pictures Web Part can be used to display a single image file that links to a more complex slide show. It is useful if, for example, you want to display images of a company event or promotion. Of course, you are free to use it for any image-based information. You could use it to display a product catalog if you permitted external access to your web site or even to provide your colleagues with a slide show of company social events.

Before you can use this Web Part, you need to have a picture library available within your site, and you will, of course, require some image file to work with. The Web Part when first put onto the page will appear to be giving you an error. The first thing you have to do is to enter the name of your picture library into the tool pane. To do so with the Web Part on the page:

1. Click Edit Modify Shared Web Part.
2. In the tool pane, scroll to the Slideshow category.
3. Enter the name of your picture library into the Image Library Name text box.
4. Click Apply. A single image should now be displayed in the Web Part.
5. Click Exit Edit Mode.

To run the slideshow of all images, click View Slide Show.

**Form Web Part**

The Form Web Part contains a single text box and a button. It is used to pass a user-entered value to another Web Part, and you have seen this working in the earlier example passing a name to a task list in SharePoint. For example, if you wanted to see documents created by a specific colleague you could enter their name into the Form Web Part, click the button, and the documents being displayed would be filtered to show only those documents.

Generally speaking, the Form Web Part is simply used to pass information entered to another Web Part and filter the information it displays. The default HTML control placed into the Web Part is a text box rendered using the following HTML:

```html
<div onkeydown="javascript:if (event.keyCode == 13) _SFSUBMIT_">  
<input type="text" name="T1"/>  
<input type="button" value="Go" onclick="javascript:_SFSUBMIT_"/>
</div>
```

This creates the text box and the button labeled Go. When you click the button, the submit event is fired and the `javascript:_SFSUBMIT_` is executed. This value is usually passed to another Web Part and, as a result, the data shown is filtered. You can change the HTML within the Web Part to provide another HTML element that can pass values to a Web Part. For example, a set of radio buttons could be used to permit someone to select from a range of values. All that is required is for you to click the Source Editor in the tool pane and edit the HTML, creating a radio button group `<input type="radio" name="My radio" Value="my Value"> Value<br>` instead of a check box. In this case, a user could select from a set of preset values, reducing the possibility of typos when filtering another Web Part.
Table of Contents Web Part (MOSS 2007)

Every web site needs a way for users to find and identify sites of interest. The Table of Contents Web Part creates a site map of your SharePoint site, providing a quick way for you and your colleagues to find subsites and information within a site.

When you add this Web Part to your site, it will default to showing almost everything available within the site structure. Several new properties help you organize the information displayed. As usual, the properties are available from the tool pane and are grouped into functional categories.

The Content category basically tells the Web Part from what point to begin creating the table of contents. It will usually begin at the root level of your web site and simply include everything. You can change the starting location by clicking the Browse button and navigating to another starting location within your web site. Most SharePoint sites will have multiple levels — an initial top level site and then below that some subsites. You can tell the Web Part to begin building the Table of Contents (TOC) at a lower level from, for instance, one of the subsites in your site. How deep your TOC goes within the site is determined by the Levels to Show drop-down, which can be set at one, two, or three levels.

The Presentation category deals with how you would like the TOC to be displayed. You can add header text to the Web Part, select a style for the header by using the Style drop-down, and select different style of each of the levels returned by the Web Part.

The Organization category allows you to specify how the information displayed by the TOC Web Part is sorted within the display. You can sort sites, and if you are returning web pages, you can perform a separate sort on those.

The remaining categories are the same as the standard Web Parts’: Appearance, Layout, and Advanced.

The TOC Web Part can return a lot of information about your site, and you again need to be careful of information overload. If you are using this Web Part, it would be much better to create it on its own web page, given the amount of data it is possible to display. You will need to play with the settings to get the best view of your site’s structures and information. Remember, the idea is to make it easy for someone else to find information within your site.

The Web Parts discussed in this section are those typically used in almost all WSS and MOSS sites to some degree. You will find that you may use the same Web Parts numerous times in your SharePoint site. One of the best ways to get used to adding and configuring Web Parts is to simply create a page and add the Web Parts to it. You can then play with the settings to see the effect. Most of you will use the Web Parts already discussed, on a daily basis, to work with your SharePoint information. The next set of Web Parts is a little more specialized and deals with exposing corporate information held within large database systems, most notably SQL Server 2005.
**Business Intelligence**

The next set of Web Parts is available to those running MOSS 2007 only, and deal mostly with business intelligence. The Business Data Catalog (BDC) allows developers to make data held in company back-end systems available within SharePoint. Where this data is held and in what system isn’t particularly relevant to the catalog and is another attempt to access data no matter where it is held. As might be expected, the BDC works much better and in a seamless way with Microsoft SQL Server data or other Microsoft products. Because of the nature of the BDC and the additional work required to have the files created, this section is mainly discussion showing you how to interact with an already existing Application Definition File.

Basically, the BDC is used to provide you with access to this data via application definitions created by programming staff. In addition, you would need specific permissions on the server side of SharePoint to add in the Application Definition File, which describes the data you wish to return to SharePoint. In the real world, all of this work would be done for you and you would interact with the data via the Business Data Web Parts and within the constraints of the application file. The Business Intelligence Web Parts include the following.

**Business Data Actions**

The Business Data Actions Web Part allows you to execute actions as defined within the Application Definition File. For example, within the Application Definition File a Staff Contact would be declared. This is known as a BDC entity. Each staff contact within the entity is referred to as an Item. When the staff contact entity is created, the programmer can define a set of actions that can be performed on it, such as updating a name, address or contact details, or issuing an email to the member of staff. These are the actions you are permitted to perform on this entity. The Business Data Actions Web Part would be attached to the specific student entity via the tool pane, and you could then display the various actions that could be carried out on it. This Web Part is commonly used with a Data List Web Part, and they work together to enable you to interact with the data in a controlled way.

To configure the Business Data Actions Web Part, enter the type of entity or browse the loaded catalog entities by clicking the Browse button to the right of the Type text box. The drawback here is that your IT department will need to create the Application Definition File for you first. For this example, Staff Contact may be the entity required, and if so you would select that. Once the entity is selected, the next field in the tool pane is loaded with the available items from the entity.

**Choose**

The Choose button will open a dialog listing the actions exposed by the Application Definition File selected as the Type. In this demonstration, I have selected a Staff Contacts entity type, and when the Choose button is clicked, a list of available defined actions is displayed. Figure 4-7 shows that only one action is available for this entity type, View Profile. Figure 4-7 also shows how the selected action is displayed in the Web Part. There is also a style option which you can use to apply simple layout styles to the Web Part.
Part I: Microsoft SharePoint Server 2007

Business Data List

The Business Data List Web Part provides you with a single listing of a particular type of data such as a listing of students, courses, departments, offices, or staff names made available by the Application Definition File. Figure 4-8 shows a listing of contact numbers returned by the BDC. Note the Actions menu item at the top left.

To configure the Business Data List Web Part, you must enter or select the entity you require from the BDC catalog; again, in this case I selected the Staff contacts entity. The name of the entity is displayed in the Type text box. Figure 4-9 shows the tool pane once the entity type has been added.
It is also possible to change the data being displayed within the Business Data List by clicking the Edit View hyperlink located within the Web Part. This will open an additional dialog, allowing you to select or deselect columns for display, and to add filtering, grouping, and sorting to the Web Part information being displayed. For large lists of data, there is also an option to set up the paging of the data (display data in sets of 10 items, for example) and provide simple navigation for your colleagues.

**Business Data Item**

The Business Data Item Web Part displays a single item from the BDC such as a single product or contact record. Figure 4-10 shows a single record being displayed using the Business Data Item Web Part.

![Business Data Item](image)

**Business Data Related List**

The Business Data Related List Web Part works with the BDC List Web Part and can display relationships created between entities (such as students or courses) in the BDC Application Definition. You could display a list of courses, and when a course is clicked you would then see students enrolled on that course.

The Business Data Web Parts are perhaps some of the more complicated Web Parts available to you when working with MOSS 2007. They do require configuration and setup by your system administrator, who will need to create the database files on your behalf. However, once this has been done and the Application Definition Files are uploaded to MOSS 2007, you can use the Web Parts to provide business information to your colleagues.

**Additional Web Parts**

There are a couple more Web Part categories available to you, depending on whether you are running WSS or MOSS 2007. You may have worked it out by now, but MOSS brings a lot more to the party in terms of Web Parts than WSS. One set of Web Parts, Outlook Web Access, is left for Chapter 8, because they will then appear in context and make a little more sense. For your information, the Outlook Web Parts are:

- My Calendar
- My Contacts
- My Inbox
- My Mail
- My Tasks

The remaining MOSS 2007 Web Parts are explained in the following sections.
Filter Web Parts

The Filter Web Parts do just that: they permit you to pass values to and from Web Parts so that you can restrict the values being displayed. Filter Web Parts permit you to filter the displayed data, using text, dates, and even personal details for the current user and provide you with a way to make what can be static SharePoint lists more flexible. Just like all the other Web Parts, they have a common set of features you can change (appearance, layout, and advanced), and once you have actually added one or two to your page, you will soon get the hang of how they work because most of them are modified in the same way. To follow the next example, you will need a list to apply the filters to. This could be a document library or you could create a custom list and then change the instructions that follow to match your own data. In this case, however, create a list of contacts that you will use to demonstrate configuration of each Filter Web Part. Once you have this main list created add it to a page. You will shortly use this list to try out the Filter Web Parts.

The example assumes that you have added the Web Part to the page and are in Edit Mode.

Choice

The Choice filter allows you to present users with a set of choices from which they can choose a value and is helpful when you would like to guide someone with a range of options. That way you can be reasonably sure that the filter will work as planned. There is no need to worry about typing errors or strange input requests from the user.

Once you have the Filter Web Part on the page, you can manually create the filter properties. To modify the properties:

1. Enter a name for the filter. Be clear about the name of the filter, as it will be used within the page as the filter header. In this case, enter Contact Filter.
2. Because this is a Choice filter, you will of course have to enter the choices. Imagine that you would like to see contacts by specific city, so enter the distinct city values you want to use as the filters.
3. Expand the Advanced Filter category, where you can require the user to select a value by checking the Require User to Choose a Value check box or enter a default value.

You can enable multiple values but be aware that this option is only usable with Office 2007 clients such as Access 2007. This is worth bearing in mind if you are going to use Access to manipulate the data later.

You must now connect the Web Part to your main Web Part. Note that the Filter Web Part at this point will state, “This filter is not connected.” You can expand this statement to get the connection instructions. To connect the Web Part:

1. Click Edit Connections, and select Send Filter Values To.
2. Select the required list from the choices offered.
3. Select the field required in the Configure Connection dialog.
4. Click Finish.
You can now apply the filter by clicking the Filter icon located to the left of the text box. Figure 4-11 shows the resulting dialog. To filter the contact list, select a city from the filter dialog and click OK. The list of contacts will then reflect the filter added. You may also find that you need to change the width of the filter, as it may run across the entire web page. If that is the case, you can set the width of the Web Part in the appearance category, using the tool pane.

**Current User Filter**

The Current User filter is a really useful Web Part, as it can help you personalize information for the person viewing the web page. It is possible to use any property about the user held within the MOSS user profiles. This profile information is usually taken from an organization’s Active Directory and held within the MOSS User Profile store. It will contain general information about the user and any additional information you choose to store or permit the user to add. For example, you will know (if the information is the Active Directory) the user’s full name, office, line manager, job title, grade, date of birth, and any other personal information that is maintained. You can then use this information to filter Web Parts on the page, making the information more relevant to the user. In addition, this Web Part is not actually visible on the page. In order to see the filter and modify its design, the page must be in Edit Mode.

On this occasion, there will be a default filter name already inserted into the Name property in the tool pane. You can overwrite this if required. If you want to filter values based on only the current user’s credentials (username), then you can accept the next default of Current Username. However, if you check the SharePoint Profile Value for Current User radio button, you will have a wider range of options. Clicking this radio button will activate the drop-down list containing all the properties available from the User Profile, and you can then choose from the available items. For example, if you wanted to filter a list based on the user’s department, you would select Department from this list. Of course, you will need to make sure that the list actually contains a Department column and that it is part of the list view being displayed on the page. Once you have set up the parameters, you will need to connect the Filter Web Part to your list.

**Date Filter**

The Date filter will allow you to filter records in a list by entering or selecting dates. You could, for example, filter a customer list to display only orders for certain dates.
The main option when working with this Web Part is the ability to filter using a default date value. You can enter a default value of a specific date or a specific date plus any number of days. For example, if you wanted to see all orders placed for the next week, you could use today’s date with an offset of seven days. You could also reverse this process and go for seven days before today’s date. Like the other filters, you can also set the advanced options to make the filter compulsory by checking the Require a User to Choose a Value check box. You will look at another example of this Web Part in Chapter 9.

Filter Actions

Filter Actions is not actually a filter but a button that applies filters on the page. This gives you some control over when the filter is actually fired. If you have noticed, many filters execute the filter button.

SharePoint List Filter

Using the SharePoint List Filter Web Part, you can pull data from any list within your SharePoint site and use it to filter other SharePoint lists. This is useful if you have information already in other lists such as a listing of departments or assets. Rather than create new filter values, you can choose existing ones. This also ensures that the filter values are up to date, and because they live in distinct lists they will be maintained separately. If you need to change a filter, you need just change it in the list rather than having to go into the individual Web Part’s tool pane.

To configure the SharePoint List Filter Web Part, basically all you need to do is point it at a SharePoint list and tell it which values you would like. In order to have a fully working example, you will need a list already on the page that you can apply your filter to. To configure the filter:

1. Enter a descriptive name for the filter such as Company Name Filter.
2. Select a SharePoint list containing the data you require. You can browse the lists by clicking the List icon beside the List text box. This will open the Select a Link dialog, which will default to the site you are currently in. However, you can also use this dialog to open other sites you have access to and select a list within them.
3. Click on the list required, and click OK to continue.
4. Select a list view if the default view does not supply the data you require. You can choose a view by using the available drop-down list.
5. Select the Value field. This is the value that is passed to the list being filtered.
6. Select a description, which is the actual text item displayed in filter.
    You can click Apply at this point to see how the filter is progressing. To continue, you must connect your Web Parts.
7. In your Filter Web Part, click Edit ➔ Connections, select Send Filter Value To, and then select your main list.
8. Click Exit Mode to try out your filter.

As with some of the other filter parts there is the option to make the filter compulsory and supply a default value. These are available under the Advanced Options in the tool pane.
Chapter 4: Web Parts

Excel Web Access

The Excel Web Access Web Part allows you to add an Excel 2007 Spreadsheet to the page and interact with it via Web Part. Figure 4-12 shows a workbook displayed in the Web Part. This Web Part will be discussed in more detail in Chapter 9, where you will set up and configure the Web Part.

![Excel Web Access](image)

Figure 4-12

This section covered all the common Web Parts that SharePoint users use on their sites. As with everything else in SharePoint, you will need permissions to add and manipulate the Web Parts, and it is likely that only a small number of users will have such permissions. However, even if you do not have the permissions required to add and manipulate the Web Parts yourself, it always helps to be aware of what a particular bit of software can do. That way, you can request that features be made available within your sites. Several more Web Parts are available to you within MOSS 2007, and the following section provides a short overview of those Web Parts.

Search Web Parts

One part of SharePoint that has only been mentioned so far in the book is the search capability. With MOSS and now with Search Server Express, SharePoint provides the search tools required to help you discover the wealth of information within its sites and beyond. Most SharePoint installations will have a search area, but several Web Parts also allow you to add search components to pages and sites. The availability of the Web Parts enables you to build a custom search area as opposed to using the MOSS Search Center. This will give you a more personalized search experience within the content of your own site area. The following sections discuss the Search Web Parts in the order in which they appear in the Add Web Parts dialog.

Advanced Search Box

This search box allows you to perform sophisticated searches based on multiple values across your sites. It is the same Web Part that is used by SharePoint Advanced Search and is accessible by clicking the Advanced Search link on the Search dialog. One of the properties you will need to change is the default search results page. You do not want the results to use the central search results page but to use your own page instead. There are two ways to tackle this issue: you can create a new web page and add the Core Results Web Part to it or you can simply add the results page to the same page on which you are placing the Advanced Search Web Part. In either case, you will need to change one of the Miscellaneous categories in the Advanced Search Part tool pane. Change the Results URL to reflect the new URL you
are using. If you are using the same page for the results, remember to add in the Core Results Web Part to the page. Using the tool pane, you can configure the options that are available to help the user conduct a search. For example, you can turn off the foreign language search options, turn off some of the text boxes a user enters search criteria into (All Words, Exact Phrase), or remove the Properties drop-down list. Removing some or all of these items leaves the user with a clean search page (think Google, a single web page containing a single text box and a search button). You will create a new Search page at the end of this section. Figure 4-13 shows the Advanced Search Web Part within a SharePoint page.

**Search Box**

A simple search text box is provided, which allows you to enter a single search term and a button to execute the search. Again, if you do not want to use your central search results page, you can use the tool pane to specify another results page inside your current site or indeed a results Web Part in the same page. When you place this Web Part on the page a drop-down list is also available from which you can select the location you want to search — your current site, all sites, or people. This is referred to as the search scope, and if required, you can remove this drop-down from the Web Part.

**Search Scopes**

Search scopes can help you target searching in MOSS and can make it easier to discover information. For example, you could create a search scope that only covers company invoices. When you are searching, the invoice scope would be included in the search drop-down. This search would look only for invoices on the server, thereby reducing the number of results returned, which is always a good idea, as SharePoint can return thousands of records when searching, many of which are of no interest to you. Search scopes will normally be created by your SharePoint administrator, as doing so requires high-level access to the servers on which SharePoint runs.
Chapter 4: Web Parts

**People Search**

In addition to searching for information, you can also search for people and just as with standard searching you can create a custom People Search page and a custom People Search results page. Both are provided as Web Parts and can be added to a page. You could add the People Search to the same page as the Advanced Search Web Parts, but it is perhaps more user-friendly to place them on their own web page. Again, you can put the People Search Results Web Part on the same page or add it to a results page and change the properties of the People Search Web Part to reflect the URL. People Search is a good alternative to a staff directory. All staff from within the MOSS user profiles will be available, and it is also possible to search for the additional profile information added by users themselves via their MySite. It is likely that your SharePoint installation will have a central People Search feature as part of the centralized Advanced Search Center, but, as stated, there is no reason why you cannot add one within your own site.

**People Search Box**

The People Search Box Web Part adds a simple People Search text box to the page much like the simple search Web Part discussed previously, and it will, if you are creating a custom results page, require a People Search Results Web Part to be added. One of the nice touches with the Search Web Part is the search options, which will open an on search form to enable you to search for people by using a combination of different properties. Figure 4-14 shows the search options when searching for people.

![Figure 4-14](image)

This form allows you to search for a single value or a combination of any of these values: First name, Last name, Department, Title, Responsibilities, Skills, and Memberships. The Responsibilities and Skills search items are particularly useful if you are searching for a staff member with a particular set of responsibilities or skills. This information is picked up from the staff member’s user profile, which can be added to by the staff member to reflect the real world. Note the browse buttons beside the Responsibilities and Skills text boxes to allow you to browse the lists for specific information. This capability is particularly useful in a large organization, where it can be difficult to know who actually does what (if, say, you wanted to know who in a particular department had first aid skills). This is an indication of how information entered into one area of SharePoint can add value to another.

**Core Results**

The Core Results Web Part is used to display the results of searches. This Web Part is highly customizable, and you can add or remove many of its features via the Modify Web Part tool pane. Using the tool pane, you can:
Part I: Microsoft SharePoint Server 2007

- Set the number of results per page. This is useful if you are listing a large number of results and would like to reduce the amount of scrolling the user has to do. The default is 10 results per page.
- Remove duplicate results.
- Alert Me, RSS, Messages, Action links, and Modify Date.

**Additional Search Web Parts**

The four previous Web Parts are the most commonly used, but several more are available to you, including:

- Search Best Bets
- Search High Confidence Results
- Search Paging
- Search Statistics
- Search Summary

These Web Parts generally require a system administrator to configure areas of MOSS Search before you can begin to use features such as Best Bets and Keywords. Best Bets and Keywords work much the same way as the initial hits from a search engine like Google. Your site administrator can associate content within your sites with particular keywords, which will ensure that that item will always be returned first in any related search. For example, the word “salary” could be associated with keywords “payments to staff,” and it could then be associated with the finance SharePoint site. Anyone searching for salary would find the finance site at the top of the search results in the Best Bets Web Part, if it has been added to the search results page. In general, these Web Parts would be available only to administrators within the system.

Now that you have an overview of the various Search Web Parts available in SharePoint, you will create a new custom search page. To continue:

1. Click Site Actions.
3. Enter MySearchPage as the name for the new file.
4. Select Header, Footer, 3 Columns as the Layout Template.
5. Select the appropriate Document Library for this page, using the Save Location drop-down list.
6. Click Create to save the changes and open the page in Edit Mode.
7. In the Header Zone, click Add a Web Part.
8. Check the Search Box in the Search category in the Add Web Parts dialog.
9. Click Add.
10. In the left column header click Add a Web Part.
11. Select the Search Core Results Web Part.
12. Click Add.
13. Copy the current URL to the clipboard but do not include the query string ?pageView=Shared.
14. Click Edit in the Search Box Web Part.
15. Select Modify Share Web Part.
16. Expand the Miscellaneous Category for the Search Box within the tool pane.
17. Paste the URL copied above into the text box, Target search results page URL.
18. Click Apply.

Figure 4-15 shows the page at this point in the process. You have added two Web Parts, a simple Search Box and the Search Core Results Web Part. By changing the URL for the results page, you ensure that the results are displayed on the current Web page rather than your central SharePoint search site. This process allows you to provide searching to your colleagues within their own sites.

Exit Edit Mode by clicking the hyperlink Exit Edit Mode, and try out your new search page by entering some text into the search box. Your results will be displayed in the Search Core Results Web Part you added to the page.

**Content Query Web Part**

Content Query is perhaps one of the most powerful MOSS 2007 Web Parts available within SharePoint in terms of allowing you to present customized information on your site. You can connect this Web Part to almost any list within your web site structure (site collection), filter the information and group and sort the results for display within the Web Part. You could for example use this Web Part to display all documents that the currently logged-in user has created!

*Content types will be discussed in detail in the Chapter 6.*
Part I: Microsoft SharePoint Server 2007

Several options are available to you when configuring this Web Part:

- **Query**: Within this category you tell the Web Part where it is to get the information to display. It can use the following options as the source of its data:
  - Show items from all sites in the Site Collection.
  - Show items from a specific site and its subsites.
  - Show items from a specific list.
- **List Type**: Select the type of list you would like to display results from. You can use the drop-down list to select the appropriate value. Once you select a value from this drop-down, the choices available from the next two options will change to reflect the type of list selected.
- **Content Type**: Select the type of content you would like to see from the choices All Content Types, List Content Types, Folder Content Types, or Business Intelligence.
- **Show Items of This Content Type**: They will be filtered to reflect the choice made in Content Type.
- **Audience Targeting**: You can target the information being displayed to a specific MOSS audience.
- **Additional Filters**: This allows you to select a value from the drop-down list, which is used to restrict the information being displayed by the Web Part.

If, for example, you wanted to show a list of documents for the current user, you would set the Web Part up as follows using the options in the tool pane:

1. Show items from all sites in this site collection.
2. Set List Type to Document Library.
3. Set Show Items of This Content Type Group to Document Content Types.
4. Set Show Items of This Content Type to Document.
5. Set the additional filter to show items when “created by is equal to [Me]” (a short way to refer to the currently logged-in user).
6. Click the Apply button to view the results.

Figure 4-16 shows the document and filter configurations set within the tool pane.
You should now see a document library that has been filtered to only show documents that you have created; if another person logs on, the view within the Web Part will change to show his or her documents. As you may have seen when you picked the filter to apply, there are many different filter options available and some of the options within the tool pane change as a result of the filter used. For example, if you wanted to create a custom display of the task lists, the filter would allow you to select as one of its values the individual or group the task was assigned to, making this a very powerful tool if you need to make information available that is particular to the logged-in user.

Summary

In this chapter, you learned about the more common SharePoint and MOSS 2007-specific Web Parts. For many of the Web Parts, you also examined the configuration options available via the browser. This chapter also went some way toward showing you how you can customize SharePoint to meet your requirements and customize pages and information to meet your own business needs. In the next chapter, you will take this personalization further as you investigate those areas of SharePoint specifically designed for you, as a SharePoint user, to personalize and make more relevant by displaying the information you need to use. In particular, you will be looking at MySite, which is a MOSS 2007 feature. If you are a WSS user, this chapter is still worth reading, even if just to see what you are missing from your installation by not taking advantage of MOSS 2007.
In this chapter, you will be looking at some of the personalization features of SharePoint, particularly the MOSS 2007 MySite feature. In the preceding chapters, you have seen how you can configure Web Parts and list views to make information more meaningful to you, how you can add and remove Web Parts from pages, and how to filter information. However, this is only the beginning of personalization in SharePoint and in this chapter you will look in more detail at this area. You will also look at some of the more administrator settings within MySite, settings you would normally not have access to as a “normal” SharePoint user.

The sole purpose of SharePoint with both WSS and MOSS is to enable you to share, search, and collaborate on a day-to-day basis. Most of this work is carried out within SharePoint team sites where you are controlled with user permissions and other settings that dictate how you interact with the system. However, when working with MOSS 2007, there is another site you will use on a daily basis, and many people use this site to control how they interact with the system overall: your personal space on the SharePoint server MySite.

In this chapter, the term SharePoint refers to MOSS 2007 as opposed to WSS v3 only. If a feature is also available with WSS, I will state that clearly. In addition, there has recently been a lot of discussion on the Internet regarding the value of MySite mostly in terms of the disk space requirements to support people using this feature. However, MySite’s value far outweighs its cost in terms of cheap disc space for the features it brings to SharePoint installations.

**MOSS 2007 MySite**

MySite is your control center on a SharePoint server. From here you will receive a highly personalized view of much the information of interest to you on the system as a whole. Within MySite you can:

- View all documents you are involved with, both public and private.
- List all sites you are a member of.
Part I: Microsoft SharePoint Server 2007

- Build up a list of colleagues.
- Customize pages.
- Create subsites.
- Add and remove Web Parts.
- Update your public and private profile.

Much of this depends on the setup of your MOSS installation and the permissions available to you, but generally speaking most MySite will contain a wider range of permissions than would be available to you when working on a business team site. If you remember back to Chapter 2 when you looked at team sites and site collections and permissions, you will recall that you can be a member of the site owners group with full permissions on an individual team site. Above that permission level sits the site collection administrator who has higher-level permissions over the collection of sites including your site. In a MySite, you are in effect the site collection administrator with full powers over your personal SharePoint world, because in effect MySite is a site collection all by itself and you are king.

You will also find within MySite that your skills with document libraries and other SharePoint features are directly transferable. This is one of the beauties of SharePoint — you only need to learn how to upload a document once, or add a Web Part on even add users to your sites. No matter where you are within SharePoint the process remains the same.

Social Networking

How many readers of this book have Facebook or LinkedIn accounts? It seems that everyone today has one or the other, or at least belongs to a number of web-based groups that utilize Web 2.0 technologies. Web 2.0 can be a struggle to define. One way to define it is to discuss the creation of interactive web sites containing up-to-date communications between people, sites that contain tools to make it easy to associate with other people who maybe share a common interest, go to the same school, or simply enjoy the same leisure activities. Such features have always been a part of the Internet, though not as technology-focused as they are today. News lists and Internet-based email discussions groups have been around a long time. Such technology allowed like-minded people to join together on the Internet to assist each other and share knowledge. Today, the range of technologies has expanded at a huge rate, and now there is voice over IP, video on demand, interactive Ajax-driven web pages, and all sorts of weird and wonderful stuff that can be put into a web page. But at the core of the technology is the simple ability to bring people together using technology. Technology that is easy to use, that hides its complexity from the user, that simply works and allows you to build what have become known as social networks. Within a business environment what part does social networking have to play? That’s a difficult question to answer if you look at it from a social point of view, but if you look at it from a business point of view it does actually begin to make sense.

How many times have you wondered who carried out a particular job function, or who had a particular skill or could provide that missing bit of information you spent the last week looking for? If you work in a large organization, the quickest way to get anything done is to know who to go see. You tend to pick this information up by working somewhere for a long time and gaining the experience required. In addition, have you ever looked for a policy document only to be told, “We put that on the web site ages ago.” Lots of information is put on corporate web sites, and somehow with some magic intervention you are simply expected to know its there.
Chapter 5: SharePoint and You

To divert the discussion away from social networking in a business sense, consider knowledge and people networking. People networking in a business sense refers to the sharing of your business knowledge and skills with others within your organization and their sharing of their skills and knowledge with you. This is where SharePoint can help: colleagues can reveal skills and business knowledge to others on the SharePoint sites, and you can discover these people by using the search tools. You could think of it as an electronic water cooler. It provides the ability to share combined knowledge to get the job done in the best way possible. Something is put up on a web site, you want to know about it, and you should have the facilities to find out. Should you need to find out who is responsible for first aid within your building, you should be able to find out. If you need to find out who is the person responsible for salaries, that, too, should be available at the click of a button.

SharePoint and in particular MOSS 2007 can begin to help an organization create an environment that actually helps people to share and apply knowledge. Of course, there is a social aspect to this as well, as people are sociable by nature, so some consideration needs to be given to that also. That’s where SharePoint MySite comes into play. MySite encourages and facilitates knowledge and information sharing plus allows some degree of sociability, if there is such a thing on a computer. It’s always worthwhile to remember that people, not computers and software, are the key to a successful business.

Before looking in some detail at MySite, you need to understand a little about how SharePoint actually gets information about you and what information it can hold. Within SharePoint, information about you is held in a user profile, which is generally imported from your organization’s Active Directory.

**What Is Active Directory?**

Active Directory is a system used to manage and maintain all the resources on a computer network, including its users. It contains details on all users of the services, computers, other networks, printers, and any other services. In terms of people, it contains information like names, system usernames, email addresses, offices, and other work-related information.

Your system administrator will set up a regular import to the SharePoint user profile of information held within Active Directory (AD) and this in turn also helps ensure that only users within Active Directory actually have access to SharePoint. For example, if a user is deleted from the AD, then during the next import that user will also be removed from the SharePoint user profile store. User profiles can also be taken from other areas within an organization such as a human resources database and combined with information from the AD to provide a richer picture of individuals within an organization. In addition to this company information, once the user profiles are created, you can actually add information yourself to your profile with SharePoint, providing richer information within the organization. Perhaps you are the unofficial company expert on Microsoft Word, and you’re the person the calls end up with. You could add this information to your profile within SharePoint, making it even easier for people to find you.

All this might sound wonderful, an organization full of people sharing information, experience, and knowledge, but in the real world it often doesn’t work out that way, as many people are very resistant to sharing what they see is their information and hard-won experience. There is still a lot of the “What’s in it for me?” culture in many organizations. The sharing of information and knowledge within an organization must be encouraged and led by example from the top down. We need to see information as a shared resource, enabling all of us to get the job done in as simple a way as possible. You need to understand how
the day-to-day things you do in your own work sphere influence those done by others and how information you hold may be of value to others elsewhere in an organization. The old saying “knowledge is power” is only partly true; the real power of knowledge is in how it is applied and shared by you with others.

This current version of SharePoint, Microsoft Office SharePoint Server 2007, is an attempt to enable the sharing of information, to access diverse business systems from a single point, and most of all to apply our knowledge to contribute not only to business targets but to each other; to provide a common place where people can publish information and documents in a secure environment and eventually to expand our own knowledge as we learn of our colleagues and peers.

**MOSS 2007 MySite**

Figure 5-1 shows a typical newly created SharePoint MySite. A MySite has both a public view and a private view. The public view is available to anyone who visits your MySite, and the private view is just that, private to you. On top of that, certain information with MySite can be made available to specific categories of people. For example, your line manager can see a different public view of your MySite than one of your colleagues can. You decide who sees what when working in the site itself, and SharePoint may make some suggestions to you as well; for example, it might suggest colleagues you may want to connect to in the site.

Many SharePoint users use MySite as the home page within SharePoint and access all their related sites from this single point rather than bookmark many different sites. Your MySite can present almost all the information connected to you at a single point no matter where that information is located within SharePoint, and this is one of its really useful features. With one click of a mouse, you can list all documents you have created on any particular SharePoint site without actually going near the site itself. When you first create MySite by clicking the MySite link on your corporate SharePoint site, the site is actually created for you.

**MySite Features**

MySite contains a number of features to enable you to personalize the site and add information about yourself and the information you contribute to the overall organization. The amount of additional information you need to enter really depends on how much of this information is already held within
the Active Directory. If this information is available and has been mapped to the respective user profile, then much of the information will already be populated for you. In this section, you will be guided through various areas of MySite, beginning with your User Profile. The user profile contains the following sections, and you will be able to update certain areas.

**User Profile**

The default information available from the imported Active Directory records will be available to you within MySite. In addition to this, you can add other information that may prove useful to your colleagues and others searching for information. One of the first tasks you should do is to populate your MySite profile. In addition to adding the information, you can also indicate for some of this information who can actually see it when they view your site. Some information will not be updateable, and you will also be unable to change the audience for it. For example, everyone will be able to see your name and contact details, and you will be unable to edit these fields. Other information is freely changeable from within SharePoint. In addition, any new information added to the Active Directory for you will be made available within SharePoint automatically. Figure 5-2 shows a section from a typical profile page in MySite in edit mode. To open the profile for editing, click the My Profile Tab, then click the Details link in the My Profile group on the MySite Quick Launch menu.

![Figure 5-2](image)

The following information is available within the MySite profile, and I would encourage you to open your MySite now and add in the information being discussed as you move through this section:

- **About Me:** A short text description in which you can describe yourself and your role within the organization. You can see beside the rich text box the word Everyone is grayed out, as this information is available to anyone who views your page and cannot be changed.
Part I: Microsoft SharePoint Server 2007

- **Picture:** Add a photograph of yourself to the server. Again, by default this information is available to everyone. To add an image file, simply click the Choose Picture button to browse to the file and upload it to your profile. If your image file is already held by Active Directory, for example, then it may already be available.

- **Responsibilities:** Type in the areas of work you are responsible for. You can click the browse icon located to the right of the text box to search and add items that have already been added to the server.

Using the drop-down list located to the right of each text box, you have control over who can see the various items within your profile and MySite. Generally, the options will be:

- Everyone who visits the site
- Your Manager
- Only You
- Your Workgroup
- Your Colleagues

It is generally entirely up to you which option you choose from the drop-down lists. Figure 5-3 shows the drop-down list and the options visible.

![Figure 5-3](image_url)

To continue to update the profile information, add the following information:

- **Skills:** Here you can add any work-related skills you have. Again, you can browse existing skill listings by clicking the browse button and selecting those required. If your server allows it, you may also be able to enter skills directly into the text box.

  You may find that the skills and responsibilities search list has already been prepopulated for you, and you cannot add to either list. You will be restricted to simply selecting a value from the list.

- **Past Projects:** Information on previous projects you have been involved with can be entered here.

- **Interests:** Enter any special interests you may have.

- **Schools:** Schools you have attended.

- **Birthday:** Your birthday, just in case someone wants to hold a party for you.

- **Assistant:** Details on your assistant, if required, can be entered into this text box. You can search the User Profiles for the individual’s details by using the browse button beside the text box.

- **Mobile Phone Number** can be entered if required.

- **Fax Number** can be added.
Chapter 5: SharePoint and You

- **Home Phone Number** can be added, and it’s likely that you will only want this presented to your manager. You can use the drop-down list to the right of the text box to indicate who should see this information; in this case, you would select My Manager.
- **Account Name** will be populated from within the user profile.
- **Work Email Address** will also be populated from the user profile.

Once you have updated the profile, you can return to the top of the page and click Save and Close.

If you remember back to Chapter 4 and the People Search Web Part, it was possible to search for colleagues with specific skills and responsibilities. This is where that information is coming from — you and your colleagues’ profiles. You should begin to see how it is very useful to populate this area within SharePoint. One of the first things I do in SharePoint training sessions is have people update their profiles. That way, they already have a skill and responsibilities search facility in place from day one.

Once you have signed into your MySite, there is a short list of what-to-do-next links on the main home page. These are designed to get you up and running right away with SharePoint MySite. You have already completed step one in the process by describing yourself to the system. The rest of this list includes the options discussed in the following sections.

**Identify the People You Know**

Clicking this option will open the My Colleagues edit page, where you can view and edit existing colleagues’ records. Before looking at this form, it’s worth taking some time to explain how the whole Colleagues system works within SharePoint. Colleagues and individuals you interact with in your business environment. They could be people you email frequently, people you work and collaborate with on documents, and perhaps those you have on your instant messaging contact list. Colleague information is shown on the web page via two Web Parts: Colleague Tracker and Colleagues. In addition to adding colleagues manually, colleagues will also be suggested to you. For example:

- Those individuals you frequently send email to. SharePoint can, with your permission, communicate with Microsoft Outlook.
- Individuals you may be in regular contact with using Office Communicator.
- Members of the same administrative Active Directory groups.
- Anyone who is in the members group of a web site where you are also a member.

Other colleagues may be added for you automatically, including your manager, other individuals who share the same manager, and anyone who directly reports to you.

As you can begin to see, SharePoint, on its own without any direct intervention by you, can build up a fairly comprehensive profile of who you interact with on the system by joining information from several sources together to build up your colleague profile. The first time you enter your personal site, if you click the My Profile tab, you will see the Colleagues Web Part at the bottom of the screen. It is also possible to manually add colleagues to the list.

**Manually Adding Colleagues**

From the My Profile tab, click the Add Colleagues hyperlink to open the Add Colleagues form.
At this point, you can enter colleagues manually using the Identify Colleagues section. You can browse existing user profiles by clicking the browse button located at the bottom right of the textbook (book Icon). Once you have found a colleague, you can click add to add him or her.

There may also be some suggested colleagues shown below the text box. You can accept the suggestions and add them to your colleague list, tell SharePoint to stop suggesting individual colleagues by clicking the Stop Suggesting hyperlink, or reset the entire list by clicking Reset List for Suggested Colleagues.

In the Privacy and Grouping section, you can decide who else you will display this colleague listing to. You can choose to display it to everyone, your colleagues, your manager, or only yourself. Simply choose which item you require using the drop-down list.

If you would like to have the selected colleagues added to your workgroup, you can select the Add colleagues to My Workgroup radio button. Adding someone to your workgroup is useful if you need to share information with those you work with frequently. By adding them to the workgroup, you can make information available to them.

The final section of the form allows you to add colleagues to an existing group or to create a new group. It is useful to use groups to organize colleagues into work areas or project teams, as it makes large numbers of names easier to manage.

Once you are happy with your selections, click OK to save them and return to the profile page. Your changes will be reflected in the Colleague Web Part. This Web Part is a quick way to visit your colleagues’ MySite within SharePoint; all you need do is to click on an individuals name to open their personal site. Also note that the presence pawn is available beside each individuals name, enabling you to interact with the individual. Clicking the pawn will allow you to interact with the individual via Outlook, add them to your contacts, and if you have Office Communication Server installed and linked into SharePoint, you can take advantage of instant messaging and perhaps voice and video.

**Colleague Tracker**

In addition to the Colleague Web Part, the Colleague Tracker Web Part keeps you up to date with what your colleagues have been doing within the SharePoint environment. Using this Web Part, you can track changes to your colleagues’ profiles and other activities within the SharePoint environment. You can also change what information SharePoint will track with respect to colleagues. To change what is tracked, click the Change What Gets Tracked hyperlink within the Web Part. Within the Web Parts tool pane, you can set the following properties. Unchecking a property means that changes to that individual property will no longer be tracked by SharePoint.

- **Anniversaries**: Important dates that your colleagues have added to their profiles
- **Profile Property Changes**: Any changes your colleagues have made to their profile data
- **Membership Changes**: Changes to site memberships
- **New Documents**: New documents added to the system by the colleague
- **Out of Office**
- **Blog Changes**: Changes your colleagues make to their personal blogs

There are also some custom properties that can be set: Show Colleagues Without Changes and Only Show Colleagues in Your Own Workgroup. Within this area, it is also possible to select a reminder time for
Chapter 5: SharePoint and You

SharePoint to let you know when it’s time to update your colleagues. Using the “Remind me to update my colleagues” drop-down list, you can select from 1 month, 2 months, or 3 months to have SharePoint remind you about updating colleagues. In this section, you can also specify the maximum number of colleagues to display. Figure 5-4 shows the Colleague Tracker in MySite displaying the latest information for a colleague’s blog posts. If you click the colleague’s name within the Web Part, you will be taken to the public profile page of their MySite. Also note the icon to the right of your colleague’s name; clicking this opens a smart tag from where you can send email, add the colleague to your Outlook contacts and schedule meetings.

![Figure 5-4](image)

**Memberships**

Membership is a list that will be dynamically updated with sites that you are a member of. SharePoint will automatically add any site where you are in the members group. The membership list will be displayed on the My Profile tab and contains a link that opens the list to allow you to manage the memberships. You will be unable to add memberships manually, but you can edit the items directly in the My Membership list. Within the My Membership list, you can also create groups to organize sites by category, for example, and choose who can see each item. If you are a member of several sites, it is useful to group them by type just to visually make it easier to see the site lists. Figure 5-5 shows the Membership Web Part.

![Figure 5-5](image)

Using MySite, you are also free to change and customize the Web Parts available to you within this area. Unlike a standard SharePoint site, you are totally in control of your MySite.

**Customize Your MySite Home Page**

Even if you do not have permissions to customize your day-to-day team sites, it is almost certain that you will be able to customize the home page of your MySite. You can add multiple Web Parts to this area, as you are the site administrator. The information provided in Chapter 4 will also be useful to you at this point.

*Web Parts discussed in Chapter 4 will not be discussed in this chapter. Refer back to Chapter 4 for the specific instructions for those Web Parts.*

However, there are a number of Web Parts that are just used within MySite and some others that are available elsewhere in SharePoint but really only make sense when used in the context of your own site. Before looking at the Web Parts you can add to MySite, let’s look at a number of Web parts and some hyperlinks that are already on the page. When you switch the page to edit mode by clicking the Customize This Page hyperlink, you will see several Web Parts. Under the My Home tab there are various options, discussed next.
Part I: Microsoft SharePoint Server 2007

Getting Started with MySite

This is a Content Editor Web Part containing the instructions that enable you to get up and running quickly with MySite. This Web Part can be deleted from the page once your MySite is up and running.

RSS Viewer

An RSS Viewer Web Part will be visible and will need to be configured with the URL of the news feed you would like to display on the web. Simply click on the Open Tool Pane hyperlink and expand the RSS properties group. You can then enter the URL to a news feed or other RSS source.

SharePoint Sites Web Part

This is a MySite specific Web Part and will present a tabbed part that will display sites you are a member of and any documents from that site you have authored. There is also a task list associated with this Web Part that will retrieve any task assigned to you from the respective site. The only problem with this Web Part is that each site and the associated documents are on individual tabs, which do not give you an overall view of all sites you are involved in and their documents. However, given that an individual could be a member of multiple sites and each contains many document they have authored, it is understandable why this tab view is used. You must click on each site tab individually to view the information from the site. As with most Web Parts, this one can be customized either within the browser or via the tool pane. From within the browser, note the black arrow to the right of the first tab. Clicking this arrow will open a context menu with two options. The first, Memberships, when clicked will list all sites of which you are a member. Selecting a site from the list will retrieve the documents and tasks and reset the leftmost site to the one selected. The second option will allow you to create a new site tab for the Web Part. To add a new tab, click the arrow beside the first tab and select New Site tab. This will open the New Tab form, and you can choose to select a site from your membership list using the “more sites” drop-down menu or add a site URL manually. Once you have made your selection, click Create to build the new tab.

By opening the Web Part tool pane, you can customize the Web Part a little more. The usual options are available: Appearance, Layout, and Advanced. The View options are a little different, and from here you can enter the number of characters in a site name before it is shortened in the form “Sitename . . .” (note the ellipsis) and set the number tabs you would like to appear before the More Sites drop-down is active.

Each menu tab also has a drop-down menu available containing two options, Hide and Delete, which refer to the specific tab you have selected. Selecting Delete will remove the tab, Hide will remove the tab but retain a reference to it on the More Sites drop-down menu available from the far-right tab. Selecting the site from this tab will return it to the Web Part. Figure 5-6 shows the Sites Web Part in a MySite.

Figure 5-6
When someone views your public page in MySite, they will see the information you make available to a specific group. Figure 5-7 shows a section of my real-world MySite as viewed by another user. Of course, some of the information displayed has been removed for security purposes. In addition, any information you have recently changed will be highlighted in yellow. For example, if you have marked information as available to everyone, then that information will be available to any colleague who opens your MySite public page. With the site Web Part, they will also see a link to documents authored by you. Clicking this link will result in a search being made returning publicly available documents that you have authored. The documents are listed below the site names in a document area. In addition, any task assigned to you will also appear just below the list of documents. Note that once you have loaded a site and its documents, a hyperlink shortcut to the actual site will appear. Clicking this hyperlink will take you into the site itself.

Quick Launch Menu

On the MySite Quick Launch menu, you will also have several options available grouped into categories. The menu options are outlined in the following sections.

My Profile

In the My Profile category you will find:

- **Details**: This will open the Edit Details form discussed previously.
- **Links**: As you work with SharePoint it is possible to add sites you frequently visit, using the My Links menu from the main navigation bar on any SharePoint site. From this menu you can choose My Links to have the site added to your list. The details of the site are actually stored within this list in your MySite. From within your MySite, you can edit the links, add new links manually or delete a link. You can also choose who else can see your favorite links when they reach your MySite. In this case, you can choose either everyone or only yourself.
- **Colleagues**: This opens the list behind the Colleagues Web Part, and again you can manually edit the list items. You can manually add, edit, and delete colleagues using this form.
- **Memberships**: As discussed previously, as you are added to the member groups on various SharePoint sites this list is populated by the system. You can use this link to manually edit the list and its items. Again, by choosing the edit menu, you can choose who can see your individual membership items when they enter your MySite.
Documents

There are two default document libraries available to you when you first create a MySite: Personal Documents and Shared Documents. Personal Documents are just that; only you will have permission to view any documents within this library. Shared Documents, on the other hand, are readable by any of your colleagues who come to your MySite. Both are standard SharePoint document libraries and offer the full range of features common to this function. The only difference you may see is in the permission setting for the Shared Documents library. You can view the permissions for the Shared Documents library by selecting Settings → Document Library from the Document Library menu and then selecting Permissions for this document library. The default permissions already created within MySite will include a group called NT AUTHORITY\authenticated users. This is how other colleagues can view items within this document library. This group refers to all users of the SharePoint software, and if the group is removed, it will remove the permissions for your colleagues to read documents in this library.

Picture Library

You site will also contain a default image library, Shared Pictures, which is also shared with your colleagues. This could be a useful tool if you are responsible for business images or other graphic files. You could use your MySite to store the images while you are working on them and then copy them to the appropriate business library within your SharePoint sites. When you upload an image to this file, you will be asked to add some metadata to the file in order to provide additional information, for example to assist with searches within SharePoint. You can change the name of the image file, add a date the picture was taken, add in a description, enter the alternative text, and provide some keywords to associate the image. Once you have entered the metadata, click OK to complete the file upload.

The next set of links is the fairly standard team site links available in most SharePoint sites. They are Lists, Discussions, Surveys, and Sites. Clicking any of the links will bring you to the All Site Content page from which you can create a new item. It is likely that you will only be able to create a subset of the available sites when building up your personal web sites within the MySite area. For example, you would not want to be creating sites aimed at corporate users such as a Report Center. It’s also worth remembering that the amount of space you will have available to you within your MySite will be restricted by the server administrator and company policy. Later in this chapter you will see how you can monitor and manage your space in MySite.

Blogs

Within MySite you can create a personal blog. It is probably worth pointing out that ‘personal’ in a business sense is slightly different. Its unlikely that your management will view with any appreciation your thinking on the latest crime wave to hit the town or any sort of political statement. Personal in this sense really means a personal business-related blog as opposed to a totally personal blog you would create outside the office.

To create a personal blog site within MySite, click the Create Blog menu item located at the top right of the MySite home page. This will create a blog site and add a link to it on your Quick Launch menu. This blog is different in structure from the standard SharePoint blog site, as it is a more personalized area. Three categories — Work, Personal, and Other — are created for you in the Quick Launch menu.

You can create new categories as required by clicking the Categories Quick Launch menu header to go directly to the list, where you can add, edit, or delete items just as with any other SharePoint list. For example, you could create a category covering commonly asked questions you receive about your role or...
job function. When you create a blog post, a lookup column is provided in the post list to look up categories. Just as in most of the areas in MySite all users of the system will, by default, have access to your blog.

**Managing a Blog**

On the home page of your personal blog, you will find several links under the heading Admin Links. These links are used to manage the blogging process. They are:

- **Create a Post**: This allows you to write a new blog post. All posts made to the site can be set up so that they need to be approved before they are published on the live site or they can be published immediately by clicking the Publish button when composing the blog entry. This automatically approves the blog entry for publication.

- **Manage Posts**: This brings you directly into the list to manage posts. Blog posts saved as drafts must be approved before publication. You can approve or reject a post directly in the Post list by clicking the document menu and selecting Approve/Reject from the document menu drop-down list. The Post List menu is much the same as a standard document library menu with the addition of an Add To My Links item on the Action menu. This will create a link to your blog posts, using your My Links menu on the main MOSS navigation bar. The View menu in this library lets you select views of the posts; the options include:
  - All Posts (the default view)
  - My Posts
  - By Author
  - Calendar view of posts by date
  - Archive
  - My Submissions
  - Approve/Reject (a listing grouped by approval status: approved, rejected, or pending)

- **Manage Comments**: Allows you to use the Comments list to manage any comments posted to your blog. Again, there is a link on the Action menu to add the comments list to the My Links menu. If this is a public-facing blog, it is worthwhile turning on content approval for comments within the list settings and the version settings option. Even with an internal business blog, it’s probably a good idea to preview comments before they are made public on your MySite.

- **All Content**: Provides access to the All Site Content page from where you can open any list or library within the blog site.

- **Set Blog Permissions**: Opens the Windows help file, where you can find instructions about setting permissions for your blog site.

- **Launch Blog Program to Post**: Opens Microsoft Word 2007, which can be used to create blog posts. This feature of Word 2007 will be covered in Chapter 7. Figure 5-8 shows the basic MySite blog.
To create a blog post:

1. Click Create a Post under Admin Links.
2. Enter a title and the actual post within the New Post form.
3. Select a Category for the post from the drop-down list.
4. Select the published default date or enter a new date using the date picker.
   
   At this point, you can save the post as a draft, changing its approval status to Pending, and it will not be available to those reading the blog. If you’re confident in what you’ve written or decide to forego revision, you can click the Publish button to make the post immediately available on the blog site.
5. Click Publish when you’re ready to publish the post.

You will be returned to the home page of your blog, and you should see the new post at the top of the list. Blog posts are normally listed with the most recent post first.

It has to be said that the blog feature in MOSS does not match the features available in larger commercial blog software, but it does get you up and running with interactive communication between you and other colleagues within your organization. It’s a safe bet that this feature will be expanded upon in later releases of SharePoint and indeed some free updates have been made available, and there are also some commercial additions that can be added to SharePoint to improve this area.

**Adding Web Parts to MySite**

You should have access to the full range of MOSS Web Parts to add to your page. However, many of the available Web Parts really only make sense in a corporate environment and are not particularly suitable for inclusion in MySite. However there are no restrictions as to which Web Parts you can add. I have
seen MySite containing Web Parts using BDC data to simply add in a telephone directory to the home page on a MySite. This particular user used the MySite as their main interface to all the other features of SharePoint and simply wanted this information up front and available. That’s the beauty of SharePoint and MySite — you have the ability to take existing information and use it to help yourself. You add a Web Part to MySite in the same way you add one to any other page in SharePoint. You place the page into edit mode and insert a Web Part into a particular Web Part Zone. For example, you could add in the MyWorkspaces Web Part, to display all workspaces created below your MySite location within the home page. The Web Part provides a link to the Workspace and the date last used and the date the Workspace was created. To add the MyWorkspaces Web Part to your MySite home page:

1. Click Site Actions Edit Page.
2. Click Add a Web Part to the Top Zone.
3. Select the MyWorkspaces Web Part (you may need to expand the All Web Part grouping).
4. Click Add to place the Web Part onto your home page.

Any workspaces you have already created below your MySite will be automatically listed within the Web Part.

Additional Web Parts are added to the page in the same way. Chapter 4 looks at each of the Web Parts available to you with team sites, and you follow the same process within MySite. A MySite is a good place to try out adding Web Parts if you have the permissions to do as you so are relatively isolated from your main sites. However, it is not a good place to make business-sensitive information available appear in the public facing team sites.

**My Profile**

The My Profile tab provides access to more personalized information about you, including the ability to switch the view to let you see how your profile will appear to other site users who visit your home page on MySite. A lot of the information available on the profile can be updated by clicking on the Details link on the site’s Quick Launch menu. Other information is displayed using Web Parts that pick up the information from lists such as memberships, colleagues, and documents you have authored and made available. This area of the site is not really customizable in terms of adding or removing Web Parts, as this is actually the page your colleagues will see when they come to your site. Other information available on the My Profile page includes:

- Your availability information, which is picked from your Outlook calendar. This information does not include any details of meetings or other events contained within your calendar; it just shows your availability throughout the day.
- Organization hierarchy, or where you fit into the chain of command, is picked up from organization structures held within your company Active Directory. If this information is incorrect or not up to date, then the display of information within this area will be incorrect.
- The In Common With You Web Part located on the public profile page of your MySite will display details about information and site memberships you share with visitors such as sites you both are members of, shared line management, and other colleagues you both may know.
- Blog Posts will be displayed directly on the My Profile page of your site. Colleagues will be able to comment on your posts by clicking the Comments link provided with each posting.
Part I: Microsoft SharePoint Server 2007

You can view your profile page as seen by other colleagues by selecting a group from the As Seen By drop-down list. This gives you a quick guide as to how, for example, members of your Workgroup will view your personal site.

When colleagues go to your MySite, they see any public information you have made available including:

- Shared Documents
- Shared Pictures
- Recent Blog Posts
- Documents Web Part showing your recent public documents
- Colleagues Web Part showing colleagues you share
- In Common Web part showing any information you share with the user
- A listing of any public URL links you have made available
- Memberships you share

MySite can be used as a self-promotion tool within a business environment, which is one of its strengths — letting the rest of the company know you’re there, what skills you have, and how you contribute to the business. All of this information can be made available via your public profile provided that you put the information into the system. Figure 5-9 shows a section of the Profile page showing some of the personalized Web Parts.

Just as with all SharePoint sites, there is a certain amount of administration and management that you must do to make the most efficient use of this web space. As you are the site administrator for MySite, there are several tools at your disposal to help you manage this area.

Managing Your MySite

Just as with any other SharePoint site, you can add and remove Web Parts, add web pages, and build subsites within your MySite depending on, of course, the space limitations you have to work with. The space limitation is likely to be the one thing you will have least control in MySite, and it is important that you be aware of how much of your allocation you are actually using up. This next section will look at
some of the settings available to you in MySite. As stated previously, these are also general SharePoint settings which because of security and permission issues you would not have access to on a standard team site. The site setting is available from the home page of your MySite by clicking the Site Actions menu and selecting Site Settings. It is also possible that your installation of SharePoint MySite may have been customized to remove many of these permissions, and on top of that some of the management options here just plain don’t work. The most useful items available to you as the site collection administrator are detailed in the following sections.

**Site Collection Administrator**
This simply states who the site collection administrator is and allows you to search the user profiles to add additional administrators.

**Site Theme**
You may already be familiar with this item from working with standard team sites if you have the permissions to change the theme used. You can select a theme from the templates supplied to change the look and feel of your MySite.

**Top Link Bar**
This option does not work within MySite, but to customize the top navigation bar in MySite, you need permission to work on the server itself. You can safely ignore Top Link Bar.

**Quick Launch**
This option allows you to customize the Quick Launch menu items by editing existing headers, removing links, and adding your own custom link and menu structure. You use the same process in a standard team site, but in the real world it’s likely you do not have the permissions for this. To edit a heading:

1. Click Quick Launch in the Site Settings, and note the layout of the page with items grouped by header.
2. Click on the Edit icon beside the Documents header.
3. Change the Description in the “Type the description” text box to something more meaningful.
4. Click OK to save your changes.
5. Return to the Quick Launch menu to see the effect of your change.

This provides you with the ability to build up your own custom menu system with very little effort. In addition to changing the Quick Launch menu, you can actually change the menu structure from the standard layout used by Quick Launch to a tree view menu. This gives you a collapsible menu system, a little like using the menu system in Windows Explorer. To change the menu system:

1. Click Site Actions ➤ Site Settings, and select Tree View.
2. Remove the check mark beside Quick Launch.
3. Check the check box Enable Tree View.
4. Return to the My Home tab to see the changes.
Part I: Microsoft SharePoint Server 2007

Figure 5-10 shows a tree view menu in MySite.

![Figure 5-10](image)

The Tree View menu is useful when you have a site with a large number of subsites and libraries, and it does save space. You can also perform this action in a standard team site if you have the appropriate permissions.

### Site Usage Report

This will provide you with some statistics on the hits that you are getting on MySite and the most popular pages visited. You can choose to report by page hits, operating system used, user, browser, and referrer URL. You can choose a monthly or daily report to view the statistics. This report is worth keeping an eye on, as it will highlight the most popular areas of your site and, of course, those areas that are not as popular. This feature must be enabled by your SharePoint Administrator before you can make use of it.

### User Alerts

Using the “Display Alerts for” drop-down list, you can view those colleagues who have created alerts on your MySite lists.

### Search Visibility

Just as with a standard SharePoint site, you can choose not to have your site return information when colleagues are searching SharePoint. Simply set the “Allow this site to appear in search results” radio button to “No.”

### Search Settings

This setting can be used to redirect searches away from the central search results pages into a results page in your MySite. Normally, if you do a search in SharePoint, your results are displayed in the main SharePoint portal Search Center. However, it is possible to create custom search results pages within each MOSS site collection, and MySite are no exception. In order to do this, you will need to create a new web page that contains a Search Core Results Web Part. This page is saved in your MySite, and you can reference it in the Use Custom Scopes text box in the Search Settings page. Now when your visitor performs a search using the search box on the home page of your MySite, he or she will be shown the results on your custom page.
Search Scopes

A search scope is basically a set of rules you give to SharePoint to instruct it where to restrict searches to. Again, in the real world, setting search scopes is usually the role of the server administrators who can monitor searching within the server and can create specific scopes to help you find information. Creating a search scope is technically very easy; creating useful serverwide search scopes can get fairly difficult. As an example, you will create a search scope that will simply look for all documents authored by you and add this scope to the Search drop-down list at the top of the home page. To create a new search scope:

1. Click Search Scopes ➔ New Scope.
2. Enter a title for the Scope such as Martin’s Docs.
3. Check the Search drop-down box in the Display Groups section.
4. Accept the default results page, unless you have created a custom results page within your MySite.
5. Click OK to complete part one of the process.
6. In the search scopes form, click the text “Add rules beside your new scope.”
7. For the Scope rule type, click Property Query.
8. In the next text box, enter your name.
9. Accept the default behaviour of “Include any item that matches this rule.”
10. Click OK.

You now have to wait until the server sets up the new search scope. This should only be a matter of 10 or 15 minutes. Once the update has run, your new scope should be available within the Search drop-down list. This is again a way to try and personalize information and make it easier to discover what is actually on the server. Figure 5-11 shows the new scope, Martin’s Docs, in the site search drop-down menu.

If your scope is not returning any records, check the View Scope page. The items column will let you know how many items the scope should return. If this number is zero, then there are no records meeting the rule you set in the scope.

Search Keywords

Keywords are basically a way to associate words with content on your SharePoint server. Again, in the real world of business systems, this is an area that will be managed for you centrally.

Recycle Bin

This is, obviously, your site collection’s Recycle Bin. You should know that items in the Recycle Bin do contribute to your overall site space quota, so you need to clear it out every so often. When you delete a document or other items within your MySite, they will be added to the Recycle Bin, from which they can be recovered.
Site Usage Report

The Site Usage Report is a simple report that provides a summary of how much space you are using from your allocation. The screen will show you how much of your allocated space you have used, how much space you have, the number of users added to your MySite, and the total number of hits to date. This is a useful report to keep an eye on, especially in terms of space used. However, you should receive a warning email when you begin to reach the limits of your space allocation. This is another feature that must be enabled by your SharePoint administrator before it can be used.

Storage Space Allocation

This provides detailed information on each item within your site collection and how much space it is using. You can filter the reports to display documents, document libraries, lists, and the Recycle Bin. Clicking on a file name will open the specific file for you. This report will display everything in your site, including system graphics and other files used by SharePoint. It is vital that you do not delete some of these files or things will stop working. For example, one of the files listed is upload.aspx, which is the page used to allow you to upload documents and other objects into SharePoint.

When Things Go Wrong

If you make a serious error when customizing your MySite, you can return it to a precustomization stage by selecting Reset to Site Definition from the site Settings menu. You can reset an individual page by providing the URL to that page or reset the entire site collection. You will lose all customizations you have made and will have to start over. A site definition is a sort of template that SharePoint uses when you create the new MySite.

Site Hierarchy

An outline of your site and all subsites created within it. You can click the Manage hyperlink to go directly to the site setting for any individual site or click the URL to go to the home page.

Portal Site Connection

This is usually the URL back to the home page of your corporate site, and it will be added to the breadcrumb menu at the top left of your MySite pages. This is a useful one-click way to return to your main site pages.

Site Collection Audit Settings

A bit Big Brother-ish, Site Collection Audit Settings lets you log how your colleagues interact with your MySite by selecting options for audit from those offered. You can audit according to two categories: documents and lists. For documents you can audit:

- Opening or downloading documents
- Viewing items in lists
- Editing items
- Checking items in or out
Chapter 5: SharePoint and You

- Moving or copying items to another location
- Deleting or restoring items

For lists, libraries, and individual sites, you can audit the following events and actions:

- Editing content types and columns
- Searching site content
- Editing users and permissions
- Site collection policies

There is one major drawback with respect to auditing in a MySite: you do not have access to the reports. However, it does give you some idea of the type of auditing that is possibly taking place on the more general sites you have access to.

Just as with other SharePoint sites, it is also possible to customize your MySite to suit the information you need and the way in which you work. The ability to customize your MySite is dependent on the features that have been made available to you by your SharePoint administrators, and in some installations, it may not be available.

**Customize MySite**

As you are the site administrator, there are virtually no restrictions to how you can customize your MySite. One of the most common ways you can customize MySite is by adding Web Parts to display your Outlook Inbox or Calendar. A set of Outlook Web parts is available including:

- **My Calendar**: Displays your Outlook Calendar
- **My Inbox**: Displays your Outlook Inbox
- **My Contacts**: Displays Outlook contacts
- **My Mail Folder**: Displays your mail folder from Exchange 2007
- **My Tasks**: Displays your Outlook Tasks

You will need to configure the Web Parts with the URL to your Outlook Web Access site and add the mailbox required.

*If you access Outlook on the web using HTTP, you will be presented with a second login screen inside the Outlook Web Parts. To remove this screen and pass your username and password directly to the Exchange server, you will need to have your Exchange administrator configure Integrated Security on the mail server. If you do not do this, you will be required to enter your username and password to the Web Parts again. It’s also worth pointing out that, if you have the URL to Outlook Web Access (OWA) stored in your user profile, you will see a My OWA link on the main MySite navigation at the top right of the MySite pages.*
Role-Based Templates

Microsoft has also released a set of role-based templates directly for use with SharePoint MySite. The templates available at the moment are:

- Administrative Assistant
- Controller-Financial Analyst
- Customer Service Manager
- HR Manager
- IT Manager
- Marketing Manager
- Sales Account Manager

As you can see, the name of each template is based on a particular job function and contains many features specific to that function. The templates contain a variety of SharePoint, and more particularly MOSS 2007, features, such as sample SQL server databases, which work with the Business Data Catalog in MOSS to provide example data to the templates. The role-based templates are really worth having installed by your system administrators just to see how you can interact with other systems and applications using MOSS 2007. Unfortunately, you cannot install these examples unless you are a server administrator as there are several settings and changes to the environment you need to make.

MySite is your landing place within MOSS 2007 and should act as your home page when working with the software. Nearly all the information you could need can be made accessible from within the MySite. It can also be your own personal showroom highlighting your skills and talents to the rest of your company.

With MOSS 2007 there are additional ways in which information can be personalized and made available to individuals or groups within an organization. One of the most popular ways to achieve this is by the use of audiences. In order to work through the following example, you need to be in a standard MOSS team site and not using a MySite, as the Content Query Web Part will not be available to you in MySite.

Personalization Using MOSS Audiences

An audience is a group of colleagues created by your server administrators (at your request) who all meet a specific set of rules. For example, if you worked in HR you could create an audience of all company executives, and when you want to make information available to that particular group, you would target it at that audience. Only members of the Executive audience would see the information. Almost every list and Web Part within SharePoint can be configured for audiences. By default, the support for audience targeting is usually turned off and must be enabled on a list or library before it can be used. You enable audience targeting in the setting for the list or library by selecting Audience Targeting and checking the “Enable audience targeting” check box. For example, to enable audience targeting on the Shared Document Library in a standard MOSS site:

1. Click Settings → Document Library Settings.
2. Click Audience Targeting Settings in the Setting form.
Chapter 5: SharePoint and You

3. Check the Enable Audience Targeting check box.
4. Click OK.

To add an audience to an individual document within the library:

1. Upload a document to the library.
2. Click Document ➤ Edit Properties.
3. In the Target Audiences text box enter the audience for this document or click the browse button to view and select from available audiences.
4. Click OK to save and return.

The idea here is that only members of the audience will be able to see particular documents; that is, those that have been assigned to audiences of which they are a member. However, when accessing documents directly within a document library this will not work, as the library does not use audience filtering. So what use is this? Well, if you use a Content Query Web Part, you can use your document library audiences. This will result in members of different audiences having a different list of documents presented to them on the same web page. If a user is not a member of the audience that a document is targeted at, they will not see the document via the Web Part. This is not a replacement for security, as it is possible to view all documents within a list irrespective of audience. If documents are sensitive or confidential, then they should be secured using fine-grained permissions within the library itself. Audiences are a means of pushing information out to your colleagues, not securing it. There are two major problems with the Web Part: one is that it is available in MOSS 2007 only, and the other is that it is only available in sites that have the Publishing features turned on. However, when it is available it is a very useful tool for displaying site information.

Adding a Content Query Web Part in MOSS 2007

The good thing about this example is that after you have done this once, the way in which you target the audience is generally the same if you later do so in a list. The key is to have your audiences created before you begin the process. However, there are other groups you can target within Active Directory, and they will be pointed out following this example. To follow the example, you will need to place a page into edit mode. You will also need a document library with several documents that have been set up for a target audience. To add the Web Part:

1. Click Add a Web Part.
2. From the list of Web Parts, select the Content Query Web Part.
3. Click Add.
4. Click the downward-pointing black arrow to the right of the Web Part name, and select Modify Shared Web Part.
5. In the tool pane, expand the Query Group.
6. Click the “Show items from the following list” button.
7. Click the browse button, and find the document library on which you have audience targeting enabled.
8. From the List Type drop-down, select Document Library.
Part I: Microsoft SharePoint Server 2007

9. From the “Show items of this content type group” drop-down list, select Document Content Types.

10. From the “Show items of this content type” drop-down list, select Document.

11. In the Audience Targeting Group, check Apply Audience Filtering.

12. In the same group, check “Include items that are not targeted.”

For this example, that is all that is required. Figure 5-12 shows the tool pane at this point in the process.

![Figure 5-12](image)

You can now click Apply and check that your Web Part returns records. The Web Part will filter the records displayed according to the Audience Target settings within the library. For testing purposes, it is useful to add yourself to one or more of the audiences so that you can see what the audience sees. It’s always useful to make sure that these things work. You can also use your MySite as your test bed for examples such as this, as it allows you to try out things far away from your live team sites.

Audience targeting can also be useful within your MySite as part of your customizations. For example, you can add other Web Parts that make the information more personal to the visitor by targeting it at specific business groupings. If you are responsible for marketing materials for a large organization, you could target a document library according to the target audience based on business areas, geography, and so forth. This would also be useful for those responsible for help desk and the production of user manuals. Your audience could again be created based on business areas and specific help-related materials targeted at them. You could use your Shared Documents Library for this by enabling audience targeting on the library and then on the documents within the library. All that is then required is for you to add a Content Query Web Part to the home page of your MySite, linked to the document library, and everyone will see what you want them to see. Don’t forget that if you are a MOSS 2007 user, you have
audience targeting available to you on any MOSS site, not only MySite. Audiences also work well with announcement lists, where you could target announcements to staff and colleagues based on grade, such as an announcement for managers only. The more information you can make personal to those using your site, the better, and the easier it will be for other colleagues to find the information they need without too much effort.

**Other Audiences**

The previous discussion deals with audiences set up by your SharePoint administrator. If you are a user of Active Directory, you can also target content at Active Directory Distribution Lists and Security Groups. This gives you a very powerful personalization tool that is available with very little effort. Just remember, it’s not a replacement for security.

In addition to targeting lists and documents, you can also target Web Parts to specific audiences. If a colleague is not a member of the audience, then just as with a document or list item, they will not get the Web Part.

In addition to using audiences, you can create personal views of many of the web pages and sites you will use within SharePoint, provided that this feature has been enabled by your system administrator. This next section looks at personalization in terms of team sites.

**Personalization with Team Sites**

You also have a degree of personalization within a standard MOSS or WSS team site. While not as full-featured as MySite, there are still lots of areas you can personalize to make sites and information more meaningful. Unlike MySite, where you are the site administrator, you will need specific permissions to personalize business team sites, and in some cases these features will be restricted across the board by the system administrator. Some areas that you will be able to personalize are views of document libraries and lists. You have already looked at views in Chapters 2 and 4. In this section, there is really very little to add. A personalized view is created in the same way as a standard view, with the exception of the Audience category. Usually when you are creating a view, you are making it available to anyone using the list or library. In the case of a personal view for your own use, all that is required is to click the Create a Personal View radio button. In this case the view will be for your exclusive use. This is a great way to ensure that you have immediate access to the documents or information that interest you as opposed to the full listing of items. Other users of the list or library would be unaware of the view’s existence.

If your server administrator has enabled personalization of Web Parts on the server, you will also be able to add and remove various Web Parts from standard sites. In addition, you could also personalize the Web Parts again to make the information more personal to you. This is a server setting, and the ability to carry out such personalization may or may not be available. One example of personalization you have already touched on is the Current User filter. This Web Part can be added to any SharePoint page and used to pass values to Web Parts, for example a document library. In this way, the documents displayed would be of immediate use to you.
Personalize a Team Site

As stated, you can create a personal view of a team site by changing Web Parts and other information to reflect what you want to see. To personalize a site, click the Welcome link on the tip toolbar, and then from the drop-down menu, select “Personalize this Page.” Figure 5-13 shows this menu within a MOSS team site with the Personalize option selected.

The web page will move into edit mode, and you can begin to change the information displayed. Figure 5-14 shows a standard team site; note the large Windows SharePoint Services logo site graphic. Figure 5-15 shows the same site with another user logged in. This user has personalized the page by removing the Windows SharePoint Services logo. Once the page has been personalized, you can move between your personal view and the standard shared view by selecting the appropriate option from the welcome menu. You can, at any time, reset the page to the standard view permanently — that is, delete your personal view of the page — by selecting Reset Page Content using the Welcome menu.
You could, for example, add some of the personalization Web Parts to the page to show your own documents rather than a list of documents contained within the site. This gives you immediate access to information of direct relevance to you. Of course, you still have access to all the other information within the site and can revert back to shared mode at any point.

You have already seen in previous chapters how you can personalize areas such as document library views by using filters set to [ME], which is short way of saying, “only show something when a value is equal to the currently logged on user” (yourself). There are other filters that can be used to personalize documents being displayed using list views, including checked out to, created by, and modified by. All can be used to help build up personal views of SharePoint data. You can also filter the list by audience if audience targeting has been enabled on the list itself. This is a neat way to make information more personal to colleagues within your sites. However, you will need to use the Content Query Web Part to actually get the filtering to work.

Another useful personalization tool is the use of audiences to target web links. This could be a useful tool for systems when you only want to show certain navigation links to members of particular groups of staff or colleagues. They work in much the same way as setting up any audience, only in this case you are adding navigation links to your site aimed at particular users. To modify the navigation process and add a targeted link on the home page of your team site, click Site Actions ➤ Site Settings ➤ Navigation.

This will open the Site Navigation screen, which offers you several choices for how the navigation structures of your site will work. Scroll to the bottom of the screen until you reach the Navigation, Sorting, and Editing section.

1. In the last category group, click on the current navigation heading.
2. Click on Add Link.
3. Enter a title and URL for the link.
4. Check the Open link in new window box, if you would like the link open in a new window.
5. Enter a description for the link.
6. In the Audience Targeting box, click the browse button to locate the audience for the link.
Part I: Microsoft SharePoint Server 2007

7. Select the Audience required, and click Add.
8. Click OK to close the Select Audience dialog.
9. Click OK to close the Navigation Link dialog and save your changes.

The new link will only be available to members of the audience selected. Figure 5-16 shows the navigation link dialog once the details have been entered. In this case, the text “no exact match was found” is displayed, as a fictitious audience was entered for this example.

![Navigation Link - Webpage Dialog](image)

Figure 5-16

However, in many cases, because of the difficulty of managing multiple changes to pages and the possibility of having thousands of different views of a team site, for example, many SharePoint applications do not make this feature available globally.

**Personalization Sites**

This is an area generally dealt with by your site administrator who can create SharePoint sites containing information directly aimed at a subset of the server’s users. A personalization site is created and will appear within your MySite, where you can choose to “pin it” to the tabbed menu. In this way, it will always be available directly. The site itself will contain several filter Web Parts that will ensure that the information you see is directly relevant to you.

In addition to the actual personalization site, your site administrator can make links available to specific groups within SharePoint. For example, if you had an annual finance department meeting, you could ask the administrator to publish a link to the conference site for all members of the finance team. This link would appear within your MySite.

In addition to the personalization features aimed at helping you with business information, there are several other settings available to you, which are discussed in the following section.
Alerts and Regional Settings

In previous chapters, you have seen and set alerts on items within the site that are of interest to you. Alerts provide another way of telling SharePoint what content you’re interested in. Usually, this has been in the context of a document or list item. From the Welcome menu in SharePoint, you can also manage and add alerts to the system as a whole or rather to the site collection you are a member of. In addition to alerts, you can also change your regional settings directly from the Welcome menu.

To view and set alerts, click Welcome ➔ My Settings. In the User Information form, click My Alerts, and then click Add Alert.

![Figure 5-17](image)

Figure 5-17 also outlines the sort of information that can be populated for you from within your organization’s Active Directory. Note that some information has been removed from this figure. Your regional settings can also be changed at this point. Regional settings are set by your server administrator, but you can customize them via the User Information form if required.

Summary

As you can see in this chapter, SharePoint, and MOSS 2007 in particular, is not a one-size-fits-all system. With the proper permissions, you can personalize not only the pages themselves but also the information they contain. Information can be targeted at colleagues based on their membership in groups and business areas, information can be personalized so that it is directly relevant to you, and, in addition, you have your own personal web site, where the system will bring not only information, but also people directly to you. This chapter discussed MySite, how to customize MySite, and how to use the Audience features of MOSS 2007 to make information directly available to those who require it. In the second part of this book, you will examine how to integrate many of these features in the applications that make up Microsoft Office 2007.
Part II: From Desktop to Internet

Chapter 6: Microsoft Office Word 2007

Chapter 7: Microsoft Office Access 2007

Chapter 8: Microsoft Office Outlook 2007

Chapter 9: Microsoft Office Excel 2007

Chapter 10: Microsoft Office Groove 2007

Chapter 11: SharePoint Add-Ins

Chapter 12: SharePoint Designer 2007

Chapter 13: Records Management
Part II: From Desktop to Internet

The first several chapters of this book looked at many of the features of SharePoint, from both WSS Version 3 and Microsoft Office SharePoint Server 2007. The remainder of the book examines how each of the core Microsoft Office 2007 applications interacts with SharePoint, and along the way you will learn about additional SharePoint features and properties that make working with the server a pleasure. As you have seen, the whole emphasis of SharePoint is on enabling you to share and work in a secure way with information and business applications. In the case of SharePoint, you do this by using a web browser as the application interface to tie the Office applications together and present information using a single tool, the browser. In the old days, Microsoft Access applications were all exclusively written to be run on the desktop, but in recent years there has been a requirement to make more and more information available to internal and external users via a web browser. Many Access developers have also noticed this shift away from locked-down systems running on the desktop to systems and applications that are available anywhere, with the browser being used as the interface of choice. This shift in focus not only applies to programs like Microsoft Access but also to the full range of Office applications and, of course, access via the web to other corporate systems. It’s difficult today to purchase a large corporate system that does not use the browser as its client interface.

Over the years, Microsoft and most other large software companies have been developing tools and applications to make development of web-based systems much easier, and this approach to technology has really taken off over the last couple of years. Today there are numerous choices when it comes to making information available via the browser. Google, for example, has made documents, spreadsheets, and presentations available in the browser through Google Docs — their own web-based software. However, Google Docs is arguably still in a version 1 state and is in no way comparable to the likes of Word 2007 or Excel 2007. None of the competition, including Google, has anything remotely like Microsoft Access 2007, which is perhaps one of the most underestimated desktop database application development platforms available. Microsoft Office as an application set is widely used in almost all large and small organizations. It’s used in schools and universities, factories and shops, to perform almost all the major business-related activities from basic word processing right up to corporate reporting. Thousands of applications have been written that rely on the power of Office to deliver functionality to end users, and millions of dollars have been invested in their development. It’s unlikely that Microsoft Office is going to disappear any time soon, despite reports of its demise. The latest release of SharePoint has guaranteed that.

Office as a Desktop Application Set

For most people, Microsoft Office is a desktop application suite they use every day to author documents, work with spreadsheets, and create presentations. But to developers it has always been much more, and they have built systems and applications that have amazed many at Microsoft. Microsoft Access 2007, for instance, has perhaps one of the biggest developer communities on the web. This information is relevant because developers have always recognized one of the strengths of Office: the capability to build applications that use all of the applications together as opposed to singly. For example, consider an application designed to maximize the interaction between Access and Word to generate business letters and other forms of communication. The capability to hook into Outlook and send emails to clients is a feature that Access and other application developers have used for years to create their applications. A problem is that most developers spend a great deal of time working with one application and overlook how the Office applications fit together into a single suite, which is more than capable of interaction. That’s where SharePoint comes into the equation. It acts as the glue that binds almost all the Office applications together. Word, Access, PowerPoint, Excel, and Outlook all fit together under the umbrella of SharePoint, providing you with access to business information regardless of which application it actually resides in.
One of the really attention-grabbing things about SharePoint is the simple capability it provides to take content from within Microsoft Word and immediately make it available to users via the Internet. Prior to the development of the capability within Word 2007 to do a simple File Save to SharePoint, doing this meant using third-party software to upload documents, email documents, or actually print them out and put them in interoffice mail. There was, of course, also the option of adding the documents to a shared folder on a network, but that meant contacting the systems people and getting the folder created and users added to it. With SharePoint, you can do everything yourself. It is still true that one of SharePoint’s great attractions is this simple process of making information available to someone who can access it with nothing more than a web browser and the right permissions. That was the other key, permissions, which allow the storage of documents and other information in a secure environment.

This release of SharePoint MOSS 2007 has tightened the integration between the browser and the Office applications, enabling even easier distribution of documents and information. This interaction can take place not just from Office applications to the web but also from the web back to Office applications. In fact, in the case of Excel, there is almost full integration between the desktop application and the browser, using Excel Server as part of MOSS 2007. Over the next several chapters, you will explore this integration between the web and the desktop, looking at each of the Office applications in the context of WSS and MOSS and how they interact. With this release of Microsoft Office, it is easy to see that Microsoft is also embracing this general trend toward making data available via the web browser. Each of the Office applications has been improved to work with browser-based information and data. Each application has had features added to make this integration easier, particularly when it comes to working with SharePoint. Microsoft Word, Access, Outlook, and Excel 2007 all contain enhanced features that make it easy to save and interact with information and documents stored on SharePoint sites.

**Microsoft Office Groove 2007**

In addition to the four main applications discussed here, you will also look at using Microsoft PowerPoint 2007, SharePoint, and an application that is new to many people: Microsoft Office Groove 2007. It is perhaps true to say that there are not as many SharePoint features for PowerPoint as for the other applications, but Groove is a totally different story. Groove is designed to work with SharePoint, and it’s a fair bet that this interaction will increase with new releases of both Groove and SharePoint in the coming years. Groove is available with the Enterprise or Ultimate suite of Office 2007 and can be downloaded as a commercial product from [www.microsoft.com](http://www.microsoft.com).

Groove is another tool in the Microsoft toolbox that permits collaboration and information sharing using the Internet. Out of the box Groove will let you share files, calendars, online workspaces, and images. It will permit secure connections to SharePoint document libraries and manage the synchronization back to the SharePoint server for you.

One of the major focuses with this release of Microsoft Office 2007 has been to make information available via the Internet using SharePoint. Without SharePoint you are restricted to using third-party FTP software or standard file uploads and downloads to make things like Microsoft Word documents available via the web. Using these approaches, however, all you have is a download link; the document is dead in terms of interactivity and document management capability.

As you can see, all of the Office applications discussed in this section have been redesigned to possess increased functionality and to improve their interaction with SharePoint. The ultimate aim is to totally blur the line between your desktop, information stores, and applications using SharePoint and the Internet as the application tools of choice.
Information Management

Many of today’s business documents no longer sit in isolation but are subject to multiple legal requirements, retention policies, and other management structures. It is becoming more difficult to simply create a Word document, save it to a local drive, and forget about it until you need it. More and more, you are required to classify and store information and documents to meet some complex guidelines that no one really explains to you. Management is continually looking for information and measures of performance, requiring more and more of your time aside from the core work that you do. You also must deal with ever-increasing amounts of information coming at you from all directions — especially from email, where everyone today seems to require an immediate response. Leave an email sitting for a day or two and without doubt the phone will ring because someone is wondering if you still work for the company.

Changing business requirements lead to increased frequency of republishing corporate documents, targets are set and reset by management and others, and this information must be conveyed outward to your colleagues and in some cases to the companies you deal with in the outside world. It is also becoming more difficult to get the full information picture about anything, really; information is stored all over the place. Documents are held on PC hard drives, USB drives, emails, file stores, and numerous other devices, all combining to make it difficult to find information. In addition, there are more Internet-based file stores around today than ever before, and although personally I would never save business-related information to a third-party document store, I do know that many people make use of such systems to transfer files around or as a temporary holding place for documents while out on the road. Companies are using larger and more numerous database systems to store huge amounts of information. Information that was once inside the system is rarely seen again outside the confines of that system. Multiple systems and multiple logins are often required to get at a basic set of data, and many people are left dependent on IT specialists to get even a basic report out of these systems. SharePoint does not do away with the need for IT experts, but it can help bring this information from various sources together and make it accessible within a single interface: the browser. MOSS 2007 provides the Business Data Catalog (BDC) to help you to access information on virtually any system and present it in a basic way that enables you to use it and report on it without constant reliance on IT staff. That being said, it does take a high level of technical skill to get the information ready for use within MOSS, but this is just standard practice when you need information held in various systems. Once the data is extracted and presented via the BDC Web Parts, you can take advantage of it.

Records management is becoming the latest buzzword in many organizations, and MOSS also provides you with tools to implement robust record management systems without a great deal of overhead. Chapter 13 looks at setting up and using record management and information management policies with MOSS.

Business Knowledge Management

A huge amount of business knowledge is held within files produced by Microsoft Office applications, documents, spreadsheets, small database applications, and Microsoft PowerPoint slides. Outlook 2007 stores a massive number of email files, many of which are likely to be required to meet your company’s various legal obligations. As stated previously, it can be difficult to find a complete picture of information within many businesses because of this huge array of storage locations. Again, SharePoint tries to help out with this. Information is held in a central location or SharePoint can be configured to search for information across a number of different areas, including email folders and corporate file shares. All of which can be searched from a single search center within the SharePoint infrastructure.
In terms of knowledge held by people within an organization, MOSS can help out there as well because individuals can make information available from SharePoint sites or from MySite. Skills and responsibilities in listings can make finding out who does what easy once the information is entered into the system. In many organizations there are unofficial experts, but they can be difficult to find. MOSS makes it easy to find such people and take advantage of their knowledge by using the search tools it provides.

There is also a lot of duplication of documents, information, and systems in some larger organizations, and there are many companies where Access databases have grown out of all control as staff seek to find ways to get the information they need, information that is either too difficult to get from in-house systems or, indeed, that does not exist at an official level. Again, you can use the SharePoint search tools to find this information. In terms of information held in Microsoft Excel or smaller Access databases, SharePoint offers a more robust and secure environment. In many cases, no one knows what information is actually out there until staff begin to move it up to SharePoint.

The use of SharePoint can begin to erode the culture of in-house, team-based information storage. This can lead to more sharing of centrally based information that everyone can use as opposed to relying on the small team-based Access databases that only those directly related to the business function can get access to. With SharePoint, information once held in Excel or Access can now be made available across the company with a few mouse clicks.

One of the other upsides of SharePoint is the building of a company people-based culture through the use of personal web space provided by MySite. You and your colleagues can build public profiles within the system, sharing information and knowledge across the enterprise. You can build a community of people interested or working in the same business areas to share thoughts and ideas using blogs and wikis and the online discussion groups available in SharePoint. Again, irrespective of physical location, you and your colleagues can work together building knowledge bases and profile information that you need to help you. Information that is specific to what you do can be shared, hopefully helping someone else to do their job better. An advantage for business owners is that they can begin to use and find all the untapped knowledge and experience locked up in people, documents, and other personal systems where stuff is stored. Most of a company’s knowledge and skills reside in its people, and using tools like discussion groups, blogs, and wikis is one way to begin to get this out and into the public domain. The key, of course, is employees actually being prepared to let it out there!

The Web Browser as an Information Delivery Tool

The heading sort of says it all, really. Instead of building multiple applications with different interfaces, the web browser offers a single interface with which you can view business information irrespective of both your and the information’s location. The case for the browser as a delivery tool is well made. Everyone uses the browser to search for and interact with information and other people. It would be unusual today to find any large-scale business software that was not using the browser as the interface to the software. Increasingly, more people want their data on the web, and so there are services like Office Live and Google Applications that try to provide an interactive service. Microsoft Office Live is actually created on top of SharePoint, and many companies now offer solutions within the Office Live space. There is also Microsoft Office Live Workspace, which is a free service aimed at business users. What is interesting about Live Workspace is that you can save directly into it from Word, Excel, and PowerPoint by downloading and installing an add-in from Microsoft. This will add in a Save to Office Live menu item to the main application menu. As already stated, it’s not the best idea to save any corporate data to another company’s server, but Office Live and services like it do show how the Internet is being used to provide access to information via the web.
Almost all the Office 2007 applications have features that enable their use within a browser, even if they are somewhat basic. For example, in Word you can save a document as HTML or XML, and in the case of Access, you can use the database as the back-end data store for data presented by web pages. Using SharePoint, you can also save almost any of the applications’ data directly to the SharePoint site. As stated repeatedly, the file is then immediately available for you to use.

One approach to information that hasn’t been discussed yet is the use of Microsoft Office InfoPath 2007 to create electronic forms for use with MOSS 2007. Using MOSS 2007’s Forms Server, you can execute the InfoPath form directly within the web browser without the need for InfoPath on the client PC.

Using InfoPath 2007, it is also possible to query and update corporate databases, using a rich interface to enter and view data. For many of a company’s forms needs, InfoPath provides a possible solution when using MOSS and Forms Server. Once again, InfoPath provides you with a technique to use the browser more effectively to provide access to information and data. But as with all technology there are issues, many of which were already discussed in the first part of this book. At the top of the list in terms of issues are accessibility and cross-browser support. For SharePoint to really take off in a business sense, more work needs to be done in terms of creating an application interface that does not require Internet Explorer. At the moment, you can use SharePoint with IE, Firefox, Safari, Google Chrome, and Opera. It has to be said again that performance in everything other than IE is diminished, particularly for those responsible for system administration.

In terms of accessibility, that is, compliance with W3C standards, SharePoint and MOSS again fall short of the requirements, and in this area in particular it cannot afford to. The business sector I work in is required to have accessible sites, and this requirement will also apply to SharePoint sites being made available externally. Chapter 11 will list and discuss some options for creating accessible SharePoint sites. However, all ordinary users of SharePoint can do is to continually pressure the developers and administrators that this software needs to be accessible to all if further change is to occur.

This is really summed up by the discussion in this chapter. Using Internet-based technologies, the actual physical location of your colleagues doesn’t matter. For example, I have coauthored books with friends I have never physically met, never mind been in the same country with. Because of web-based tools, where they are was not an issue. We had more hassle over the time differences than we did with anything else!

For large organizations that may have offices and business needs in multiple locations, the ability to use secure, web-based systems is a huge plus. The ability for a staff member in the New York office to simply save the latest sales figures into a SharePoint document library and have colleagues in Paris receive an email telling them the document is there is a great time saver and a very simple act to perform: click File ➔ Save As in Word or Excel and you’re done.

If your company ties this whole Internet-based setup together with something like Microsoft Office Communications Server, you could also use secure instant messaging, and even online video conferencing, from within your SharePoint site to actually discuss the document in question. By using Communications Server inhouse rather than a hosted Microsoft solution, you remain in total control over setup and administration. By the way, none of this is actually new to many Internet users. What is new is the simplicity and ease of use that tools like SharePoint have brought to the game. For most people, there is no need to understand how it all works at a technical level; you just work in familiar software simply to get the job done. This is a huge advantage. Too many technical people are so enmeshed in the actual technology that they forget that software, the Internet, and Office applications are simply tools needed to do a job. Most of the time it doesn’t matter or you’re not interested in how the
Part II: From Desktop to Internet

technology works. All you’re worried about is that it does work and works in such a way that you don’t have to wade through acres of technobabble to understand it.

In much the same way, Internet-based software like SharePoint can assist those organizations that are based in the same city but spread over a large geographical area — for example, a university that may have different operations split up over several campuses. Research teams may be located in different areas of campus, but by using SharePoint that fact is made irrelevant, as they can collaborate directly online using the many tools available.

Access to Corporate Data

The browser is the perfect tool to interface with data stored in the organization without the need to build a different application for every system in use. Most large organizations store data in a variety of locations, from a number of large-scale systems right down to applications built with Microsoft Access. If you need access to such systems, normally you will have a unique username and password for each system. Each system may have its own associated application that needs to be launched in order to access data or complex reporting tools used to extract data for your use. Tools like SharePoint and its Business Data Catalog can make information held in different systems available via a single browser-based interface. Microsoft Office data connection files can be made available that allow you to connect to multiple data stores, using programs like Excel 2007 from within SharePoint, giving a single point of entry to systems. This saves not only time but also money by cutting down on the development costs associated with building distinct applications for each data source. That’s not to say there will not be a cost involved with SharePoint — there will — but as your skills grow, the costs will be reduced in terms of both application maintenance and development time.

The Business Data Catalog Web Part in SharePoint offers you a reasonably straightforward way to make corporate data available globally within your organization. The application definitions can be created by professional programmers within your organization and then made available on the server. From that point on, they are available for use by your colleagues within the secure confines of SharePoint. You have already seen the BDC Web Parts available to you in Chapter 4, including the BDC filters that you can easily use to pass filters into corporate data, making it fairly easy to create and display meaningful information. Third-party tools are also available to help create the application definitions, but despite what some of the web sites say, it’s doubtful that many server administrators will allow you to access either the levels required on the SharePoint servers or the corporate data to enable you to use them.

Summary

In this short chapter, you looked at some of the reasons and ways that Microsoft Office and SharePoint are blurring the distinction between your desktop and the Internet. You looked at how the actual physical location of your colleagues is no longer important when using browser-based software to collaborate and share information. In Part 2 of this book, you will look at how each of the Microsoft Office applications can be used to work directly with SharePoint, both from the application itself and from within SharePoint and the browser.
In this chapter, you will be looking at the interaction between Microsoft Word 2007 and Microsoft SharePoint Server 2007. You will look at features on the server that can make life easier when dealing with Word documents, creating and working with SharePoint content types and document properties, and looking at some of the records management features of both Word and SharePoint. You will also return to looking at document libraries, this time in the context of Microsoft Word 2007, and look at SharePoint content type in some detail. It would be a fair guess to say that many of you will interact with SharePoint most of the time by using Microsoft Word 2007 and perhaps Word 2003, so in this chapter only, I will provide some coverage for Word 2003 users. However, it really does hold true that your best experience with SharePoint will be with Microsoft Word 2007. In addition to the standard use of Word to author documents, you will also see how Word integrates with the blogging features of SharePoint, including creating and managing your blog site.

Because of the nature of the next set of chapters, some information may be duplicated. Duplication will be kept to a minimum; however, because Word, Excel, and even Access have some features in common, it is important to see the feature in the context of each application. I should also point out that some of the SharePoint-related menu options such as the Workflow option are only available for those running Office Professional Plus 2007, Office Enterprise 2007, Office Ultimate 2007 and the standalone versions of Word, Outlook, PowerPoint, and Excel 2007. The examples that follow were composed on a client PC running Microsoft XP Service Pack 2. Some of the screenshots may differ if you are accessing SharePoint running a Vista operating system. However, the core concepts, walkthroughs, menu instructions, and features are identical.

What’s New in Microsoft Word 2007?

Word 2007 is perhaps the most commonly used application in Microsoft Office, and its user range from very advanced word processors right through school children getting a project together. Just as with the other Office applications, there have been additions to Microsoft Word 2007 in terms of new file types and, of course, how it interacts with SharePoint.
New Menus

Word 2007, in common with the other Office 2007 applications, contains some new menu items related to publishing documents on SharePoint. Figure 6-1 shows the new menu available for use with SharePoint, accessed by clicking the Office button. You’ll also notice the Office Live item, discussed later in this chapter as another approach to collaboration and sharing files in the context of cloud computing, which is becoming the latest buzzword in information technology.

In terms of SharePoint, the menu items you will be particularly interested are the Server, Publish and Workflow menus. The Publish menu will, of course, allow you to publish a documents to a SharePoint site and the Workflow item will allow you to work with SharePoint Workflows from within the Office client. Figure 6-2 shows the Publish menu and the options available.
Chapter 6: Microsoft Office Word 2007

- **Blog:** Allows you to use Word 2007 as a blog-authoring tool. You will be trying this out later in the chapter.

- **Document Management Server:** Allows you to save your documents directly into Microsoft SharePoint.

- **Create Document Workspace:** Create a new documents workspace site within your SharePoint area to enable management of complex documents.

The Workflow menu options enable you to create document-based workflows directly from within Microsoft Word 2007, provided, of course, you do have access to a SharePoint site. Once you are working with document stored on a SharePoint server, the Server menu also becomes available, enabling you to work directly with features on SharePoint. Figure 6-3 shows the Server menu available by clicking the Office button, and each item on this menu is discussed during this chapter. Just to restate this point, the Server menu will only be available to you when you are working with a document that is saved within Microsoft SharePoint. This can cause some confusion when you open Word 2007 and don’t find the Server menu item.

As you can see in Figure 6-3, you can work with many of the document-related options directly from within Word 2007 without actually opening up your site in a web browser. Just as with the other Office 2007 applications, it is apparent that SharePoint is beginning to figure in a large way into the Microsoft plan for Office generally, and you can expect to see the integration between Microsoft Word and SharePoint increase with future releases of both Office and SharePoint. Before looking at the interaction with Microsoft Office Word 2007, there are some areas that we have already discussed in SharePoint that we need to go back to in more detail, as they make more sense in the context of Microsoft Word 2007.

**Microsoft Office Word 2007 and Document Libraries**

This book has already discussed document libraries and that discussion will not be repeated here. However, if you think of a document library as a Windows folder with some extra features, it will help you to understand and make the change from saving to a standard file server to saving to a SharePoint Internet site. A document library is the basic storage mechanism for your documents, which can be not only Word documents but any document you would like to save within the server. It’s only when you get documents onto SharePoint that you can begin to see the differences between SharePoint and the Windows folders. Many of the settings within the document library are useful when working with Microsoft Word, and some were examined in the discussion on document libraries. One of the most important areas when working within a document library is the use of content types. This next section will discuss MOSS content types in some detail.
Part II: From Desktop to Internet

Document Library Content Types

By this point in the book, many of you will already have a couple of documents available within a document library. It’s also safe to assume that you have tried to create new documents from within the library. When you do this, you get the opportunity to create a blank document, which in all probability will be a new blank Word document. But what if you would like to create a new invoice, company contact sheet, or perhaps an Excel workbook that you use every day? In previous versions of SharePoint, this was possible but was not part of the SharePoint interface. In fact, it’s more likely that you would have needed to create a new document library for each type of content you needed to create. Using the previous example, you would have had a document library for invoices, contacts, and Excel workbook creation. In this version of SharePoint, Microsoft has introduced the concept of content types; in fact, you have already worked with them if you have created a new Word document using the features of a document library. The Word document is based on a built-in content type of Document. You will find that SharePoint already contains many dozens of content types that you will use for everything from lists to Excel workbooks and web pages. In this case, it’s likely that you have used the Document content type to create a new blank Word document, but you are not restricted to this single document approach with this release of SharePoint. MOSS 2007 allows you to create custom content types and then create documents based on the particular content that you find useful within the same document library.

Metadata and Workflow

Content types can also contain metadata that you would like to capture about a specific type of document. For example, when creating an invoice, you may want to add some additional information such as salesperson or comments from the sales team member. In addition, SharePoint workflows can also be associated with a content type. For example a Request for Payment content type could be associated with an Approval workflow within your business group. You create a new document based on the content type, add the additional metadata, and save it to the document library. Immediately, a workflow is started, routing the document for approval to your manager. Right away, with very little effort, every team member within your site has access to the process when they create a new request for a payment document. The other great thing about content types is that you can search for content within your sites based on content type (for example, “show me all the request for payment documents”). Later, this section outlines how to set up this process, but it does require additional permissions on the SharePoint servers.

Existing Content Types

As stated, there are many existing content types available to you in SharePoint. In general, they fall into the following categories:

- Business Intelligence
- Document
- Folder Content Types
- Page Layout
- Publishing Content Types
- Special Content Types
- List Content Types
When creating your own content types, you will always start by using a built-in content type as the parent. For example, to create a new document content type, you will begin with the existing parent type: Document. In that way, you will inherit all the existing columns and other information associated with the parent into your custom type.

Content Type Scope and Inheritance

You can create content types for use by any site in a site collection or for the use of a specific document library. In this way, you can begin to customize document libraries to reflect their business purpose. For example, a general document library for a team site could contain several different content types: office memos, standard letters, requests for payment, and other general business documents. As you will see, content types add a very powerful feature to your document libraries.

In terms of inheritance, you always create a custom content type using an existing parent type. In that way, your custom type can inherit the features of its parent. All content types in SharePoint work in this way. For example, if the parent content type contains a column for author, your custom content type will also be able to use that column.

Creating a Document Based on a Content Type

This may be a bit like putting the cart before the horse, but including this section upfront should help you in working through the following discussion. This first basic example uses a CustomLetter content type that I have created in SharePoint to illustrate how Word 2007 interacts with SharePoint and content types. For the moment, you will not be able to follow along unless you have a content type created, as this example simply illustrates the process. You can return to this example shortly and try it out. To continue with the example, from within the document library:

1. Click the arrow beside the New menu. Figure 6-4 shows the newly available document content type, CustomLetter, in the menu.

   ![Figure 6-4](image)

2. Select the required content type; in this case, select CustomLetter.

3. Click OK in response to the warning about downloading files.

Your document will open within Microsoft Word. From this point on, treat the document as a standard Word 2007 file as this is all it basically is. Once you have completed the document, simply save it back into the document library by using File ➤ Save As, just as you would save it to a normal Windows folder. Note that the default Save As location will be the SharePoint document library.

When working with documents based on content types, you will find that all is fine when you create the document from the SharePoint document library directly. However, when you create a document in Word and then save it in a document library that has content types enabled, you will be prompted to
Part II: From Desktop to Internet

assign the document to the content type required. Figure 6-5 shows the dialog that appears when you save a document from Word into a content type-enabled library.

![Figure 6-5](image)

In this way, you can ensure that documents are associated with the correct types even if they are not created directly from within SharePoint.

**Setting Up the Library for Content Types**

Before you can use content types in a document library, you must first turn on this capability. To do so from within your document library, click **Settings ➤ Document Library Settings ➤ Advanced Settings**, and select Yes to allow the management of content types.

Your document library is now enabled to allow you to begin to use content types to manage and organize the information within the library.

**Creating a Custom Content Type**

At this point, you are going to create a custom content type for a standard business letter — again, a simple example but one that demonstrates the process and feature set. In this case, you will also associate the content type with a workflow that will route the letter to one of your colleagues for approval before you can print it out and issue it. You will also be adding a custom Word 2007 template to the content type, which will replace the default template used by SharePoint. Before starting the process, you will need to create a new template in Word 2007. The easier way to do this (unless you have an existing template you would like to use) is to simply select an existing Letter template in Word 2007 and save it as a template on your desktop. This will make it easy to find when it’s time to upload it to SharePoint. To open and save an existing Word template from within Word 2007:

1. Click the Office button.
2. Click New.
3. Select the Invoice template group, and select the Sales Invoice template, for example.
You are also going to create a content type that can be used in any library within the site collection. One
of the advantages to this is that not only will your team be able to use the type, but it will also be
available to any team site within the site collection. This is a great way to standardize business processes
within an organization. But first you will create a content type for use only by your own team. To
continue from your team site’s home page:

1. Click Site Actions ➤ Site Settings.
2. Click Site Content Types to open the Site Content Type gallery.
3. Note that you can now review all of the existing Content Types available to the site.
4. Click Create to open the new Content Type form.
5. Enter a name for the content type that reflects its use, such as Company Invoice.
6. Enter a description to further help your colleagues understand the content type.
7. Select Document from the available Parent Content Type drop-down list.
8. Select Document Content Types from the Parent Types.
9. In the Group section, click New Group and enter a name for the new group — for example, Sales Content Types.
10. Click OK to complete the process.

That’s part one of the process completed. You have created the new content type, and now you must
configure it by adding additional columns and other features you require. To continue with this process,
scroll down the Site Content Type page until you see the Columns area. At the moment, your content
type has two columns available by default, which are inherited from the Document content type. You
will now add more columns:

1. Click the hyperlink “Add from existing site columns,” which is available within the Columns
grouping located at the bottom of the form.
2. In the Select Columns From drop-down, select Core Document column.
3. From the Available Columns list box, select Author, Category, Status, and Version.
4. In the final section, accept the default selection of Update List and Site content types.
5. Click OK to complete this step in the process.

Up to this point, you have defined the content type and added additional columns to those inherited
from the parent document type. Next, you will add your new Microsoft Word 2007 template to the
content type. To do this, return to the Site content type form for the content type:

1. Click Advanced Settings.
2. Click the radio button Upload a New Document Template.
3. Click Browse and navigate to the new Word template you would like to use for this content
type. In my case, I used an existing Microsoft Word 2007 Company Invoice template discussed
earlier in the section on saving an existing template to your desktop.
4. Accept the remaining defaults and click OK.
Part II: From Desktop to Internet

That’s it: you have created your first content type, added some additional columns, and assigned a custom Word 2007 template to it. The next stage is to return to your document library and add the content type to the menu. To continue from within a document library:

1. Click Settings → Document Library Settings → Advanced Settings.
2. Click the radio button Yes in the Allow Management of Content Types section.
3. Scroll to the bottom of the form, and click OK to save the changes and return to the Customize form.
4. In the Customize form you should now have a Content Types section.
5. Click “Add from existing site content types.”
6. Select the custom group you created earlier, and select your content type.
7. Click the Add button to move the content type over to the Content Types section to add the list.
8. Click OK.

Figure 6-6 shows the result when the New menu item is clicked within the document library. Selecting Company Invoice will open a new Microsoft Word document using the custom template you associated with the content type. For the moment, simply close the document without saving the changes.

Figure 6-6

At this point, you may want to remove the Standard Document option from the menu. To do so:

1. Return to the Settings page for the document library and scroll through the content types.
2. Click the hyperlink “Change new button order and default content type.”
3. Uncheck the “Visible” check box beside the document content type.
4. Click OK to save the changes.
Return to the document library and notice how the option to create a blank document is gone, leaving you with the new content type and the ability to create a folder. The content type you created was a Word document using a custom template; however, this could have been any other type of Office file required such as a custom financial workbook using Excel 2007 or a corporate PowerPoint template. The content type could also have been a business document like an invoice or an annual leave request. In fact, it could be any sort of business document you require, and this is where the power of the content type lies. The ability to add business documents directly into your SharePoint site and standardize their use across the site will pay dividends later in the process, as you shall see when we return to content types in Chapter 13.

Adding a Workflow to Your Content Type

At the moment, you have a content type that uses a custom template to create a company invoice if you used the same name as outlined for the content type created. You will now associate a workflow with the content type. To associate the workflow with the content type:

1. Click Site Actions.
2. Click Site Content Types.
3. Click on your content type shown in the custom group you created.
4. Click Workflow Settings.
5. Click Add a Workflow.
6. Select the Approval Workflow.
7. Enter “Content Type Company Invoice Workflow” for the name. This is to make it fairly obvious that this process actually works.
8. In the Start Options select “Start this workflow when a new item is created.”
9. Click Next. In the resulting screen, do the following:
   - Choose “All participants simultaneously” (parallel).
   - Check the box “Reassign to another person” to permit the reassignment of the task should the approver not be available.
   - Select an approver for the document.
   - Enter a due date for completion of the workflow task.
   - Figure 6-7 shows this section of the form used at this point in the process.
10. Click OK to save the changes and associate the workflow with the content type.
Customize Workflow: Company Invoice Workflow

Workflow Tasks
Specify how tasks are routed to participants and whether to allow tasks to be delegated or if participants can request changes be made to the document prior to finishing their tasks.

- Assign tasks to:
  - All participants simultaneously (parallel)
  - One participant at a time (serial)
- Allow workflow participants to:
  - Reassign the task to another person
  - Request a change before completing the task

Default Workflow Start Values
Specify the default values that the workflow will use when it is started. You can opt to allow the person who starts the workflow to change or add participants.

- Type the names of people you want to participate when this workflow is started. Add names in the order in which you want the tasks assigned (for serial workflows).
  - Assign a single task to each group entered (Do not expand group).
  - Allow changes to the participant list when the workflow is started
- Type a message to include with your request:

Due Date
If a due date is specified and e-mail is enabled on the server, participants will receive a reminder on that date if their task is not finished.

Tasks are due by (parallel):
24/01/2019
- Give each person the following amount of time to finish their task (serial):
  - Days

Notify Others
To notify other people when this workflow starts without assigning tasks, type names on the CC line.

Complete the Workflow
Specify when you want the workflow to be completed. If you do not select any option, the workflow will be completed when all tasks are finished.

- Complete this workflow when:
  - Following number of tasks are finished:
- Cancel this workflow when the:
  - Document is rejected
  - Document is changed

Post-completion Workflow Activities
 Specify the actions you want to occur after the workflow has been successfully completed.

- After the workflow is completed:
  - Update the approval status (use the workflow to control content approval)
Chapter 6: Microsoft Office Word 2007

Up to this point, with several mouse clicks you have added a very powerful feature to your SharePoint library using a combination of SharePoint and Word 2007 features. You have added a content type, using a custom Word template and associated a workflow with the content type. When you create a new document based on this content type, the approval process will be triggered and the document will be assigned to the approver automatically.

In this next example, you are again going to create a custom content type and again add some custom columns. The document on this occasion is another invoice, and you will add columns to allow you to collect the following additional information: employee reference, contact name, and contact number. The employee reference will be a contact name within your own company for this invoice; contact name and number will be the customer contact and their contact telephone number. All columns will on this occasion be required, that is, you or your colleagues will not be permitted to add the letter to the library without entering the three pieces of metadata required. To continue, follow the instructions earlier to create the new content type called Invoice based on the Document parent content type. (Simply save another Word 2007 invoice template to your Desktop and upload it as the default template for the content type.) Once you have the content type created, you will be returned to the Site Content Type form. From there:

1. Scroll down the screen to the Columns category.
2. Click on the hyperlink “Add from new site” column.
3. Enter EmployeeReference as the column name.
4. For the data type select Person or Group.
5. Leave the default Group as Custom Columns.
6. Enter a description for this column.
7. Leave “Allow multiple sections” set to No.
8. Set “Allow selection of” to “People Only.”
9. Choose Set to All People.
10. Accept the default “Name with presence” in the Show Field drop-down.
11. Accept the default “Update content types.”
12. Click OK to create the new Site column and return to the Content Type form.

In order to set the column as required you must change the column settings.

13. In the Content Type form, click on your new content type, EmployeeReference, in the Columns category.
14. Check the Required radio button in the Column Settings group.
15. Click OK.

You have created a new column and associated it with your content type. Because this is a Site column, it is also available for reuse in any list within your site. In this case, you can use the EmployeeReference column anytime you need to look up a member of staff.
Add two additional columns for the Content Type, called ContactName and ContactNumber, which will both be text. Set both columns as required by editing the column settings for each column. At the end of this process, your screen should look like the one shown in Figure 6-8.

![Figure 6-8](image)

Return to your document library and again follow the earlier instructions in this section to add the new contact type to the library. Figure 6-9 shows the menu with the new content type added.

![Figure 6-9](image)

There is one more setting to apply to this content type. You will set the property that enables the Document Information panel to be available in Word when you create a new document based on the content type. To continue:

1. Click Settings ➔ Document Library Settings, and scroll down to Content Types.
2. Click the Invoices content type.
3. Click Document Information Panel Settings.
4. In the Show always section check the box “Always show Document Information panel.”
5. Click OK to save the changes.

Now that the contact type is created, you will create a new invoice directly from within the document library. To continue, from the document library, click New ➔ Invoices, and click OK in response to the warning message.

Microsoft Word 2007 will open a new document based on the Invoice template you added to the content type. Figure 6-10 shows the default server-side Document Information panel, which will display the metadata columns associated with the document. These are the columns you created earlier plus the default column from the content type, Title.
Chapter 6: Microsoft Office Word 2007

The Document Information panel is actually a Microsoft InfoPath 2007 form that is displayed within Microsoft Word 2007. It is also available in Microsoft Excel. You will be looking at this panel again shortly.

The process in Word 2007, in terms of creating the document, is just the same as if you had created this document directly in Word 2007 using a local template. In the Document panel, you will be required to enter the metadata. If you attempt to save the document back to the SharePoint document library with any of the required metadata missing, you will be stopped and forced to return to the document to complete the required fields. One of the more interesting pieces of metadata in this example is the EmployeeReference. If you remember, you set this up as a lookup field that would supply a list of names from which the user could select. To open the list of available names, click the book icon beside the text box. The Select Names dialog (see Figure 6-11) will open to allow you to search for a colleague to add to the Invoice metadata as the employee responsible for this invoice.

As you can see in Figure 6-11, the author’s name has been selected, and when you click the Add button the name will be added to the EmployeeReference text box. You can then simply enter the additional metadata required. Also note the arrow beside the text Invoices Properties - Server, shown in Figure 6-12. Clicking this arrow will allow you to move between the document’s standard properties and the properties required by the SharePoint server.
Part II: From Desktop to Internet

Adding document properties is always a good idea even when not working with SharePoint. Later in this chapter you will see how you can use the server properties to search for documents, and the same idea applies when looking for documents on your PC based on its properties.

Creating a Custom Document Information Panel

The Document Information panel shown in Figure 6-13 is the default panel created when you open the document, but you can also create a custom panel from within SharePoint, using Microsoft InfoPath. Using Microsoft InfoPath 2007, it is also possible to create custom panels as required. Figure 6-14 shows a very basic custom panel created using Microsoft InfoPath 2007.

To create a custom panel, follow the instructions used when creating the Document Information panel for the Invoices content type earlier. To open the Document Information panel settings from SharePoint, once the Document Information panel setting form is open:

1. Click on the link “Create a new Custom template.” Microsoft InfoPath 2007 will start displaying an initial data source dialog.
2. Click Finish. InfoPath will remain open and display the default panel in the Design interface.
3. In the Design Task pane, click Layout.
4. Select Custom table and enter 4 columns and 3 rows. This will place three new rows above the existing InfoPath layout.
5. Click OK to place the table on the design surface.
6. Click within the first cell in the top of the table, and drag the mouse over the adjacent cells to select them.
7. Right-click and select Merge Cells. This will be the placeholder for the Panel Title.
9. Select the Title text, and click the bold icon on the toolbar.
10. Right-click the merged cell, and select Borders and Shading.
11. Click the shading tab, and change the background color.
12. Drag and drop each of the Title properties into their respective cells within the new table. For example, click on the text “title” and drag it to the cell above. Repeat this process for each of the property titles.

Repeat this process for the properties themselves. For example, drag EmployeeReference up to the cell immediately above.

13. Delete the now empty default placeholders labeled Horizontal Region by clicking on each in turn and pressing Delete.

This should leave a nice clean table structure used to display the metadata properties. Figure 6-15 shows the custom panel at this point in the process.

14. Double-click the EmployeeReference text box which, in Figure 6-11, is displaying the handles. This will open the properties dialog for the object.

15. In the Text option, add a space; that is, change the text to read “Employee Reference.”

16. Rename the other column headers in the same way.

17. From the main InfoPath menu, select File ➔ Publish.

18. Click OK in response to the “save template” prompt.

19. Enter a filename and save the template.

20. In the Publishing Wizard select the option “As a document information panel for a SharePoint site content type or list content type.”

21. Click Next.

22. Click Publish.

23. Click Close to finish the design and publish process.

24. In SharePoint, click the link “Go back to the Document Information Panel settings page.”

Return to your document library and create a new invoice based on the content type. You should now see your new custom document panel in Microsoft Word 2007. On occasion, you may need to add additional columns to the content type. If that is the case, your information panel may not contain the resulting columns. In order to have the panel contain your changes, you will need to edit the panel again in InfoPath. InfoPath will automatically pull in the changes, but you will need to republish the form to SharePoint in order to include the changes in your custom panel.

However, there is a little more that can be done with metadata within a Word 2007 document. You can actually add the metadata to the content of the document.
Part II: From Desktop to Internet

**Using Metadata and Content Types within Word Documents**

As you can see from the examples you have already completed, content types offer you a powerful way to manage information about documents and to make use of that information within your Word documents themselves. Once you have added the SharePoint document metadata to the Document Information panel, you can then begin to actually add it into the document content itself using Microsoft Word Quick Parts. Quick Parts are standard bits of text that can be added to any document within Microsoft Word 2007. When you complete the metadata information, your metadata columns become part of the items offered to you on the Quick Parts menu. Figure 6-16 shows the Quick Parts list available to a SharePoint document which has had the metadata required by the content type added.

![Figure 6-16](image)

Note that the columns added to the content created in the previous examples, for example EmployeeReference, are now available for use within the document. In addition, all standard document properties are available for you to use. To view the Quick Parts menu:

1. Click the Insert tab on the Word 2007 application Ribbon
2. In the text group click Quick Parts.
3. Select Document Property to view the available properties.

To add the Quick Parts information to your document you simply select the area in the document where you would like the property item to appear and select it from the available list. Figure 6-17 shows a name and address block in a Word document created simply by using the properties available from the Quick Parts menu.
One very useful feature provided by SharePoint is the use of content types and metadata. In addition to the content types, document libraries and Word 2007 offer you a number of other features that can be very useful in the world of document management. Some of these have been discussed already, so excuse the repeated information. Given the nature of some of the book’s content, some repetition is difficult to avoid, especially when discussing Word 2007 and document libraries. The following are some of the features available to you.

**Document Check-In and Check-Out**

This feature is used to ensure that two people cannot edit the same document at the same point in time. As discussed in Chapters 1 and 2, you can enforce check-in and check-out within the document library. If you need to work on a document, you must check the document out. To check out a document from Microsoft Word 2007, simply open the document in the usual way by navigating to the document library and double-clicking its name. The major change will be the addition of a new Word 2007 information panel, shown in Figure 6-18, which tells you that you must check out the document before you can make any changes.

In this case, you must click the Check Out button to edit the document. Clicking the Check Out button opens another dialog (see Figure 6-19) that will inform you that a local copy of the file will be downloaded to your SharePoint draft folder for editing.
Part II: From Desktop to Internet

Two additional options are provided: SharePoint Drafts and Offline Editing Options. You can change the location of your offline draft folder by clicking Offline Editing Options. From the SharePoint Documents library side, if one of your colleagues wishes to use the same document, they will be informed visually that the document is checked out, and if they move the mouse over the Word file icon they can see who actually has the document out for editing. Figure 6-20 shows this icon and message in a document library.

As you can see, the Microsoft Word icon now contains a green downward-pointing arrow and the mouseover message, in this case reading that the file is checked out to Martin Reid. From the SharePoint side, you can explicitly check out a document by selecting Check Out on the document menu. In that case, the dialog is slightly different and is shown in Figure 6-21. Simply click OK to continue. If you uncheck the local drafts folder, a draft copy of the document will be maintained in SharePoint while you work on your edits.

What you need to watch out for is that, if content approval has been turned on, you will not be able to work on a document until the previous changes have been approved, even if it has been checked in. If that is the case, you will be shown the dialog in Figure 6-22, which informs you that the document has been changed and has not been approved.
This is one way to ensure that a document you are working on, even if you check it back in to a document library, cannot be changed by other users. Only users who can approve items and the document’s owner will see draft items if that is the case. Once you have a document checked out, you can also disregard the check-out form within SharePoint by selecting this option from the document menu. This returns the document to its original state before you checked it out.

**Document Properties**

In addition to the content types already discussed, you will also have access to the standard properties of a document using the Document Information panel in Word 2007 for documents saved on a SharePoint server. You can move between the server (SharePoint) properties and standard properties by using clicking the Document Properties button located at the top left of the information panel.

**Working with Document Versions**

As you know from Chapters 1 and 2, it is possible to turn version history on within your SharePoint document libraries. One of the neat things about Word 2007 is its capability to compare different versions of documents from within the Word 2007 interface. Figure 6-23 displays a section of this chapter showing the major revisions.

![Figure 6-23](image)

To view the versions in Microsoft Word, click the Review tab and select Compare. Select “major version” from the options offered. From within SharePoint, you can also view the versions of a document. Using the Document menu shown in Figure 6-24, you can select Version History.
Part II: From Desktop to Internet

This will open the document versions form, which will permit you to view previous versions of the documents, restore previous versions if required, and also delete versions of a document. Within a document library, it is also possible to turn on document version history, if this feature has been enabled. In this way, SharePoint will keep a fixed version history for each document within the library allowing you to retain major and minor revisions of documents.

**Document Management Task Pane**

At the beginning of this chapter I mentioned the Server menu, and the Document Management task pane is available from within this menu item. This task pane also available in Microsoft Excel 2007 and enables you to interact directly with the server and many of the items on the server, including other users of the system. Figure 6-25 shows the Document Management task pane for the Invoice content type document created earlier in this chapter displayed in Microsoft Word 2007.
As you can see, the document library icon is selected, and you have direct access to all the documents within the library directly from within Microsoft Word 2007. (In this case, displaying some of the test documents used for this chapter.) The Document task pane also allows you to browse your PC and add a new document to the library, add a new folder to the library on your team site simply by entering a folder name, and sign up for alerts directly on the SharePoint site. You can also interact with the document individually by moving the mouse over the document name in the task pane to open the document menu. Figure 6-26 shows the options available to you using this approach. The options available to you will also depend on the permissions you have on the SharePoint site. Figure 6-26 shows the options available on the currently opened Word document.

One of the more interesting options is the ability to create a new document workspace for the document from within Word 2007. A document workspace is a site dedicated to the production of a complex document. Again, you will require permissions to create one of these on the SharePoint site.

**Creating a Document Workspace from Microsoft Word 2007**

How you create a document workspace from within Word depends on whether you are working with a server document or not. If you are, because the document is located on the SharePoint server, the option is available within the Document Management task pane. To create the site:

1. Move the mouse over the currently opened document name in the task pane.
2. Select Create Document Workspace.
3. Click Yes in response to the prompt.

SharePoint will create the document workspace using the document name as the site name; the document you are currently working on will be saved in the new workspace and be opened so you can continue working. The original copy of the document will be retained in its document library. Figure 6-27 shows the new document workspace created on SharePoint from within Word 2007 for you. Note that in addition to moving your document into the workspace, SharePoint has created a standard team site totally dedicated to working with documents. A task list is also available to help you assign tasks associated with the production of the document.
When working with a standard Word document, you can also choose to create a document workspace directly from within the Word 2007 Office menu. Click the Office button, select Publish, and then click Create Document Workspace. In this case, the Document Management task pane will open, and you can enter a new name for the workspace. The name will default to the name of the document, and you can choose to create the workspace on your MySite or enter a URL to a SharePoint site. Figure 6-28 shows the Document Management task pane with a default name and the location set to MySite.

Adding Tasks

You can add and assign tasks directly to users on your SharePoint site. To create a task from within Microsoft Word 2007, click the Tasks icon located on the Document Management task pane, and then click Add New Task.

Figure 6-29 shows the resulting dialog once you have completed the various fields in the Task dialog. This is a great way to add tasks while you are working live within a document, or indeed any of the Office applications, without having to log in to your SharePoint site and open lists.
Interacting with Colleagues

When colleagues are working online, you can see them and interact with them using the task pane. Figure 6-30 shows the members available in the task pane and some of the options available to you. You can add the colleague to your outlook contacts, schedule a meeting with your colleagues, view their Outlook properties, or even send an email and access their MySite. The options available to you will depend on the permissions you have within the SharePoint site. In Figure 6-30, you will notice the Edit Permission Level and Edit User Information options. If these options are grayed out, then you do not have permission to carry out that function.

However, a more fully featured experience is available once Office Communicator is integrated with Windows and SharePoint. Microsoft Office Communicator is part of Office Live Communications Server and offers voice, video, and instant messaging within a business environment. In that case, you would have the ability to instant message with your colleagues and perhaps video conference about the document being viewed. It is also possible, if you have the appropriate permission, to add users directly to your SharePoint site using their Document Management task panes from within the Office 2007 applications.
Part II: From Desktop to Internet

The Document Management task pane is a great tool if you need to quickly interact with your SharePoint site without accessing the full set of functionality available within the browser. It allows you to carry out many basic tasks related to the currently open document, such as instant message another member of your team while actually editing the document of interest or assigning a document-related task.

Another really cool feature, if you have the right versions of Office 2007 installed (Office Professional Plus 2007, Office Enterprise 2007, Office Ultimate 2007, or the standalone versions of Word, Outlook, PowerPoint, and Excel 2007), is the ability to run workflows directly from within Microsoft Word 2007.

**Workflow from Word 2007**

The workflow is a great time-saving feature of SharePoint and is used extensively within team sites. The ability to kick off a workflow within Microsoft Word 2007 (and Microsoft Excel 2007) is a really useful feature of this release. To create a new workflow from Word 2007, click Office → Workflows.

Figure 6-31 shows the initial workflow dialog that opens, giving you the choice of which workflow you would like to create.

![Workflow from Word 2007](image)

To create the Collect Feedback workflow, click Start to open the second screen in the process, shown in Figure 6-32.
Using this screen, you can search for or add colleagues you would like to assign the feedback task to, enter a due date for task completion, and notify other colleagues that the process is underway. Finally, clicking Start will kick off the workflow on SharePoint. Within the Word 2007 interface, when the person who the workflow has been assigned to opens, the server documents a toolbar is available informing them of the task. Figure 6-33 shows the workflow notification.

Clicking the “Edit this task” button opens the task form into which you can enter the feedback requested, again, directly from within Word 2007. Figure 6-34 shows the form in Word. Simply complete the required fields and click the Send Feedback button.
As you can see, there are very considerable document management features available to you from directly within Microsoft Word 2007, and as you will see, similar features are also available in Microsoft Excel 2007, mostly based around the Document Management task pane.

**Blogging with Microsoft Word 2007**

To demonstrate this feature, create a SharePoint blog post using Microsoft Word 2007 as the authoring tool. You will then publish the post to a SharePoint blog site. As you may have guessed, the first thing you will need is, of course, a SharePoint blog site that you have permissions to post onto. When creating a blog post, you can start of with a standard Microsoft Word 2007 document. Enter the following text, taken from the Word 2007 help file topic “Blog,” into a new Microsoft Word 2007 document. If you don’t want to type the text simply search Word help for “blog” and copy and paste the text into Word.

1. Once you are ready to post the document to your blog, click the Office button then click Publish Blog Register Now.
2. Select SharePoint Blog from the drop-down list of providers.
3. Enter the URL to your SharePoint Blog site.
4. Click OK.
5. Click OK in response to the Account Registration Successful dialog.

That’s it — your Word document has been published to your blog site on SharePoint. Figure 6-35 shows the post once it has been saved into the SharePoint blog.
It is also possible to create a blog post directly within Word 2007 by clicking the Office button, selecting New, and then selecting Blog Post from the available document types. In this case, the Blog ribbon group (discussed shortly) will be immediately available to you. It is also worth pointing out that if you have inserted image files into your blog post using Microsoft Word 2007, then they will also be transferred to your SharePoint blog site.

Now that you are blogging from Microsoft Word 2007 and have published your first blog post, you will notice a new menu item in Word — the Blog ribbon group. Figure 6-36 shows the blog group on the Office Word 2007 Ribbon.

The Word Blog Ribbon options available are:

- **Publish**: Publish the document to your SharePoint blog site. Note that clicking the arrow will allow you to publish a draft post.
- **Home Page**: Open the home page of the blog site directly in the browser.
- **Insert Category**: Insert a Word Quick Part containing a drop-down list that allows you to select a category for the blog post. Figure 6-37 shows the category list in Word 2007.
Part II: From Desktop to Internet

- **Open Existing**: Allows you to select existing blog posts from the site and edit them from within Word 2007. Figure 6-38 shows the resulting dialog. Note that you can use the drop-down list to view posts by other SharePoint bloggers on the site if you have the appropriate permissions.

![Figure 6-38](image)

- **Manage Accounts**: Allows you to manage existing accounts and register existing blog accounts for use with Microsoft Word 2007. A wide range of the most popular blog sites is available. Figure 6-39 shows the list of available account providers in the drop-down list.

![Figure 6-39](image)

Simply select your service and enter the connection information to enable blogging from Microsoft Word 2007. Complete the details in the new registration dialog and continue with the document by clicking the Publish button when you’re ready to put the blog online.

*Here are some blog service providers to try.*

- **Windows Live Spaces** ([http://spaces.live.com](http://spaces.live.com)): To use Live Spaces as your blog provider, you must first create a space. Follow the instructions on the home page to create your own space. The service is free.
Microsoft Windows SharePoint Services: If your organization hosts a Microsoft Windows SharePoint Services 3.0 site, ask the site manager to set up a blog page for you.

Community Server (www.communityserver.com): Follow the instructions on the home page to purchase your own hosted community site, including blogs, forums, file sharing, photo sharing, and user management. The service is available on a tiered price structure.

Office Live Workspace

It’s worth speaking about Office Live, as this is the first indication of how Microsoft intends to implement cloud computing, that is, the storage of information and documents on the Internet. The concept can be confusing, as hosted services have always been available to enable you to save data on servers other than those within your own company. Office Live Workspace is a free service offered by Microsoft, which is technically still in beta. Office Live is essentially a light version of SharePoint running in the browser. An add-in can be installed on your PC that will add the Office Live Open and Save menus to programs like Word 2007. In addition, Microsoft recently announced that Word, PowerPoint, and Excel will all be available via Office Live running in the browser. This will be the direct competition to Google’s set of Internet-based applications, but, unlike Google Docs, for example, you will be able to save to Office Live directly from within Microsoft Office. Screenshots of the web versions of the Office applications are available at http://workspace.officelive.com/FAQ/thumbnails. However, the web applications will only be released with the next version of Microsoft Office, which will be version 14. It’s worth looking at these applications, as it’s a safe bet to assume that the ability to work with Word, Excel, and the other applications directly in the browser will also be available with SharePoint 14. All of the skills you use within SharePoint can also be applied to Office Live, as it is based on the same underlying technologies and concepts as WSS and MOSS 2007: the continual blending of the interface between the traditional PC and the Internet. Eventually, it will be difficult to see where one stops and the other starts.

Summary

This chapter discussed many of the features of Microsoft Word 2007 and SharePoint. You looked at content types to gain a better understanding by seeing them in context. Content types are a huge feature of SharePoint in general, and you should learn as much as possible about them. You examined document versions and using check-in and check-out within a document library and one of the most powerful tools available to you from client applications, the Document task pane, which allows interaction with SharePoint without actually opening a web browser. The next chapter deals with Microsoft Excel 2007 and how it interacts with SharePoint, including working with Excel Services.
Microsoft Office
Access 2007

In this chapter, you will work with Microsoft Access 2007 both from the desktop and from the server. For those who may be new to Access 2007, you will start of with a quick review of what’s new with this application and how you can use the new features to help you get the job done. You will see how Access can enable you to build interfaces to your list data, take data offline and synch to the server later, and how to create reports using Access 2007. You will also see how you can incorporate data held on a SharePoint Server with applications created solely using Access 2007.

Microsoft Access is perhaps the most widely used desktop database in the world, used by professional developers and general PC users to store information, ask questions of information, and report on information. One of the most frequently asked questions when working with Access applications is “Can I get this on the Internet?” In terms of SharePoint, the answer is absolutely. Do you need to be a technical genius to do it? A resounding no. Microsoft Access is used for a large number of different things, from keeping small lists of data to full-blown desktop applications that run entire businesses. It can be used for things as simple as keeping a record of your DVD collection to running a material-processing operation for a small business. You can interact with Word to produce letters and mail merge, you can interact with Excel to produce complex statistics based on the data held within your applications, and you can even output data within Microsoft PowerPoint presentations. In this chapter, you are going to work with Access and SharePoint data, looking at how it interacts with Microsoft SharePoint and how Access can be used both as an offline data store and as a reporting tool for SharePoint. You will look at downloading SharePoint into Access and taking the data offline and resynching it later, using the new features of Access. Access is a tool that can be used by almost anyone once they have a basic understanding of how it works and how databases are created.
Part II: From Desktop to Internet

What’s New with Access 2007

This current release of Microsoft Access 2007 has several additions that are designed to increase and simplify its interaction with Access. This chapter assumes that you are familiar with the new interface by now — the Ribbon, navigation pane, and the new features in forms — so it will concentrate on the new data features released with Access 2007. One of the major changes to Access has been the creation of a new file type, the ACCDB file. Normally, when you save an Access database it gets an MDB extension but now the default file type with Access 2007 is ACCDB. One of the main reasons for this change was to improve the interaction between Access and SharePoint. Using this new Access file type, you can take advantage of many SharePoint features and new additions to Access 2007 itself, including:

- **Save attachments into the database.** When you are creating items in some SharePoint lists, you can add file attachments, for example attach a word document to a SharePoint announcement. This feature is now available with Access ACCDB files. It is not supported by earlier versions of Access, so you need to be careful if others within your organization use other earlier versions of Microsoft Access.

- **Support the use of multi-valued columns in the database table.** This is a reflection of the SharePoint multi-valued column. This data type is not supported by earlier versions of Microsoft Access.

- **Mark code as safe or trusted,** which makes it easier to upload to a SharePoint server. This is not possible with an MDB file.

Access 2007 contains changes that make it easy to manipulate SharePoint data without being connected to the actual SharePoint server. Changes can be fed back to the server by Access the next time you connect.

Access 2007 has a sort of track-changes capability when you are working with Memo data types. It is now possible to maintain a history of changes made to data in this field type. Again, this is done to match SharePoint’s multi-line text fields and ability to maintain a history.

It is also important to stress that the new Access 2007 file type also stands on its own without SharePoint. Using the new features and data types, developers and expert users can build more interactive, complex applications than ever before.

A Brief Database Design Primer

Many databases are bad because they are not designed correctly, and while there isn’t space to write a couple of chapters on database design, a few pointers can be provided that apply to both SharePoint and Access. To be honest, it’s doubtful you’ll see many high-end applications built using both Microsoft Access 2007 and SharePoint at the moment. What you are likely to see is Access used to take SharePoint data offline, Access used to build simple but functional interfaces into SharePoint Data, Access used to query large SharePoint lists, and, finally, Access used to create functional reports of data held on SharePoint. All of these are areas that SharePoint alone cannot do at the moment. Following are a few basic rules when using Access 2007 and when creating SharePoint lists.
Think about what you are doing before touching the computer. This is particularly true when dealing with Microsoft Access. Remember, a computer is basically stupid and will do just as you tell it. If you tell Access you are going to store a date of birth and use a data type of text, then Access will just let you go right ahead and do it. The problem comes when you need to calculate, say, someone’s age and you find that, because you have entered a date of birth as text, you can’t do it.

Get your data types right. With a data type you define or tell the database what type of data you are going to store. As in the first rule, you have dates, text, memos, images, and all sorts of other types of data that can be stored.

Understand your relationships. This is the bit that gets most people when working with Access—to understand the relationships between data tables. Take, for example, students and courses. In a database, you want to create a table for each subject, in this case a Student table and a Course table. You would add the fields and specify the data types for each of the fields. Next, you would define and add in the relationships between the tables. So, what are these relationships? Start with students: What is the relationship between student and course? Students attend or enroll on courses. Do they enroll in one course or many courses? They can enroll in at least one course but could enroll in several courses. A single student may enroll in one or more courses. This is a standard one-to-many relationship between student and course. Then you look at the relationship from the other direction: what is the relationship between course and student? A course can have one student enrolled in it. A course could have many students enrolled in it. This again is a standard one-to-many relationship between course and student.

At this point, you have two relationships between student and course, and this type of relationship is known as a many-to-many relationship. One student can be related to many courses, and each course can be related to many students. This type of relationship is modeled in Access by creating a third, or junction, table to join or link the Student and Course tables. In this case, the table would be used to store enrollment data, that is, the details of each course a student is enrolled in. If you are going to do any serious work with a database like Access, it is highly recommended that you learn a little about database design and structure.

You then take this information and build the database structures, as shown in Figure 7-1, which illustrates a database relationship model in Microsoft Access 2007.

This is really just the very basics when it comes to creating databases, and you really should read up some more on this area, especially if you intend to create databases on which you will base business decisions. A good place to start is with Wrox’s *Beginning Database Design*, which covers this topic very well.
Part II: From Desktop to Internet

There is only one way to build a database and that’s the right way. If you put some time and effort into the design stage not only of databases but also of your SharePoint lists, it really will pay off in terms of ease of use and reporting later on in the process. Some of the more useful data types available only in the ACCDB data file are discussed in the next section.

Earlier versions of Access also provide the ability to interact with SharePoint data, but the experience is not as fully featured as when working with the new file type in Access 2007. However, in Access 2007 you still have the ability to link to SharePoint lists, import lists, and export to SharePoint.

Multi-value

A multi-valued data type is one that can contain more than one value. For example in SharePoint, you might have a task list that has several tasks assigned to more than one person. This reflects the real world, where multiple people can be involved in a given task or project. In older versions of Access, you would model this using the many-to-many approach. In Access 2007, you can use the multi-value data type to create such fields easily. In the background, Access will still build the many-to-many relationship, but you as the user will be shielded from it. In SharePoint, there is no shielding or background for many-to-many data types, as the multi-value column (field) is native to a list. The Access approach is designed to help you pick up and use such multi-valued columns from SharePoint lists in a seamless way within your Microsoft Access 2007 database. This data type is not available if you do not use the new ACCDB file type in Access 2007 and will cause problems for users of earlier versions of Access.

Attachment

The attachment data type allows you to store multiple file attachments with a database record. Again, reflecting the way in which you use a SharePoint list, you can associate attachments with items in a list. This is a useful facility to have within Microsoft Access, as it is a common request when creating applications. As you shall see later, Access also provides a special control that allows you to interact with attachments from user forms. Attachments can be virtually any type of data but will tend to be mostly Word documents, Excel workbooks, or image files.

Append Only Fields

Using the ACCDB file type, it is possible to create a version history when you are working with Memo data types created within Access. A Memo data type allows you to enter blocks of text into an Access table. When you make changes to the data Access will record those changes, including a timestamp showing when the changes were made. This is a really useful feature that goes a little way toward matching the SharePoint version history, but it is not on the same scale. If you are new to Access, you need to right-click over the Memo field and select Show History in order to view a list of changes made to the memo.

If you change the Append Only property at a later date, you will lose whatever history has been collected on the memo. The history will not be recovered, even if you set the property back to yes.

These new data types are basically there to enable interaction with SharePoint column data types and make it easier to work with list data from within SharePoint and to deal with tables that have been moved from Access to SharePoint. They also give Access developers more tools with which to build useful user applications that have the potential for upsizing to SharePoint.
Data

One of the really useful things about Microsoft Access is that it can generally find and make use of data no matter where that data is held. For many years, Access has been used to link to data held on various systems and in various file types. It is common to use Access to link to data held within SQL Server, for example, or Microsoft Excel and then use the features of Microsoft Access to build applications based it. The capability to easily link and move your Access applications to SharePoint sites and lists is another tool available to you. More and more data will be held within SharePoint, and Access 2007 offers you another way to expose that data. One of the great things about Microsoft Access has been its ability to use data held in other systems and applications such as Excel and SQL Server. This allows you to create Access databases that can present data held in different places in a single program. To the database user, it looks as if the data is held within the Access database. If you do need to work with data held in, say, SQL Server, it’s worthwhile to remember the Business Data Catalog Web Parts for use within SharePoint as well. They provide a great way to expose this data.

General Access Advice

Access 2007 is still one of the applications within Microsoft Office with which many people do not have a lot of experience. Microsoft Word and Excel people tend to use it every day and are more or less familiar with the structure and features. If you are already familiar with Access 2007, you can simply skip this discussion and move on.

- When working with objects (discussed in the next section) in Access, you will normally have two views: the design view, (how the object was created) and the standard view (in which you actually see the data). Access 2007 has a third view, layout, which lets you design an object such as a form or report while viewing the data. You need to be comfortable switching between and understanding the different views in Access. You can switch views by clicking the View Ribbon item directly beneath the large Microsoft Office button located in the top-right corner of the application.

- The Ribbon in Access is dynamic and changes depending on what it is you happen to be doing at the time. Tabs will appear and disappear again, depending on what you are doing. You will need to learn the tabs on the Ribbon, the groups on the tabs, and the items within each group.

- Always create a primary key in your tables. This will make life easier for you as you become more advanced with Access. A primary key uniquely identifies records and is used to create relationships between tables. For example, in a customer and order database each customer would be given a unique reference number. When an order is created the customer primary key (customer reference) would be saved with each order record. That way it is easy to trace back from the order to the customer details. Within the Order table, the primary key of the customer is referred to as a foreign key. That is a value that refers back to the primary key of the referenced table.

- When you are creating your own tables and fields, avoid spaces in their names, which will save you trouble when you become more advanced.

- Be careful of queries that select records from a single table, because the data the query returns can always be edited.
Part II: From Desktop to Internet

- Read the Access dialogs. They are generally there to stop you from doing something silly like deleting records.
- Always back up your Access databases. Always back up your Access databases. Always back up your Access databases.
- Sit down and think about what you are going to do before you do it. This will save you time and stress with Access databases.

**Database and Object Properties**

An entire book could be written on database and object properties, but for this book some SharePoint-specific information is required. Each object in an Access database has a set of properties. At a high level, the database, its tables, queries, and forms all have properties that you can change. The property you will be interested in is the property that tells Access that you want to share or expose the object on SharePoint such as an Access form. SharePoint treats a form as if it were a SharePoint view, but you need to tell Access you want the form exposed on your list. You do this by setting the properties of the database itself and then, for each individual object, you can set the property to expose that object to SharePoint. The property is available for each object by switching to design view and clicking the Property Sheet option on the Ribbon.

This short list will help you work with and understand Access, and it takes time to learn Microsoft Access 2007 properly, but it really is worth it to learn as much as possible about this application.

**Access Objects**

Everything in Access is an object: tables, queries, forms, and reports. Each object also has a set of properties that you can manipulate. For example, the size of the text showing in the table cell would be a property of the table object. When you begin to work with SharePoint and Access, it is useful to have a basic understanding of each of the objects that together make up Access.

**Tables**

A table in Access equates to a list in SharePoint. It contains fields, each of which contains a single piece of data, like a surname. A collection of fields that belong together is known as a record, and a record describes one item in the table. For example, all the fields that describe a customer: name, address, telephone number, customer number, and so on. Each field is in turn of a specific data type: text, date, memo, number, or attachment. Within the table, you will have one special field called a primary key. A primary key is used to uniquely identify a single record. Take your Social Security number in the United States or your National Insurance number in the UK; these identify you in multiple government systems, and the number is unique to you. No two living individuals, in theory, will have the same number. Microsoft Access also makes a special data type available to you when creating tables, the AutoNumber data type which will generate a unique number for every record, and it is standard practice to use this as the primary key in an Access table.
Each field in a table also has a set of properties that can be applied to that particular field: the amount of
text it will contain, a range of numbers it can contain, if the field is required, and any validation required
before a record can be saved to the table. It’s almost identical to a SharePoint list — “almost” because a
list doesn’t (for our purposes) have a primary key, and you cannot create relations between SharePoint
lists. Figure 7-2 shows an Access table in design view.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
</tr>
<tr>
<td>Last Name</td>
<td>Text</td>
</tr>
<tr>
<td>First Name</td>
<td>Text</td>
</tr>
<tr>
<td>Full Name</td>
<td>Text</td>
</tr>
<tr>
<td>Email Address</td>
<td>Text</td>
</tr>
<tr>
<td>Company</td>
<td>Text</td>
</tr>
<tr>
<td>Job Title</td>
<td>Text</td>
</tr>
<tr>
<td>Business Phone</td>
<td>Text</td>
</tr>
<tr>
<td>Home Phone</td>
<td>Text</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>Text</td>
</tr>
<tr>
<td>Fax Number</td>
<td>Text</td>
</tr>
<tr>
<td>Address</td>
<td>Memo</td>
</tr>
</tbody>
</table>

That’s one of the drawbacks to Access, you start out with an empty sheet and have to create and design
the tables yourself—usually from scratch. If you look at Figure 7-2, you will see how the field (column)
names and the data types have been defined within the table.

Queries

One of the most powerful tools in Access is the ability to use queries to slice up your data and extract
what you hope is useful information. A lot of people simply use Access as a query tool into which they
import Excel spreadsheets and run queries to slice the data up. Queries are a powerful tool in Access and
offer you functionality in excess of that provided by SharePoint views, which tend to be static. That is,
you cannot pass parameters into them via the interface. Queries are also useful when you need to update
large numbers of records, say, by changing a product’s selling price en masse. If you were just to use
SharePoint, you would need to edit each list item individually. With an Access query, you could update
thousands of items at the click of a button.

Forms

A form is a user interface into your data. The form is used to present and control how you interact with
data held within an Access table or in our case a SharePoint list. Forms allow you to build graphical
interfaces through which records are presented and manipulated.

Reports

The reporting tools in Access are arguably the most powerful and easiest to use desktop reporting tools
available. Again, many people just use the reporting tools to produce great-looking documents for
printing or to produce mailing labels from data held in other applications. A good example is the
production of mailing labels for contacts held within a SharePoint list. Within SharePoint, there is no
way to do this unless you’re a programmer and code it yourself.
Part II: From Desktop to Internet

For more advanced users of Access and developers, Microsoft Access 2007 provides an advanced programming language called Visual Basic for Applications (VBA) with which you can build complex business applications that will rival almost any other database for both purpose and complexity. For those who have no interest in programming, there are also macros available that allow you to make automatic many of the standard Access features and functionality.

Lookup Values

In both Microsoft Access 2007 and SharePoint lists, it is possible to add a special field that looks up values in another table or list. This is really useful when you need to present static information to your colleagues and allow them to select a value. For example, you could hold all the U.S. state names in a table or list. When you are adding in a state to another table, rather than your colleagues having to type in the state, you could present a drop-down list form which they select an option. In Access, lookups are set using the field properties and in SharePoint when defining or editing the columns of a list. As a final word, it’s reasonable to assume that the integration between Access and SharePoint can only grow and expand with future releases of both products.

Now that you have looked at some of the core features and objects within Microsoft Access 2007, it is important to remember that when working with a SharePoint data, all of the data is actually held within the SharePoint data store and not in Microsoft Access. Unless, of course, you import the data from SharePoint into Access and use it from that application. In the next section, you will look at how we can take this data held in SharePoint and work with it directly from within Microsoft Access 2007.

SharePoint and Access

In this section, you will look at the interaction between SharePoint and Microsoft Access 2007 using a simple SharePoint list of company contacts. If you have investigated SharePoint, you will see that visually everything is presented as a list, and there is no particularly graceful user interface. While you can create views on the lists using the features of SharePoint, you cannot provide a useful user interface into the data. There is also no native reporting tool in SharePoint that would allow you to present information in a consistent format. Microsoft Access can handle all of these requirements once you either link to it or bring the data down to the desktop.

Create the Contact List

For this example, create a SharePoint team site based on the Contact template by selecting Site Actions > Create and then selecting Contacts from the Communications grouping. This will give you a totally blank contact list into which you will need to add some records. About 20 records will do for this example. The quickest way to do this, if you are typing the records in yourself, is to switch the view to datasheet view. Click Actions > Edit in Datasheet, and add in the records. Once you have added the records into the list, switch back to standard view and add a couple of attachments to the list items. To add an attachment to the list item:

1. Open the document menu for an individual list item.
2. Select Edit Item.
3. Click the Attachment menu item named Attach File.
4. Click Browse to locate the file required.
5. Click OK to save the attachment with the list item.

Once you have the list created and populated, you will look at the features of Microsoft Access 2007 from the SharePoint side.

**Linking to Your List in Access 2007**

One of the things that many people do when working with SharePoint is to open SharePoint lists in Access to take advantage of the query or reporting tools. One of the great strengths of Microsoft Access has always been its ability to use data held in other systems and database applications. This is usually done by linking from Access to the required data. For example, if you had an Access database that required data about employees, you would not create an employee table in Access. In the real world, you would link to the employee table in your human resources database and use that data. The same is true if you were required to use data held in Microsoft Excel or SharePoint. Rather than importing the data into Access and breaking the link between the data in Access and the source data, you would simply create a linked Access table. In this way, your linked data is always up to date as it is maintained in the original system. Linked data appears in Access as another table, and you proceed as if it were just an actual Access table. One of the limitations of linked tables is that if you do need to change the design of the table, you must do so in the source data store, as you will not be allowed to change the design within Access itself.

You may have already noticed that the option available to open a list with Microsoft Access is available on the list Action menu. To open a SharePoint list with Microsoft Access:

1. Click Actions.
2. Select Open with Access to open the initial dialog. Figure 7-3 shows the dialog that will open, offering you three options:
   - Choose a location for your Access database to be created.
   - Link to the data on the SharePoint site.
   - Import the data into access as a new table.

![Figure 7-3](image-url)
Part II: From Desktop to Internet

Accept the default location, which will be used to create a new Access database or navigate to an existing Access database on your PC. A default database name will be provided using the new Access 2007 file type ACCDB. If you would like to navigate to an existing database click the browse button.

The next set of options allows you to either link to the list from Access or copy the list down into Access. Linking to Access results in the data remaining in the SharePoint list and becoming available within the Access database. If you choose to export a copy of the data the list items will be transferred to Microsoft Access, and the link between your data and SharePoint will be broken. For this example you will be doing both. If the table already exists, the process is still completed and an incrementing number will be added to the table name in the database.

3. To continue, accept the default database name and location.
4. Accept the default option of linking to your SharePoint list from within the new Access database.
5. Click OK to begin the process.

Microsoft Access will start up and your database file will be created containing a link back to the list held on SharePoint. Figure 7-4 shows a section of the Access interface at this point in the process.

![Figure 7-4](image)

The SharePoint linked list is shown in the navigation pane as a table icon with an arrow pointing in towards it. You have surely noticed that there are two linked lists. One is the list you intended to link to; the other is something that SharePoint has added. This second linked list is the user information list. This list will display all the members of the SharePoint site in which you have linked the list.
If you look at the form (a form is an Access object used to display records held in a table) that Access has opened to display your data, you may notice that not all of the SharePoint columns are included. The only columns being displayed are those you have indicated in SharePoint in the default view. If you check back to your SharePoint list, you should see exactly the same columns displayed in the list view as are displayed in the Access form. All your other columns are there, but they are just not made available using this first form. If you open the linked list, you will see all of the data from SharePoint, and this data can be added to other Access objects, for example a query. Figure 7-5 shows the open linked list (in design view) just to prove that all the list data is actually there and available to you. When Access creates the new objects in the database, it will base the contact form on the current view as defined in SharePoint.

![Figure 7-5](image)

To open a table in Design view, right-click anywhere over the table and select design view. Note that in the case of a linked table, in this case a SharePoint list, you will be advised that you cannot make design changes in Access.

If you would like to add additional fields to the Access view:

1. Click on the Home tab.
2. In the Records group, click on the More icon.
3. Select Unhide Columns.

This will open a list of columns with those currently available already checked. To view more columns in the Access view, simply check the required check box beside the column name.

You will also notice that there are other database objects created at the same time within the Microsoft Access database. Access is smart enough to know that you are using a SharePoint contact list and it knows that it can create your new database using one of its built-in template databases, Contacts. In effect, what you have ended up with is a fully functioning Access database based on your SharePoint list. The Access objects created include:

- **Contact List**, which is an Access form that will display the Contacts default view from the SharePoint list. It also provides you with the ability to:
  - Add new contacts.
  - Collect data via email.
  - Add additional contacts from Microsoft Outlook.
Part II: From Desktop to Internet

- Email the contact list.
- Run a contact report, using the report drop-down list.
- Open the SharePoint site’s Recycle Bin. The icon next to the report drop-down will, when clicked, open the Recycle Bin on your team site.
- Open the default list view on SharePoint.
- The relevant part of the menu bar is shown in Figure 7-6.

![Figure 7-6](image)

Also note the status bar located at the bottom right of the form (you can refer back to Figure 7-4 if required). Note the status message “Online with SharePoint.” Clicking this option opens a context menu that will offer you different options depending on whether you are online using live SharePoint data or have taken the Access-linked list offline. If you are online with SharePoint, you will have two options:

- **Cache List Data**, which enables Access to keep a local copy of the data on your PC, which can improve performance with larger lists and is the recommended approach if you need to work with large amounts of data in linked SharePoint lists. If you are caching data locally and remain online with SharePoint your updates will be available on the SharePoint list. Caching data locally does not disconnect you from your SharePoint list.

- **Work Offline**, which takes the list offline and disconnects from the server. You will still have the list data available to you in Access, but any changes you make will not be reflected on the SharePoint server until you reconnect.

When you choose to work offline, the content menu will offer you a greater range of options when you reconnect to SharePoint. Offline you can:

- **Discard all changes and refresh**. This option will reconnect to the SharePoint list and disregard any changes you made to the data when working offline in Access. It will also refresh the list bringing in any changes that were made to the SharePoint list via the team Site.

- **Synchronize** to reconnect to the server and update the SharePoint list with your changes. Changes will remain local to Access until they are updated to the server list.

These options are also available by clicking the External Data tab and then opening the SharePoint Lists group.

**Managing the Linked List from Access 2007**

The Access navigation gives you immediate access to all the objects in an Access database, including the linked list. Right-clicking over the list name in the navigation pane gives you a number of options some of which are specific to SharePoint lists. To view the options: click on the list name to select the object. Right-click, and select SharePoint List Options from the context menu. The options available on this menu are:
Open Default View, which will open the list in Internet Explorer.

Modify Columns and Settings, which will open the list in your team site at the Customize List page. This gives you immediate access to the columns and other settings of your list. You can change the design of a linked list in Access 2007. In order to add or change a column, for example, you must do this in the original list on SharePoint and relink the list to Access in order that your changes are available.

Alert Me goes to the alert settings for this list on SharePoint.

Modify Workflow will open the change workflow form in SharePoint to permit you to modify any existing workflows that may be attached to the list.

Change Permissions for This List opens the permissions form for the list in which you can change or update permissions.

SharePoint Site Recycle Bin opens the site’s Recycle Bin.

Refresh List will refresh the data in the linked list, picking up any changes that have taken place on the server.

Delete List is an option you need to be careful with, as you are not simply deleting the link in Access but deleting the list in SharePoint.

Relink Lists, which is also available on the External Data tab, is designed to allow you to link to a list on another SharePoint site.

You might think this option would actually allow you to relink the current lists within your access database and it does, in a way. What this option is actually for is to allow you to link to lists in another site. This is useful if you need to change the list items being displayed or if your list has been moved. It could also be used in the case of your Access contact database being used by another team who has their own unique contact list available on their team site.

To link to lists with the same name on another SharePoint site:

1. Select the Relink option from the SharePoint List Options menu.
2. Enter the URL to the new site.
3. Click Get Lists to view a drop-down of lists available on the new site.
4. Use the drop-down lists to select a new Contact list if available.
5. Click OK to link to the new contact list on the new SharePoint site.

As you can see, there are several options in Access that will take you to the SharePoint list directly to enable you to manage the linked list on SharePoint. Once you have linked the list with Access, you simply treat the lists as if it were a standard Access table. You will work with standard Access features as you progress through this chapter.

**Creating Access Views with SharePoint**

It is not possible to link anything other than the SharePoint default view to Access. You get the entire list. For example, if you only wanted to link to a list of contacts in New York, you would be unable to do so. Any time you link the list you will get the default view and all other list items. The solution is to create your views either on SharePoint or within the Access database, using queries.
Part II: From Desktop to Internet

However, there is another approach that can be used to create a view of your list using Access. This creates more or less the same sort of solution outlined above but in a slightly different way. To create an Access view of your list, with the list open within SharePoint:

1. Click the View drop-down list.
2. Select Create View.
3. Click Create Access View.
4. Enter a name for the database that will be created to contain this view.
5. Click Save.

Access 2007 will create the database, again using the Contact template, but the major difference this time is that Access will open a dialog requesting that you choose the type of view you would like to create. You can choose from a variety of Access forms — Pivot Table views if appropriate, or even create a simple Access report.

6. To continue, select Report.
7. Click OK.

Access will create the report and open it for viewing in design view. You can choose to save or cancel the report as required. This option offers you a very quick way to create custom Access objects based on your list. In addition, all the Access objects created in the first example in this chapter will also be available. Another interesting feature when using Access is that you can also create an Access view of a document library. In the case of a document library, you do not have the menu option Open with Access, but creating an Access view is fine. In the case of a view, Access will create a table or a form containing a hyperlink back to the documents stored within the library on SharePoint. Figure 7-7 shows a document library view created within Microsoft Access 2007. The process is identical to creating a list view as discussed, only this time you start the process from within the document library.

<table>
<thead>
<tr>
<th>Shared Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>12</td>
</tr>
</tbody>
</table>

Figure 7-7

In the case of documents displayed in the Access interface, you will also see a read-only field containing the name of the user if the document is checked out, the link to the document, and the title of the document if one has been added within SharePoint. If you look at the design view of the linked list, you will also see several additional fields that are not displayed in the Access interface. Again, by default, the Access object created when you create the view will display the default view of the document library as used by SharePoint. Just as before, the additional list columns are also available to you within Access by using the Records group on the Home tab to unhide the columns required. If you do need to display a document library in that way, it is perhaps better, within the Access 2007 interface, to actually display the items within an Access 2007 form, which provides a nicer interface, especially when it comes to
displaying and using the documents. You can also see in Figure 7-7 that you can store more than
documents in a library; note the sample Access database file also stored in the library.

When you need to work with your SharePoint list data in an Office application, including Microsoft
Access there is another approach you can use. This approach is seldom used in my experience, but it
offers you a wide choice of interaction between your SharePoint data and Office applications. Most
SharePoint lists provide you with a task pane providing one-click interaction with Office applications. In
order to use this task pane, your list must be in datasheet view.

**List Task Pane**

You have already worked with a list in datasheet view, but this time you will also work with Access.
Open your contact list on SharePoint in datasheet view. Remember that you must have ActiveX enabled
in your browser to enable datasheet view, and this will not be available in non-IE browsers. To continue,
click Actions Edit in Datasheet. This will change the view from the standard view. Once you are in
datasheet view there are as you know additional options available from the Actions menu. To proceed:

1. Click Actions.
2. Select Task Pane.

This will open a task pane on the right side of the list. The pane is shown in Figure 7-8.

From the task pane, you can work with external Microsoft Office programs using the list data.
For the moment, you are going to work with the Microsoft Access options; you will return to the
task pane in Chapter 9 Microsoft Excel 2007. The access options are Track this List in Access and
Export to Access. You will also be looking at Exporting to Access in some detail shortly; for the
moment we can ignore this option.

3. To continue, click Track this List in Access.
4. Check the New Database radio button.
5. Click OK.
Part II: From Desktop to Internet

6. Accept the default name (or rename the database file).
7. Click Create.

You have successfully created a new Access 2007 database file and linked your list to it. Up to this point, you have seen and tried out three ways to link a list to Microsoft Access 2007. All of the methods achieve the same end result; it’s mainly a case of using the one you find most convenient to use.

Changing Data in Access and Synchronization to SharePoint

If you have completed the earlier example using the contacts list, you can take the data offline using Microsoft Access 2007. Again, this is useful if you need to travel out of the office but would like to have access to some of your SharePoint data and do not have a decent Internet connection. Once the data is offline, Access will treat the linked list just like a native Access table and all the features of Access will be available to you just as when you return to the office and relink the list to SharePoint again. One of the major dangers doing this (taking lists offline) is that anyone who has access to the database will have access to the list information, as SharePoint’s security system will not apply offline. For sensitive data, you can use the database password feature in Access and perhaps even encrypt the data just for that added comfort level. At the same time, for truly sensitive data Access is perhaps not the best choice for storage.

When keeping data that identifies individuals within an Access database, you may be required to abide with the current data protection legislation in your country. For example, in the UK you will be obliged to ensure that the data is protected as laid down in the Data Protection Act (www.ico.gov.uk/what_we_cover/data_protection.aspx) and in the USA there is the Sarbanes-Oxley Act dealing with how a company conducts financial services.

To take your list offline, you must first click the Cache Data with Access option and then you can click the Online with SharePoint button in the status bar and select the Offline with SharePoint options from the pop-up menu. Once you have done this, your list will be disconnected from the SharePoint list (the list icon changes from gold to blue), and the list data will be cached inside the Microsoft Access database. For this example, you will now add a record to the contact table. You may need to reopen the Access contact form or table if you have closed it.

1. Click in the first empty cell within the Access window.
2. Enter the required contact data into each field in the table until you have created several complete records.
3. At this point, the data will only exist inside Access. You can check the list just to be sure on the SharePoint side.

Just for interest, also edit a record by changing a surname in an existing contact. To edit a record, just click within the Surname field and change the text. Figure 7-9 shows the Access window and the live SharePoint list with Access offline. Note that there are more records in the Access table than appear in the SharePoint list.
To update the SharePoint list with your changes:

4. Click the External Data Table.

5. In the SharePoint Lists group, click Synchronize.

The data in the linked SharePoint list will be added to the list on SharePoint, and you will remain offline. In SharePoint the records will be highlighted as new records in the list. As discussed previously, you can also decide to disregard the changes using the menu in the Access SharePoint group. If you do need to do this, make sure that you do it before synchronizing your changes to the server. You can also update the SharePoint list by taking the list back online by clicking Online with SharePoint. Doing so will immediately update the list with the pending changes from Access.

**Conflicts**

It’s always possible that someone could be editing a SharePoint list at the same time as you are changing a record in Access or indeed the other way around. Should this happen from the SharePoint side of things when you attempt to save your changes in SharePoint, you will receive an error message shown in Figure 7-10.
As you can see, you will need to return to the list and refresh the page. This will reopen the Edit Item form showing you the change made by your colleague. You can choose to accept their change or continue to edit the item adding in your own changes. From the other side of the fence, if you are editing a record from Access and a user in SharePoint is editing the same item, then Access in turn will respond with an error dialog. This dialog is shown in Figure 7-11, and it lets you know that another user has edited the record you are currently trying to save.

This conflict information message will inform you that another user has edited the record while you were offline and that your changes will conflict with those of your colleague. The dialog on this occasion shows the items (highlighted) where the conflict has happened and offers you the opportunity to discard all your changes or retry the save operation. If you retry the operation your changes should overwrite those made by your colleague. In general, it is perhaps a good idea to hold off overwriting your colleagues’ changes just in case they are more up to date or relevant than the one you’re making.

A quick email describing the conflict note left on the Team Site discussion board could save some stress.
later. You can always copy the items out to the clipboard and paste into a Word document if required and update the information later once you have sorted out the data issue.

Conflicts can also occur when you are working offline with SharePoint and synchronize the data back to the SharePoint list. If a colleague has made a change to the same SharePoint list item as you have been working on while offline, you will again receive a data conflict warning. Figure 7-12 shows this warning dialog.

This time the screen, unlike the error message in SharePoint, gives you a number of options: You can copy the record to the clipboard to allow you to check the changes on SharePoint and overwrite if required, or you can disregard your changes leaving things as they are, or you can over write your colleague’s changes.

![Write Conflict Dialog](image)

**Figure 7-12**

**Exporting Lists to Access**

In the first set of examples, you have been linking lists to Microsoft Access to maintain the link between the database and the data on the server. When you import the list into Access, you break this link and the data now exists in two places, the database and the SharePoint list. Generally, this is not a good idea as data will get out of synch, and no one will know which data is the true set or which is up to date and relevant. Keeping the same data in two places is never a good idea, particularly in the business world, where you should have one set of data which is the true data for a particular subject. However, you may at some point have a need to provide someone outside your company with information from SharePoint while not providing them direct access to the sites. Microsoft Access 2007 offers you one way to do this. It is also possible that you may require data held within SharePoint for use within an existing Access database and do not require live access to the server. For example, your SharePoint list could simply contain a list of company assets, for example computers used within a business area. You could pull this data into Access as part of a larger system. Access can also be used when you need to filter and work with a particularly large list, using queries and reports to prepare information at a fixed point in time. In that case, you may simply pull the data from the list directly into Access for further work, remotely, from the SharePoint servers. The actual process of importing the data from the list into Microsoft Access is just like linking, only in this case you want to export the list data from SharePoint and import it physically into your database. To export the data to Microsoft Access:

1. Click Actions.
2. Select Open with Access to open the initial dialog. Figure 7-3 shows the dialog that will open.
3. Next, select “Export a copy of the data.”
4. Click OK.
Part II: From Desktop to Internet

Your list will be exported to Access as a standard Access table in a new database with the same name as the list itself. It is important to understand that the link between the data exported into Microsoft Access is now totally divorced from that in your SharePoint list. Changing the data in SharePoint, for example, will not be reflected in the Access version. Using this technique there are no additional Access objects created for you. All you get when exporting a list is the actual list itself. One other major difference you will find when exporting to Access is that you can export a view and the exported data will be restricted to that view. All that is required is that the view you wish to use is the current view; that is, the view currently being displayed within SharePoint. This is very useful when you do not require all the list data but only need a subset of the list data.

As you can see from the preceding sections and discussions, there is a fair bit that you can do with Access 2007 from the SharePoint side of things. The same is true from within Microsoft Access 2007 itself, where you can begin to incorporate SharePoint list data into your Microsoft Access databases and applications.

Working from Access 2007

So far, you have been learning how to interact with Access 2007 from within your SharePoint site, but it is also possible to work the other way around, and Access 2007 has been improved to make this much easier than with previous versions. You have already seen how the new data types within the Access 2007 ACCDB file type have been added to make the interaction between Access and SharePoint much cleaner. It’s reasonable to guess that this is the sole reason that these data types have been added to the program. Access brings much to the game in terms of working with your SharePoint data, and as the use of SharePoint grows, it’s likely that you may find you are required to integrate more SharePoint data into existing Access applications. Not only that but Access provides the perfect tool to build graphical interfaces into the list information that you use each day, also allowing you to create forms, reports, and queries to further refine interfaces to the data. Another issue that has haunted Access databases has been multiple users accessing the database. This has sometimes caused problems because Access is not a server database application. Storing your data on SharePoint overcomes this problem as SharePoint is a server-based system capable of handling thousands of users. To illustrate how SharePoint has become more a part of Microsoft Access, Figure 7-13 shows a section of the Access Ribbon in the sample database, Northwind 2007, with the Create tab selected.

Note the SharePoint Lists item in the Table group. Clicking this icon will open up a list of SharePoint templates, which give you a quick way to add some common lists to your Access databases. The following list templates are available: Contacts, Tasks, Issues, Events, and Custom. Finally, you can connect and link to an existing SharePoint list.
Creating a Database in Access and SharePoint

In this example, you are going to use Microsoft Access to create a database and link it directly to Microsoft SharePoint Server 2007. You are going to carry out the entire procedure from within Microsoft Access 2007, using one of the existing list templates that come with Access. You will need a SharePoint site and permission to create objects within the site, and you will choose a custom list type, but the general process is the same irrespective of the template chosen.

2. Click the Create tab.
3. Click SharePoint lists in the Tables Group.
4. Choose the Custom List template option from the SharePoint Lists submenu to open the first screen in the process.
5. Enter the URL to the SharePoint site you would like to use.
6. Enter a name for this list.
7. Enter a description for the list.
8. Click OK.

Your new list will open within Microsoft Access, but you will be unable to customize the design of the list in Access. It is common to all linked objects that the design of the object can only be edited in the original application, in this case SharePoint. You need to define and edit the rest of your columns within SharePoint. The point of all that is twofold: first, to show you how easy it is, and second, to let you see that it is perhaps better to define the list in Access first and then move it to SharePoint. That way you do all the design in one place, and when you’re happy with the structure you can simply move it to SharePoint. So for the second example, you will create an Access table in Access 2007 and move it to SharePoint.

9. To continue, click Create.
10. In the table group, click Table Templates and select the Events template.
11. Access will open the new table with, for some strange reason (considering you picked a template called Events), the name of Table 1.
12. Close Table 1 by clicking the Close button in the top-right corner of the table.
13. Click Yes in response to the Save Table dialog.
14. Name the table “Events”.
15. Click OK to save the table to Access.

A couple of things with regard to table design will be useful to you later in SharePoint.

In the navigation pane, click Events ➜ View ➜ Design View. The design view screen is split into two areas; the field design at the top and the field properties at the bottom. The properties are specific to the field selected in the design part of the window.
Part II: From Desktop to Internet

Click in the Start Time field. Note the validation in the validation property for that field: 
\[ \geq \#01/01/1900\#. \] Any data entered into this field must have a value greater than or equal to 01/01/1900.

Click within in the Title field. Note the Required property is set to Yes. In this case, you must provide a value for this field before the record can be saved. Now, move this table to SharePoint:

1. Close the table.
2. Right-click the table name within the navigation pane.
3. Select Export SharePoint List.
4. Enter the URL to your SharePoint site.
5. Name the list EventsExport.
6. Enter a description.
7. Click OK.

The export to SharePoint will proceed, and you will be left with a Save Export Steps dialog.

You can choose to save the steps taken in the export of the table if you might need to run it again. To save the export to SharePoint, check the Save Export Steps box. Next, enter a description. You should enter a description at this point as it could be several months before you return to the export and might need reminding what you where doing. (You can also create an Outlook task to remind you when you want to run this export again.) Click Save to save the table.

Your events list should be open within Microsoft SharePoint showing the default view of the Event list on the Calendar. If you remember back to the Access table there were two validation properties pointed out on the Title and Start Date fields. The Title property was set to Required and the start date had to be greater than or equal to 01/01/1900. If you notice in SharePoint when you click New to create a new event the Title column has a red star beside it, indicating that it is required and by a strange coincidence SharePoint will not let you add a date that is before 01/01/1900. In fact, the SharePoint date range is 01/01/1900 to 12/31/8900. Your validation from Access matches the validation in SharePoint but the main reason for this is that you used the Access table template to create the table and it has been built with this in mind. It can be a different story when you have some custom validation in your Access table, and you may not be as lucky when you move it to SharePoint.

**Importing a SharePoint List from Access 2007**

You can also import a list directly via the Access interface simply by entering the URL to the SharePoint site and choosing the list or lists you require. This is a useful approach if you need to make use of SharePoint list data within an existing Access database. To import a list directly into Microsoft Access 2007:

1. Click the External Data Tab.
2. Click SharePoint Lists.
3. Enter the URL to the SharePoint site you require or select an existing list from the dialog.
4. Click the Import Data radio button (note that you can also link to SharePoint using this method). The dialog will then offer you a number of lists from which to import, and for each list item you can select to import all items or base your import on an existing view. You can select the items to import by clicking the check box to select the list and then selecting the view to import by clicking the Items to Import drop-down list.

5. Select the item or items you would like to import.

6. Click OK to import your selected object. You can choose to save the import for later use if required.

7. Check the box Save Import Steps.

8. Enter a name for the saved import.

9. Enter a description. If required, create an Outlook task to remind you to run the import at a specified time.

10. Click Save Import to finish the process and import the list.

Your SharePoint list will now be saved into Access as a standard Access table.

Creating an Access Database on SharePoint

In addition to linking to a SharePoint list, you could also just simply create the entire Access 2007 database and create the linking structures on SharePoint at the same time. For this example, you are going to use one of the Access 2007 template databases from Access 2007, only this time you are going to use both Access 2007 and SharePoint to build the database. This is a classic Access front end/back end system. The front end (queries, forms, reports) will be within Microsoft Access 2007; the back end, in this case SharePoint lists, will store the data.

Another Access Design Tip

It is standard practice with Access always to create two databases. One database—the front end—contains the access objects such as queries, forms, and reports. The back end contains nothing but tables, and you then link both databases together. This is particularly useful if you are placing your Access database on a file server for sharing by multiple colleagues. Each colleague gets his or her own copy of the database front end, which links into the tables in the back end. This way everyone is using the same set of tables on the server. The same approach is used when you need to work with data held on other larger databases like SQL Server. An Access front end is usually linked to the tables in the larger system.

For many years, it has been possible to upsize an Access database to various versions of Microsoft SQL Server and truth be told it has never been a straightforward click-of-the-mouse feature. You always ended up with grief and manual work once you had moved the tables and other objects out of Access. Over the years, Microsoft has improved the process with different releases of Office and SQL Server, but it is still not a standard one-click process. When looking at moving Access databases to SharePoint, it felt like SQL Server upsizing in the early days in that once you got from Access to SharePoint, there was still a lot of manual work to be done, and you could never quite recreate it in SharePoint. It still seems like a
Part II: From Desktop to Internet

version 1 technology at the moment, but it is what it is and as usual you make do. One of the major drawbacks in moving applications from Access to SharePoint is the fact that SharePoint does not support referential integrity. If you think back to the example earlier of students, courses, and primary keys and look back at Figure 7-1, you will see that there are three Access tables, each connected by a black line, which represents the relationships between the tables.

In the students and courses example you encountered earlier in the chapter, if you tried to delete a course record that had students enrolled in that course, the database would stop you. It would stop you because deleting the course while students were enrolled in it would leave students assigned to a nonexistent course. That’s referential integrity. It ensures consistency among your tables in Access. This sort of consistency does not exist between lists in SharePoint. In SharePoint, you could delete a course even if you had thousands of students enrolled in it. In addition, in an Access database, it would only be possible to enroll a student in a course if that student’s record already existed — you could not enroll a nonexistent student in a course. Going back to the earlier example, if you had to delete a course, in order to maintain referential integrity you would be required to delete all of the student enrolment records as well. In the real world, of course, you would delete neither. You would need this information for historical record purposes. However, SharePoint provides none of these controls and will let you delete anything, anywhere, anytime, provided that you have the SharePoint permissions to delete items in lists.

SharePoint however does try and help out with the process. If you have linked tables (such as Customer and Order), SharePoint will create two lists, a Customer list and an Order list. Because Customer and Order contain a relationship defined in Access by using the AutoNumber primary keys to link the tables together, SharePoint will create a lookup in the Order list, displaying the Customer who placed a specific order based on the foreign key to primary key link. But in terms of linking the lists together that’s about as far as it currently goes with SharePoint lists in terms of relating lists together.

**Creating a SharePoint Back-End Database Application**

Now you are going to actually create the database, which in this case will contain links to the lists that will be created on your SharePoint site as opposed to actual tables within Microsoft Access. However, other Access objects, like forms, queries, and reports will all exist inside the Access front end application. Basically, all you are required to do to create the database links in Access and the lists on SharePoint is to check a box when you are creating the database. To proceed (assuming that you have Access open):

1. Click the Office button and select New.
2. Select the Personal Template category, and select Personal Contact Manager.
3. Check the box below the database name text box (lower-right side of screen) named Create, and link your database to a Windows SharePoint Services Site.
4. Click Download.
5. The Create database on SharePoint Wizard will open.
6. Enter in the URL to your SharePoint site.
7. Check the box “Save a copy of my database to the SharePoint site.”
8. Click Browse, and select the document library you will save the database file to.
9. Click Next.
   The process will begin and you will be informed of progress on screen as the various objects are created. Once the process has ended, do not close the dialog just yet.
10. Click the box entitled Show Details to reveal some messages about what has just taken place. For example, in the preceding example, you will receive a message very similar to the one that follows.

   The following lists have been created on the SharePoint site
   
   https://yourSharePoint URL

   Call, Contacts

   The following URL takes you to the published copy of your database:


   Some issues were encountered while moving your tables. Access has created a log table called “Move to SharePoint Site Issues” listing these issues.

The area to pay particular attention to is the last message, which tells you that there have been some problems creating this application on SharePoint. The message lets you know that the problems have been listed in a new table in your database, called Move to SharePoint Issues. This table will provide you with details about the issues that have occurred. Of course, you need to sort them out yourself. Once you have read the message, you can click Finish to end the process.

Figure 7-14 shows you the navigation pane in Access 2007, its links to your SharePoint site containing the lists, and the additional Access objects created in the database. If you open any of the forms, you will see right away one of the major benefits of using Access to interface to lists with SharePoint — the rich interface available you to when working with the list data. Figure 7-14 shows an Access contact form.
Part II: From Desktop to Internet

It’s fairly obvious from Figure 7-14 that Access 2007 provides you with a much richer and more fully featured interface to your list data than that available on SharePoint itself. In SharePoint, you have a simple list view to enter the data into. Access 2007, on the other hand, allows you to tie multiple lists together and present it to your colleagues. For example, the Contact form can be used to enter both contacts and multiple calls they make. Note the tabs across the top of the form that allow you to enter and view information from the various lists. The use of Access also gives you access to other features of Office 2007, for example, the ability to collect data via Outlook, and to send email and save the contact into your Outlook contacts.

**SharePoint Site Issues Table**

As stated previously, this table will list any issues that arose when the application was created. In general, you will find that the errors in this case relate to the lack of referential integrity in SharePoint, or the fact that SharePoint does not support a cascading delete. For example, if you delete a customer and cascading delete is turned on in Access, Access will also delete the associated calls. In SharePoint, this is not supported, and your colleagues are free to delete the contact record via SharePoint, leaving you with a call list that has no supporting contact entry in the contact list. Having said all that, at the end of the day, SharePoint is not a relational database, it is a list-based system, and you must use other more creative ways to overcome these shortcomings. The third error refers to validation in the Call table’s Call Time field and the BirthDate field in the Contact table, which are not moved to the SharePoint list. In this case, both these problems are easy to fix, as they are both validation checks to ensure that data meets a particular date rule. One way to ensure that the validation is performed within Access is to add it to the field’s validation property in the Access form. In this way, the data is checked and fixed before it even gets to SharePoint. However, on the SharePoint site, if someone is entering data directly into the list, it’s a lot more difficult and you will need the help of a professional programmer. To resolve this issue with Microsoft Access:
Chapter 7: Microsoft Office Access 2007

1. Open the Contact Details form in design view.
2. Click on the Additional Information tab.
3. Click on the BirthDate text box.
5. Click on the Data Tab in the property Sheet.
6. Enter `>/H11022` into the Validation Rule property.
7. Enter “Please enter a date greater than 01/10/1900” into the Validation text property Incorrect Date Entered.
8. Close and Save the changes to your form.

Now if someone is adding data via the form, Access 2007 will check the date entered in field, and if it does not meet the validation, your colleagues will be given the chance to enter a valid date. You can repeat this process for the missing validation in the Calls table, using the Call form to enter the validation in the Before Update property of the required field. This gives you a useful technique when working in Access, as you cannot alter the design of the linked list and your Access validation is not carried over into SharePoint.

Queries versus Views

You have already seen in previous chapters how you can create views of your lists in the SharePoint interface. However, these views are static. You create the view and it provides a result, which is displayed on screen. Access, on the other hand, allows you to build views that are dynamic, in that you can pass parameters to them, and they will filter the result set based on the values entered. This feature is simply a standard feature of Microsoft Access and unrelated to SharePoint. From a data point of view, you are simply treating the linked list as an Access table. Queries are a great tool when you need to refine the information in larger SharePoint lists. Creating a query is a fairly straightforward process. To create a query for the Contacts linked list in Access:

1. Click the Create tab.
2. Click the Query Design icon in the Other group.
3. In the Show Table dialog, double-click the Contacts Table to add it to the Query grid.
4. Click Close to close the dialog.
5. In the graphic representation of the Contact table, double-click each field you need in the result set. In this example, make sure that you select City, Last name, and First Name.
6. In the Criteria row in the cell directly below the City field, enter, including square brackets, “[Enter a City]”.

The square brackets will cause Access to prompt you for a value when you run the query. Figure 7-15 shows the query design.
7. Run the query by clicking the run icon in the Results group on the Ribbon.

You will be prompted for a City value, and your query will restrict the display to those records meeting that criteria. SharePoint views, while very powerful, do not allow you to do this. However, you could of course add both a list Web Part displaying your contacts and a filter Web Part to a SharePoint page and achieve the same basic result. However, it’s more likely that you do not have the permissions to do this in SharePoint, so Access may be your only solution to this type of freedom in the system. You will still be restricted by your list permissions, but you will be free to create Access objects that meet your needs in your local copy of the database.

**Moving a Database to SharePoint**

A good example of using Access 2007 to move an entire database to SharePoint can be shown with the Northwind 2007, the sample database available with Access. Most writers use this example because almost everyone who has Access 2007 will also have this database available to them, and readers can follow along without the effort of creating new databases and populating them with information. In general, the basic error you will get when you use Northwind will reflect to a fair extent what happens in a real database application.

Of course, you will need a database to move to SharePoint for this example, and in this case you will need to create a clean version of Northwind 2007 database on your local machine, which you will then move to SharePoint. For this example, also create a new team site in SharePoint, called Northwind 2007. The site is completely empty, containing only the default objects. To create the Northwind database on your PC using Microsoft Access 2007:

1. Click the Office Button in Microsoft Access 2007.
2. Click New.
3. In the From Microsoft Office online category, click Sample.
4. Click the icon labeled Northwind 2007.
5. Enter a file name for the database or accept the default.
6. Select a location for the new database.
7. Click the Download button to download and install the template.

Now that the Northwind database has been created, close the login form without logging in and proceed:

1. Click the External Data tab.
2. In the SharePoint List group, click Move to SharePoint.
3. Enter the URL to your SharePoint site.
4. Click Browse.
5. Select the Shared Document Library.
6. Click OK.
7. Check the box to save a copy of the database to the library.
8. Click Next.

Your copy of the Northwind database will be moved to SharePoint. The dialog will inform you of progress as objects are configured and moved to the SharePoint server. Once the process is finished do not close the dialog, as you will need to read over the results presented on the screen. However, before looking at this message, if you look at the SharePoint site where you moved the database to, you will see absolutely nothing relating to your Northwind 2007 database in the Quick Launch menu. In order to see the results of the move, you will need to click the View All Site Content link at the top of the SharePoint Quick Launch Menu. Figure 7-16 shows some of the Northwind lists available to you. Note that all of your Microsoft Access 2007 Northwind tables are now available from this page. You can open any of the required lists by clicking on the name in the list.

![Figure 7-16](Image)

Returning to the dialog in Access 2007, the following information is displayed within the dialog, and it is important that you do actually read it.

```
The following lists have been created on the SharePoint site
http://yoursharepointsite/northwind.

Customers, Employee Privileges, Employees, Inventory Transaction Types,
Inventory Transactions, Invoices, Order Details, Order Details Status, Orders,
Orders Status, Orders Tax Status, Privileges, Products, Purchase Order Details,
Purchase Order Status, Purchase Orders, Sales Reports, Shippers, Strings, Suppliers
```
Part II: From Desktop to Internet

Microsoft Office Access has created a backup copy of your database.
C:\Users\martinreid\Documents\Northwind 2007_Backup.accdb

The following URL takes you to the published copy of your database.
http://yourSharePointsiteURL/Shared Documents/Northwind 2007.accdb

Some issues were encountered while moving your tables. Access has created a log table called “Move to SharePoint Site Issues” listing these issues.

This is particularly true of the last area, which lets you know that a warning that has been issued during the move process and that a table containing this information has been created in your database. Generally, the first thing to do after moving the database to SharePoint is to check out the warnings that have been issued in the Move to SharePoint Issues table that will be created within the database on Microsoft Access 2007. Do not delete this table until you have reviewed its contents.

As stated, the table created after migration lists the issues that occurred during the migration to SharePoint. In the case of the Northwind database, there are 53 reported issues, and you will find that they represent the general issues you will have when moving a database to SharePoint lists. The issues in the main are:

- Referential integrity is not supported by SharePoint.
- Unique indexes are not supported by SharePoint.
- Data validation is not moved to a SharePoint list.
- Some field-level default values in Access will not be recreated on the SharePoint server.
- Field values are not auto-generated in SharePoint.

At this point in the process, it’s worthwhile to print out the Issues table as an Access report. That way, you can work through the issues without constant referral to the table. To create the report, simply select the Issues table, and click Report using the Create Tab. As discussed previously, there is little you can do about the referential integrity issues; they are simply not supported using SharePoint and, yes, this is a major failing, and hopefully in the next release of SharePoint it will be addressed. To address the other issues, it is useful to create a standard copy of Northwind 2007 and use this as a reference, together with your Issues printout, to address the other issues raised during the move. The issues will include:

- **Unique indexes**: An index in a database is a little like a book index. When you are searching for a record, the database looks up its location within the index and points to the record’s location on your hard drive. A unique index is just that: a value that is unique. Each record must have a unique identifying value; this is the primary key. In some cases, it takes two or more field values to guarantee the uniqueness of a record; this cannot be implemented by SharePoint, as it is
Restricted to using one value for a unique index — the list ID. However, using AutoNumber primary keys usually resolves this issue, in terms of Access at least.

- **Cascading updates and deletes**: As discussed previously, cascading updates and deletes are part of the referential integrity rules and are not implemented by SharePoint. There is no user interface workaround for this issue at the moment.

### General Issues

The next discussion looks at some of the more general issues you will face when moving Access tables to SharePoint. Some of this has already been covered elsewhere in this chapter, but a little duplication does no harm. Generally, the issues you will face revolve around data and how it is defined and manipulated in Access 2007.

### Dates

If any of your data contains dates prior to 1900, the data will not be moved to SharePoint. There is a similar problem with moving SQL Server data to SharePoint. In the Northwind example, the Orders table contains an OrderDate field, has a default value set to the Access function `Now()`; this returns the current date. This function will not be copied over to your SharePoint list. To fix this issue in SharePoint:

1. Open the Orders list.
2. Select Settings.
3. Select List Settings.
4. Scroll down the Settings page until you reach the Columns category, and click on the Order Date column.
5. In the additional Column Settings group, check the radio button Today’s Date in the default Settings area.

When you are adding a new order record to the list, today’s date will already be in place in the Order Date column. This duplicates the Access default value that did not move to SharePoint.

### Table Validation Rules

As already discussed, validation rules will not be taken into your SharePoint lists. The fix that recreates the validation rule within the Access interface should resolve these issues. In the case of Northwind 2007, the issues with validation rules should also be taken care of automatically, as they are mainly created to stop dates being entered that occur before 01/01/1900, which is the SharePoint date range start date.

With a SharePoint column, you can have some form of validation out of the box. For example, you can set the size of text columns, make a column required, and select the appropriate data type for the column. You do not have the type of validation property that Access provides at the column level but then again, as you know, SharePoint is not a relational database management system.

### Access Lookup Fields

As already discussed, Access allows you to set a field property that looks up values in another table. In the case of Northwind, Access looks up a user name as the input to the Purchase Orders Created By field. Once you select a user, Access grabs the primary key value of the user record from the Employee table and saves it within the Purchase Order table. If you check out the Purchase Order list on...
Part II: From Desktop to Internet

SharePoint, you will note that this column is not displayed by default, but it is included as part of the list column definition. If you need to display this column, you must modify the default view and add the column. In the case of the SharePoint list, you do not actually need to look up a user, as this field will by default save the currently logged-in user with their record.

Queries, Forms, and Reports

Once you have moved your Access database to SharePoint, you will find that you can access all the database’s queries, forms, and reports directly from within the SharePoint list. Figure 7-17 shows the Customer list with the View menu available.

![Figure 7-17](image-url)

Figure 7-18 shows the original object list in Microsoft Access 2007 for the Customer table.

![Figure 7-18](image-url)

In this case, you can see that both lists are almost identical in that all of your forms, queries, and reports have become views within the SharePoint list. In this case, when you open one of the list views the corresponding object will open in Microsoft Access 2007 (as well as the rest of the database) provided you have Access installed on the local machine. If you do not have Access 2007 installed on your local machine but have, for example, Access 2003 installed you will be offered a link to download the saved copy of the database for local use. Of course, if you have saved the database as an ACCDB file, this will not work even if the dialog says you’re downloading an MDB file. This is another feature of the software that will need to be ironed out in the next release.

Generally, it would be better to work with your local copy if you need to take advantage of the rich development interface provided by Microsoft Access. What SharePoint brings to the game is the ability to use a secure web site if you need to make your information available via the web, the ability to take the information offline with Access and then synchronize changes with the server at a later date, and of course a server system that is much more robust than the desktop Access normally runs on.
Keeping an Object in Access

What is actually moved to SharePoint as a view is controlled by the property of the object concerned and in part by a general property setting in the database. For example, if you open the Customer table in design view and click Property Sheet in the Show/Hide group on the Ribbon, you will find a property called Display View on SharePoint, which in the case of a linked table will contain the text Follow Database Settings. This is because a database also has this property (DisplayAllViewsonSharepoint) in its Properties available in the Manage database menu. This property can hold a value of 0 or 1. A value of 1 allows you to work with the database tables on SharePoint; a setting of 0 will stop any interaction with SharePoint. You will also find the same property in Forms and Reports, and this property is available in the Other tab in the Forms and Reports property sheets. Setting the property to Do Not Display will result in the form or report not being available on SharePoint as a view.

Access 2007 and Workflows

Another of the pluses when you have moved your Access database to SharePoint is the ability to build workflows into your data that is now held on SharePoint. You have already seen how to create workflows in Chapters 2 and 6. These same techniques apply even when you have linked the lists to Access or if you have moved your database to SharePoint. You still set up and run the workflows from the list in SharePoint but for Access users and developers, workflows are another valuable tool to have in your toolbox, as they can be triggered from activity within Access via the SharePoint linked lists. You can also link to the workflow lists used to manage the process (such as the Workflow History or Tasks lists) and use the reporting tools within Access to create published reports on progress. Using the Customer list as an example, you can create an approval workflow from within the SharePoint list and trigger it when a new customer record is added either via the list or through the Customer Details form in Access. In either case, the workflow process will be started on the SharePoint server; the fact that you have added the record using Access 2007 is irrelevant.

As you know, the workflow item will be added to the site’s Tasks list, and you can also link to this list to use it as the basis for workflow tasks from Access. You can then use the reporting features of Access to print out styled reports on the workflows. Another example of a workflow that is useful within Microsoft Access is one where you capture information when a record is edited, showing, for example, who made the change. A SharePoint workflow could be set up to handle this as well. You will be looking at workflows in more detail in Chapter 12. You can also modify workflows on specific lists from within Access 2007 by right-clicking a linked list in the navigation pane and selecting SharePoint List Options and Modify Workflow, which will take you to the Manage Workflow page on your SharePoint site.

Building Basic Access Objects

This section walks you through creating basic Access objects, to get you up and running with Microsoft Access 2007. At a basic level, Access is an easy program to learn to use, but if you’re just starting Access, it’s advisable to read up a little on database design because it really does pay off in the long term. It will also help you, when designing SharePoint lists, to understand the relationships between items of data, and planning actually does pay off. One of the really good things about Access is that it can be as basic or as complex as the amount of interest and time you are prepared to invest in learning how it works.
Part II: From Desktop to Internet

**Forms**

As you have already seen, an Access form is a window into data held within a table or a linked list in SharePoint. However, a form allows you to do much more than simply present data. Using form properties, you can restrict how users interact with that data. For example, you could only permit your colleagues to enter or edit data, and also restrict the deletion of data. You can do this by using the form’s property sheet to set a range of data properties. When working with SharePoint via Access, you can also use these properties to control how your colleagues deal with the data in SharePoint. For example, if you wanted an Access form that only allowed someone to add data to an existing list, you could create an Access form just for this. Access also allows you to create different types of forms, from the plain one record per form type to forms containing multiple tabs, which are useful when you have a lot of data to display and need to categorize it. As you will see, Access provides you with multiple ways to expose and control your SharePoint data, bearing in mind that you are also covered by the security restrictions within the list and the site itself when working with data from Access. Given the confines of a single chapter, only a small example can be provided of what you can do with Access forms and linked SharePoint lists, but it should be enough to get you interested in using Access and SharePoint together to present and control list data.

**Creating a Blank Form**

The best way to understand Access is to start with a blank canvas, even though Access provides you with several form templates on the Ribbon. From within Microsoft Access and using the Northwind sample linked database:

1. On the Create tab click Blank Form.
2. Click View and select Design view.
3. In the Tools tab, click Add Existing fields (if required).
4. Expand the Customers group by clicking the plus symbol and opening out the group to show the fields in the linked Customer table.
5. In the Ribbon look at the Controls group, and click on the tab control.
6. Move the mouse over the form’s surface, and drag out the tab control shape.
7. From the field list pane drag the First Name, Last Name, Job Title, Address, and City fields onto Page 1 of the tab control.
8. Drag the Company contact details onto Page 2 of the tab. (telephone numbers, email address, and fax number).
    You now have a tab control showing two pages — 1 containing name and address information and Page 2 containing address data.
9. You can also replace the Page 1 and Page 2 tab names by changing the properties of the tab control. To do this, click on the Page title of the first tab (Page 1).
10. Click the Property Sheet icon in the Tools group.

11. In the property sheet, click the All tab and replace the default name, Page 1, with “Personal Details”.

Repeat the process with Page 2, replacing the tab name with Contact details. Figure 7-19 shows the result when you switch to the standard view of the form.

This simple example gives you an indication of one type of form and interface you can create using Access 2007, and with a little practice you can create forms that are as simple as the one in the example or as complex as you require. A more complex tabbed interface is shown next in the Issue Tracking database. Remember that you have the full range of Access features at your disposal now that the list is linked within Access 2007. Another common object added to Access forms is the drop-down list from which you select a value. Generally, the values displayed are held in a different table than the one the main form is based on (hence the name lookup), and the object is configured using the properties chosen.

**Issue Tracking Example**

The Issue Tracking database in Access 2007 is a good example of how you can build a functional interface to SharePoint list data and provide your colleagues with a true Windows experience when working with lists. Figure 7-20 shows the Issue Details form, which demonstrates the functionality that you can achieve when using Access to work with lists. This interface uses a number of Access form objects to allow you and your colleagues to log information. Note that it also displays the Comment Version history in a text box within the form. A view like this is impossible to achieve in SharePoint without developing complex code-based web pages. Using Access you could build this particular form with several mouse clicks. Figure 7-20 was created just like the one in the previous example, using a tabbed control with the addition of some standard Access drop-down lists.
Part II: From Desktop to Internet

Form Templates

In addition to allowing you to create your own forms from scratch, Access also provides a set of instant forms that you can use. These forms are available directly on the Create Ribbon and include a Standard Access form, a Split form, a Multiple Item form, a Pivot Chart, a Datasheet, and of course a Form Wizard that will walk you through the form creation process. The Form Wizard is a useful feature for those new to Access to begin working with these objects. To use an instant form, simply click on the list or query that you would like to base the form on, and click the form’s name in the Form group on the Ribbon — instant form.

Queries

There are different types of queries: Select queries simply return records, Delete queries remove records, Update queries can be used to change one or more records, and other specialist types of queries can be created within Microsoft Access and used with your linked SharePoint lists. The Update query is useful if you need to change several records in a linked SharePoint list as opposed to changing the records singly using the list itself. Another type of query that is useful when you need to archive list data is the Make Table query. The Make Table query will take the results of your query and build a table inside the current Access 2007 database or indeed another Access database. The idea behind this is that you will then have an archived copy of your list data that can be retrieved later if required. For this example, you
will again use the Northwind database, which was moved to SharePoint. For this query, you want to archive all records for customers who live in Boston. To create the query:

1. Click the Create tab.
2. Click Query Design.
3. Select the Customers Table.
4. Click Add.
5. Close the Add Table dialog.
6. Select Last Name, First Name, and Company.
7. Double-click the City field to select that as well.
8. Under the City field in the criteria cell, enter the text “Boston”.
9. Execute the query to ensure that it returns only the records required — customers who live in Boston. The query should return two records.
10. Click the View icon. Click Design View to return to the design of the query.
11. In the Query Type group in the Ribbon, click Make Table.
   In the Make Table dialog, you can select an existing table to be overwritten in the current database, select another database in which to save the table, or simply enter a new table name.
12. Enter CustomersBostonArchive as the table name.
13. Click OK.
14. Execute the Query to make the table.

Your new table, containing two records for customers who live in Boston, will appear in the navigation pane. If required, you could now delete the Boston customers from the customers list by changing the query to a Delete query and executing it. You could then save the query for future use. This is a useful technique that can help you with the archiving of older records from your SharePoint lists. One word of warning: always run a standard Select query first to ensure that the records your query is returning are those you want, then you can change the query to the appropriate type, in this case a Make Table query. This is particularly important if you are going to delete records — always check first.

If at some future point you need to add the records back to the customer list, you can use an Append query. An Append query will load records into another table, so you could simply run the query, selecting records from the archive table and appending them to the linked customer list. You do need to be careful that you do not end up with duplicate customer records using this approach.

*A word of warning: if your linked list contains multi-valued columns, this approach will not work. If that is the case, simply copy the linked list and paste it back into your database, choosing Structure and Data Local Table in the Paste Table As dialog. This is a tip a lot of people don’t know about in Access — the ability to simply cut and paste a table back into the same database as a clone. Once the table is pasted back as a local table, you can simply copy it out to your archive database file by right-clicking the table name and selecting Export from the submenu.*
Part II: From Desktop to Internet

Reports

Access 2007 introduced a new feature with Reports, the ability to design a report while displaying the data. This gives you a real-time live preview of how your report will look when printed out. In this next example, you will use one of the most used features of Access reports: the production of mailing labels. Access contains a Mailing Labels Wizard that makes label production very easy. Again, this is something that is available out of the box in Access that is not available with SharePoint. To create a mailing label report in your Northwind 2007 linked database:

1. Click the Customers list in the navigation pane to select it.
2. Click the Create tab.
3. Click Labels in the Report group.
4. Choose the correct label size required in the first screen of the wizard.
5. Click Next.
6. Accept the default fonts and colors or change the items as required.
7. Click Next.
8. Using the Available field box, click on First Name.
9. Click the right-pointing arrow button to move the field to the Prototype label box.
10. Click Last Name and move to the label box.
11. Press the Return key.
12. Select the field required for the address, remembering to press return when you need a new line.
13. Select a field to use when sorting the labels on the printed page.
14. Click Next.
15. Enter a name for the label report.
16. Click Finish.

Access will create the label report and provide a preview on-screen for you to review. All that is now required is to load the printer with label stationery and print the report. This is a very useful feature of Access, and many people use Access just for this capability. The Northwind 2007 sample database includes some example reports, which should give you some ideas to get you started. Again these are features that are simply not available in SharePoint, and if you use Access for nothing more than reporting on your SharePoint data, you will be well ahead of the game in terms of presenting list data. Figure 7-21 shows the Customer Phone Book report from the Northwind 2007 linked database. It’s also worth noting that the Access Customer Phone Book report is interactive in that you can go directly to a customer record by clicking the contact name field and interacting with Outlook by clicking the smart tag icon to the left of the Business Phone field. This is another advance in Access 2007, the ability to interact with report data. It is also possible to use Access queries to restrict the data used by a report. By default, if you select a list, all the data in the list is made available in the report. If you only need a subset of data, you should write a query first and then base the report on the query as opposed to the linked list.
Just like an Access 2007 form, a report has a set of properties that you can manipulate, and each object in the report has a set of properties. You may have picked this up already, but one of the keys to learning Microsoft Access is learning how the properties work and how you can manipulate them within your database. Object properties are really basic to your understanding of Access and the doorway to building your knowledge of this application. For reference there are several excellent books on this topic available from Wrox (www.wrox.com) and from other publishers. Figure 7-21 shows a section of the Customer Phone Book report in Access based on the linked Customer list.

![Customer Phone Book](image)

As you can see from Figure 7-21, even a report in Access 2007 gives you a lot more interactive features than the standard SharePoint list displayed in a browser.

Before finishing this look at Microsoft Access 2007 and SharePoint, I would like to point out some areas where common mistakes are made with Access, particularly when you are considering moving databases to SharePoint or to SQL Server for that matter.

**Common Gotchas**

There are a couple of issues you need to watch out for, from both the Access and SharePoint side when you are creating and working with lists.

**Field/Column Size**

In Access a datum is referred to as a field, and in SharePoint a datum is referred to as a column. They are in fact the same thing, and the terms are used interchangeably. When you create a text column in SharePoint, the default size of that column is 255 characters. It can be exactly the same in Access, where the default field size for text is 255 characters. This is fine if you need to store that amount of text, but it is much a better practice to set an appropriate size when you create the item. If you link to a list in Access and then go on to create a form in Access, fields on the form will be created that allow 255 characters, which can make forms look very untidy. The Access data type will inherit the field size property from SharePoint. If you are using the form as a data input form, you will find that if someone can place 255 characters into the field, they will do so at some point. This is where you come back to thinking about what you’re going to do before you create anything. Just like Access tables, SharePoint lists need to be planned.
**Part II: From Desktop to Internet**

**Multi-valued Data Types**

If you are only going to be using Access 2007 ACCDB file types, then you are good to go with multi-value fields. If you are using any other version of Access, including Access 2003, you will run into trouble because earlier versions of Access do not understand multi-valued fields, and all you end up with is a comma-separated list of items in a single field. Unless you can program, this is really not of much use to you. The multi-valued data type is implemented in Access 2007 using a drop-down list of values containing check boxes from which you can select multiple values.

**Attachment Data Types**

You will have much the same issues with the Attachment data type in any version of Access other than 2007. Earlier versions cannot use the Attachment type; they simply will not know what it is. Within Microsoft Access 2007, the Attachment data type is best displayed using Access forms, as they contain a control that allows you to work with multiple attachments.

**Matching Data Types**

When you are moving Access tables to SharePoint and vice versa, you need to be aware of how each application treats the other data types. It’s important to understand that when you move an Access table to SharePoint, some of the data types, such as AutoNumber, are not supported.

**Summary**

In this chapter, you looked at working with Microsoft Access 2007 from both sides of the fence — from SharePoint via linked lists and Access views and from Microsoft Access 2007 via linking to SharePoint, exporting SharePoint lists to Access 2007 and moving Access databases to SharePoint. You looked at how you can use the features of Microsoft Access 2007 to begin the journey into creating rich user interfaces to your SharePoint data and how to report on the same data. All of these are features of Access that are not found in SharePoint. This chapter built the foundation for using Microsoft Access 2007 to work with SharePoint, particularly if you have a need to take SharePoint data offline and then link it back to the server. Microsoft Access 2007 received a lot of attention from Microsoft with respect to its integration with SharePoint, a focus that should increase with new releases of both Office and SharePoint. You will return to Access again in Chapter 11 when you look at SharePoint add-ins and how you can use Access data directly within SharePoint Web Parts simply by clicking the mouse (almost).

Working with SharePoint is reminiscent of working with SQL Server and Microsoft Access — the same sorts of issues arise, particularly around dates and other time-based data. Over time, Microsoft made tools and processes available that made the process easier (still not completely problem free, but easier), and they ought to do the same with SharePoint and Access. Time will tell. But all the issues aside, Access 2007 offers you a way to report on and present data held in SharePoint in a way that SharePoint cannot and for these reasons alone it is recommended you try it and see how you go. In the next chapter, you will see techniques to allow you to take SharePoint data offline as you work with Outlook 2007.
Microsoft Office
Outlook 2007

As you have there have been many changes in the Office applications to increase the integration with SharePoint, Microsoft Office 2007, and Outlook 2007 being no exception. In this chapter, you will look at working with SharePoint data from within Microsoft Outlook 2007 and using Outlook features inside your SharePoint team sites. The examples in this chapter have been carried out on a Windows XP Pro PC using Outlook 2007 connected to Microsoft Exchange 2007. If you are not using Exchange 2007, you may find that some of the examples may not run as expected. In some cases, menu options available within SharePoint that enable you to link your various list data to Outlook 2007 have already been discussed. In this chapter, you will look again at these options and see how they actually work out in practice. You will look at working with Tasks and calendars from both sides and see how you can use Outlook 2007 to take your data offline and work with documents using only Microsoft Outlook 2007. You will also look at how you can email-enable lists and, using email, post data directly to SharePoint. Later, the book will also discuss how you can use the record management features of Exchange Server to enable compliance with email data within the SharePoint record management environment.

What’s New in Outlook 2007

Outlook 2007 is slightly different from the other applications in the Office 2007 suite in that the Ribbon has not been made available globally throughout the program. The main Outlook menu is still in the older style, while many of the menu options use the Ribbon. Figures 8-1 and 8-2 show the main menu and the Tasks option dialog open in Outlook 2007, respectively.
Other than the main menu, you will find the Ribbon in most other Outlook 2007 screens. As you have already seen throughout the book, there are options within your SharePoint team sites and lists that enable you to link SharePoint data and documents directly into Microsoft Outlook 2007. One of the major changes in Outlook 2007 is that you can actually update your SharePoint list calendar directly from within Outlook. Using Outlook 2003 this is not possible, and calendars can only be updated from SharePoint. You can consume SharePoint data within document libraries inside Outlook 2007, and the ability to use RSS feeds to expose your list data to your colleagues is also available. One of the things that confuses many people using Outlook 2007 and SharePoint is that some of the Outlook menu items are available but do not apply to SharePoint, for example creating subfolders. This gives the impression that full integration is possible when, in fact, it is not. Generally speaking, Outlook 2007 is basically a read-only interface to SharePoint data other than calendars and Tasks. However, from within Outlook 2007, as you will see, you can directly access many of the features within SharePoint, both WSS version 2 and Microsoft Office SharePoint Server 2007.

### Outlook Files

When you are working with SharePoint data in Microsoft Outlook 2007, it is stored in an Outlook PST file. This is one of the reasons that you will not see your SharePoint data when using Outlook Web Access. Later in this chapter, you will see where your SharePoint files are actually stored. Once you edit the document within Outlook, Outlook will use your local SharePoint draft folder located within your My Documents structure on your PC.

For the usual security reasons, some of the URLs shown in the image files for this chapter will be blanked out. Other than that, the files reflect accurately each step in the specific process.
Lists and Libraries

As already discussed, you have the ability to link many of your document libraries to Microsoft Outlook, and one of the main reasons for doing this is to take your data offline and then resynch it back to the server later. Another of the benefits to this, particularly with Office documents, is the ability to browse the documents using the Outlook 2007 Review pane. This is a feature not available in SharePoint, where you need to download documents in order to view their content.

Linking Your Documents to Outlook 2007

In this example, you will take a document library offline using Microsoft Outlook 2007 and then resynch the contents back up to your SharePoint library. Getting the documents linked into Outlook is a fairly easy process from within a document library. To begin linking your documents to SharePoint:

1. Open a Document Library.
2. From the Actions menu, select Connect to Outlook.
   
   If you are not logged into your Outlook 2007 account, you will be asked to sign in. Figure 8-3 shows the initial Outlook/SharePoint dialog. In this case, the full URL to the SharePoint site that is displayed on the dialog was removed.

3. Click Yes to connect the library to Outlook 2007.

   The Advanced options shown in Figure 9.3 offer you some minimal options when working with SharePoint data and allow you to review the list you will be using. Figure 8-4 shows the dialog and the options available you. You can change the default folder name used in Outlook to identify the library being exposed, and the dialog also provides details about the site and list you will be using. You also have the ability to ensure that the list concerned is not displayed on another computer you use. This is useful if the documents contain confidential data that you do not want to make available elsewhere. Security of documents, particularly if those documents are being used outside the security areas of SharePoint, should always be a consideration when making lists and libraries available to programs like Outlook. Once you have added the edits required, you can click OK to close the advanced dialog.
4. To continue to connect the library to Outlook, click OK in the Outlook dialog. Figure 8-5 shows the resulting structure in Microsoft Outlook 2007 once the process has completed.

As can be seen in Figure 8-5, there are several SharePoint lists added to the menu, including items from MySite, your personal SharePoint area. Once you have added your documents to Outlook, you can take advantage of the reading pane to immediately browse document content. You can locate the reading pane from the Outlook 2007 View menu and then choose the location for the viewing pane — to the right, left, or bottom of the Outlook window. The Review pane in Outlook 2007 allows you to preview Microsoft Word documents, Excel Workbooks, PowerPoint presentations, and image files. Each of the aforementioned document types is fully usable within Outlook except for being able to actually edit the documents. For example, with PowerPoint 2007 files you can preview the entire presentation file without leaving Microsoft Outlook 2007. In addition to the document itself, you will also be provided with some of the basic document information such as Changed By, Checked Out To, Date Last Changed, and the size of the document file.
Opening a Document in Outlook 2007

To open a document within the Outlook window:

1. Select the document name and select Open.

2. Click Open in response to the security message. You can also choose Save to save a local copy to your PC at this point.

   Once the document opens in Word 2007, for example, you will be informed in the Document Management panel that this is a server document and must be saved locally before it can be edited and then resaved back to the SharePoint server.

3. To continue with editing the document, click Edit Offline within Microsoft Word.

4. Click OK to save a copy of the document to your local SharePoint drafts folder to enable local editing of the file.

   When you make changes to the file, those changes will not be available to any other user until you upload the file to the SharePoint site. From the Outlook side of things, when you have a document offline for editing, the icon shown in Figure 8-6 (red arrow) will be placed on the document name. However, this is purely a visual clue for you. If your colleagues are using the same document, unless you have it checked out, they have no way of knowing that it is being edited.

5. Once you are done with your edit, you can close the document in Word 2007. When you do this and are still online and connected to SharePoint, Word will prompt you to save the changes to the server. The dialog shown in Figure 8-7 will open.

6. Click Update to save your changes to the SharePoint server or do not update server to hold your changes of until a later date.

   Each time you reopen the file from your SharePoint drafts folder you will be prompted to update the server copy with your changes. The biggest danger with this approach is that there is no check-out feature on the Outlook 2007 side using this approach. The best approach is to save the changes to SharePoint and then check out the document using Word 2007 if you need to continue editing. However, the use of Outlook 2007 does provide you with a way to take SharePoint documents out on the road and apply your changes when you return to the office.
Part II: From Desktop to Internet

Using and Linking Calendars

Using Outlook 2007 you can now communicate with SharePoint directly and write events into linked SharePoint calendars. Using one of the other features of Outlook 2007, you can “combine” the SharePoint calendar with your standard Outlook personal calendar, giving you a view of all appointments from both SharePoint and Outlook at the same time in a single interface. Figure 8-8 shows a section from an Outlook calendar with both SharePoint and Outlook 2007 appointments showing. The SharePoint appointment will appear in colored text. This is not a true single calendar but uses the ability of Outlook 2007 to overlay calendars.

![Figure 8-8](image)

This technique provides an easy way to visually combine calendar data from a number of sources. For example, if you have an Office Live Workspace account, you can combine that information within Outlook 2007. Figure 8-9 illustrates this with data being shown from Outlook 2007, SharePoint, and Office Live Workspace. While not directly related to SharePoint, it does illustrate the ability to use data from various sources and present it using Outlook 2007.

![Figure 8-9](image)

When viewed in Outlook, appointments from different sources will be highlighted using different-colored text as a visual clue. The capability to at least visually combine data held anywhere and present it in a single view is quite nifty. Perhaps this is how the concept of cloud computing arises — the ability to present information irrespective of location. In any event, it does point to the direction Microsoft is taking and is, therefore, worth including. To link a calendar from SharePoint from the home page of your calendar list:
1. Click the SharePoint list or library Actions menu item.
2. Select Connect to Outlook.
3. Click Yes in the Microsoft Outlook dialog.

Your calendar will now be available inside Microsoft Outlook 2007. If you check the name of the calendar, you will find that it is formed using a combination of the site and the list name. That’s all there is to it really, a couple of mouse clicks and you are done. One of the major advantages of this approach is the ability, as stated, to combine visually, multiple calendars and then use Outlook’s search features with large date-based lists. To add an appointment to the SharePoint calendar from within Outlook 2007, simply add the appointment as you would normally do in your Outlook calendar, only on this occasion make sure that you are adding it to your linked SharePoint calendar. Figure 8-10 shows an appointment added to SharePoint. Both sides of the task are displayed in the screenshot. Once you save the appointment in Outlook, your SharePoint list will be updated if you are online. In the case of the appointment shown in Figure 8-10, the update was instant.

![Figure 8-10](image-url)
Part II: From Desktop to Internet

It’s worth remembering that a calendar in SharePoint is not as fully featured as a standard Outlook 2007 calendar. However, once you have added the calendar to Outlook 2007, you can then take advantage of such Outlook features as color category, create recurring appointments, and all the normal Outlook calendar features. Bear in mind, though, that features like color category will not be available within the calendar in SharePoint.

Another really nice feature in Outlook 2007 is the ability to overlay calendars from multiple sources, including SharePoint, and visually give the appearance of a single calendar. Figure 8-11 shows four calendars: the author’s personal calendar, a SharePoint calendar, an Internet calendar, and an Office Live calendar, using the overlay technique in Outlook 2007. An extreme example, yes, but it does certainly demonstrate the principle.

![Figure 8-11]

To overlay a calendar using Outlook 2007, click the Calendar item to open the Calendar tool pane, and then check the box for each calendar you would like to view.

When the calendars you require are shown side by side within Outlook, click the left-pointing arrow beside the calendar name of the tab. To return to side by side view, click the right-pointing arrow. Using multiple calendars like this also allows you to drag and drop appointments and other events between calendars; for example, to drag an appointment from your SharePoint calendar to your own personal calendar.
Tasks and Outlook 2007

Another of the neat features of Outlook 2007 is its ability to display multiple tasks assigned to you from across the SharePoint servers and present them in a single usable interface: Outlook 2007. In general, you can connect your SharePoint Task lists to Outlook 2007 by using the Action menu. As most people use Outlook on a regular basis, you will have a more or less permanent view of your SharePoint Tasks available without having to open the web browser. Figure 8-12 shows multiple SharePoint Tasks lists connected to Outlook 2007.

Viewing the various tasks associated with each list is a simple matter of clicking the task list name in the Other Task section of the task pane.

Within Outlook, you can also edit a task and synchronize the changes to SharePoint. To edit the task:

1. Double-click the task title.
2. In the Task dialog form make the required changes to the task.
3. Click Save and Close.

If you are online, your changes should be sent to SharePoint. Figure 8-13 shows the result in SharePoint of editing a task in Outlook 2007.
Part II: From Desktop to Internet

In Figure 8-13, note the text at the bottom of both screens. The screen in the foreground is Outlook and in the background is the SharePoint Task list. The edit was carried out in real time — from creating the task to editing it in Outlook 2007 over a slow remote connection just to prove that it actually does work. It is also possible to create a new task within your SharePoint list directly from within Outlook 2007. To do so:

1. Open your linked task list in Outlook.
3. Click the Assigned To button to open the Global Address List.
4. Enter the name of the individual you would like to assign this task to. You can also change the list of contacts. For example, if you have linked your team site contact list to Outlook, you can click the Address Book drop-down list and select the linked list as opposed to the Global Address booklist (GAL). The GAL is a sort of electronic phone directory created by Microsoft Exchange in large organizations.
5. Enter a subject for the task.
6. Enter a start date, end date, status, and priority for the task.
7. Enter the details for the task.
8. Click Save and Close to complete the process.

Figure 8-14 shows the completed form in Outlook 2007 (the Ribbon has been minimized).
Note the link to the task list in the status bar of the task form. Clicking this link will open the task list on your SharePoint site. If you look at the Ribbon in the Task dialog, you will also note that you can take advantage of Outlook 2007 features and apply them to the task; for example, adding color categories to tasks to help you identify them. However, this is an Outlook feature and will not be available within your SharePoint team site.

**Contacts**

Sometimes a team will build up a list of contacts that may be of use to you or one that you may need when you do not have access to the SharePoint site, or you might want to make the SharePoint contacts available in Outlook to use when sending email messages. All of these options are possible within Outlook 2007.

**Linking Contacts to Outlook 2007**

At times, it can be useful to have a list of a team site’s contacts available within Outlook to enhance the emailing capability of data held within SharePoint. This provides you immediate access to the contact list when, for example, you may be working with library data offline.

The process used to link a contact list from SharePoint to Outlook is very simple. From the Actions menu within your contact list, select Connect to Outlook, click OK in response to the Warning dialog, and that’s it, you’re done.

**Copying Contacts to and from the Web**

For internal company contacts, the majority of readers will use their company’s global address book and their own local contact lists from within Outlook. On a personal level, I only use SharePoint contacts in the content of the team site I am working in, so I would add them on a site-by-site basis if they are not already available within the Global Address List for my organization. This is a useful feature, particularly when you are working with external customers. However, it is also possible to move people from these “internal” lists to SharePoint, and you will look at that within this section. This is also a useful
Part II: From Desktop to Internet

way to quickly populate a contact list for a team site if the information is already available in your company, for example as a distribution group. To follow this example, you will first need to create a contact list within Microsoft SharePoint. To do so from within a team site:

1. Click Site Settings → Create.
2. In the Communications category, select Contacts.
3. Enter “Team Contacts” as the name for the new list.
4. Click Create.
5. From within the “Team Contact list,” Click Actions.
6. Select Connect to Outlook.
7. Click Yes in the Outlook dialog to connect the list to Microsoft Outlook.

From within Microsoft Outlook, open your Outlook 2007 contacts. To add a contact to the SharePoint list, simply drag the contact from your contacts to the linked SharePoint contact list. You can select multiple contacts by clicking on the first contact, holding down the Shift key, and clicking on the last contact required. Then, simply drag the group across to the SharePoint contact list. This is a useful technique if you need to take your SharePoint information out on the road with you. The other major difference when using Outlook 2007 over previous versions is that you can update contacts directly from within Outlook 2007 or SharePoint and view the changes right away. When you are working with linked contacts, you will also find some new items added to the contact menu in Outlook, for example, Copy to My Contacts, which will copy the SharePoint contact to your local Outlook contacts. If the contact already exists, you will be prompted to update the contact details with any changes. Another example is Open in Browser, which will open the contact on SharePoint.

**Managing Your SharePoint Alerts from Outlook**

You can, as you know, sign up for alerts from within SharePoint, and with Outlook 2007 you can manage those alerts from the client. When you sign up for an alert within SharePoint, you will receive an email confirming that the setup has been successful. It is also possible to manage the alerts by clicking on the hyperlink provided in the confirmation email. Once the alert has been created, you can use Outlook, when connected to your site, to actually manage the alert. This example sets up three alerts on various documents and libraries within a SharePoint team site. To view your SharePoint Alerts from Outlook 2007, Click Tools → Rules and Alerts, and then click the Manage Alerts tab to view existing alerts. Figure 8-15 shows the Rules and Alerts dialog in Outlook 2007.
To manage the alerts from within Outlook 2007, click on an alert in the dialog, click Alert Properties, and then click Modify Alert in the Alert Properties dialog (see Figure 8-16).

You will be taken to the SharePoint site, and the Edit Alert page will be open and ready for any changes you would like to make. Clicking View Item will open the respective SharePoint library containing the item you have placed the alert on.

If you want to work with all of your alerts, simply click the “Go to the alerts management page” hyperlink to open the management page for alerts on your SharePoint site. From this page, you can manage multiple alerts. If required, you can also create a set of rules for the alerts you receive within Outlook 2007. For example, if it is important that you be immediately notified of an alert, you can add a rule that will display the New Alert Item window when an alert is received.

It is also possible to create a new alert on your SharePoint site through the dialog shown in Figure 8-16 using Outlook 2007. All you have to do is click New Alert and enter the URL of your SharePoint site.
Part II: From Desktop to Internet

Planning a Meeting

Outlook 2007 and SharePoint can work well together when you are planning a meeting and when you would like to create a meeting workspace for those invited. When creating the meeting invitation, you can also, at the same time, create a new meeting workspace, link to an existing meeting workspace, or create a workspace at a later date once you have the responses and are sure the meeting is actually going to go ahead. However, creating the meeting workspace at the point of invitation is a useful way to present agendas and other information to those invited.

When you create the workspace, the names of those invited will be added to the SharePoint workspace as attendees. In terms of site security, you as the meeting leader will have full control of the site, while your attendees will have contribute permissions. All of this is set up for you when you send the invitation. To create the invitation and the workspace from within Microsoft Outlook 2007:

1. Click New Meeting Request.
2. Enter the email addresses for those you would like to invite.
3. Enter the text of the email message.
4. On the Ribbon, click Meeting Workspace to open the Meeting Workspace task pane (see Figure 8-17).

Configure the Workspace

You have two options when working with the workspace in Outlook: Create a New Workspace or Use an Existing Workspace. When you open the task pane, if you have created a meeting workspace before, it settings will be set as the default settings. In this case, you will create a new meeting workspace. To continue:

1. Click Change Settings.
2. Select a Location using the Location drop-down list.
3. Accept the default language.
4. Select a workspace template using the Select a Template drop-down list. You can select from any of the standard meeting workspace templates.
5. Click OK to continue, and create the Workspace.

Figure 8-18 shows Outlook 2007 (the Ribbon has been minimized) once the workspace has been created. After that, you can send the email as normal. Note the link placeholder added to the body of the message into which you can add a description.

Within the meeting workspace, those you have invited will be added to the workspace as attendees, and as stated, will be given contribute permission to the workspace site. When they reply to the meeting request in any fashion, this information will automatically be added to the workspace.

You now have a central location within your team site structure to manage meeting and all up from within Microsoft Outlook 2007. If you are required to change the meeting request, such as change the time or location of a meeting, this information will also be updated within the workspace by SharePoint when you send an updated meeting request.

**Outlook 2007 and Workflow**

Outlook 2007 is also used to manage the information process associated with workflows within your team sites. Workflows will generally use Outlook to communicate status of the flow of process, that is, the start of the workflow, reminders for due dates, and any custom information processes you build into your own workflows. This example uses the document approval workflow to trace Outlook’s involvement in the process. In this case, you will start an approval workflow on a document. Once the
Part II: From Desktop to Internet

approval starts, the approver receives an email notifying them that the workflow has been started. If it has an associated task, an additional email will be issued notifying the approver that a task has also been assigned. The task assignment email will contain comprehensive information about the approval task. Figure 8-19 shows the email issued.

Figure 8-19

Clicking the Edit this Task button will open an additional form to allow you to add the information required by the task. Once you have approved the document, another email will be issued by SharePoint acknowledging that the process is complete. As you can see, it’s apparent that email, and in this case Microsoft Outlook 2007, is central to the entire process. Overall, you will find that Outlook 2007 is central to many of the communication features of SharePoint in both WSS V3 and MOSS 2007.

Saving Emails

It is possible to save emails and attachments directly into a SharePoint document library, if required. From the library, clicking the email will open it within Microsoft Outlook 2007. To save an email to a SharePoint document library, you simply perform a normal File ➔ Save As operation, selecting the SharePoint library required, and save the email. Remember to change the Save As type to Outlook Message format before actually saving. With attachments the process is identical: simply right-click over the attachment and select Save As, navigating to the required document library. Another approach is to save the email message onto your PC and then upload it to the SharePoint library. One advantage of this approach is that, if you have associated metadata in the library, you will be required to associate it with the uploaded message. This option will not be available using the File ➔ Save As approach. However, this is still a clunky process requiring a Save, Upload and then completion of the metadata. For example, the metadata could actually contain the text “business email,” which would make it easy to search for items with that value later.

258
These are fairly basic solutions to the issue of saving emails that contain business information to SharePoint team sites and, to be honest, they do just the job — it is what it is. However, SharePoint does provide you with a much more sophisticated method of dealing with emails. Your SharePoint administrators can actually set up your SharePoint lists and libraries to allow you and your colleagues to submit data and documents using your internal email systems. In addition to uploading documents to a library, for example, you would simply send an email to it containing the information you would like to add.

As discussed in the previous section, by using SharePoint it is possible to email-enable your document libraries. In this way, you can send an email directly to a document library. In order to email-enable your libraries, you will need to have access to several different systems, so this is a task normally performed by SharePoint system administrators. There is a considerable amount of setup required before you can submit email to a document library, but once it is configured, you can allocate an email address to a library or list, and you and your colleagues can send data directly from Outlook 2007 and other email clients. How to configure this service is outside the scope of this book and outside the scope of standard SharePoint users. It really is a job for system administrators to carry out. Once the background work has been carried out, you will have the option when creating a document library to enable the library to receive emails. Just to restate: The email settings must be configured on your SharePoint installation by your server administrators before you can enable a library to receive emails. This section outlines how to configure the library once this has been done.

To enable a document library to accept email messages you should select “Enable this library to accept emails” when you are creating the library in your site. Once this is done, you need to set some additional options. To continue with this example, you must also have the appropriate permissions to configure the list or library.

2. You will have a new section, Communications.
3. Select the option “Allow this library to receive emails.”
4. Enter in a new email address for this library. This will usually be the library or list name.
5. In the E-mail Attachments section, specify how this library will deal with attachments: save in main library, save in folder grouped by sender, or save in folder grouped by subject.
6. Click Yes in the next section if you would like to save the original EML file for the message. (.eml is the extension used when saving an Outlook email file.)
7. Click Yes in the next section if you would like to save meeting invitations in this library.
8. Select “Accept email messages based on document library permissions” in the Security section.
9. Click OK to save your preferences.

Pay particular attention to whom you set up email lists to accept messages from. It is better practice to ensure that you only accept messages from within your own company or selected individuals as opposed to setting the security option to accept any emails. Your SharePoint administrators can also ensure that they have set options within their control to only allow email to be sent to the SharePoint server from specific email servers. If that is the case, you could relax the security option in the document library if it is appropriate; for example, if you would like anyone within your organization to be able to email a particular list or library.
Part II: From Desktop to Internet

Now that the configuration has been completed, your library (or indeed your SharePoint list) is ready to receive emails from your colleagues. (You can send email form any email client, and you are not restricted to using Outlook 2007). One immediate use for emailing lists springs to mind, discussion lists. Emailing email-enabling discussion lists would place SharePoint discussion lists on par with a standard Internet-based list server.

**SharePoint and RSS**

RSS is a way to connect to information from a web site that is continually kept up to date from the source. As new information is added to the RSS feed, your system will be continually updated. SharePoint can expose data as an RSS feed, which can be read by Microsoft Outlook 2007. For general use, there is an RSS Feed Web Part available that you can use to place an RSS feed on any page within your team sites. Using RSS, another approach is available within Microsoft Outlook 2007 — to receive information and data from your SharePoint libraries. To enable an RSS feed from your document library: Click Actions ➔ View RSS Feed, and then click “Subscribe to this feed.”

This will add the RSS feed to your Internet Explorer Favorites, and it will be available directly within the browser. Figure 8-20 shows the RSS feed for a standard SharePoint document library.

Clicking feed item name (TechEd Files) or the arrow, in this case beside my name, will open the Properties form in SharePoint for the particular item. Clicking the Windows SharePoint logo in this case will open the document library itself. You can sort the feed by Date, Title, and Author. Clicking the “View feed properties” link opens the property form for this feed, and you can choose how often the feed will be updated.

![Figure 8-20](image.png)

Because this chapter is about Outlook, you should be aware that you can also subscribe to a SharePoint RSS feed from that application. To begin the process:

1. Open a SharePoint document library.
2. Follow the previously outlined steps to create an RSS feed from the library.
3. Copy the URL to the clipboard.
5. Right-click the RSS Feeds folder.
6. Select Add a New RSS Feed.
7. Paste the URL created by SharePoint into the New RSS Feed dialog.
8. Click Add.

This will add the feed into Outlook 2007, and you should now see a list of the documents contained within the library. In this case, within the Outlook Preview pane, clicking View Article will open the Items Property form in SharePoint. When you click Send/Receive in Outlook, items within the RSS feeds folder will be updated with the latest information.

**RSS Settings for Document Library**

If you have the required permissions, you can customize how the RSS feed works for a particular document library. For example, you can decide which columns you would like to expose, in the RSS, to your colleagues. You can also choose not to enable RSS feeds on a list or library if you do not want this feature to be available on your sites. It is also possible to turn off the RSS feature for the entire site collection, so if this feature is not available on your sites, check with your site administrator. To view the RSS feed settings for a document library:

2. In the Communication group, select RSS Settings to open the RSS settings page.

   From the settings page you can:
   - Turn RSS feeds off or on.
   - Reduce the number of characters in multi-line text feeds to a sensible number.
   - Change the title and descriptions of the feed.
   - Change the default WSS logo used on an RSS feed.
   - Choose which List columns you would like to show in the feed.
   - Set the maximum number of items to appear in the feed.
   - Set the maximum number of days to include in the feed.
3. Click OK to close the Settings form and save the changes.

RSS gives you another way to make information that could be buried within your SharePoint lists and libraries available to colleagues within an organization. With little effort, lists and libraries can be kept up to date with a lot of the information held within SharePoint.

**Discussion Lists and Outlook 2007**

As with other lists in SharePoint, it is also possible to work with your discussion list using Outlook 2007. This is a more natural home for discussion lists than perhaps a document library. The discussion lists are connected to Outlook 2007 by selecting Connect to Outlook from the Actions menu. It has to be said that the visual experience when working with discussion lists is much better when you use Outlook 2007 as the interface to the list than when you work directly within SharePoint, and it is my own preferred method when using this feature of SharePoint. Other than managing the discussion list, I tend to use...
Part II: From Desktop to Internet

Outlook almost all the time. Figure 8-21 shows a discussion group in Microsoft Outlook 2007, and I am sure you will agree that it is a lot more visually appealing than the standard SharePoint look and feel — even though from the image you can see I am talking to myself.

To reply to a post from within Outlook:

1. Double-click the post title to open the message.
2. On the Ribbon select Post Reply.
3. Enter the text of your reply to the post.
4. Click Post to add your reply to the discussion.

As with most things in Windows, you can also right-click to find what you’re looking for: in this case, select Post Reply to Folder.

One of the major benefits when working with discussion lists using Outlook is that many of Outlook’s standard features are available to you; for example, the ability to search large busy discussion groups for messages, custom sorting and filtering of the discussion in Outlook, and the use of rich text. The message shown in Figure 8-22, even though it’s black and white, was authored using Outlook 2007 and contains some red text and a yellow highlight.

Of course, the same feature is available within SharePoint, using the rich text features of SharePoint lists. You can also, with a single click, add a discussion post to your Outlook to do list — just click the flag icon beside the Post button in Outlook 2007 and right-click to bring up the Context menu where you can set the to do item for the message. This menu offers you several options when working with discussion lists; all are standard Outlook options, many of which you can apply to the list. Figure 8-23 shows the menu in Outlook 2007.
The options offered in this menu, in particular the ability to search large discussion lists using the Find All menu item, are huge improvements over working on the SharePoint site.

Summary

In this chapter, you saw many of the features provided for use with email within SharePoint, both WSS version 2 and MOSS 2007. You looked at working with document libraries within Outlook 2007, managing Tasks and alerts, and working with meeting workspaces. You learned how you can use Outlook to work with your contacts stored on SharePoint team sites and how you could copy contacts from Outlook address books to your team site. Overall, this chapter demonstrated how email is used as the main communication tool in SharePoint to provide you with very extensive communication features both online and when you are on the road. The chapter finished by looking at how you can use RSS feeds to keep colleagues informed directly from within Microsoft Outlook 2007.

In the next chapter, you will investigate the integration between SharePoint and Microsoft Excel 2007 and see how you can work with data on both the desktop and via the browser.
Microsoft Office Excel 2007

After Microsoft Word 2007, Excel is perhaps the most-used application in the Office suite. It is used for everything from complex financial spreadsheets to workbooks that keep simple lists of inventory and other items that people need to keep track of. In this chapter, you will look at what’s new in Excel 2007, how it interacts with SharePoint, and in particular, how it interacts with Microsoft Office SharePoint Server (MOSS) 2007 and Excel Services. In this chapter you will also be investigating key performance indicators and how to display and work with them on SharePoint. This chapter will be using some features only available with MOSS 2007, and it will point out when something is not available to Windows SharePoint Server (WSS) version 3 users. Because this is a single chapter, it is assumed that you are familiar with the basics of Microsoft Excel 2007. Guidance is provided where something is a little out of the ordinary; otherwise, you will be pointed in the right direction in terms of Excel 2007 only.

Excel is a hugely popular program with a very wide user base ranging from normal everyday users to professional programmers. People use Excel for all sorts of things including creating databases to maintain information, as many find Access 2007 a little difficult to use or too restrictive in terms of design knowledge required. Users like this tend to use Access for its query tools, creating queries on data held within Excel and imported into Access 2007.

What’s New in Excel 2007

Just as with Access 2007, the first major change that hits you in Excel is the new user interface, particularly the Ribbon, which has been totally redesigned in this version. Just as in the other Office 2007 applications, features have been added to Excel to make it as easy as possible to work with SharePoint and distribute your workbooks using the web browser. New items have been added to the standard Ribbon menus, and just as with Access and Word 2007, you have a new file type. Again as with Access and Word 2007, you will need to be careful using the new file type if not all of your colleagues are using Office 2007 or indeed if everyone who will be accessing the
Part II: From Desktop to Internet

SharePoint site does not use Excel 2007. A compatibility pack is available from Microsoft, which will enable Office 2003 users to work with the new files types in Word, Excel, and PowerPoint, and it can be downloaded from http://office.microsoft.com/en-us/products/HA101686761033.aspx. It might even be a useful service to your colleagues to provide a link on the home page of your team site to the pack download with a short description, letting them know that it is available and what it is for. It has to be said that, in terms of SharePoint, there is not that much new in the Excel client, as the majority of the changes take place when working with Excel 2007 files on SharePoint.

There are several limitations on Excel 2007 files using earlier versions of Excel. For example, if one of your colleagues is using Excel 2003 and tries to open an Excel 2007 workbook in your site, they may find that unless they have the Office compatibility pack installed they cannot open the file, and even with the pack installed the file will be read-only. Therefore, the link to the pack and a note can help colleagues who maybe have not upgraded yet. However, strange as it may seem, there are also some features available in Excel 2003 that are no longer available in Excel 2007, such as the capability to synchronize data between Excel and SharePoint lists. This is no longer possible, as Microsoft Access 2007 is now the Microsoft preference for maintaining lists shared between the client and the SharePoint server. An add-in is available that provides this functionality back to Excel 2007 and can be downloaded from www.microsoft.com as part of the white paper entitled “Excel 2007 Add-in: Synchronizing Tables with SharePoint Lists.” The only major drawback to using this add-in is that you will need to save your Excel files as 2003 version files or the process will not work. Once you do that, you get back the ability to write to SharePoint lists from Excel 2007. Given that the add-in will be useful to many of you reading this, the following section covers some of the tools available when you are working with this add-in and SharePoint.

Installing the add-in is a straightforward process of downloading the file from Microsoft and running it on your PC. Full installation instructions are available from http://msdn.microsoft.com/en-us/library/bb462636(office.11).aspx. Basically, all that is required is that you download the installation file to your PC and double-click it to begin installation. Once the add-in is installed, you will need to make it available to Excel using the Excel 2007 add-in. Once it is installed, a new group, called SharePoint, is added in the Table Tools group, within the Design tab. It contains an option to Publish and Synchronize the file to a SharePoint list. When running the add-in, you will initially be prompted for the URL to your SharePoint site and required to enter a name for the list on SharePoint; include a description for the list and then simply click the Publish button.

Once you begin to make changes to your Excel sheet and want to synchronize those changes to the SharePoint list, simply right-click anywhere in the Excel table and select Table→Synchronize with SharePoint. The Refresh option on the Ribbon will also no longer refresh your data for you. You are forced to use this new item on the table menu to synchronize changes to the SharePoint list, which is not a great price to pay for the feature. Figure 9-1 shows the new table menu once you have installed the add-in. If you do not want to keep your changes, there is also an option to discard the changes made to the worksheet, which will replace any changes you have made on the Excel side with the original values held within SharePoint. When you save the file, remember that you must save it as a 2003 version Excel file or you will lose the ability to synchronize it to SharePoint. If you do try to save the file in the Excel 2007 file format, you will be given a warning. If you continue, you will lose the ability to synchronize the changes between the worksheet and SharePoint and will need to repeat the export and linking process.
The options provided by this menu but not already discussed allow you to:

- Add a totals row to the workbook.
- Convert data to named ranges.
- View details about the data connection being used.
- Break the link between the worksheet and SharePoint, and go directly to the linked SharePoint list to view or edit data there.

It is recommended to download and install the add-in because you never know when it will become useful, but remember the supported way to synchronize a workbook is to use Microsoft Access. That will require you to move your workbook directly into Microsoft Access 2007 in order to take advantage of the toolset available to you with that application. In saying all that, it is also possible that the synchronization functionality will be put back into Excel with a new release of Office in the future.

**New Menus**

You will find some new additions on the main Office menu item; however, what you see will depend on the version of Microsoft Office that you have installed. This little nugget of information caught me out recently when I was writing part of this chapter on a laptop and Excel Services Options disappeared. I wondered for a while where it had gone, and then realized I had Microsoft Office Professional installed. In order to use the Publish to Excel Services options discussed later in this chapter, you must have the Office Plus, Ultimate, or Enterprise Edition of Office 2007 installed. You can still publish your Excel workbooks to the server without these editions, but you will find the experience not as fine-grained as using one of the more advanced editions of Office 2007. The new menus are outlined in the following sections.

**Server Menu**

The Server menu offers the following options once you have opened a workbook from SharePoint:

- **Check Out**: If this is enabled within the document library the workbook is stored in, you can check out a document for editing. In this way, anyone else requiring the document will be informed that you already have it checked out.

- **View Version History**: If this is enabled within the document library, you can view the versions of the Excel document and open a version, restore versions if required, and delete versions of the document.

- **Document Management Information**: Open the Document Management task pane to work directly with many of the SharePoint site features. For example, you could interact with other
members of the site via instant messaging (if available) or email, view who’s online (if enabled),
view tasks from within the SharePoint site, see who has documents checked out, and directly
interact with documents available on the site. Normally, I would always open this task pane
when working with documents stored in SharePoint.

- **Excel Services Options:** Enables you to select which “bits” of your spreadsheet you would like
to expose on the server. This is discussed in detail later in the chapter. But for now you should
know that without these options you can only publish the entire workbook as opposed to being
able to publish named ranges or individual sheets, or being able to specify parameters for Excel
Services.

### Publish Menu

With Office Professional 2007, you have two options: Publish to a Document Management Server, which
will allow you to save the workbook to SharePoint, and Create a Document Workspace, which will
allow you to create a workspace on SharePoint for the document. With higher-level versions of Office
2007, you will have the additional option Excel Services, which will allow you to choose exactly what
you want to publish to SharePoint Excel Services.

### Workflows

The Workflows menu will allow you to create a workflow and associate it with the current workbook. This
option is not available with Office Professional 2007. You can choose from the Approval, Collect Feedback,
and Collect Signature Workflows available in a standard SharePoint document library. View Workflow
Tasks allows you to view any workflow tasks assigned to the document from the SharePoint site.

As you can see, there is not actually a whole lot that’s new from the client side of things when it comes to
Excel 2007 and SharePoint. The biggest change is on the server, and even then it’s only available to those
who have installed MOSS 2007 as opposed to WSS. From the client side, you need to be using Office
Enterprise, Plus, or Ultimate to interact with the new server features provided by Excel services. The rest
of the chapter will look at how you can interact with SharePoint, using the standard features available in
Excel 2007 and SharePoint, and also look at the new features provided by Excel Services on MOSS 2007.

### Importing Your Excel Worksheet to a Custom List

The first thing to look at in terms of bringing your data from Excel to SharePoint is simply importing a
set of data into a custom list within SharePoint. In this case, the process is driven from within your
SharePoint team site. Using a custom list will enable SharePoint to set the data types of the list according
to those already available in the Excel worksheet. This process offers you a very convenient way to move
your Excel data directly into SharePoint libraries. From within your SharePoint team site:

1. Click Site Actions ➔ Create.
2. From the Custom Lists category, select Import Spreadsheet.
3. Enter a name for the new list.
4. Enter a description for the new list.
5. Click Browse to navigate to the required Excel 2007 file, and select it for uploading,
6. Click Import. The required workbook will open, and you can then select the data to import
using the Import dialog.
Chapter 9: Microsoft Office Excel 2007

7. To continue, in the Range Type drop-down select Range of Cells.

8. In the Select Range text box, click the button on the right side.

9. Use the mouse to drag around the range of cells required.

10. Click the button below the Import to SharePoint dialog when you are done.

11. Click Import.

That’s it, you’re done. The range of selected cells will be imported into SharePoint as a new custom list. The only thing that is left to do is to customize the columns further. For example, you may find that text columns have a text size of 255 characters, which is usually too big for most people’s needs and will need to be changed by going into the list settings and changing the column property. Once your list is in SharePoint, you have access to the full range of SharePoint list features, including those related to security and the ability to add more columns to the list as required.

This simple approach could open the door to increased use of SharePoint to share Excel lists and other small tracking applications between team members. A lot of people keep a lot of personally useful business information within Excel 2003 and 2007, and this is one way to make it available in a safe and secure manner.

Export an Excel List to SharePoint

From within Excel 2007, you can also move a list to a SharePoint library, again a useful tool if you need to share information within your team. There is only one issue with this approach really, and that is you need to define the list as an Excel table. To define an Excel list as a table, click within any cell, click the Insert tab, and then click the Table icon. Your list will be formatted as an Excel table, and you will be good to go. During the export to SharePoint, the headers in the table will become column names within SharePoint provided you check the “My Table Has Headers” box when creating the table, and the data in the cells will become the list values. It is really worthwhile creating table headings, as if you do not, when you see the list in SharePoint, the columns will have names like Column1, Column2, and so on. This makes it really difficult to work out which column holds which value, and you will need to rename the columns anyway. Once you have a table of data, the Table Tools tab will become available. From within this tab (which to me seems to be a strange place to put it), you have the option to select Export the Table to SharePoint. To continue with the table selected:

1. Click the Design Tab within the Table Tools group.

2. Click Export.

3. Select Export Table to SharePoint List.

4. Using the Address drop-down list, select the URL to the SharePoint site or enter a new address. You can create a read-only connection to SharePoint by checking the “Read Only Connection” box. This could be important if you need to make the changes in SharePoint available back in Excel. But remember that changes in Excel will not appear in the SharePoint list no matter what you check here. It’s also worth noting that changes you make to the local Excel 2007 worksheet will be overwritten if you click the Refresh icon.

5. Click Next.
Part II: From Desktop to Internet

6. Check and confirm the data type that will be used by SharePoint. If you don’t wish to confirm it, you can return to the worksheet and change the types. At this point, you will also see the proposed SharePoint column names.

7. Click Finish.

8. Click OK to end the process. Note that the URL to the list is also provided if you want to access the list on SharePoint at this point.

Once the list has been linked to SharePoint, you will notice that some of the options in the External Table Data group become active. These include the ability to refresh the data in the worksheet, to break the link between the local worksheet and SharePoint, and to work with the actual connection file properties. Figure 9-2 shows the group Ribbon item fully active in Excel 2007.

As you can see, this is a reasonably straightforward process when working from Excel, as the interface provides a simple set of prompts for you to respond to. You will find that the process from SharePoint is just as intuitive when it comes to exporting a SharePoint list to Excel.

**Export a SharePoint List to Excel 2007**

Almost all lists in SharePoint offer you the opportunity to export the list items to Microsoft Excel 2007 using the Actions menu. If your export to excel is based on a view you will download only the data exposed by your view definition. To open a list in Excel 2007, click Actions and select Export to Spreadsheet.

The main difference when exporting a list to Excel is that the list will not open immediately within the client. Before you can use the file you must download a set of instructions about the connection and the information you want to return to Excel 2007. In the case of Excel you must download a web query file. Figure 9-3 shows the dialog.
To continue with the download, Click the open button to open the file in Excel, or Save to download a copy of the query file to your PC. You may also at this point be given a security warning; in this case, click Enable to close the warning dialog and continue.

*Be careful of not becoming too quick with the mouse when enabling connection files downloaded from the web on your PC. Always be sure the connection or other information is coming from a trusted source before enabling it. Many computer viruses are spread this way and not everyone reads the prompts and messages on computers.*

The query file contains all the information needed to connect to the SharePoint server and return the details of your request within Excel. If you save the file down to the PC you will not see an Excel icon but rather a query file icon as shown in Figure 9-4. To open the file and view your list information in Excel double-click the Icon and click OK in response to the Security Alert.

![Figure 9-4](image)

When downloading a file to Excel the options you are offered different depending on whether Excel 2007 is open on the client PC or not. If Excel is open, you’ll be offered several options via the Import Data dialog. You can choose to open the data as a standard table, a pivot table report, or a pivot table chart and report. You can also choose where in the open worksheet you would like to place the report or even place it into a new worksheet or workbook. The choice you make depends on the data you are bringing down from the server and how you would like to analyze it. For example, if you were downloading the results of a SharePoint survey, you could open it in a pivot table report to help you analyze the responses. In the background the query file is still saved as a connection for the workbook. If Excel is closed, your list data will be downloaded and opened as a standard Excel 2007 table.

If you remember the foregoing discussion, the data is not linked to SharePoint, and as a result any changes you make to the exported list will not be reflected in the SharePoint copy unless you have downloaded and installed the add-in discussed earlier.

**Hyperlinks in Lists**

If any of the columns within the exported SharePoint list act as hyperlinks, they will retain that capability when you view them in Excel 2007. Clicking on a hyperlinked item in the workbook will open the file located in the SharePoint site in its client application. For example, if the link is to a Microsoft Word 2007 document, the document will open within Microsoft Word 2007.

**Excel Services in MOSS 2007**

As already stated, Excel Services is a component of Microsoft Office SharePoint Services 2007 and is not available to those of you running WSS version 3 only. Excel Services provides the engine required to display and interact with Excel files within a web browser once the file has been saved into a SharePoint library. There are multiple configurations that need to be enabled by your SharePoint administrators before you can use Excel Services, and you should discuss your requirements with them; for example, which document libraries will you use to store and interact with Excel Workbooks within SharePoint. The closer you work with your SharePoint administrators, the easier it will be to enable and get Excel Services up and running to meet your needs and the needs of your team.
Part II: From Desktop to Internet

Limitations

There are many limitations to Excel's use via a web browser and the bottom line is that this is not Excel 2007 on the desktop so you will be restricted in what you can do with your workbooks. The limitations include:

- All workbooks are essentially read-only.
- You cannot create a new spreadsheet from the web interface; you must use Excel 2007.
- Worksheets protected with information rights management cannot be used.
- Complex pivot tables cannot be used.
- Spreadsheets that use add-ins cannot be loaded by Excel Services.
- Any sheet that included embedded image files, shapes, or Word art will not be loaded.
- Sheets that use embedded clip art, auto shapes, or clip art will not be loaded by Excel Services.
- Workbooks containing VBA code will not be loaded by Excel Services.

As you can see there are some limitations to working via the browser. A strange thing is that for many of these features and for many users of Excel 2007 and SharePoint, Spreadsheets with Google work just fine. However, recently Microsoft announced that a new release, Office Web Applications, will have almost full authoring capability via the browser. (Just goes to show that sometimes they actually do pay attention to their customers.)

Things to Do in SharePoint to Stop Your Head from Melting

There are one or two things you need to remember to do in SharePoint before you start working with Excel Services. If you don't do them, you can end up going around in circles trying to work out what you have done wrong.

- Make sure that your SharePoint administrator adds your SharePoint libraries for workbook storage to the trusted locations for Excel Services, or the process just will not work.
- If you are going to be creating your own connections to corporate databases, speak to your database administrator to get the security model correct, or it will not work.
- Save your Excel workbooks using the new Excel 2007 file types, or again it will not work.
- Set up your document library to open the workbooks in the browser.
- Remember to approve the connection when you move it to the SharePoint Server.

(For information, “head melting” is a common term in Belfast for something or someone that drives you totally mad with frustration.)
Publishing Excel 2007 Files

In this first example, you will work from within Microsoft Excel 2007 and publish a workbook to your SharePoint site. Remembering the previous advice, make sure that the document library you are saving into has been added to the trusted locations for Excel Services by your SharePoint administrator. In order to follow this example, you will need a sample workbook containing some data. It does not have to be anything complex, as at the moment you are mostly interested in learning how to move the workbook to your sites. Before moving the workbook to SharePoint, you need to consider if you want any of the cells within your workbook to be editable on the server. In order to edit a cell on the server, it must be named. To name a cell, click on the Formulas tab and select Define Name in the Define Names group. By default and intention, all the workbooks you move to SharePoint will be read-only. Even using this method does not give you a fully editable workbook, as this approach is really intended to allow you to pass parameters used within the workbook for calculations.

In order to truly edit the data contained within a workbook, it will need to be downloaded to the local PC and the changes made there. To continue, you will firstly create a workbook in Excel 2007 that contains details of sales by region. You will then create four named ranges to use on the server to demonstrate parameters, and finally you will publish the workbook to the server and interact with its features via the web browser. To continue, you will create the workbook shown in Figure 9-5, which outlines a simple revenue statement. To continue, open a new workbook in Excel 2007, and:

1. Click in Cell A1, and enter the title text Quarter 1 Sales.
2. Enter the header text into cells A3 to A8 (Region, North, South, East, West, and Total).
3. Enter the column headers into cells B3 to F3 (Men, Women, Boys, Girls, and Regional Total).
4. Enter the following formula into cell B8: \( \text{SUM(B4:B7)} \).
5. Copy the formula by clicking in cell B8 and selecting Edit, Copy from the main menu.
6. Paste the formula into cells C8, D8, E8, and F8. This formula simply totals up each column.
7. Enter the following formula into cell F4: \( \text{SUM(B4:E4)} \).
8. Copy the formula into cells F5, F6, and F7.
9. Enter a set of sales data into the workbook. Once it has been saved, it should resemble Figure 9-5.

Figure 9-5
Part II: From Desktop to Internet

Creating Parameters

In this case, you will create parameters to allow you to enter sales figures for North Boys Sales, South Boys Sales, and East Boys Sales within SharePoint. While a simple example, this will demonstrate some of the features of Excel Services.

1. Click in Cell D4, and enter the following: =D10.
2. Click in Cell D5, and enter the following: =D11.
3. Click in Cell D6, and enter the following: =D12.
4. Cells D10, D11, and D12 will become the input cells once the workbook is saved in SharePoint. It’s useful to enter a description to the left of cells D10, D11, and D12.
5. To continue, click in cell D10.
6. Click the Formulas tab.
7. Click Define Name, and enter North into the dialog.
8. Repeat the process for D11 and D12, naming them accordingly.
9. Click the Office button.
10. Select Publish.

Before publishing the workbook to SharePoint, you need to set up parameters.

1. Click the Excel Services Options button. Figure 9-6 shows the resulting dialog.

![Figure 9-6](image)

2. Click the Parameters tab.
3. Click Add.
4. Select the three parameters by checking the box beside each parameter name.
5. Click OK to close the dialog.

The Excel Services Options dialog also offers you various ways in which you can save your file to the server. You can choose to display:

- The entire workbook.
- Individual sheets from within the workbook.
- Particular items within the workbooks, such as all the named ranges defined previously, individual charts, tables, or pivot tables.

6. Click Save to complete the process and view the workbook on the server. Figure 9-7 shows a similar workbook with parameters in SharePoint.

![Figure 9-7](image)

To the right of the workbook, you will find the Parameters tool pane into which you can enter the values for North, South, and East. Once you have entered the parameters, click Apply to see the changes applied to the workbook. Note that the workbook itself is still read-only and that parameters must be entered via the Parameters tool pane. Granted this is a basic example to illustrate the point, but think if you took the concept further into the world of complex what-if analysis, which can now be performed on SharePoint using a web browser and Excel Services. The next example will use a Microsoft Excel 2007 pivot table saved in the SharePoint library to demonstrate some of the drill-down features available using Excel Services.

### Using a Pivot Table in the Browser

This example uses a set of data taken from the Northwind 2007 sample Microsoft Access database, which provides details of customer orders, including the employee who dealt with the order. To produce this example, execute an existing query in Microsoft Access 2007 to return the records required. Once you execute the query, simply copy and paste the result set into Microsoft Excel 2007. Within Excel, click within the table and click the Insert tab and then the pivot table icon. Figure 9-8 shows the pivot table within Microsoft SharePoint, containing all the interactive features you will be familiar with from using pivot tables in Excel 2007. For example, you can expand and contract the Employee group to drill down into the sales figures for each employee by customer. This example demonstrates three areas: using Access to grab a snapshot of data, (a snapshot is a set of data fixed in time), simply coping and pasting data between Access 2007 and Excel 2007, and then making that data available via the Internet.
Part II: From Desktop to Internet

This example uses an existing query within the Northwind database and copies its result set to Microsoft Excel 2007. To continue, first you will need to execute the query in Northwind. To do so, with Access running:

1. Double-click the query named Order Summary to execute it.
2. Copy the result set of the query and paste it into Microsoft Excel. To copy the results, simply select all the records using the mouse and select Edit → Copy, and in Excel select Edit → Paste.
3. Click within the data table you have pasted into Excel.
4. Click the Insert tab.
5. Click the Pivot Table group on the Ribbon, and select Pivot Table.
6. Click OK in response to the Select Range dialog, as your table will already be selected by default.

In my case, I am using the dataset copied from Northwind, and you may need to change the following selection if you are using a different dataset.

7. In the Pivot Table field list, click “Choose fields to add to report,” move the mouse over the Employee field, and drag it down to the Row Labels box.
8. Repeat this action using the Company field.
9. Drag the Order Total field into the Values box.
10. Click the arrow in the Values box, and select Value Field Settings.
11. Select Sum in the Summarize Value by Group.
12. Click OK.

Your pivot table should resemble Figure 9-7 shown earlier.
That’s most of the hard work done, and you now have to publish the file to a SharePoint site with Excel Services enabled. To do this from Excel 2007:

1. Click the Office button.
2. Select Publish, and click Document Management Server.
3. Enter the URL to your document library into the File Name text box, replacing the default filename already entered.
4. Your library will open in the file Save As dialog.
5. Navigate within the dialog to the required library.
6. Enter a new name for the file, and save it to the library.

**Using SQL Server Data and Publishing to SharePoint**

In many organizations, you may find that you will not be using data held in a desktop database like Access but will be required to work with data held on other database systems. In the Microsoft world, the most popular of these databases will be SQL Server. For this example, you will be using a sample SQL Server database called Northwind. Yes, you guessed it — it’s the Microsoft Access 2007 sample database that I have moved to SQL Server for the example. Again, I picked this example because, even if you don’t have SQL Server available to you to test on, you will have the Access 2007 Northwind database available and the instructions, other than how you connect to the database, are the same. I will include the connection to Northwind Access 2007 version for those of you who need it. This example deals with creating database connections and storing them on the SharePoint server. Later you will be looking at storing connections on the server and using them in place. For those with access and permissions on a SQL Server, you can download an SQL Server copy of Northwind to save you from having to upsize the Access version. To download the databases simply do a search at [www.microsoft.com](http://www.microsoft.com) for “SQL Server example databases.” You will find versions for both SQL Server 2000 and 2005.

One important restriction with Excel Services and data held within databases is that you cannot just display a simple table of data; you must create a pivot table report.

For the next example, you will create the connection and save it to SharePoint to make it generally available to your colleagues.

When you are working with SQL Server during the connection process, you may be required to select a database. In many organizations, you will be given permissions to specific databases and this option to change databases may not be available. On occasion, I have also sent the connection dialog default to a database in SQL Server called Master. This is a system database and not generally of use to non-IT professionals. But it’s worth pointing out that during the connection process you may have to pay attention and remember to change the default database showing during the connection process.

**Creating the Connection**

First of all it’s highly likely that, rather than creating connections to systems within your workplace, you will simply make use of them. However, some of you may have permissions to carry out this task or indeed have databases of your own that you may want to make available to others in this way. Even without SharePoint, knowing how to connect Excel to databases is useful given the number of small Access databases there are in many organizations. Just as with most things computer-related, you will need specific permissions on the database in order to connect to and retrieve information for use in your
workbooks. You should contact your database administrator, who can arrange this for you for large
database systems like SQL Server. For small systems like Access, particularly if they are your own
databases, you should be good to go. To create the connection file to SQL Server 2005 within Excel
2007, create a new blank workbook and:

1. Click the Data tab.
2. Click the Get External Data Group, then click the From Other Sources icon.
3. Select the Data Connection Wizard from the submenu.
4. Accept the default connection type of SQL Server, and click Next.
5. Enter the name for your SQL Server.
6. Choose how you will log on — by using Windows Authentication, or a username and password
   if your system administrator has given you one.
7. Click Next.
8. In the drop-down list select the database required. In my case it’s the Northwind demo
database.
9. Select the table required — in this case, the Northwind Orders table.
10. Click Next, and complete the next screen with the connection details. If you are moving this
    connection to SharePoint, you need to be clear about its name and description. Figure 9-9 shows
    the connection dialog at this point on my machine.

![Data Connection Wizard](image)

**Figure 9-9**
11. Click on the button entitled Authentication Settings and note the title beside the button Excel Services.

This is where you specify the security model to use when your colleagues open this workbook from SharePoint. Normally, the default, Windows Authentication, is okay, provided the accounts have been added to SQL Server. You have other options, such as SSO, or Single Sign On, which is another system that can be used to authenticate users.

12. Accept the default, including the check box “Always attempt to use this file to refresh data,” and click Finish.

That’s it — you have created your first connection to an SQL Server database and requested table data. The next dialog you will be looking at asks you how you would like to have the table data presented.

1. Click the Pivot Chart and Pivot Table Report radio button, as in this case we would like to do a summary report of the order placed by city.

2. Click OK.

3. In the PivotTable Field list, check ShipCity.

4. Check OrderID.

Instantly you should have an order summary by city and a corresponding chart, as shown in Figure 9-10, placed into the workbook.
Part II: From Desktop to Internet

Other Database Types
You will have noticed that there are additional database connections offered to you in the connection dialog. The basics when you are working with another database system are much the same. Basically, you need to know the name of the database server or data source, you will need a username and password to connect to the database or data source, and you will need specific permissions on the object you want to retrieve.

You need to remember that this data is dynamic and as your SQL Server order-processing system is updated and edited, your data will reflect these changes. At this point in the process, you have created the Database Connection file and the associated workbook saved in the new Excel file format.

That type of connection, retrieving data from a specific table, is useful but very inflexible. What if you want to see a subset of data, or, for example, customers and the orders they have placed. Again, Excel 2007 will allow you to create a data connection that will return these values to the worksheet. In this example, you will create a database query that returns customers and the orders they have placed, which would be more typical of the information you may require. I am basing this on a real-world example of how this would actually be done, as opposed to how many books would say it’s done. When working with data in SQL Server, it’s highly unlikely you would be given free reign to write your own queries. What would happen is that a query would be created for you and you would be given access to it. That way the database security is maintained, and you only get access to data in a controlled way. In SQL Server techie language, you would be given access to either a stored procedure or a view that returns the data you wanted. What you then need to do is to use an often overlooked tool in Microsoft Office to actually execute the stored procedure and return your data to Excel 2007. That tool is Microsoft Query, which is very similar to the Query tool in Microsoft Access.

Using Microsoft Query
To create the query and return the data to Excel 2007:

1. Click the Data tab.
2. Click the From Other Sources icon.
3. Click From Microsoft Query.
4. In the Choose Data Source dialog, choose New Data Source.
5. Click OK.
6. Enter a name for the data source.
7. Select the SQL Server driver from the list available.
8. Click Connect.
9. Enter the Server Name.
10. Check that you are connecting to the correct database, and if you are, click OK three times.
11. Click on the Customer Table and expand it.
12. Select the Address field, and move it to the columns in the Query box by clicking the right arrow.

280
13. Click Next three times.

14. Select View Data or Edit Query in Microsoft Query.

15. Click Finish. Microsoft Query will remain open and display a list of Customer Addresses.


17. Click OK in the Import Data dialog to import the data into Microsoft Excel 2007.

With very little effort you can create and populate Excel workbooks with up-to-date data held within your business systems. I should point out that, if you can program using Excel VBA code, this would be a better approach to connecting to the database and populating your workbook. The idea here is again to make data available to you no matter where it is located, and again this is the sole purpose of SharePoint.

There is another important object you can use when working with data held on a corporate system: Views.

Server Views
A view is a virtual table that is created by the database upon request and can contain data from multiple tables. For example, if you wanted to see a list of all customers whose orders had been shipped, you would need to access data held in two tables: Customers to get the name of the customer, and Order to return the shipped date. This could be created on SQL Server as a view and you could then create a data connection to that view. When you are creating the connection, the view will appear in the list of tables available to you to choose from. The process to bring the data into your workbook is identical to that already discussed when working with tables directly. The drawback here is that you will need your SQL Server or other database administrator to create the view for you first. However, this could be a much simpler approach than using Microsoft Query.

Moving the Connection to SharePoint
Up until this point everything has been locally saved on your PC, and the Data Connection file is saved in a folder on Vista called My Data Sources. Moving the data connection file to SharePoint is just like uploading any document within a library. If you have the MOSS reporting site available, you will find that a Data Connection library already exists and you can upload the file there. If you prefer, you can create a new library within your team site, choosing the Data Connection template if the connections are only for the use of your team members. Remember, when you upload the file, to approve it once it’s in the library. By default, a Data Connection file must be approved within the library before it can be used. To create the library and upload the connection file from within your team site:

1. Click Site Actions.

2. Click Create.

3. Click Data Connection Library in the Libraries group.

4. Enter a name for the library.

5. Enter a description for the library.

6. Accept the default to have the library appear in Quick Launch.

7. Click the No radio button for the Version History.
Part II: From Desktop to Internet

8. Click OK to create the library.
9. From within your new library, click Upload.
10. Click Browse and navigate to the My Data Sources Folder, and upload the connection file required.
11. Open the document menu by moving the cursor over the filename.
12. Click Approve/Reject.
13. Select the Approved radio button.
14. Click OK to approve the connection file.

There is one more setting to make within the site. Return to the library you will use to store the workbooks from Excel 2007, and:

1. Click Settings.
3. Click Advanced Settings.
4. Select the radio button “Display as Web Page” in the Browser Enabled Documents group.
5. Click OK to save the setting and return to the library.

The Display as Web Page setting will ensure that any document (in this case your Excel workbooks) will open within the web browser as opposed to offering your colleagues the opportunity to download the file. The file is now uploaded and approved and ready for use by you and your colleagues. So, why have you actually done this? Generally, data connection files live on your PC, and you are the only person who has access to them. Now that you have moved the file to the team site, all your colleagues within the team site will have access to the file and any workbooks you create and save in the site. If your data is moved to another database, or indeed another database system, all that is required is for you to generate a new Data Connection file and all of your workbooks using that file will be immediately up to date. Now that you have the connection file loaded into your trusted Data Connection library in SharePoint, it is available to the rest of your team to use within their Excel workbooks.

**Using SharePoint Connection Files in Excel 2007**

When one of your colleagues needs to use the connection file to access data, he or she can connect to the SharePoint site. The process is almost identical to that used to create the connection file, except that on this occasion the data connection file will automatically pull the data down into the worksheet. The key to this is that everyone working with the connection will be working with the same set of data, which is shared among the members of the team. However, each team member can work with the dataset independently and either save the resulting calculations locally for their own use or save a new worksheet back to the SharePoint site or indeed to their own personal MySite. You can also, of course, use more than one connection in a workbook, and all the connection files will be stored in a single secure location. Figure 9-11 shows part of the screen that appears when opening a new connection file stored within a SharePoint connection library, in this case a connection file that will display all the customer orders from the Northwind database. To reach the shared connection library from within Excel 2007:
Chapter 9: Microsoft Office Excel 2007

1. Click the Existing Connections Group on the Excel 2007 Data tab.
2. In the Existing Connections dialog, click Browse for more.
3. Enter the URL of your SharePoint site into the file name text box in the Select Data Source dialog.
4. Click Open.
5. Select the connection to be returned to your Excel worksheet with the connection available.

You can also add the SharePoint site to My Network Places (Network Locations on Vista) and navigate to the connection from there. For those paying close attention to the image file in Figure 9-11, you may notice an additional item on the Look In menu, My SharePoint Sites. This is a little like My Network Places, but in this case this location is created and managed by Microsoft Office 2007 once you create a SharePoint MySite and will contain links to all the SharePoint sites of which you are a member. Office applications can run this process once per day, but to be blunt I have found it a little flaky and it does not appear to keep things totally up to date. Figure 9-11 shows the dialog.

![Figure 9-11](image)

Adding a data connection within Excel 2007 and SharePoint is a powerful way to make use of and share corporate data in a very controlled manner. SharePoint offers you the opportunity to make a central pool of connections to corporate databases available to your colleagues within the enterprise. At the web page level, SharePoint also provides a set of Web Parts that you can use to display the data being returned.

**Excel Web Part**

The Excel Web Part is available in any team site within SharePoint and can be placed on any page. It is commonly used within the context of a business reporting area but is not restricted to this use. This is a useful approach if you would like to display reporting data within your team site or reporting infrastructure. The examples will display an Excel workbook stored within your Excel document library. The first example will display the actual data within the Excel Web Part, and the second example will display a chart from the same Excel sheet. Also, create a document library called Excel Examples in which to store all of the example workbooks. In addition, set the workbook template to Excel 2007 file types to ensure that all the files within this library are viewable in the browser. (See Chapter 6 for more information on library templates.) To continue from within a team site:
Part II: From Desktop to Internet

1. Click Site Settings.
2. Select Create.
4. Enter Excel 2007 Examples for the page name.
5. Select the second template in the list for this page.
6. Change the library to your Excel Example library, using the drop-down list.
7. Click Create.
8. Using the Left Column Web Part Zone, click Add a Web Part.

Figure 9-12 shows the Web Part once it has been added to the page. Note that the Web Part in design mode has two hyperlinks, “Click here to open the tool pane,” which will open the Configuration tool pane for this Web Part, and a link to SharePoint help, which opens in a new window at the correct topic.

![Select a Workbook](image)

Figure 9-12

Click the hyperlink within the Web Part to open the tool pane to configure the Web Part. There are several options available to you within the tool pane, grouped according to category.

**Workbook Display**

- **Workbook**: This is where you select the path to the workbook to be displayed within the Web Part. To navigate to the correct library and file within the server, click the Select a Link button to the right of the text box.

- **Named Item**: In this text box, you can add in a named range you would like to be displayed by the workbook when it loads in the browser.
Chapter 9: Microsoft Office Excel 2007

- **Rows**: Number of Rows from the Spreadsheet to display.
- **Columns**: Number of Columns of the Spreadsheet to display.
- **Tool Bar and Title**: Generate the title of the Web Part based on the workbook being displayed. If you want to replace this with your own custom title, uncheck the box and add your own title.
- **Auto Generate the Web Part URL**: This will generate a URL that, when clicked, will open the spreadsheet in the full window.
- **Type of Toolbar**: Standard SharePoint toolbar options.
- **Toolbar Menu Commands**: Choose to display or hide different toolbar menu options. This is discussed shortly.

**Navigation and Interactivity**

- **Workbook Navigation and Interaction**: The default is to allow navigation within the workbook. Uncheck the box to ensure that your colleagues cannot open additional sheets within the workbook. Uncheck Interactivity to stop your colleagues from interacting with the workbook.
- **Interactivity**: This group deals with how you and your colleagues interact with the workbook. There are several options that can be activated or deactivated by checking or unchecking the item.
- **All Workbook Interactivity**: The workbook is basically read-only.
- **Parameter Modification**: Choose if your colleagues can use parameters with the workbook.
- **Display Parameters Task Pane**: Show or hide the Parameters task pane. Of course, if you hide the task pane, your colleagues cannot interact with the workbook.
- **Sorting**: This provides the ability to sort items in the workbook.
- **Filtering**: This turns filtering on or off.

**Pivot Table Interaction**

- **Periodically refresh if enabled in workbook**: Enable or disable the refreshing of external data used in the workbook.
- **Display Periodic Data Refresh prompt**: You can select Always, Optionally, or Never using the drop-down list.
- **Close Session Before Opening a New One**: You begin a workbook session when you open the workbook in SharePoint. Use the latest version. The session ends when you either refresh the workbook or close it. If during this session one of your colleagues makes changes to the workbook in Excel 2007, you will be unaware of this until you open a new session. This property ensures that your current session is closed before you can open a new one.
Part II: From Desktop to Internet

The remaining task pane options are the standard SharePoint options offered when working with Web Parts. Figure 9-13 shows the Excel Web Part once it has been configured within the page. In this case, most of the default options were left active. Within the Excel Web Part itself, you will see that there are a number of menu items available to you, provided that you have not turned them off in the tool pane.

![Figure 9-13](image)

**Excel Web Part Menu**

There are three menu items available to you when working with workbooks or sheets from within SharePoint.

The Open menu will open a copy of the current workbook in Microsoft Excel. It’s worth pointing out that if you have a workbook with several sheets and other items and you are, for example, only displaying a chart to your colleagues, they will have access to the entire workbook by opening it in Excel 2007. The Update menu contains the following options: Refresh Selected Connection, which will allow you to refresh a section of a pivot table; Refresh All Connections, which will refresh all connections in the workbook; and Calculate Workbook. When a workbook is uploaded to the server, the original author may set calculations to be manual, that is, the workbook does not automatically calculate values until told to do so. The Calculate Workbook menu option will calculate such workbooks for you. For example, you may be required to enter parameters into the workbook and then calculate its values. The final option, Reload Workbook, will do just that and reload the current workbook from its source.

**Using Filters with Excel Services**

The pivot table used in the earlier example and shown in Figure 9-7 was exported to SharePoint and did not contain any filtering capability. However, if you add filtering to the spreadsheet while working in Excel 2007 and upload it back to SharePoint, you will find that the full filter feature is now available to you within the browser. Figure 9-14 shows the same spreadsheet shown in Figure 9-13, only this time it has had filtering enabled within Excel 2007, and it was saved back to the SharePoint library. In this case, because this sheet contains almost entirely numerical data, you have access to numeric filters. You will notice that you don’t have the full filtering features as available on the Excel client, but you do have a decent range of options within the browser.
Filtering Using a Document Library Web Part

In this example, you will display a list of your workbooks and allow your colleagues to select the workbook they would like to see within the Excel Web Part. This is a useful technique that allows you to present this type of information. In general, you will have a document library that is specifically used to store all the workbooks for your team. This library will have been added to the trusted sites by your SharePoint administrator and will be available for use. To continue you will need to create a new blank Web Part page called Excel Choice. This example works better if you select a template that allows you to place Web Parts side by side. To continue:

1. Click Add Web Part, and select your Excel Workbook Library.
2. Click Add Web Part, and select the Excel Web Part.

Your first Web Part should be displaying a listing of all workbooks within the library. The second Web Part, the Excel Web Part, will be displaying nothing. Usually at this point, you would configure the Web Part to display a workbook. However, this time you are going to pass the URL to the workbook from your Excel library to the Excel Web Part. The Excel Web Part will then display the chosen workbook. To continue, in the Excel Library Web Part:

3. Click Edit Connections Provide Row To, and select your Excel Web Part.
4. In the Choose Connection dialog, choose Get Workbook URL From.
5. Click Configure.
6. From the Field Name list select Document URL. This is the item you will pass to the Excel Web Part.
7. Click Finish.
8. Exit Edit mode to return to the page.

Figure 9-15 shows the results of selecting a workbook from the library and its display in the Excel Web Part.
Part II: From Desktop to Internet

Selecting a worksheet in the Shared Documents Web Part passes the document URL to the Excel Web Part, which will then display the required workbook. This gives you a nice dynamic display of your workbooks within the browser. Your colleagues also have the option of opening the workbook directly in the browser by clicking the workbook link directly.

Filtering Using Web Parts

In this example, you are going to add two Web Parts to a SharePoint page and use the text filter Web Parts to pass values to the Excel Web Part. You or your colleagues can enter a text value into the filter Web Part and display the corresponding range of values from within the workbook on the page using the Excel Web Part. To start, you will need to create a new Excel 2007 workbook.

Enter into the workbook the data shown in the following table.

<table>
<thead>
<tr>
<th>Company</th>
<th>Total Orders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company A</td>
<td>2410.75</td>
</tr>
<tr>
<td>Company AA</td>
<td>1505</td>
</tr>
<tr>
<td>Company BB</td>
<td>15432.5</td>
</tr>
<tr>
<td>Company C</td>
<td>2550</td>
</tr>
<tr>
<td>Company CC</td>
<td>2905.5</td>
</tr>
<tr>
<td>Company D</td>
<td>4949</td>
</tr>
<tr>
<td>Company F</td>
<td>8007.5</td>
</tr>
<tr>
<td>Company G</td>
<td>13800</td>
</tr>
</tbody>
</table>

This is a simple dataset that will demonstrate the process. Once you have entered the dataset into Excel, you need to define each company row as a named range. To do this:

1. Select the company name and Total Sales cells for each company.
2. Click Formulas.
Chapter 9: Microsoft Office Excel 2007

3. Click Define Names.
4. In the New Name dialog, remove the underscore from the name, that is, change Company_A to CompanyA.
5. Click OK.
6. Repeat the process for each company in the list.

You now need to convert the list to an Excel Table:

1. Click Insert.
2. Select Table to convert the list to an Excel 2007 Table.
3. Using the Office menu, click Publish \ Excel Services.
4. Before publishing the Excel workbook, click the Excel Services button to open the Options dialog (see Figure 9-16).

![Excel Services Options](image)

Figure 9-16

5. Select Items in Workbook on the drop-down list.
6. Check All Tables and All Named Ranges in the dialog.
7. Click OK.
8. Save the workbook to your SharePoint library as CompanySales. Figure 9-17 shows the workbook open within Excel Services.
Part II: From Desktop to Internet

Note the All drop-down located to the right of the window. You will find that all of your named ranges previously entered into the workbook are now available as views on SharePoint using Excel Services. Selecting a named range from this list will only display records from that range. However, you are going to take this one step further and set up a filter to enable your colleagues to enter a company name to return this information. In order to do that, you will now create a web page and add in the required Web Parts. To continue from within your team site:

1. Click Site Actions.
2. Click Create.
4. Enter Company Sales for the page name.
5. Select Header, enter a footer, and 3 columns.
6. Select the approved document library, which has been added to the trusted locations for Excel Web Services.
7. Click Create to create the page.
8. Click the middle column, Add a Web Part Link.
9. Select the Excel Web Access Web Part, and add it to the page. The options for this Web Part were discussed earlier in this chapter. For this example, you need to link the Web Part to the Company Sales Excel workbook you have just saved. In the tool pane, enter All in the Named Item text box, then click Apply to view the workbook.
10. To continue, in the left column, click Add a Web Part.
11. From the filters group, select the Text Filter.
12. Within the text Filter Web Part, click Open the Tool Pane.
13. Enter Company Sales as the filter name.
14. Expand the Advanced filter section, and enter All as the default value. You will now set the filter connection between the Web Parts.
15. In the Text Filter Web Part, click Edit.

Figure 9.18 shows the screen at this point in the process.
17. Accept the default selection Get Named Value From.

18. Click Finish.

Exit Edit mode to return to the standard page view. Figure 9-19 shows the Excel Web Part using a filter value of ALL. In this case, toolbars were turned off within the Web Part to restrict colleagues to using the text filter.

While this is a multi-step process, it is fairly simple to use, and based on the information you would like to present, you can build highly interactive pages using a combination of filters and Excel Web Parts. For example, you could change the text filter to a choice filter, giving your colleagues a range of options to choose from. The main drawback of the text filter is it will not work if you misspell something.

To further enhance the information being shown, you can add a third Web Part to the page. This Web Part will display the actual products ordered by the customers. Using the same process already outlined, connect the Filter Web Part to this third Web Part. In this case, when you enter a company name into the text filter, you will see the total orders in the first Web Part and a breakdown of the products ordered in the third Web Part. Figure 9-20 shows the result of this process. You are displaying the Company Name cell just to illustrate the connection between the three Web Parts as the text filter is passed to both Excel Web Parts and displays the named ranges. You could further enhance the Products Web Part by adding in the actual sales of each product and, of course, you could also add an Excel 2007 chart.
Part II: From Desktop to Internet

The use of the Filter Web Part in combination with one or more Excel Web Parts allows you to build up a very flexible and informative picture of what’s happening, in this case with sales and customers, and provide access to this information to your team. The Excel Web Part allows you to make workbooks, spreadsheets, charts, or simply named ranges available to your colleagues in a controlled and secure manner. Using named ranges and filters increases the interactive nature of these objects, allowing you to create informative management reporting interfaces that are fairly easy to set up. The biggest hassle is actually creating the spreadsheet or workbook in the first place. In the previous examples, you created named ranges using small numbers of cells, but you can also create named ranges of larger cell groupings, such as monthly or quarterly sales, annual sales, and so on. Even if you do not use the filters, the use of named ranges and the ability of Excel Services to use them as a sort of list view also provides interactive features, again at little set up cost to you.

There are issues and limitations with Excel Services in this release of SharePoint but, as indicated by Microsoft, this will change with the next release. Not much comfort to those of us using this feature now but at least you have a way to share and control Excel information on the Internet without being a programmer. Just remember to have your SharePoint administrator set up the trusted locations for Excel Services before you begin, as this will save you a lot of work trying to find out why your information is not appearing.

SharePoint Reporting Site

MOSS 2007 contains a prebuilt site called Reports, which is used to demonstrate the features of Excel 2007 and Excel Services. A general reporting site is available within the corporate Internet portal template, and you can create custom reporting sites within your own team sites as required.

Because I am using a server belonging to my employer, Queen’s University Belfast, some of the pages in the screenshots may be customized in terms of look and feel. Functionality is the same as on any server running Excel Services.

The general Reports site is mainly aimed at a corporate level displaying information across the company. Your own reporting site can be used to build up a reporting system specific to your own business area, containing information of direct relevance to you and your colleagues. Figure 9-21 shows the home page of the Report site.
The main Dashboard page is constructed in much the same way as the example you have already created, and is based on an Excel workbook stored in the Reports Library Sample, which strangely enough (on my server) is actually an Excel 2003 workbook file, which you will be asked to convert to Excel 2007 when you open it. One of the main differences is that, in this case, a Choice filter is used. Clicking the Browse button opens a list of Account Representatives from which you can choose an individual staff member and pass the value to the various Excel Web Parts. The home page of the reports site also displays a key performance indicator (KPI), which can tell you at a glance how your team is performing against a set of indicators within SharePoint. Of course, the indicators used could also be taken from a corporate database and displayed via one of the KPI Web Parts. You already created a set of KPIs in Chapter 4 when you looked at Web Parts.

**Key Performance Indicators**

This example again uses a dataset from the Northwind Access 2007 example database. On this occasion, you will be using a query already in the database, called Product Sales by Category. You will simply execute the query in Access and copy and paste the values into a new Excel 2007 workbook. Within SharePoint you are going to create a new list for the KPIs and use the data within the saved Excel workbook to set up a KPI. You will, therefore, need to upload your workbook to a trusted library within your team site. Once you have this done, task 1 is to create the new KPI list:

1. Click Site Actions.
2. Select Create.
3. Select KPI List from the Custom Lists group.
Part II: From Desktop to Internet

4. Enter Sales KPIs for the list name.
5. Click Create.

Once you have the list created, task 2 is to create the KPI within the list. To continue:

1. Click the New menu, which will offer you a number of choices:
   - Indicator using data in a SharePoint List
   - Indicator using data in Excel workbook
   - Indicator using data in SQL Server 2005 Analysis Services
   - Indicator using data manually entered

2. Choose “Indicator using data in Excel Workbook” to open the new item, which is where you will configure this KPI. Enter the following details for the new KPI into the form:
   - **Name:** Enter a name for this KPI, such as Sales Targets.
   - **Description:** Enter a description for the KPI.
   - **Comments:** Enter additional information to describe the KPI.
   - **Workbook URL:** Use the Browse button to navigate to the workbook containing the data you require for the KPI.
   - **Cell address for indicator value:** Use the Browse button (Excel Sheet icon) to open the Configuration form shown in Figure 9-22. In this form, you will select the cell containing the main indicator values.
     - Indicator Value is the main value that you measure your progress against.
     - Indicator Goal is the value you would like to achieve.
     - Indicator Warning is the level that you are concerned about.

3. To continue, click within a cell and click the first Set button. This is the indicator value; set it to 1400.
4. Click in a second cell and click Set. This is the Indicator Goal; set it to 13800.
5. Click in a third cell, click Set, and set the Indicator Warning to 276. The three indicator cells will now contain references to the respective cells within the workbook.
6. Click OK.

Note that the cell values will be carried down into the Status icon section of the form. You could click the Excel icon to change the values at this point if required.

The remainder of the form contains two additional sections that need to be expanded, a details section where you can provide a link to a page containing additional information about the KPI, and an Update Rules section. You can set the value to be updated automatically for every user or provide for the value to be updated manually by the user via the Web Part.

7. Click OK to close the form.

At this point you have created a single KPI, and this is sufficient to demonstrate the process and the point. To continue with this example, you will need to add a KPI Web Part to a web page. It is assumed that you can follow the previous instructions to do this.

8. Once the Web Part is added to the page, click the Open the Tool Pane link.

9. For the indicator list link, navigate to and select the KPI list you just created.

The Change Icon drop-down located below the link address allows you to select the icon used to highlight your KPI within the Web Part. You can then choose to turn on or off various features of the Web Part, using the check box options also in this area.

10. Click Apply.

11. Click Exit Edit Mode to view the new KPI Web Part (see Figure 9-23).
Part II: From Desktop to Internet

Figure 9-23 shows the final Web Part displaying the KPI you created. You can, of course, continue to add KPIs to the list and have them appear within the Web Part.

Summary

In this chapter, you looked at the new features available in Excel 2007 when working with SharePoint. In reality, it was more a case of what’s missing. You looked at installing an add-in to bring back some of the missing functionality, and you examined importing and exporting data to and from SharePoint. You then looked at Excel Services, how to work with this new feature, and how to use data connections to access corporate data. It’s likely true to say that Excel Services is a first-version technology, but it does, as you have seen in the chapter, start you on road of exposing Excel data via the browser in a secure way to your colleagues. In the next chapter, you will look at add-ins for SharePoint, bits of software, both free and commercial, that bring added value to you when working with Office data on the web via Microsoft Office SharePoint Services.
Microsoft Groove is a strange program, and it’s difficult to see where it fits into the long-term SharePoint strategy, but it’s a good bet that you will see a lot more integration between Groove and SharePoint in the future. Microsoft Groove, like SharePoint is a collaboration environment that allows you to work with colleagues and others outside your business organization. Of course, as this is a SharePoint book, Groove works with documents held within SharePoint, both Microsoft Office Server 2007 and WSS version 3. Groove offers those who may not have SharePoint an alternative approach to collaboration and offers those with SharePoint another approach to collaboration, especially with others outside the corporate network and when they need to take document libraries offline, and perhaps with others outside their company. For those of you who use Microsoft Office Ultimate or Office 2007 Enterprise, you will have Groove 2007 as part of the Office 2007 suite; for those that don’t, it can be purchased as a separate product from Microsoft.

Once you create a new Groove account, you are ready to go with the software. The alternative is for a company or large enterprise to have total control over the Groove experience by running the full service as part of the corporate network, using Groove Server. This gives you total control and integration into your business systems. In this chapter, you will use Groove out of the box and see how it works both on its own and when working with information held within Microsoft Office SharePoint Server 2007.

A pointer to how Groove will fit into SharePoint can be seen in this question-and-answer session between Groove and SharePoint MVPs and Ray Ozzie from Microsoft. A full transcript of the conversation can be viewed at www.microsoft.com/presspass/exec/ozzie/04-17MVP.mspx, but overall Ray Ozzie was reasonably clear that the integration between Microsoft Office Groove and SharePoint will get deeper with future releases of both products. In my view, this means that any time spend working with Groove now will pay off for SharePoint in the longer term.
Part II: From Desktop to Internet

**Groove Server 2007**

In this chapter, you will be running Groove locally on your PC; however, an Enterprise version is also available, giving you total control over the Groove environment. Using the environment outlined in this chapter, the control is with you. There is no real central control over the use of the software nor is there any integration with your central security systems. Groove Server will reverse this and give an organization total control over how Groove is issued within the company, including full auditability of the environment and the activities taking place. The use of Groove Server also allows an organization to provide access to corporate data systems within the workspace environment.

---

**Groove 2007 Feature Set**

So what do you get when you run Groove? The following features are available as standard with Microsoft Groove 2007. It’s important to point out at this point that Groove 2007 needs to be installed on your PC in order for you to follow the examples and discussions in this chapter. Groove 2007 is a client application unlike SharePoint, which is a server application, and no install is required on your PC. However, if your company is running Groove 2007 Server, in order to totally control the experience, you will need to register an account with them, as opposed to registering with Microsoft as in the example in this chapter. The features available with Groove include:

- Workspace
- Presence Information
- Instant Messaging
- Integration with SharePoint
- Discussions
- Calendar and Meetings
- InfoPath forms
- Alerts

As you can see, there are a range of features that are very similar in nature to those that are provided with SharePoint, and that’s what makes it hard to figure out where Groove fits in relation to SharePoint.

**SharePoint Features with Groove**

If you are working with SharePoint and have Groove installed, you will find that Groove is also limited in terms of many features available to you in a SharePoint team site. There are several SharePoint features that you do not get with Groove 2007, including:

- No full integration with Microsoft Office 2007.
- No integration with SharePoint Designer.
Chapter 10: Microsoft Office Groove 2007

- 5000-document limit — recommended.
- All documents stored on the client PC.
- Maximum of 30 users per workspace.
- SharePoint blogs are not available.
- Document auditing is not available in Groove.
- Version history for documents is not available.
- No support for mobile devices.
- MOSS 2007 Enterprise Search is not available.
- MOSS 2007 Excel Services is not available.
- SharePoint Workflow not available.

However, this does not restrict you when using Groove because you can, as stated, integrate Groove with SharePoint, giving you the best of both worlds in terms of collaboration. It is probably best to use Groove for ad hoc types of projects when you may not need the full range of MOSS features and particularly when you need to collaborate with others outside your corporate network, such as external contractors or suppliers. In this case, using Groove can save a lot of time, particularly if you do not want to add external users to your internal security infrastructure. In the case of external users, you can add them directly into a Groove workspace without reference to your corporate IT teams. For example, they would not be required to add external users into your company Active Directory.

Another reason to use Groove is that you are mostly working outside your main location — if, for example, you travel a lot and need access to a collaboration environment or documents from SharePoint without having to worry about finding an Internet connection. Documents from SharePoint can be taken offline with Groove and resynched to the server when you return to the office.

Getting Started with Microsoft Groove 2007

How you run Groove 2007 depends on whether you already have the software as part of your Microsoft Office environment or you need to download a trial copy from Microsoft. You can download a free 60-day trial of Groove 2007 from http://us1.trymicrosoftoffice.com/product.aspx?sku=3082923 and install it on your PC. The rest of this section assumes that you have either installed the Groove 2007 trial copy or have Groove already available as part of Microsoft Office 2007. To get started with Groove 2007, click Start » All Programs » Microsoft Office, and select Microsoft Office Groove 2007. The Account Configuration Wizard will start up at this point:

1. Click the radio button “Create a New Groove Account.”
2. Click Next.
3. Click the radio button “I don’t have a Groove configuration code.”
4. Click Next.
Part II: From Desktop to Internet

5. Complete the registration screen.
6. Click Next.
7. Choose “no listing for the public Groove directory” using the drop-down list.
8. Click Finish. (You can choose to watch a “getting started” movie at this point if you like.)
9. Click No.

Groove is set up and configured, and the Launchbar should open. Figure 10-1 shows the Groove 2007 Launchbar open.

![Groove Launchbar](image)

**Figure 10-1**

This is the Groove Launchbar, which provides you with quick access to features of the program. For example, you will have access to multiple workspaces, the ability to invite colleagues to a workspace, to manage alerts for the workspace, and to message other members of your environment.

**Creating a Workspace**

The basic feature of Groove is the workspace. Think of this as your online desk, very similar to the SharePoint working space. This is the area where you will invite your colleagues to collaborate on documents and other work-related tasks. Before you begin you can create a new workspace.

1. Click the New Workspace hyperlink.
2. Enter a descriptive name for the workspace.
3. Choose the type of workspace required. Initially, this will be a standard workspace. Later this chapter will discuss workspace templates. You can also choose to share a folder on your PC as the basis for the workspace.

4. Click OK to finish and create the workspace.

Figure 10-2 shows the new workspace ready for first use.

Before looking at the various options and features in Groove, you will invite a colleague to join your workspace. To invite a colleague, enter an email address into the Invite to Workspace drop-down list and click Go. This will send an invitation to a colleague to join your workspace. Your colleague will receive an invitation email containing an attachment similar to Chapter10.grv. This is an actual copy of the workspace file they can install on their PC. They will also click the Accept hyperlink within the email body to let you know that they have accepted the invitation. Now that you have the workspace created and at least one other person as a member, you can look at some of the other features of the software.

**File Menu**

In common with other programs, the workspace File menu contains standard software options such as New, Open, and Close. It also contains several Groove-related options, the most important of which are:

- **Save Workspace As:** Allows you to save your workspace as a new template or as an archive file for backup purposes or if you are finished using a particular workspace.

- **Save Invitation As File:** Allows you to save the Groove workspace as an invitation file, which you could then email to several people or make available within a file share or Microsoft SharePoint list. All colleagues would be required to do is to install Groove if required and double-click the invitation file to join the workspace.

- **Delete Tool:** Delete various tools from your Workspace.
Part II: From Desktop to Internet

- **Delete Workspace**: Delete the workspace from your computer or all computers being used to host the workspace.
- **Rename**: Allows you to rename the workspace or tools associated with the workspace.
- **Properties**: Work with the properties of the workspace or a specific tool. Properties are discussed shortly.

**Options Menu**

The Options menu provides you access to various tools available within Groove 2007, including:

- **Send Message**: Send an email message.
- **Send Message to Members**: Send an email message to workspace members only.
- **Invite to Workspace**: Invite a colleague to your workspace.
- **Invite My Other Computers**: Create an invitation file for use on other computers.
- **Cancel All Pending Invitations**: Will cancel any pending invitations to your workspace.
- **Set Roles**: Each colleague within your workspace can be given a role. For example, the creator of the workspace will be in the Manager role, and those you invite will normally be added to the Participant role. The Set Roles option allows you change the role a user is associated with. There are three roles: Manager, Participant, and Guest.
- **Navigate Together**: Allows you to work in the same area as all other users within the workspace. For example, if you navigate to a workspace tool, all your colleagues will navigate to that same tool. If one of your colleagues navigates elsewhere, you will follow them.
- **Message History**: View all messages you have sent or received as part of your interaction with the workspace.

**Inviting Colleagues**

Of course, you will want other colleagues to join the workspace, and using Groove this is a simple process. When you receive a Groove invitation to join a workspace, you will find the Groove workspace file attached. If you already have Microsoft Groove 2007 installed, simply download the Groove file and double-click. Once you have been authorized by the workspace manager, you will be able to work within the workspace.

To invite a colleague to join the workspace in the Workspace Members pane, enter the email address of the colleague in the Invite to Workspace drop-down list shown in Figure 10-3.

![Figure 10-3](image)

Once your colleague has accepted the invitation, you will be notified and can then authorize that colleague to join the workspace. A Groove alert (see Figure 10-4) will pop up, asking you to authorize the acceptance.
Clicking on the hyperlink message will open a dialog where you can confirm acceptance of the invitation. Once confirmed your colleague’s name will appear in the Workspace Members pane.

**Workspace Properties and Permissions**

You can view the permissions individuals have within your workspace (if you are the Manager of the workspace) by looking at the properties for each member. In addition, you can configure other system features, such as alerts, on a per-user basis. This is in addition to the settings for the workspace generally. To view the properties for the workspace, click File ➔ Properties ➔ Workspace.

This will open the property sheet for the workspace, and you can view and set alerts, roles, and permissions. You can change an individual’s role within the workspace or change permissions for existing roles. For example, to view and change a user role within your workspace:

1. Click the Roles tab.
2. Click on a username.
3. Click Change Role to open the Change Role screen shown in Figure 10-5.
4. Select a new role for the individual.
5. Click OK to save the changes.

To view and change the existing permissions for a particular role, click the Permissions tab in the Workspace Properties dialog. You can add or remove specific permissions by checking or unchecking the box beside a permission. For example, for a participant the following permissions are available:

- **Invite**: Invite others into the workspace.
- **Uninvite**: Uninvite participants to the workspace.
Part II: From Desktop to Internet

- **Add Tool**: Add specific tools to the workspace feature set.
- **Delete Tool**: Remove tools from the workspace.
- **Cancel All Outstanding Invitations**: Cancel any invitation made to colleagues to join the workgroup.

You can add or remove permissions on a role as required by using the workspace properties sheet. You will also find that many of the tools available to you in Groove also have associated permissions that you can customize as required to meet your own needs. In this way, a colleague can have various permissions on the workspace itself and the individual tools being used.

**Workspace Tools**

In addition to the ability to share files, there are also several tools available within a workspace, and they can be made available as required. To view the tool set available, click Add Tools in the Common Tasks pane within the Workspace to open the More Tools selection dialog shown in Figure 10-6. Selecting a tool is simply a matter of checking the box beside the tool’s name.

![Figure 10-6](image)

Once added, the tool is available for use by you and your colleagues. The most useful tools are discussed in the next section.

**Calendar**

The calendar can be used to share any date-based information with those colleagues who are members of your workspace. To create a new appointment, double-click within the date required to open the Add Appointment dialog, complete the required information, and then click OK to save the event to the calendar.

Figure 10-7 shows the Add Appointment dialog open within the workspace. To view an event detail, you can either hover the mouse over the appointment to view a tooltip or double-click the event to reopen the Add Appointment dialog. If you need to select a range of dates, simply drag across the calendar.
using the mouse and create the event as outlined. One of the major drawbacks is that you cannot link to or use this calendar in Outlook 2007 without third-party commercial software.

As the workspace manager, you will have full permissions for the calendar. Participants within the workspace will, by default, be able to add an appointment, edit their own appointments, and delete their own appointments. Guests will, by default, have no permissions for the calendar. You can view permissions for the calendar by clicking File ➔ Properties ➔ Tool.

This will open the Properties dialog for the Calendar tool, and you can then click on the permissions to review and edit existing permissions if required. The Properties dialog also allows you to set the timing for alerts. To set alerts, click the Alerts tab, and use the slider bar to select an appropriate level for alerts — to be alerted, for instance, when new or modified content is available on the calendar. This will override the workspace generic settings for alerts.

**Discussion Tool**

The Discussion tool within the workspace is an online discussion forum which can be used by you and other members of the workspace to conduct online discussions.

To begin a new discussion:

1. Click New.
2. Select Topic.
3. Enter a subject for the topic.
Part II: From Desktop to Internet

4. If required, you can create a new category by clicking the plus (+) button beside the Category drop-down and entering a category. You can also add documents to the discussion by clicking the Attach button.

5. Once you have added your message, click Save.

Figure 10-8 shows a discussion within the Groove interface.

To reply to a discussion, click the item required and select New Response from the main menu. You can also add an attachment to discussion topics and responses by clicking the Attach button located on the reply form itself. This will open an Add Attachments dialog from which you can select the required file or files to attach to the discussion post. Figure 10-8 also shows the menu bar added to the response once you add an attachment. Using this menu bar, you can save the attachment locally, open the attachment in the client application (such as Word 2007), or delete the attachment. To be honest, the discussions within Groove are far more visually appealing than those in SharePoint, and it is a little easier to follow the topic because of the tree view layout of the lists. Groove discussions also include a search feature, both standard and advanced, allowing you to find information very quickly. Again, this is an improvement over the similar features in SharePoint. Using the advanced search, you can search by topic and response and build up AND/OR conditional searches. To open the Search form, click the Find icon in the main menu bar.

**Discussion Alerts**

Just as when working in the Calendar tool, you can also work with the properties of the discussion. You can set alerts on information you would like to be informed about changing, such as a particular subject you would be interested in. Alerts can be set at the workspace level or at the individual tool level. If you don’t set alerts at the tool level, you will inherit those set for the workspace as a whole. Alerts can be set
Chapter 10: Microsoft Office Groove 2007

The Discussion tool provides you with a basic way to begin to use interactive discussion forums within your workspace. The ability to search is a great benefit, helping you to find the information you need quickly. While not on the same level as Enterprise or Internet discussion groups, it does give you a good means of communicating among your team members.

Discussion Permissions

You can set up unique permissions for the discussion tool by opening the properties. Once you have opened the Properties dialog, click on the Permissions tab to view the permissions currently assigned to each group, Manager, Participant, and Guest. Generally, it’s reasonable to leave the permissions as they are by default. The only changes really needed are those to the Guest permission set, if you decide to use this user group. By default, a Participant within the Discussion tool can create, edit, and delete their own documents.

As you can see, the permissions are generally the same as the Calendar permission set, and you will find the process of setting permissions and options available to you much the same for each Groove tool.

Meetings Tool

The Meetings tool is used to organize and administrate meetings that take place within the workspace among the members. To add a Meetings tool to your workspace:

1. Click File → New → Tool, and select Meetings.
2. Click the New Meeting button.
3. Enter a subject for the meeting.
4. Enter a start and end date and time.
5. Enter the meeting location.
6. Enter any comments you may have re this meeting.
7. Click OK to save the meetings.

Figure 10-10 shows the new Meetings tool created within the workspace.
Part II: From Desktop to Internet

As you can see in Figure 10-10, there are several tabs located across the meeting profile: Attendees, Agenda, Minutes, and Actions. Clicking a tab will open the options for that particular area. If you need to edit the main meeting profile, just click the edit button.

Once you have the main meeting created, you can then begin to use the other features of this tool to add the support materials required.

- **Attendees**: The first thing you will want to do is to add those attending the meeting. To do so, click the Attendees tab and click Edit. Simply check the box in the Attendees group for each person attending the meeting. Once this is done, you can then use the Chairperson and Minutes-Taker drop-down lists to select the appropriate people for these tasks.

- **Create an Agenda**: To create the agenda, click the Agenda tab (clicking Yes if prompted to save the attendees), click New Topic and enter the details about the topic. Click OK to save the details. To create additional agenda items, simply repeat this process for each item in the agenda.

- **Minutes**: Click the Minutes tab and then click the Edit button. Click the Insert Agenda button to add the agenda items automatically to the minutes. Create the minutes by entering the details with each agenda item. Click Save (or save and close) to save the minutes.

- **Actions**: Click the Actions tab, and then click New Action Item and enter the Action Point details. Click OK to save the item when complete.

Figure 10-11 shows the screen when the agenda items have been added. From this point, it is simply a case of recording the notes under each agenda item.
As you may be able to tell, the features available with Groove to manage a meeting are very simple to use. Everything you need for the meeting is directly on screen, and it’s reasonable to assume that with the new release of SharePoint, you might see some of this simplicity ported over to the meeting workspaces.

**SharePoint Files**

One of the main reasons that many SharePoint users actually use Groove is to take SharePoint data offline and then synch it back to the main SharePoint servers. One of the other common uses for this tool is to provide access to SharePoint data in a controlled way to individuals outside your organization or colleagues who may be located in other countries. There are a couple of limitations when working with SharePoint. For example, metadata from SharePoint is not supported by Groove, and Views are not supported either. Other than that Groove provides an excellent interface when you are required to either work offline from your main SharePoint server or collaborate with colleagues outside the organization.

When working with SharePoint, you, as the manager, must have permissions on the SharePoint document library being used by yourself and the other members of your workspace. However, as long as one individual participating in the workspace has permissions on a SharePoint library, the documents can be made available to all participants.

**Connecting to SharePoint**

In order to work with a SharePoint document library, you must first run the SharePoint Connection Wizard. To do so, click File ➪ New ➪ Tool ➪ SharePoint Files, and then click the Setup button.

Once you have connected to your SharePoint site, the library will be downloaded to your PC. Figure 10-12 shows a SharePoint document library loaded into a workspace in Groove.
The files from the SharePoint library will also be available to those you have invited to the workspace, but you, as the manager and the person with the permissions within the SharePoint library, will have control over the information and its associated permissions, including the ability to synchronize the documents with SharePoint. Other members of the Workspace can request the ability to synchronize files with SharePoint, but it will be up to you to grant that permission. This is not something I would do. I would prefer to check that the files should be synched to the server before they actually are moved. This keeps the control with the person who holds the permissions on SharePoint.

If you look at the bottom of the tool in the workspace, you will see that information about the current synchronization state is constantly displayed, including the name of the person responsible for the process. The synch process can either be automatic or manual, and you can configure this from within the workspace tool. Clicking the Synchronization icon located beside the last synchronized date text will open the schedule dialog shown in Figure 10-13; from there you can set up the manual or automatic process.
Chapter 10: Microsoft Office Groove 2007

Clicking the Synchronize Now button located on the SharePoint files window will open the Preview Synchronization dialog from which you can immediately synchronize the files between the workspace tool and the SharePoint library once you have previewed any pending changes. As a member of the workspace, you can request permissions from the workspace manager to carry out synchronization.

**Editing a Document**

When you open a document for editing and save your changes, you will be prompted in Groove to save those changes back into the workspace. Clicking Yes will update the workspace with your changed document. If you are responsible for synchronization, you will be informed that there are unsynchronized changes in the workspace; other members of the workspace will not see this message. Clicking the Synchronize Now button will open a dialog to allow you to preview the documents about to be copied into your document library, and from here you can actually begin the synch process by clicking Synchronize Now.

**Checking Documents In or Out**

If your document library requires that files be checked out, then this feature will also be available in Groove and reflected within the document library. To check out a file, select the file you want to check in or out, and on the toolbar, click the Check Out icon. Figure 10-14 shows the resulting menu for check-out.

![Figure 10-14](image)

Figure 10-14

Figure 10-15 shows the result immediately available within your document library in SharePoint, indicating that the file has been checked out.

![Figure 10-15](image)
Part II: From Desktop to Internet

This is a much improved process over using Outlook 2007, for example, to take documents offline. Once the file is checked out, you can check the file in or discard the check-out using the Check In/Out icon on the menu.

Local Files and Folders

In addition to SharePoint files, you can also choose and share a local folder from your PC within the workspace. To share a local folder with your workspace team:

1. Click on the Files icon located at the bottom-left corner of the workspace.
2. Click Add Files.
3. Select a file or files to share with your team.

Figure 10-16 shows a set of local files being shared in Groove. Note that a subfolder has been created by right-clicking within the folder and selecting New Folder.

You can create new files within the tool by right-clicking within the file pane and selecting the file type (a new Word document or an Excel workbook, for example) required from the context menu. Just like the other tools within the workspace, the Files tool has its own set of properties that you can edit, including setting alerts and permissions.

Using Instant Messaging in a Workspace

When you have added some users to your workspace, it is also possible to instant message (IM) them using the built-in chat feature. To open the chat window, click the Chat icon in the Workspace Members pane. This is shown in Figure 10-17. The chat window opens, and you can then simply select a member of the site and begin chatting.
Figure 10-18 shows the chat window open and ready for use.

As you can see in Figure 10-18, the status of each member is shown. In this case, I am in the workspace, one user is online but not within the workspace, and two users are offline. When using Conference mode, audio is also available within the workspace. For management purposes, you can also record a transcript of the chat for future use.

**Issue Tracking**

The Issue Tracking tool is a fairly complex interface used to manage any sort of traceable issue you may have, such as a simple help desk application. It is a good example of what can be done using the Forms tools in Groove to build your own tools. Again, this is useful when you are working on a project and need to trace who is doing what. Before using the Issue Tracking list, you need to set up some values. To create an Issue Tracking list, click File ➪ New ➪ Tool.

Once the tool has been created, you can begin to create issues. As part of the issue record, several drop-down lists are used to assign the issue to an organization and a category, and associate the issue with keywords. You can populate the various drop-down lists as you create the issue records or prepopulate them, using the New menu option. All members of the workspace team can create issue and issue response records. To create an issue:

1. Click New ➪ Issue.
2. Enter a title for the issue (note that the issue will be assigned a unique reference number).
Part II: From Desktop to Internet

3. Click the plus (+) button beside the Category drop-down.
4. Enter a new category such as Site Planning (a subcategory could also be added by following the same process with the subcategory drop-down).
5. Click the plus button beside the Originated By drop-down, and add a new record.
6. Enter a description for the issue in the rich text field.
7. Click the Current Status tab.
8. Click the plus icon beside the Status drop-down list, and enter Started as the status.
9. Click the plus button beside the Priority drop-down, and enter the text “high.”
10. Click the plus button beside the Assigned to Organization drop-down list, and enter the name of the unit this issue has been assigned to. You can also add an individual to the Individual Assigned To drop-down.
11. If required, enter in remarks regarding the issue, in the rich text box.
12. Click Save.

You could of course have entered all the values for the various drop-down lists by using the New menu item. That way the list would already be populated, and you would simply choose a value. Figure 10-19 shows the issue once it has been saved. However, the values you have entered into the drop-down lists will be available to you when you create additional issues in the workspace. To add a response to an issue, such as additional information or an update, click New Response. Enter your text into the rich text field. Responses will appear directly below the issue concerned.

![Issue Tracking](image)

You can also change the view of the issues themselves to provide a more meaningful display simply for example viewing issues by the group responsible for them. You can choose a view using the View By menu. The issue tracking tool provides a nice, easy interface to record issues and responses on a project-by-project basis for small projects and teams. It does not have the capability of specialized project- and issue-reporting software, but it is what it is and it can be a useful addition to your workspace. If you need to carry out additional analysis on the issue data, you can export it to Microsoft Excel for further work. From the main menu, select File Export All Entries when you are in the List tool.
Other Tools

In addition to the main tools already discussed, there are a number of other tools available to you within a workspace, including:

- **Sketchpad Tool**: Allows you to create simple drawing objects within your workspace.
- **Pictures**: Allows you to add a picture library to your workspace.
- **Notepad**: Add notes to your workspace.
- **InfoPath Forms**: Create custom forms in your workspace based on Microsoft InfoPath form templates.

Downloadable Tool Templates for Groove

There are several Groove workspace templates available for downloading from the Microsoft web site at http://office.microsoft.com/en-us/groove/HA102636281033.aspx. The files should be downloaded and extracted into your Groove template folder located within your My Documents folder (this folder name may be different if you are using Windows Vista). Each template comes with a useful user guide. The Tool templates available include:

- **Asset Tracker**: A template used to track the location of fixed assets. It can also be used to prepare work orders and billable items.
- **Contacts**: Allows you to manage contacts for the current project being managed within the workspace.
- **Issues and Task Tracker**: A little like the Issue tool discussed earlier, this tool also includes an Associated Task tab allowing you to associate tasks with each issue recorded.
- **Project Status**: Simple reporting tools that will permit you to create project update records.
- **Time Tracker**: A tool that will allow you track projects and related activities and the time spent on each area. This is a fairly complex tool that will allow you to break projects up into discrete activities and record bookable hours against each area. This is one tool that Microsoft should seriously consider moving into SharePoint.

It is worthwhile downloading and installing the free tools into your Groove environment, as they also illustrate how tools and workspaces can be customized and additional features added.

Summary

Microsoft Groove 2007 offers you both an alternative to a full-featured SharePoint installation and another way to work with SharePoint data offline. Like SharePoint, it provides a very intuitive interface, making what are technically complex features very easy to use. In this chapter, you received a broad-brush overview of Groove and looked at some of the more useful features of this program. Bear in mind that Groove and SharePoint integration can only increase with the next release of the software, so any time spent using Groove now will pay off in the longer term. That aside, Groove is a nice bit of software and for those occasions when you do not require all the features of a full SharePoint installation. In Chapter 11, you will be looking at SharePoint add-ins, useful software that will enhance your use of collaboration environments much like Microsoft Groove 2007.
In this chapter, you will look at some of the add-in software available to enhance your working with Microsoft SharePoint — both Windows SharePoint Server (WSS) version 3 and Microsoft Office SharePoint Server (MOSS) 2007. While SharePoint is a huge program capable of many things, there will come a time when out of the box it does not do what you need. When that is the case third-party add-ins to SharePoint can really help out. In this chapter, both commercial products and free software are discussed. Please note that discussion of these solutions does not equate to recommendation or endorsement, nor does it verify their fitness for a particular purpose; it merely points out their availability. Some of the software I have personally used in my own installation of MOSS 2007 and others I have not. However, in every case I have installed and tested the add-in using either a free version, a full commercial version, or a test version. I have no relationship with any of the companies mentioned in this chapter.

All of the software discussed will be installed on Windows Server 2003 and Microsoft Office SharePoint 2007 Server running in a virtual machine. Because of the complexity of some of the features discussed, installation steps will not be tackled. However, for Web Parts that are within the scope of a SharePoint user, this chapter will discuss how they are installed and configured. For all the Web Parts and features, full installation instructions are provided with the downloads from the particular add-in’s web site.

You might be asking yourself why you need add-ins in the first place. In some cases, you may need a feature that does not come out of the box with SharePoint and you are not in a position to develop or have developed for you a new application to carry out a specific function in SharePoint. I am also a great believer in not reinventing the wheel — why have your in-house programmers and developers spend time building something that you can purchase for a few hundred dollars in most cases or indeed download for nothing? It’s almost certain that the development costs for you to create something in-house will be higher than simply purchasing the equivalent application from a third party. As long as you purchase it from a reliable third party, you can be sure that the software has been well tested by both them and their customers. In many cases, support is also included with the products, as is the case for almost all the third-party products discussed in his chapter. On many occasions, third-party software takes the form of Web Parts, and if you remember, Web Parts provide a specific area of functionality for your site; for example, the ability...
to display your document libraries in a tree view control. This chapter is divided into two areas: free Web Parts or features for SharePoint, and commercial software, which you need to purchase. However, always bear in mind that there’s nothing for free in this life; you will end up paying something even if it’s in terms of having to learn how the Web Part or feature works to support it yourself or in the time you need to spend making sure that your version of the software is up to date. In some cases, free add-ins to SharePoint are also unsupported, so you are more or less on your own and dependent on the good graces of the developer to answer your emails and any questions you may have.

One of the drawbacks of using third-party software is that it is normally licensed on a per-server basis, so for a large firm with several front-end servers, the costs can initially be high. However, experience has proven that the cost will still not be as high as inhouse development of the equivalent Web Parts.

Free SharePoint Software

The best spot on the Internet to search for and download free Microsoft SharePoint software is at www.codeplex.com, a Microsoft-sponsored open source-community web site where developers can share software, generally based on the Microsoft platform. Using Codeplex, you can download everything from a simple Web Part or administrative software, to a fully featured SharePoint community web site. There are hundreds of applications to download, and only a few can be covered in this section, so it’s really worthwhile having a look and searching the site for SharePoint or MOSS 2007 software.

Community Kit for SharePoint

The Community Kit is an entire site structure aimed at any user group type of setup. A live demo of the site can be viewed at http://sharepoint.microsoft.com/sharepoint/cks/uge/default.aspx. This is a great set of features that can help you build a SharePoint support site and self-help group area within your organization. It can also be used for any sort of membership-based SharePoint site to which you allow self-registration by members. Your SharePoint administrator will need to download and install this template for you, but once that has been done, if you have permissions to create sites, then it will be available. It may require some redesign to fit right in with what you have in mind for your own site or user group, but it does get you up and running almost right away with SharePoint.

SharePoint Learning Kit

The SharePoint Learning Kit (SLK) is part of the Microsoft approach to online learning, and your mileage with this feature can vary. When I installed it, I found that it was too self-contained for what my organization needed. Its needs were too specific to just slot it in on its own, and it was easier and, in that specific case, cheaper, to build a proprietary system from the ground up. So, the SLK allows you to issue assignments to students and track the progress of the assignments. Teaching staff can record grades against the assignments that will be made available to students. The learning kit can be downloaded from www.codeplex.com/SLK.
Podcasting Kit for SharePoint

This free download, also available from Codeplex, is perhaps one of the most outstanding free features you can add to a SharePoint site, particularly if you are building a social networking site with SharePoint. The podcasting kit will allow you to upload and use podcasts within the SharePoint installation. One of the only drawbacks to this free feature is that it must be installed by your SharePoint administrator, as there is a considerable amount of work to do to set up and enable the podcasting solution.

Document Library Tree View

This is a great little Web Part that can be used to display a document library on any page within your SharePoint site. When you add a document library Web Part to a page, you will find that, if it contains subfolders, there is no built-in way to navigate back up to the top-level folder from within a sub folder. This Web Part resolves that issue and also provides you with an easy way to navigate complex document libraries. Figure 11-1 shows the Web Part within a standard SharePoint page. The Web Part can be downloaded from http://man.unice.net/Works/WebPartsCollection.html and is also available from www.codeplex.com/MyWebPartsCollection.

This gives you a nice simple way to navigate around a document library. Note also the ability to add documents and folders directly to the document library using the links at the bottom of the Web Part. The Tree View Web Part also contains a number of settings that determine what is actually displayed. Figure 11-2 shows the tree view displaying the document library structure and the files and folders contained at the top level of the library.
Part II: From Desktop to Internet

This view provides a very clean way to navigate the structure, and it is a way that most computer users are familiar with from using Windows Explorer, so most people can immediately use the Web Part to find files. Figure 11-3 shows the configuration options specific to the Tree View Web Part. You can choose to display files and folders from any document library in your site. For each library, you can select a view to display and further configure the display of the tree view structures in the Web Part. This Web Part really overcomes the inability in SharePoint to navigate within a document library Web Part and is well worth installing.

![Tree View Configuration Options](image)

**Figure 11-3**

Telerik RadEditor Lite

One of the first cross-browser issues I had with MOSS 2007 involved Firefox users and MOSS discussion groups. As it turned out, the rich text editor supplied with MOSS failed to function in Firefox and other non-Internet Explorer browsers. Fortunately, Microsoft and Telerik have released the RadEditor Lite, a replacement editor that can be added to a SharePoint site and used to replace the out-of-the-box editor in non-IE browsers or indeed Internet Explorer as well. This light version also supports Safari running on Macs, which was exactly what some of my users required. The control, which is free, can be downloaded from [www.telerik.com/community/free-products.aspx](http://www.telerik.com/community/free-products.aspx). Once installed on your SharePoint servers, you can add the editor to those sites that require its features as required. For example, if some of your colleagues use the Firefox browser for a particular site, then you can enable the feature for that site alone. I found it easier just to enable it across all sites as there is nothing to lose really. To illustrate the point of cross-browser issues, Figure 11-4 shows a reply to a discussion post in MOSS 2007 displayed in Firefox 3.0.5 using the out-of-the-box SharePoint rich text editor.

![RadEditor Lite Example](image)

**Figure 11-4**
In order to respond to or edit this content, you would need to add raw HTML to the editor. Figure 11-5 shows the same screen once RadEditor Lite has been enabled on the site and, as you can see, it provides a much improved experience for you and your colleagues, returning them to the standard rich text editor interface used by SharePoint.

![Figure 11-5](image)

This is one of those add-ins that should be installed on every SharePoint server, as you have no idea what browser someone could be using to access the site, particularly if it is an Internet-facing site as opposed to an intranet site where you can have some control over the browser being used.

In general, the CodePlex site is one you should add to your browser favorites and keep referring back to every so often to see if any new releases have been made for SharePoint. You should always read the release notes and discussions before installing any of the software on SharePoint. Some software is well tested and will be declared as stable, while other free downloads may still be in development. As with everything free, the risk is yours to evaluate and accept. Some of the more interesting downloads available from CodePlex are discussed in the following sections.

**Google Maps Web Part**

This Web Part allows you to supply latitude and longitude coordinates to the Web Part to pinpoint locations with a Google Map. You will need to request a special key from Google for this to work, but full installation instructions are included with the Web Part. This Web Part can also retrieve the details required from information stored in a SharePoint list within the site itself and is useful if you need to provide directions or other location-based information to your colleagues.

**WSS and MOSS Home Drive**

In many cases, SharePoint users will still need access to information located on other computers, or from commonly shared space on a company file server. This Web Part allows you to provide access to such information from within SharePoint.

**SPUserPoll**

This is a simple Web Part that allows you to add a single one-question survey to a SharePoint site. It’s much easier to use and configure than the standard SharePoint Survey tools and can be used to get a quick response from your colleagues.

**SharePoint Skinner**

The SharePoint Skinner is a great tool for those of you who may be required to redesign SharePoint sites using Cascading Style Sheets (CSS) and SharePoint themes. This tool can be used to inspect the CSS...
Part II: From Desktop to Internet

styles used on a SharePoint site and change them as you go directly in the interface. Changes are reflected in the tool interface but not on the actual SharePoint site. The finished result can be saved and applied to the SharePoint site as a new theme. While not exactly an add-in, it is a great tool that can be used to teach yourself about SharePoint and CSS design as it can help you track down styles used in your site and instantly show how your changes will appear. The SharePoint Skinner runs as an application on your PC and is also available from the author’s web site, where instructions are also available. Information on the software and an overview are available from www.elumenotion.com/Blog/Lists/Posts/Post.aspx?ID=4. Figure 11-6 shows the SharePoint Skinner running on an XP Pro system linking to a demo SharePoint site. Again, any changes you make are not reflected within the live site, but the resulting files can be saved and uploaded as a theme once you are happy with the results. Please note that some areas of this site have been blanked out — for example, URLs and navigation items — as this is a live site.

![SharePoint Skinner](image)

Figure 11-6

Custom Workflow Activities

There are several built-in workflow actions available with SharePoint Designer 2007 that can be applied within your SharePoint sites. This collection of additional activities is worth installing to cover some of those areas the product is missing. The following additional activities are provided by this collection:

- Send Email with List Item Attachments.
- Start Another Workflow.
- Grant Permission on Item.
- Delete List Item Permission Assignment.
- Reset List Permissions Inheritance.

322
Chapter 11: SharePoint Add-ins

- Is User a Member of a SharePoint Group?
- Is Role Assigned to User?
- Look Up User Info.
- Copy List Item Extended Activity.
- Send Email Extended.

**Mini Calendar Web Part**

As you already know, the large event calendar in SharePoint takes up a lot of screen space. This Web Part recently released on CodePlex allows to use a mini-calendar, which can be linked to lists and document libraries to display date-based list information and documents.

This is just a small sample of the free Web Parts and solutions to be found on the CodePlex web site. There are numerous other Web Parts and solutions aimed at both the end user and the professional SharePoint developer.

Before looking at some of the commercial Web Parts, it’s worth pointing out that many of the commercial organizations also offer some free Web Parts, most likely as a way of hooking you into the purchase of other items. The companies discussed in the following section offer free Web Parts, with perhaps Bamboo Solutions offering a larger number. For example, Bamboo offers the following Web Parts totally free of charge and downloadable from their web site: (http://store.bamboosolutions.com).

- **Bamboo Video Library:** Much like a document library, this Web Part is specifically geared to display video files within sites like yours. It’s actually a great tool that could be used to display short how-to instruction videos for common business tasks or information on using SharePoint. In fact, I have installed this Web Part as part of an internal SharePoint staff training portal.

- **SharePoint Analyzer:** A product aimed at your SharePoint administrator and can help with form design and maintenance.

- **SharePoint Analytic Accelerator:** Another really useful set of tools that can be used to graphically view site interaction. You could use it, for instance, to discern the number of users who actually visit your site.

- **PDF Document Parser:** Uploads a PDF form and uses it as the definition for a new SharePoint list. This tool is more geared towards system administrators, as it is a command line tool that may not be suitable for everyone to use.

- **SharePoint Price Calculator:** As many SharePoint administrators will know, working out how much you will actually have to pay for a SharePoint license can be horrendous. This tool is designed to take the pain out of working out how much it will actually cost in terms of license fees to Microsoft for SharePoint.

There is an abundance of free Web Parts and additional features that you can download from the Web for SharePoint — both the full MOSS 2007 version and WSS. While they can and do meet a need at times, you sometimes have no other choice than to actually bite the bullet and spend money to get the functionality you require for your SharePoint installation. In the next section, you look at some of the commercial Web Parts that are available, again usually via the Internet, that can assist you in providing functionality within your SharePoint sites.
Commercial Web Parts

There are three major suppliers of commercial Web Parts covered in this section, but I mainly have experience using Web Parts from two of them — from one I purchased several Web Parts on a commercial basis, and from the other company I downloaded and installed the evaluation version of various Web Parts. The three companies are major players in the SharePoint market, and I suspect you would need budget approvals to purchase their suite of programs. The companies I have direct experience of are Bamboo Solutions and KWizCom. The third company is Lightning Tools, which develops state-of-the-art Web Parts for both MOSS 2007 and WSS. My experience with all the companies includes either purchasing Web Parts or using evaluation versions of their products.

To repeat, discussion in this section is not tacit endorsement. You are advised to check out the products to ensure that they meet your business requirements by downloading and testing evaluation copies from multiple suppliers before purchasing anything. All of the products have good and bad points, and you should satisfy yourself as to their fitness for your purpose before purchasing them. In addition, other companies supply Web Parts and other solutions for SharePoint, both MOSS 2007 and WSS version 3, and a quick Google search will return several options for you to check out. The companies included in this chapter were included because I have had direct, hands-on experience with their products.

The initial set of Web Parts discussed is available from KWizCom, a commercial Web Part solution developer based in Canada (for more information see www.kwizcom.com) and includes the following Web Parts and solutions:

Calendar Plus

One of the features many SharePoint users require is the ability to combine multiple SharePoint calendars into a single combined view and display this in the top-level site. For example, you might have several sites that contain events or other date-based information that you would like to combine to give your colleagues an overall view of what’s happening in the company. Calendar Plus, available from www.kwizcom.com, will allow you to do that, and the professional version will also allow you to connect the Web Part to your Microsoft Outlook Web Access and other systems to display a unified view of all your events. Figure 11-7 shows Calendar Plus in one of the views available to you, mini-calendar.
Chapter 11: SharePoint Add-ins

This view is very useful as the standard SharePoint calendar takes up a lot of space on a page. This mini-view will display more information about a selected event directly beneath the calendar Web Part. But the real benefit of this Web Part is the ability to display any date-based information from lists within your site structure via a single SharePoint calendar. In addition to standard SharePoint lists, it is also possible to configure the Web Part to display events from your Outlook calendar. This provides a very powerful technique to help you and your colleagues manage event-based information from a single interface within your team sites. One obvious use for such a Web Part is within a multi-site team area, such as a division that can have many units. Each unit may have its own event calendar detailing events for the individual unit. Using tools like Calendar Plus, you can provide a single view of all events across the division on the home page, giving instant access to all staff. Also note the ability to set a specific time zone within the view shown in Figure 11-7. This feature can be turned off or on as required in the settings of the Web Part.

**SharePoint Forum Web Part**

Again from KWizCom, this Web Part provides you with a much more interactive and attractive view of SharePoint discussion lists. Discussions are displayed in a tree view structure, which makes it much easier to interact and view messages by topic. This provides a more web-based interface to the discussion lists that you and your colleagues will be more familiar with. The Web Part also makes it possible to add new items to the discussion using a pop-up window as opposed to opening a new page within the SharePoint site and adding the content. This Web Part provides you with a familiar way to work with discussions groups. Figure 11-8 shows the Forum Web Part in use on a live site. One of the additional features is the ability to use the Web Part to interact with a discussion list on another site within your overall structure, enabling your colleagues to enter discussions within a single team site; that is, it provides the ability to create cross-team site discussion groups.
Part II: From Desktop to Internet

**Wiki Plus**

This Web Part, or, to be more accurate, solution, replaces the default basic SharePoint wiki with a more familiar fully featured wiki normally available on the Internet. It provides the ability to add and manage attachments to wiki posts and provides a fully functional tagging solution for posts. This is a huge advantage over the standard SharePoint wiki, which does not include this tagging ability. Wiki Plus also provides:

- Wiki expiration dates
- Page-level discussions
- Automatic table of contents
- Connected wiki sites across multiple areas of your SharePoint environment

This add-in is an extensive addition to the out-of-the-box SharePoint wiki. For those areas you need or where you would like to encourage Web 2.0-type interaction between your colleagues and team members, this feature is more than worth looking at.

**InfoPath Form Viewer**

This Web Part allows you to embed an InfoPath 2007 electronic form within your SharePoint page as opposed to opening it in InfoPath 2007 or using Forms Server within the web browser. This results in a cleaner experience for you and your colleagues. This Web Part does require Forms Server, so you will need to be running MOSS 2007 and Forms Server before you can use it.

**SharePoint List Aggregator**

If you need to combine information from several lists within your SharePoint site, this Web Part provides an alternative solution to the Content Query Web Part. It has one major advantage over the Content Query Web Part in that it allows you to edit items being displayed within the rolled-up list itself as opposed to having to return to the original list for editing. It also provides the ability to export the list data to Excel or PDF and provides several built-in templates used to display the data. Like the Calendar Web Part, this is a useful Web Part if you need to display several lists in a single view at the top level of your site. For those of you using WSS only (the Content Query Web Part is not available), this is one of the only alternatives you may have to enable this ability. Just like a standard list, the aggregator list can also be enhanced using views of the list data, allowing your colleagues to filter the items being displayed to make the lists more meaningful to them. Figure 11-9 shows a list aggregation in a team site, on this occasion containing contacts from several lists within a SharePoint site.
In addition to the Web Parts discussed in this section that I have personal experience in using, the company also provides several other useful Web Parts that can be used as required to enhance your SharePoint site:

- **SharePoint Tagging Feature**: Used to tag content within SharePoint. For example, when adding a document to a document library, you can associate it with a specific content category. This sort of feature can help you when you need to categorize information for records management solutions within SharePoint. When you or a colleague adds a document to a library, for example, you would also be required to select which category of information it belonged to.

- **SharePoint List Columns Security**: Allows you to specify security permissions on specific columns within a SharePoint list.

- **SharePoint List Filter**: Provides multiple filter options when applied to SharePoint lists. Provides a flexible way to search directly within large lists.

- **WSS Cross Site Search**: Provides some advanced search features for WSS version 3 users who do not have access to the extensive search features of MOSS 2007.

If your needs haven’t been met yet, several other Web Parts can be viewed and downloaded from the company web site.

Another major player in the SharePoint Web Part market is Bamboo Solutions. As you will see, they offer many Web Parts similar to those already discussed. The best advice when looking for Web Parts is to download and try out the Web Parts and compare them to those that other companies offer that provide the same functionality. Then you can safely choose which to purchase based on how each Web Part meets your business needs. Bamboo Solutions’ Web Parts are available from http://store.bamboosolutions.com and include the following:

- **Calendar Plus Web Part release 2.6**: Similar to the Calendar Web Part offered by KWizCom, this calendar allows you to display data from SQL Server databases; color-code entries within the calendar; view data according to year, quarter, day, week, or month; and represent data in a Gantt chart view.
Part II: From Desktop to Internet

- **SharePoint Team Calendar**: Allows you to display multiple Exchange calendars within SharePoint via a single calendar.

- **Mini Calendar**: Places a small calendar onto your SharePoint page containing links to any date-based list information you would like to display to your colleagues. One of the best uses for this Web Part is to allow your colleagues to filter date-based information by placing it beside a SharePoint list. If the list contains date-based information, you can use the mini-calendar to enter the dates you would like to filter the list by.

- **List Rollup Web Part**: Provides the ability to take information held in multiple lists and display it in a single combined view.

In addition to standard Web Parts, Bamboo Solutions also offer a range of pre-built applications for SharePoint, providing you with an immediate solution that can be installed on SharePoint to solve a particular business problem. Available software includes:

- **Grants Management Solution Accelerator**: Designed to permit an organization to keep track of finances associated with grants and other funding sources.

- **Requisitions and Interview Manager**: Adds additional functionality to the free application template available from Microsoft. This is achieved by using several Web Parts commercially available from Bamboo made available as part of this solution.

- **SharePoint Knowledgebase**: Will enable you to create a fully functioning knowledge base within your SharePoint sites to post articles and other information that you and your colleagues will find useful.

- **Data Viewer Web Part**: For those who don’t have SharePoint Designer 2007, this Web Part offers similar functionality as SharePoint Designer’s Data Form Web Part. Data Viewer provides a graphical tool that can be used to display data held, for example, in a SQL Server database and provides the ability to actually edit data within the list itself.

- **Cross List Web Part**: Much like that supplied by KWizCom, this Web Part allows you to roll up list information and present it to your colleagues in a single view.

- **List Integrity – Release 2.1**: One of the things many database developers in particular miss when moving data to SharePoint is the ability to delete information that is related. For example, when deleting a Customer record, you want to delete the associated Order records. In a standard SharePoint list structure, this is not possible and you would have to delete the data in the lists independently. This Web Part resolves this issue and permits this cascade delete to take place, but just as importantly (if not more so), it can also be configured to prevent the deletion if related records exist. This is a huge bonus for those of you who may need to move Access databases to SharePoint and want to retain the relationships between tables in the team sites when they are converted to SharePoint lists. It’s really worthwhile if you are moving Access databases to SharePoint to download and look at the evaluation copy of the tool before you make the move.

In addition to these and other Web Parts, Bamboo Solutions also recently released a product called MashPoint, which can be used to tie in your corporate data to all the Web Parts available from this company. Of course, this will give you a total Bamboo Solutions infrastructure, but this is not an issue if
you are a user of their products anyway. At this point, MashPoint is free, and if you make large-scale use of this company’s Web Parts, it is worth taking a look, especially if you need to integrate corporate data with their Web Parts. MashPoint also contains the capability to allow your own in-house developers to build their own applications using the software.

Other Useful Software

In addition to KWizCom and Bamboo, another company also offers some very useful tools for SharePoint. Lightning Tools (www.lightningtools.com/bdc-meta-man/default.aspx) is the provider of the BDC Meta Man software, which is used to work with the MOSS 2007 Business Data Catalog. In fact, working with the BDC without this tool can be a horrible experience, and the BDC Meta Man really does make connecting to database information much simpler. BDC Meta Man provides you with a graphical interface that is used to connect to and create the application definition files required to enable the use of the BDC Web Parts in MOSS 2007. If you are working with corporate information stored in SQL Server or Oracle and need to integrate it using the MOSS 2007 BDC, then this software is highly recommended; even the free developer version will save you hours of grief when setting up your application definition files for MOSS BDCs. The professional version, which you will need to pay for, offers additional features such as the ability to connect to Oracle databases (versions 9 and 10), to have unlimited tables within the design surface, and to write back to your SQL Server 2000/2005 database. For serious users of the MOSS Business Data Catalog, the Professional version of the BDC Meta Man is almost a must have. This tool can save you hours of work. Additional Web Parts from Lightning Tools include:

- **Lightning Conductor Web Part**: A list rollup Web Part that is used to bring together information from multiple SharePoint lists and present it in a single interface.
- **Lightning Storm Forums for SharePoint**: Another replacement for the out-of-the-box SharePoint forum, which, again, should provide a more familiar experience for you and your colleagues.
- **LT Data Viewer Web Part**: A Web Part for WSS version 3 users who need to connect to and display information held in corporate databases.

Additional Web Parts are available from the company web site.

The preceding chapters have discussed some other add-ins for SharePoint, including add-ins for Microsoft Excel 2007 to enable read/write functionality and add-ins that enable increased search functionality for WSS version 3, which are not available out of the box.

Summary

This chapter discussed some of the add-ins to SharePoint, both MOSS 2007 and WSS version 3, that I have found most useful when deploying sites within my own environment. Some of the add-ins are free to download and run; others are available from commercial suppliers. All add-ins should be compared and tested before using them and especially paying the license fees, and almost all of the commercial suppliers will provide a copy for testing purposes. In many cases, you may find that a lot of the software available for SharePoint is aimed at developers and site administrators, but it’s always possible that you will find that little nugget of code that you as an end user need to get your job done.
SharePoint Designer 2007 is the program provided by Microsoft to allow you to work directly with SharePoint sites. Using SharePoint Designer you can:

- Design and customize existing sites
- Back up SharePoint sites
- Create new sites
- Add objects to your site (for example, information held in databases)
- Create workflows
- Create custom pages

This chapter can only outline some of the features and functionality of SharePoint Designer 2007, showing how it works and providing some examples of what it can be used for. One of the problems in deciding whether or not to include a chapter like this is that, not all the information you will need — or, to be truthful, not even a small part of what you will require — can be provided, but what this chapter can do is expose you to some ideas and pointers that will get you off and running using this powerful tool to begin working directly with SharePoint site design and other areas of SharePoint Designer 2007. As with everything else in SharePoint, you will need the appropriate permissions granted to you in order to work directly with SharePoint Designer and your team sites. In this chapter, you will see how you can add your own Cascading Style Sheets (CSS) in SharePoint Master Page to change the default layout, connect to data sources using SharePoint Designer, and back up SharePoint sites.

Wrox’s Professional Microsoft Office SharePoint Designer is worth looking at if you would like to find out more about this powerful tool.

Some areas of SharePoint Designer can be used with little need for technical skills; other areas require a sound grounding in web development techniques and technologies. In the real world of SharePoint design and development, you will find that opinion on SharePoint Designer ranges from excellent to the worst thing ever invented. In the right hands, however, it can be useful. In the wrong hands it can be a total disaster.
Part II: From Desktop to Internet

Skills Required

In order to take full advantage of SharePoint Designer 2007, you will need to have some experience working with HTML, CSS, and .NET. However, as you will see in this chapter, it is possible to go a fair way without a great deal of knowledge. Nonetheless, at some point you need to take time out and understand the different technologies that make up a SharePoint page and site. In fact, it is highly recommended that you learn something about each of these technologies before playing about with site design and customization of SharePoint pages.

In this next section, you will look at a brief overview of two of the core technologies you will need to master in SharePoint Designer: HyperText Markup Language (HTML) and Cascading Style Sheets (CSS), both important tools you will need to learn.

HTML

HTML is the language used to create standard web pages. Basically, it is a set of instructions to the web browser about how you would like your content to be displayed. For example, if you need a string of text bold in Microsoft Word you would simply select the B icon on the Ribbon. In HTML, you would surround your text with the HTML tags to instruct the browser to display your text as bold: `<b>YOUR TEXT</b>`. Notice that a pair of tags are used to enclose and the closing tag is denoted with a `</` notation. In the same way, every element you need on your web page can be defined using HTML tags. A single chapter cannot define all the tags with examples for you but a basic web page file created using HTML is listed here for your information. (Of course, I cheated and used SharePoint Designer to create the page.)

```xml
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<meta http-equiv="Content-Language" content="en-gb" />
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>HTML Example</title>
<style type="text/css">
.style1 {
  font-family: Arial, Helvetica, sans-serif;
}
</style>
</head>
<body>
<p class="style1">This is a basic web page created using SharePoint Designer.</p>
<p class="style1">It is designed to simply show you the structure of the page.</p>
</body>
</html>
```

Another common tag you will see in a SharePoint page is the `<div>` tag, which is often used to create a section of a page to which style can be added using CSS. For example:

```html
<div class="ms-titleareaframe"><img src="/_layouts/images/blank.gif" width=1 height=100% alt=""></div>
```
A great web site to learn HTML and other web technologies is www.w3schools.com, which contains examples of all the HTML tags and online teaching materials, and it is well worth a visit if you want to learn more about HTML. Additional links are provided in Appendix B to other sites that can be useful when learning HTML and other web technologies.

CSS

Learning CSS is a must if you want to use SharePoint Designer (or any other tool for that matter) to design and customize pages within SharePoint both WSS and MOSS 2007. You will find that the entire look and feel of your SharePoint sites is defined by a large set of CSS files located within your web servers. So what is CSS? CSS is a way to tell the browser how you would like your web page to look — the color and type of font used, the font size, and the overall layout and positioning of items within your web page. You can see an example of CSS in the previous HTML above. This section of the file defines the font to be used for text in the page:

```html
<style type="text/css">
.style1 {
  font-family: Arial, Helvetica, sans-serif;
}
</style>
```

Note further down the page that, when we want to apply the style, it is referenced in the HTML tag:

```html
<p class="style1">This is a basic web page created using SharePoint Designer.</p>
```

This is called a CSS class, and it can be applied anywhere within the document to apply the style defined earlier in the document using the `<style>` and `</style>` tags. What is happening is that, rather than the browser applying its own style, we are telling it to use the style we have defined within our HTML document. In SharePoint, you will find that CSS is defined within external files and applied to your SharePoint pages when required by referencing the CSS file in the page code. Note the use of the word “code” here, not “HTML”; within a standard SharePoint page, you will find that there is a mixture of CSS, HTML, and .NET programming code. The file extension will also not be HTML or HTM but ASPX, denoting a .NET code page. The following example is from the main CSS file used by SharePoint and defines the Recycle Bin option you see on the SharePoint Quick Launch menu:

```html
table.ms-recyclebin td{
  background-color:#f2f8ff;
  width:100%;
  border-top:solid 1px #ffffff;
  border-left:solid 1px #ffffff;
  padding:3px 5px 7px 3px;
}
table.ms-recyclebin td a{
  font-weight:bold;
  color:#008800;
  text-decoration:none;
}
table.ms-recyclebin td a:hover{
  color:#000000;
  text-decoration:underline;
}
```
For example, if you wanted to change the default text used for the words “recycle bin” from green to red, this is where you would do that. However, it’s not really as simple as that, as there are other issues involved in this process, not the least of which is working out which style sheet file is applied to which area of your page.

**Ghosting and Unghosting**

When you work with SharePoint Designer you are working with pages that live on the web server’s file system. A bit like saving a file into your My Documents folder (Documents folder if you are using Vista) on your PC. When you change one of the default files in SharePoint Designer, the file is actually stored within the SharePoint databases as opposed to the file system; these pages are called unghosted pages. Ghosted pages live on the file system in normal folders. Now there are, as in every argument, those who say this is the worst practice in the world and those who say “Why worry?” It is important to understand that, once you edit a page in SharePoint Designer, it is now stored within the database and not the file system, as this may have performance implications and implications when you upgrade your SharePoint environment in the future. I use SharePoint Designer and have noticed no impact on the performance of the SharePoint installation I am running, but note that your mileage may vary.

One of the really good things about SharePoint Designer, as you will see later, is that you can cancel the ghosting by reverting back to the original page.

**IE Developer Toolbar and Using Firefox for CSS Tracing**

Before you can begin to customize your SharePoint page, you need to know which CSS style is being used and which CSS file it is stored in. There are a few ways in which you can do this, including using SharePoint Designer 2007 itself and the following tools to assist you. The Internet Explorer developer toolbar lets you examine a web page and see how it is put together. If you are interested in CSS, and within those sheets, which classes are applied to certain areas of a SharePoint page, the toolbar can be downloaded from www.microsoft.com; just do a search for the IE Developers Toolbar. The Firefox browser has tools built into it to allow you to look at a web page in the same way that the IE toolbar does. All that is required is to install Firefox. This is a good idea anyway, as it gives you the opportunity to see how your sites will look in a browser other than Internet Explorer. This is always a good idea given that you cannot know which browser someone will be using to open a site, and you need to ensure that everything functions as expected.

The cascading nature of style sheets can be confusing, particularly in SharePoint when it can be difficult to work out which style sheet will actually be applied to a page and when it will be applied. *Cascading* refers to the order in which a style is applied to a page or item on a page. Within a web site, you may be using several different style sheets and usually the last style applied will be the style used within the page. Generally speaking, when using CSS to style a page, styles will be applied in the following order or cascaded into the page:
Chapter 12: SharePoint Designer 2007

- The browser’s default style.
- Any external style sheet.
- Styles in the head section of the HTML file.
- Inline style directly associated with an HTML tag.

Because of this cascading effect, you can replace styles with your own or more technically override a defined style. That is how you will change the styles in the SharePoint examples that follow. You will define styles within the Master Page, which will override those used within SharePoint by default.

Getting Started with SharePoint Designer 2007

The first thing you need to do with Designer is to open one of your team sites within the environment, and it’s likely that, if you have never used a Microsoft development environment, you will be put off by the interface that greets you, which can appear very confusing. If you are a FrontPage 2003 user or in fact have used Dreamweaver to work on web sites, you will be familiar with many of the interface items you will see in SharePoint Designer. To continue and open a team site:

1. Open your SharePoint team site in a web browser and copy the URL, leaving out the filename as it is not required.
3. Click File → Open Site.
4. Paste the URL of the team site into the File Open Site dialog.
5. Click Open.

Figure 12-1 shows the resulting SharePoint Designer interface with a team site open. In the case of this figure, it shows the window open on my system which may be different from your own installation as SharePoint Designer “remembers” the layout from the last time the program was run. For security reasons, I have obscured the full URLs to all sites used in this chapter. For your information, the full URL of the site currently being worked on will be displayed in the title bar above the main SharePoint Designer menu. As you can see, the program is divided up into various application panes according to the task they perform. In Figure 12-1 the most common SharePoint Designer design panes are open. They are:

- **Files and Folders**: Windows Explorer view showing the structure of the currently open team site.
- **CSS Property Pane**: Used to view and work with the currently selected items Cascading Style Sheet rules. The rule is the style that is currently applied to the area of the page or object you have selected. This feature is important when you are trying to discover styles used within a Master Page and allows you to directly edit styles in the interface.
- **Web Site**: Main center window that will also display the overall structure of your team site. When you begin to open files, this will also become the working area to make changes to your
Part II: From Desktop to Internet

SharePoint site pages. As you work, additional tabs will be opened in this area to allow you to quickly move between files.

- **Manage Styles**: Displays the currently used CSS file and provides a quick navigation tool to open and interact with styles from that sheet. You can view all styles used in the current page and edit each style directly.

- **Data Sources**: Any data sources you may be using within a custom page, such as a connection to Microsoft Access 2007.

![Figure 12-1](image1.png)

Figure 12-1

A menu system is also provided at the bottom of the document window to allow you to quickly move between different functions of the application. The full menu is shown in Figure 12-2, and you can move between folders, the remote site view, reports, navigation, and hyperlinks.

![Figure 12-2](image2.png)

Figure 12-2

**Folder Pane**

The Folder pane shows you a view similar to Windows Explorer of the structure of your SharePoint site. Figure 12-3 shows the site for many of this book’s chapters.

336
It’s worth pointing out that all of the main lists and libraries within your team site are also displayed. Expanding a list folder will reveal the content. For example, the Chapter 9 library contains several different file types and they are all available to you directly from within SharePoint Designer. Figure 12-4 shows this library opened within SharePoint Designer. If required, you can open a file directly within its application from here.

In addition to the folders you may already know, there are several others available. The one of real interest at the moment is the Catalogs folder. If you expand the Catalogs folder, you will see a subfolder called Masterpage (Masterpagegallery) and, depending on the site you have open, you may see a single file called default.master. Master Pages are key to your understanding of how a SharePoint page is put together and eventually customized. If you are already familiar with web development, you may be familiar with using templates to control the layout of a web page (for example, the menu system). Rather than create a page from scratch, you base it on an existing template and inherit the
Part II: From Desktop to Internet

common features of the template on all your web pages. A Master Page works in much the same way and controls the layout and design of your SharePoint page. In SharePoint a Master Page contains:

- Placeholders for objects you will be using on a SharePoint page. The placeholders are replaced with standard SharePoint objects when you execute the page. A SharePoint Master Page must contain a standard set of placeholders even if they are not all being used.
- Links to CSS files that will be used.
- Links to its content page that will determine the information you want to display; master and content will then merge to give you the page you view in the browser.
- Common navigation objects used throughout your sites.

Getting Started with Customization

One of the first customizations I carried out was to place a copyright marker and URL back to my main web site on a SharePoint Master Page so that it would be available on each page in my pilot team site structure. Not a major task, but if you have never worked with a MOSS Master Page before and you open it up in code view, then it can seem daunting. In this case, all I had to do was to add the text “Copyright Information Services” at the bottom of every page.

The example that follows will demonstrate some of the many features of SharePoint Master Page, including some of the CSS tools available to you and using a single line of text. To get started:

1. Open your SharePoint team site using SharePoint Designer.
2. Locate the folder Catalogs and open it.
3. Open the subfolder Masterpage.
4. Double-click default.master to open the file. (You may need to check out the file.)

What you are seeing is your team site Master Page in design mode. As you can see, this is a live preview of your SharePoint home page. Note the pink outlines located at various points in the page; these are the content placeholders, and it is important that you do not delete any of them. If you delete any of the placeholders, your page will be broken. Placeholders not being used are normally hidden at the bottom of the web page. Using SharePoint Designer, you can work in one of three modes: design mode, which you may currently be in; split mode, which will divide the screen into design and code screens; and code mode, which will allow you to work directly with the underlying page code. For this example, you will work in split mode to allow you to see what happens under the covers when you make a change to the page. Figure 12-5 shows the option buttons for changing the work mode.

![Design Split Code](image)

Figure 12-5

5. To edit the page, click Split to divide the screen.
6. Click directly at the bottom of your page in the design screen directly below the last placeholder indication (pink link). This should place the cursor at the \</BODY> tag within the document.
7. Click at the end of the previous line of code in the page ending `runat=server"/>.`
8. Press Enter to add a new line to the code.
9. Enter the following text “Copyright `<your name>`”.
   
   At this point, your page should look like the following (the copyright statement is in bold):
   
   ```html
   <asp:ContentPlaceHolder id="PlaceHolderUtilityContent" runat="server"/>
   <asp:ContentPlaceHolder id="PlaceHolderBodyAreaClass" runat="server"/>
   <asp:ContentPlaceHolder id="PlaceHolderTitleAreaClass" runat="server"/>
   
   Copyright Martin Reid
   
   </BODY>
   </HTML>
   
```

11. Click Yes to save the changes.
12. You will be informed that you are about to customize the page and asked to confirm this. Click Yes.

   *What you are doing now is placing a copy of the `default.master` in the database, that is, you are unghosting the file from the copy of the file server. At the moment don’t worry about this, as you will reset the file back at the end of this example.*

Note that an icon has been placed beside the `default.master` to show that it has been customized from the file server copy. This is shown in Figure 12-6.

And the results of the exercise are shown in Figure 12-7. Your new statement is displayed in the bottom-left corner of each web page on your team site. You can view the results by opening the SharePoint site currently being edited in your browser.
As you can see, it sort of sticks out on the page and does not fit in with the styles used by the rest of your page. In the next example, you are going to add a CSS class to the text so that it fits in with the overall page design. To add the CSS class:

1. Reopen the default.master.
2. Select the text Copyright <your name>.
3. From the main menu, select Format.
4. Select New Style.
5. Enter .Copyright as the selector name, overwriting the default (note the period [.] before the name).
6. Check the box “Apply new style to document selection.”
7. For the font, select Arial, Helvetica, Sans Serif from the drop-down list.
8. In the Font Size drop-down, select x-small.
9. Click OK.

The following HTML tag should now surround the copyright text:

```html
<span class="Ccopyright">Copyright Martin Reid</span>
```

10. Save the page and view your site within the browser. Figure 12-8 shows the results, which are much improved over the first example.
In order to achieve this, a new CSS style will have been added to the top section of your Master Page within the `HEAD` section. If you scroll to the top of the document, you will find the following style has been added:

```
<style type="text/css">
 .Copyright {
    font-family: Arial, Helvetica, sans-serif;
    font-size: x-small;
  }
</style>
```

Once this has been done, save the changes to your SharePoint styles within the Master Page itself. Many of the leading SharePoint design experts agree that this is best practice when working with this file type and site design.

MasterpageMasterpageMasterpagecore.css

When you edit a style within SharePoint Designer 2007 a file will immediately open. This file is `core.css`, which is the main style sheet used to design your pages. Standard practice is to leave this file alone and do not change it. The idea is to find out which style from this file is being used for the item of interest and copy and paste it into the Master Page and edit it there. You can use the IE Developer toolbar or the Firefox Developer’s add-in to identify the style, or better yet, go to Heather’s site (www.heathersolomon.com) and download her SharePoint CSS style guide. This is an invaluable tool when customizing a SharePoint site, as it lays out all of the styles used with a screenshot showing where they are applied.
Part II: From Desktop to Internet

In this next example, you will change something a little more obvious: the Quick Launch menu system. You will create a set of new custom styles within the default.master page for the site. That way you will be sure that your styles are applied to the page. The styles used by the SharePoint Quick Launch menu are contained in a huge CSS file called core.css, which contains almost every style you will ever require in SharePoint. For this example, you will change a couple of styles just to get the idea about how this all works. The first style to look at follows and defines the Header column in the Quick Launch menu; the cell that contains the text “View All Site Content”. This fragment of CSS can be found in the core.css file for your site. The style you are about to create will be used by SharePoint instead of the style defined in this file.

```css
.ms-quicklaunchheader{
    padding:2px 6px 4px 6px;
    font-weight:normal;
    color:#003399;
    background-image:url("/_layouts/images/quickLaunchHeader.gif");
    background-repeat:repeat-x;
    background-color:#d6e8ff;
    border-left:solid 1px #f2f8ff;
    font-size:8pt;
}
```

The first thing to do is to change the background color to red; this will make it a little more obvious that you are actually changing something using CSS, and you will see the immediate effect of your changes.

Within the HEAD tags of your default.master, add in a set of STYLE tags <STYLE> </STYLE>. The styles you add will be placed between the opening and closing style tags. If you are carrying out this example immediately following the earlier example, you may already have the style tags defined within your page.

Enter the previously highlighted block of CSS code called .ms-quicklaunchheader between the style tags and change the line background-color:#d6e8ff; to read background-color:#FF0000; (FF0000 represents the color red).

Change the code to read as follows. The line to change and the change to make are shown in bold in the following example:

```css
.ms-quicklaunchheader{
    padding:2px 6px 4px 6px;
    font-weight:normal;
    color:#003399;
    background-image:None
    background-repeat:repeat-x;
    background-color:#FF0000;
    border-left:solid 1px #f2f8ff;
    font-size:8pt;
}
```

This removes the image that is also used in the background of this cell. If you do not do this, your color change will not be apparent because it is behind the image file.

You should see an immediate change in the background color behind the text View All Site Content. Rather than work directly in the code of the page, you could also use the CSS properties pane to select
colors and fonts to use for the particular styles. Once the style is entered into the Master Page, you can use the Properties panel to work with editing the various styles defined. Figure 12-9 shows the CSS Properties pane and the CSS file in the designer window. If you are new to CSS, this is probably the best way to proceed with the task until you become more familiar with the subject. The CSS Properties panel is available from the main Format menu. As you click around the Master Page, you will see the various styles applied to that region in the CSS Properties pane.

Turning to the real world, there are three styles applied to the Quick Launch header. The full set of styles is shown next. In order to customize the header, you will need to make changes to all of the styles used:

```
.ms-quicklaunchheader a,.ms-unselectednav a{
    color:#003399;
    text-decoration:none;
}
.ms-quicklaunchheader a:hover{
    color:#000000;
    text-decoration:underline;
}
```

To change the color of the font used in the header, change the line `color:#003399;` to read `color:#FFFF00`. The font color applied to the text will be changed to yellow.

Save the changes to `default.master`, and preview your change in the browser. Your header in Quick Launch will now have a red background with yellow text. At this point, you have changed some CSS styles to change a single area on the page. In order to change the entire Quick Launch look and feel, you would need to edit each style class applied to the area.

This short example will give you some idea of what is required to change the look and feel of a basic SharePoint site. As you can see, it is really not a simple matter and does require some knowledge and skill, especially with CSS.
Part II: From Desktop to Internet

There is another approach to customization that does call for changing the core.css file. In fact, SharePoint Designer can make a copy of core.css and use the copy to style your SharePoint site, thereby protecting the original copy. This is the approach that I took when first working with SharePoint. To try out this approach:

1. Open a Team Site within SharePoint Designer.
2. Open the default Master Page.
3. Click on the Quick Launch header.
4. In the CSS Properties pane, click on .quicklaunchheader class.
5. Using the CSS Property pane, change the font size to 8 pt; simply overwrite the font-size property shown in the CSS Properties pane.
6. core.css should now be available within SharePoint Designer as an additional tab.
7. Close your Master Page and save the changes.
8. Click Yes in response to the Customization Message.
9. In the Save Embedded Files dialog, accept the defaults and click OK.

SharePoint Designer will create a new folder called _styles, and it will contain a custom copy of core.css. From this point on, your Master Page will use the styles defined in this custom copy to lay out your site. If you make a mistake or would like to undo your changes, simply delete the _styles folder to reset the Master Page back to using the original core.css file.

As you will see from this short section, it is not a particularly easy task to customize a SharePoint site, and it could be argued that for internal sites there is no real need to customize any areas. Customization may be required if your SharePoint installation is outward facing — for example, a public-facing Internet site. If that is the case, then extensive customizations may be required to fit in with company branding and then SharePoint Designer will be one of the tools you will need to learn how to use.

Site Administration with SharePoint Designer 2007

In addition to the development and design features of SharePoint Designer, there are also some areas that can assist you with site management, things like site backup. In the real world of business, your SharePoint installation will be backed up and maintained centrally by systems administrators using either the built-in features of MOSS 2007 or third-party software. As part of the administration feature set of SharePoint Designer, you can back up and restore a SharePoint site. As part of this process, it is possible to use the SharePoint Designer to restore your team site, for example, to another SharePoint Server, but again this is more likely to be carried out by your systems team. And if you don’t have a systems team, it’s more than likely you will have to rely on SharePoint Designer to do this for you.

Backing Up a Team Site

For this example, you are going to back up a new team site and restore it to the same SharePoint server. To follow along with this section, create a new blank team site in SharePoint. In that way, you can safely follow the example without risking any real sites or data. To back up your team site using SharePoint Designer:
Chapter 12: SharePoint Designer 2007

1. Click the Site menu.
2. Select Administration.
3. Select Backup Web Site.
4. Check “include subsites” if you require your subsites to be included in the backup.
5. Click OK.

   The backup will store any temporary backup files it requires on your team site. This location can be changed by clicking the Advanced button in the Backup Web Site dialog shown in Figure 12-10.

6. You will be prompted for a location in which to save the backup file. Select a location and enter a name for the file.

7. Click Save to commence the backup process. You will be kept informed on progress by the Backup Progress dialog, which will remain on screen while the backup is made.

8. Once the backup has been completed, click OK in response to the success message.

   That’s about it for backing up the site. I should say that in the real world where you are likely to have large team sites with large numbers of documents, it is better to use specific backup software for this process. The SharePoint Designer backup will not include any workflows, site collection properties, or alerts, which will all have to be recreated in the newly restored site.

Restoring a Site

It can happen to the best of us: a few mistimed clicks of a mouse and a site is gone. SharePoint Designer also allows you to back up a site using a Content Migration Package (CMP) backup file. (A CMP is a little like a zipped archive containing all the files and definitions that compose your Web site.) To create a new site using the backup file created in the previous example, before you can restore a backup you need to use SharePoint Designer to create a new empty web site on your SharePoint server. To create the new empty web site, click File ➔ New. To continue:

1. Click the Web Site tab in the New dialog.
2. Click General.
3. Select Empty Web Site.
4. Enter the location where you would like to restore the web site to into the “Specify the location of the new web site” drop-down list.
5. Click OK.
Part II: From Desktop to Internet

6. Once the empty site is created, you can then start the restore process using the file backup from
the backup example. To restore the backup into the empty site, click Site.

7. Select Administration, then select Restore Web Site.

8. Navigate to the backup file created in the example earlier.

9. Click Open.

10. Click OK in the Restore Web Site dialog to begin the restore process.

Figure 12-11 shows the original Chapter 12 site in the browser showing the new subsite that has been
created below the main site.

You could have created the new blank site using the SharePoint interface and then opened the blank site
in SharePoint Designer 2007 and restored directly into it. The key here when restoring files is to make
sure that there is absolutely no content in the site you are restoring into. If there is any content, the
restore will fail.

It’s worth pointing out that when you entered the address for the new empty web site, this could have
been on a totally different SharePoint server if required. You are not restricted to restoring the files back
onto the original server. However, in most cases you will use SharePoint Designer to back up and restore
SharePoint sites in the absence of more sophisticated software and on a site-by-site basis as opposed to
for an entire site collection.

Workflows with SharePoint Designer

As you have already seen, SharePoint will provide you with several workflows out of the box.
SharePoint Designer will also allow you to create new workflows on a list or library within your team
sites. The major drawback to this approach is that the workflow is attached to the library you have
authored it on and cannot be used elsewhere in your site. This is as opposed to Visual Studio-authored
workflows that can be used anywhere within your site structure. The workflow you are going to create
will compare a document property. If it equals a value of “Quarterly Management Report,” the workflow
Chapter 12: SharePoint Designer 2007

will execute. It will add an entry to your task list, and send an email notifying you that the report is available.

The workflow will start automatically as documents are added to the library but only for Quarterly Management Reports — all other documents will be ignored. This is not a complex example, but it will give you an idea of how workflows work and how SharePoint Designer helps you author them. You will step through this example and then you will return to the various screens to explore them in more detail.

Before creating the workflow, you will need a document library with a custom column called DocCategory, using a data type of choice. In this example you may not have a category called Quarterly Management Reports. If that is the case, use an appropriate document category available in your team site. The choices in this example will be Quarterly Management Report, Monthly Report, Half Yearly Report, and Annual Report.

1. With your team site open, open the Workflow Wizard by clicking File ➔ New.
2. Click the SharePoint Content tab, and select Workflows.
3. Click OK.
5. Select the list you would like to attach this workflow to, in this case a Finance Document Library.
6. Check “Automatically start this workflow when a new item is created.”
7. Click Next.
8. Click the Conditions button.
9. Select Compare Finance Documents Field.
10. Click on the field link.
11. Select the field required, in this case the custom column DocCategory.
12. Click the Value link.
14. Click the Actions button.
15. Select “Assign a to-do item” and click the link “a to-do item.”
16. Click Next.
17. Add a name for the task (in this case Quarterly Management Report Task) in the Common Tasks dialog.
18. Enter a description for the task.
19. Click Finish.
20. Click the “these users” link.
21. Select one or more users to assign the task to.
Part II: From Desktop to Internet

22. Click OK.
23. Click Actions and select Send an Email.
24. Click the “this message” link, and enter the email address of the person you need to email, the subject, and the email body.
25. Click OK.
26. Click Finish.

To try out the workflow and see that it actually works, you will need to return to your document library and create a new document. Remember to create it within your Quarterly Report category. Figure 12-12 shows the results within the library. Note that the workflow is now set as In Progress.

![Figure 12-12](image)

Figure 12-12

Figure 12-13 shows the associated task that has been added to the task list within the site. Accordingly, an email was sent notifying you that a task was added.

![Figure 12-13](image)
With several mouse clicks and nothing too technical, you created a new automated process that can add value to your document library. As stated, this is a fairly basic example, but it did actually solve a real-world business problem that involved a lot of manual work notifying staff when a particular set of reports was available.

**Workflow Wizard**

As you have already seen, a set of forms is used within SharePoint Designer 2007 to walk you through the process of creating workflows. In this section, you will look at the options available within the various screens.

**Define Your New Workflow Screen**

This screen has a row of buttons along the bottom that will always be available to you as you create the workflow. They are:

- **Check Workflow**: Allows you to run a quick check to ensure that your logic is correct.
- **Initiation**: This can be used to collect data from the person running the workflow if it is being started manually. The workflow engine in SharePoint Designer will build a form to allow the information to be input.
- **Variables**: Values that you can enter that can be referenced within the sequence of steps your workflow is taking. You can then make conditional choices based on their value. Figure 12-14 shows the first screen in the process.

![Figure 12-14](image-url)
Part II: From Desktop to Internet

Workflow Conditions Screen

This is the screen where you create the conditions and actions that you need to carry out your workflow. A condition allows you to give your workflow some thinking skills. If a condition is true, then usually an action is carried out. Conversely, if a condition is false, then the action is not carried out. In the previous example, if a document had a property of Quarterly Management Report, then the action was carried out; if not, then nothing happened. However, workflows also allow you to make decisions if a condition is not met. This allows you to begin to create some branching logic in the workflow. If A is true, do this. If B is true, do something else. Or if A and B are true and C is false, carry out a third action. This provides a very powerful nonprogramming tool for you to use to create powerful workflows, granted within the confines of the tool, but useful none the less. Figure 12-15 shows the second screen in the process.

The out-of-the-box conditions available to you within SharePoint Designer are:

- **Compare fields in a list**: Select a field from the list of interest and compare its value to either an existing column in the same list or a value from another list. Figure 12-16 shows the setting from the earlier example of DocCategory. However, using the Source drop-down you could navigate to another list within your site and select an existing value to compare.

  ![Figure 12-16](image)

- **Compare any data source**: Basically, in much the same way as the first option, this allows you to select any of the data sources (lists and columns) within your team site to be used as the condition. It is also possible to use multiple conditions; for example, you could add two conditions, such as: If DocCategory equals Quarterly Management Report AND title field contains AccessContacts:FullName.

  ![Figure 12-16](image)

- **Now before the workflow will execute, both values must be true. Note the use of the AND operator to enforce this condition or rule. You could also set the source to be a specific type of content, for example, an Expense Report which you are particularly interested in. Drop-down lists are used to select the source and field and add the value required. The options available are:
Chapter 12: SharePoint Designer 2007

- **Title contains keywords**: A range of keywords that are required before the workflow will execute. These can be free text or a reference to a value elsewhere in the site, such as another list.

- **Modified in a specific date span**: Enter a modified from and to date.

- **Modified by a specific person**: Execute if the document or list item has been modified by a specific individual user.

- **Created in a specific date span**: Execute if the document or list item was created between two specific dates.

- **Created by a specific person**: Execute if the document was created by a specific user.

- **The file type is of a specific type**: Execute the workflow if the file is a specific type; for example, only Microsoft Excel 2007 documents.

- **The file size**: Only execute if the file is of a specific size.

**Conditions Screen**

In addition to the conditions, you will of course need a set of actions to carry out if a condition is met. The following are some of the actions available to you:

- **Send an email**: Send an email to a specific user. The email message can also contain dynamic information from the list or another list on the same site. You can use the Add Lookup to Body to select the text you would like to add to the message body. For example, the following combination of free text and lookup values can be added to the message body. In the case of the example shown, you are looking up the name of the person who has the document checked out.

  This document was checked out to [%Finance Documents:Checked out to%].

- **Assign a to-do item**: Add an item to the task list. You can also choose the users to whom you would like to assign the task.

- **Set content approval status**: Depending on the condition being met, you can change the approval status of a document within the library. This could be useful if you want to automatically approve content from certain individuals or, for example, content with specific keywords or titles.

- **Create list item**: Create an entry in a SharePoint list when the conditions have been met. You can choose the list required and the fields to update when the workflow executes.

- **Log to history list**: Log a message to the workflow history list.

- **Collect data from user**: Allows you to create a custom task to collect additional information from the user.

- **Set field in current item**: Allows you to update a field within your list to a specific value.

If you want to see a list of all the actions available to you from within SharePoint Designer, select the More Actions link to open a list of all available actions. Figure 12-17 shows the Workflow Actions list.
As you can see, there are a large number of actions available to you when creating a workflow in SharePoint.

**Edit a Workflow**

Once you have created your workflow, you may need to return to the wizard to reconfigure a condition or action. Within the folder view in SharePoint Designer, you will see a structure similar to that shown in Figure 12-18. The top-level folder, called Workflow, will contain a subfolder for each workflow you have defined on your site. Within a specific subfolder will be the files associated with one particular workflow.

If you need to redesign or edit a workflow, double-click the file ending in the XOML extension to rerun the Workflow Creation Wizard. Make your changes and simply save the edited file back to the folder.

This section briefly outlines some of the workflow capability available with SharePoint Designer 2007. Appendix B lists several web sites and tutorials you can use to learn how to use this extremely powerful tool to build more interactive features into your team sites.

**Working with Data Sources**

One of the most powerful features in SharePoint Designer is its ability to allow you to connect to other data sources and display them within your team site. This is made possible by the use of the Data Form
Web Part, which can be used to display information held in other stores like Microsoft Access or SQL Server. In addition to the Data Form Web Part, you can also set up links to information held in lists in other sites and XML files. All of this is, of course, in addition to the data you can make available using the BDC Web Parts in MOSS 2007. You can of course make use of BDC application files from within SharePoint Designer as well. In this section, you will look at SQL Server 2005 and how you can use the BDC to provide date to the pages within your SharePoint sites.

When working with data sources within SharePoint Designer, you can make use of the Data Form Web Part, which can be used to display and format your data being retrieved from SQL Server and other database systems, SharePoint lists, XML files, and Web Services. For the purposes of this example, you will work with first an SQL Server database and then a SharePoint list. The SQL Server database information will be displayed using a new ASPX page, and the SharePoint list will be customized on an existing SharePoint page.

**Displaying SQL Server 2005 Data**

It is also possible to display information held within SQL Server databases and other data stores in custom and standard pages within your SharePoint site using the features provided by SharePoint Designer. This is useful when you need to display ad hoc information within your SharePoint site or are required to display corporate data without using more sophisticated tools such as the Business Data Connectors. Using SharePoint Designer 2007, you can connect to many different database systems, including Microsoft Access, SQL Server, and Oracle. For this example, you are going to expose a read-only set of customer contact details on a page in your SharePoint site. You are going to start off by adding a connection to the database (SQL Server 2005 in this case), creating a blank page in SharePoint Designer, and then presenting the data on the web page. At the same time, you are going to attach the default SharePoint Master Page to your new page to see how the Master Page changes its look and feel and to ensure your new page fits into the general design of your team site.

For the example that follows you will need a copy of the example SQL Server Northwind database on your SQL Server. To download the sample Northwind database from www.microsoft.com, simply search for “SQL Server 2005 Samples and Sample Databases.” Referring back to Chapter 7 might be useful for a recap on the basic database structure for this example.

To get started, you need to create a new database connection to your team site. To do this, you need to have the Manage Data Sources pane open. If it is not open, click Data View and select Manage Data Sources. You will, of course, also need permissions on the database you are using within the team site. If you are using a different database, simply replace the database and table names with your own relevant names.

1. Expand the Database Connections group.
2. Click “connect to a database.”
3. Click Configure Database Connection.
4. Enter a server name, provider name, and authentication information into the connection dialog. For the provider name, select Microsoft .NET.
5. Click Next.
6. Click OK.
Part II: From Desktop to Internet

7. Select the Northwind database from the drop-down list.
8. Select the Customers table you would like to use from those available.
9. Click Finish.
10. Click OK.

Your database connection should now be available within the Data Sources pane in SharePoint Designer. You will now create a blank ASPX page to host the data.

1. From the main SharePoint Designer menu, click File ➔ New ➔ ASPX, and then click OK.
2. To select the data from your table that you would like to display within the Web Part, hover the mouse over your database connection.
3. Click the connection name, and select “Show data” from the drop-down list. This will display the columns available from your chosen table in the pane.
4. Select a set of columns by holding down the Control key and clicking the columns required. Select CustomerID, CompanyName, and ContactName.
5. Drag the columns onto the design surface in SharePoint Designer. Figure 12-19 shows the design screen at this point in the process.

![Figure 12-19](image-url)

This example only scraped the surface of what can be done with these tools in SharePoint Designer. Figure 12-20 shows another example illustrating another powerful feature of this approach, the ability to pass values between Web Parts.
Connecting Data From Web Parts

In this case, there are two Data Form Web Parts on the page. The top Web Part displays customer information. The bottom Web Part displays order information but with a slight difference. Order information is filtered to only display orders for the selected customer in the top Web Part.

If you click on a customer’s name, the order detail records are displayed below in the Order Web Part. This is a very powerful technique, allowing you to recreate database relationships between tables in your databases and recreate those relations dynamically, using the Data Form Web Parts and SharePoint Designer 2007. To create an example like the Customer and Orders one, you will need to use two Web Parts that retrieve two related sets of data from your database. In the case shown, I used Customers and Orders, which are related in the database by CustomerID. For every order placed, the corresponding CustomerID is saved with the order record. This acts as the link back to the customer who placed that order. For this example, you can reuse the page created for the customer example earlier and add the second Data Form Web Part, only this Web Part will be used to display order records. Before adding the Order Web Part, you will need to create a second data connection:

1. Expand the Database Connections group.
2. Click “Connect to a database.”
3. Click Configure Database Connection.
4. Enter a server name, provider name, and authentication information into the connection dialog. For provider name, select Microsoft .NET.
5. Click Next.
6. Click OK
7. Select the Northwind database from the drop-down list.
Part II: From Desktop to Internet

8. Select the Order table you would like to use from those available.
9. Click Finish.
10. Click OK.

Your connection should now be available in the Data Source Library. You will now need to add a second data form view to the web page. To do so:

1. Click immediately below the Customer data form view.
2. On the main menu, click Data View Insert.
3. Click the connection name, and select “Show data” from the drop-down list. This will display the columns available from your chosen table.
4. Select a set of Order columns by holding down the Control key and clicking the columns required (ShipName, OrderID, CustomerID, ShipAddress). Ensure that you select the CustomerID column in addition to any others you pick. CustomerID is the value used to link the customer to the order placed.
5. Drag the columns onto the design surface in SharePoint Designer and into your second Form Web Part.

Now that you have the data on the web page, you will create the connection between customer and order. To do this:

1. Right-click within the top Web Part displaying customer records.
2. Select Web Part Connections.
3. Accept the default, Send Row of Data to, in the first screen in the Web Part Connection Wizard.
4. Click Next.
5. Accept the “Connect to a Web Part on this page.”
6. Click Next.
7. Accept the defaults on the confirmation screen, and click Next.
8. In the next screen, scroll down the right-hand column until you find the CompanyID field.
9. Click in the left-hand cell, which will contain fields from your Order Web Part, and click the arrow that appears on the right of the cell.
10. Select the ID field.

If you have worked with a relational database, you will be familiar with primary and foreign keys. These are used to create relationships between database tables, and they are the values being selected here. For each order created in the database, a matching CustomerID is saved with the order record. In this process, we are matching the primary key from customer, which is CustomerID, to its foreign key value in Orders, which is ID, recreating the relationship between the two database tables within SharePoint Designer using Data Form Web Parts.

Figure 12-21 shows the screen at this point in the process.
Click Next.

In the “Create a hyperlink on” drop-down list, select the CompanyName. The next screen in the process, shown in Figure 12-22, requests you to supply the field in Customers that you would like to use as the link to the related orders. For example, clicking the company name will pass the CustomerID to the Orders Data Form and filter it to show the matching records.

Click Next.

Click Finish.

Save the page, and view it using your web browser. To view the filtering and data connection, click the column you defined as the hyperlink, and the second Web Part should restrict the records displayed to only those with a matching record. In my case, that is Orders with a CustomerID matching that of the company selected.

The data is presented in a table format for you. At this point, you have created the connection and added the data to your SharePoint page. At the moment, it doesn’t actually look like a SharePoint page.
Part II: From Desktop to Internet

In order to give your page the normal SharePoint look and feel, you need to attach a Master Page to it. To attach the default SharePoint Master Page:

1. To attach the default SharePoint Master Page, from the main menu, select Format ➔ Master Page.
2. Select Attach Master Page from the submenu.
3. Accept the default selection of Default Master Page.
4. Click OK.
5. In the Match Content Region dialog, click on Body.
6. Click OK.
7. Save the changes to your page. I named my page Customers.aspx.

When you are attaching the Master Page, you must specify where any existing content will be placed within its placeholders. In the case of the default master, there is a placeholder for main content called PlaceHolderMain and the Web Part code pages are placed into this area within the Master Page.

Figure 12-23 shows Customers.aspx in the browser. Because you have attached the default Master Page to the file you get all the features of SharePoint, including Quick Launch, navigation aids, and links to all the other SharePoint objects automatically with your new page. This is a very powerful tool to have at your disposal. Once you have permissions on the database server storing your data, you should be free to add it to SharePoint pages using Designer 2007. There is, however, one major issue with this approach and that is the username and password are saved with the connection. This means that anyone who has access to the area using SharePoint Designer will have access to the connection and thus to the username and password. Figure 12-23 shows the final result in the browser with your Master Page applied.
Chapter 12: SharePoint Designer 2007

The Data Form Web Part is a very useful tool when you need to display information within your web site. It offers a very flexible and nontechnical way to get information onto the web page for you and your colleagues.

Summary

In this chapter, you were introduced to many of the features of SharePoint Designer, page design, access to databases and workflows, and backup and restore. As stated at the start of the chapter, it’s always difficult deciding what to include in chapter like this because you can only touch the surface of what is in reality a huge topic on its own. The intent was to get you interested in working behind the scenes with SharePoint, learning how it is put together and functions at a level other than the interface you deal with every day via the web browser. You are encouraged to carry on learning how to interact with this sophisticated software.
In this chapter, you will look at records management in Microsoft Office SharePoint Server (MOSS) 2007. You will look at this area assuming that the Records Center has already been created; you will look at configuring information management policies (IMP) within document libraries, lists, and content types; and working with documents on the records management sites. Even if you do not have permissions to carry out some of the functions within this chapter, it will be useful for you to have a solid overview of how this all fits together, because at some point working with SharePoint you are going to come across the records management and information management features. In addition, you will also look at some of the auditing features available within SharePoint, including its general auditing capability.

Generally, you will find that you are required by various laws to retain data generated in the course of business for specific periods of time. For example, in the United States you have Sarbanes-Oxley, and in the UK the Data Protection Act, both of which require businesses to retain records for specific periods. The records management and information management features of SharePoint 2007 are attempts to assist companies meet their legal and business obligations in this respect. Figure 13-1 shows the Records Center in MOSS 2007; this is the location where your documents will be placed once you begin to implement records management. This is a totally new Records Center, and you will look at how you can configure both the Records Center and your lists and libraries to take advantage of its features.
As you can see in Figure 13-1 it is remarkably similar to a standard SharePoint team site containing the same Quick Launch menu system and, as you will see later, some default lists and libraries.

The management of your company’s business data is a large and complex task and is usually designed by individuals with the required experience and knowledge of professional records management. Like many things IT-related, records management is an area that must be well thought out and planned before implementation. The next section will discuss some of the areas you need to consider before creating the records management center and is based on guidance released by Microsoft on the best practices when working with MOSS 2007 and records management.

Please note I am not a records manager, which is a professional role in itself. In my own employment I work directly with a records manager who has specific skills in this area. The discussions in this chapter are again based on Microsoft best practices when working with MOSS 2007 in my own experience. In large organizations, professional guidance should be sought when creating a management strategy for records management.

Planning for Records Management

In order to implement records management, you need to know the information that is used within your own company and any regulations that apply to that information. Regulations can be legal requirements or company guidelines. For example, you may be legally required to hold copies of invoices for a particular number of years and then review them. Other documents you produce you may not need any records management features applied to them, and they can be disposed of or stored as you see fit. In general, people tend to not dispose of anything, and documents end up sitting in shared folders, email folders, or on hard drives at home for endless periods of time, some never seeing the light of day again. Generally the first step in records management is defining, in the context of your own role, what a record actually is. This is where the development of a file plan comes in, and the best person to assist with this
is you, the person who is actually dealing with the information on a daily basis. A file plan will generally:

- Describe the type of information you work with.
- Be organized at a high level that indicates categories for records.
- Locate where records are currently stored.
- Allocate the retention periods for records and who is responsible for their review.

These four bullet points could take a large complex organization many months to define and draw up a plan for, and involve a large number of staff working on the project. Generally, you will find that business documents fall into three groups:

- Active records which are currently being used from day to day; not only those you are saving in SharePoint documents libraries but other documents like emails relating to business functions, documents stored on your USB key, or perhaps documents you have at home. All of these documents could be subject to a records management policy.
- Archived records, which are required but not used on a daily basis, including records that may be retained for historical reasons.
- Historical records, which need to be retained for a specified period of time.

You must, as already stated, decide which of the documents you are dealing with is actually a record. At a recent meeting on this topic, I suggested that, first of all, you define those documents that you are required by law to retain, the “What’s going to get you in trouble first?” approach. Out of all the hundreds of documents produced in an organization, which ones do you need to keep? These will be the initial documents that will be declared as records — invoices, accounts, legal papers, and contracts, for instance. Of course, this also includes any associated emails related to the documents and their creation and discussion. Once you have identified the documents that make up your initial record collection, you can list them out. Microsoft provides a set of worksheets that can be used at different stages of planning records management. Basically, for each item you:

- Define the record name
- Add it to the appropriate category
- Add a description for the record

Take, for example, a company invoice that could have the following details recorded:

- **Record Name:** Company Invoice
- **Category:** Financial Business Documents
- **Description:** Records of sales made to our customers

Once you have completed this process, you will have a definition of each record type you are required to look after and a detailed set of worksheets describing those records. As stated, this part in the process can take some time. Now, if you simply use SharePoint, you may be asking yourself, “Why is he telling me all this stuff?” Well, you need to be involved in this process, and you will almost certainly be either at the design stage or certainly at the implementation stage, as you will see. It will help to have an understanding of how and why records management is both configured and carried out.
Part II: From Desktop to Internet

The Reality of Records Management

In my own experience, I have found that records management is an area difficult to define. Many people are totally unaware of what is supposed to be a record subject to various legal restrictions and what is not. Many people simply create and store documents and never think of records management as long as they can find the document when required, which is foremost in their minds. For this reason, you may find that company records are not stored where you may think they should be. For example, many people save documents on their local hard drives rather than company servers. In a large organization, you may begin to see the scale of the problem in simply identifying what a record is and, just as important, where it is located. This is one of the benefits of a properly implemented SharePoint solution: beginning to save documents and other related material in a central storage location as opposed to the diverse storage locations used by many people. Again based on my own experience, this is a hard habit to break, storing documents wherever you feel like it. Once you begin to implement records management, it is vital that documents declared as records be stored within the document management system; in this case, that will be MOSS 2007. I have found this to be particularly difficult to implement when individuals are used to saving documents anywhere they choose. One way to combat this is to make network file shares read-only. From that point on, staff would have access to historical files but could no longer save documents into that area. A considerable amount of training and education is required to break the habits of a lifetime in some cases, but eventually it will be worth it. So, the first two steps define what records are and lay out a file plan. However, using SharePoint it is also possible to make file shares searchable, and in that way you can have the best of both worlds: the collaboration features of SharePoint and the long-term storage space available in existing file servers. In the real world, generally a combination of both SharePoint and file shares will coexist.

Retention Plan

Now that you know which records you need to retain, you need to define a retention policy for those records you have identified as being required. Within the retention policy you need to know:

- How long you need to keep a document.
- Who will review the document or documents at the end of the period.
- If a document can be automatically deleted.
- Where the longer-term storage of documents will take place.
- At what level in SharePoint your policy will be applied. (On a document-by-document level or across the entire site?)
- How email integration will work with respect to this policy.
- If you require emails to be included within your policy.

Once you know this information for each of your records types, you are almost ready to begin using SharePoint to manage the records management process. The following table shows the sort of layout you
Chapter 13: Records Management

should have for your record and file plan at this point in the example used here for a set of administrative school records.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Description</th>
<th>Retention Period</th>
<th>Disposal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student report</td>
<td>Report on each student’s progress</td>
<td>10 years from date of creation</td>
<td>Archive</td>
</tr>
<tr>
<td>Exam papers</td>
<td>Papers related to the publication of exams</td>
<td>5 years from use date</td>
<td>Archive</td>
</tr>
<tr>
<td>Exam notes</td>
<td>Notes made on exam performance</td>
<td>5 years from creation</td>
<td>Destroy after review</td>
</tr>
<tr>
<td>Staff appraisal</td>
<td>Appraisal papers related to annual appraisal</td>
<td>2 years</td>
<td>Review by creator</td>
</tr>
</tbody>
</table>

**Information Management Policies and Auditing**

In addition to the full ability with respect to Records Center in MOSS 2007, there are other areas that are beneficial to discuss when it comes to the management of information within a SharePoint environment. An understanding of these areas will also help you and your colleagues when it comes to implementing and using the full set of records management features. The planning information above should also be carried out if you are going to implement auditing and information management policies even if you are not intending to implement the MOSS Records Center to carry out full-fledged records management.

**Document Library Information Policies**

Within your standard SharePoint Document library, you can define an information management policy that will be applied to the documents stored within that library. An information management policy can be defined at the library or at the site collection level. A site collection policy can be applied to any library within the collection. This process is in addition to the central records management policy applied across the SharePoint installation. To view the information management policy settings within a document library from within the document library, you need to open the Information Management Policy settings form, where you can create a new policy or reuse a site collection policy. To create or set an information management policy for a document library, content type, or list:

1. Click Settings.
2. Click Document Library Settings.
3. Select Information Management Policy Settings to open the Settings form.

The Settings form is also dynamic in that different options will be available, depending on the type of information management policy you choose to set. It’s worth noting that you cannot add a name for an information management policy defined at this level. You will see how to name a policy later in the chapter. The following generic features are available to you when creating an information management policy in a SharePoint:
Part II: From Desktop to Internet

- **Administration Description**: Used to inform list managers about the policy when they are creating lists or libraries.

- **Policy Statement**: A policy statement that will be available to users who are working with documents subject to an information management policy within your environment. When you open a document with an associated information management policy in Microsoft Word 2007, this policy statement will be shown in the document management panel. Figure 13-2 shows a simple statement in Word 2007. It is important to inform your colleagues when an IMP is being applied to a document or list rather than applying them under the covers.

![Information Management Policy](image)

**Figure 13-2**

To follow the example used in this section, you will need to create a new document library containing two custom columns, Room Number and Item. To create the new library:

1. Click Site Actions, then Create.
2. Click the Document Library.
3. Enter a name for the Library, for example Records Example.
4. Click Create, accepting the remaining defaults.
5. Within the new library, click Settings and Create Column, and create a column called Room Number; repeat the process, creating a column called Item. To finish the setup, you will create the Information Management Policy.

The following features are dependent on the type of information management policy you are creating within the list or library.

**Labels**

You can add a descriptive label to documents that provides additional information with respect to the policy. Basically, the label can include metadata about the document. For example, in an asset control library, you might have metadata of Room Number and Item. You could, if you wished, ensure that this metadata was associated to a document in the form of a label that would be added to the document automatically by Word 2007 and SharePoint applying the information management policy. A label is created by using the metadata enclosed in curly brackets:

```
{Room Number} - {Inventory Item Reference}
Purchased By Martin Reid
```

The preceding example would produce the following label in SharePoint:

```
12 - Item123456
Purchased By Martin Reid
```

Note the use of `\n` to add a new line to the label. You can view a preview of your label within the settings form by clicking the Refresh button. If you have made an error when setting up the metadata values for the label, these will be shown in red text at the top of the form.
Chapter 13: Records Management

Any combination of the library’s metadata can be used, but you cannot use built-in SharePoint properties such as Created By. To create the information policy and label:

1. Click Settings within the library.
3. Select “Information management policy settings.”
4. Check the radio button “Define a policy.”
5. Click OK.
6. Enter an Administrative Description for the policy.
7. Enter a Policy Statement like “This document is required to have a label.”
8. Check the Enable Labels check box in the Labels section of the form, and check both boxes “Prompt users to insert a label before saving or printing” and “Prevent changes to labels after they are added.”
9. Enter the following text into the label format text box:

{(Room Number)---(Item)\nPurchased by Martin Reid}

10. Accept the remaining defaults and click OK to save the policy and associate it with the library. Note the section in the Label form that allows you to format the label in terms of font and style used if required.

Figure 13-3 shows the relevant part of the Information Management Policy Settings form that you use when you are working with labels.

![Figure 13-3](image-url)
Part II: From Desktop to Internet

To test out the policy, create a new document from within the library by clicking New ➔ New Document on the Library menu. From the Microsoft Word 2007 side of the process, when you come to save a document that has a label policy applied, you will be prompted to add the label when you save the document back into the library. Figure 13-4 shows the dialog when saving the document from Microsoft Word 2007.

Clicking Yes will stop the save, and the label will be added to the header of the document, as shown in Figure 13-5.

If you click No in response to the dialog, you can still save the document, but a label will be created using the default metadata values for the document. Figure 13-6 shows a document library with the label column visible. Note the second document (no label) was saved into the library even after clicking No in response to the label dialog. Figure 13-6 also demonstrates how the label was created by combining the metadata from the document (Room Number and Item) with some standard text.

The label column will not be visible in the initial view of your document library within SharePoint. In order to view the label, you need to add the column to the library’s default view. Click on the View menu and select Modify This View. Check the Label column check box, and click OK to save the changes and return to the library. Your label column should now be visible.
Chapter 13: Records Management

Barcodes

Barcodes are an electronic way to identify documents. SharePoint contains a single barcode type out of the box, but if you use specific barcodes in your documents, you can add additional configurations to the system. The barcoding system works in much the same way in SharePoint as configuring labels. In this case, all that you need to do is check the Enable Barcodes check box. Checking the Prompt user check box will also prompt you when working in Word 2007, for example, to insert a barcode before saving the document into SharePoint. Figure 13-7 shows the barcode settings in the Information Management Policy Settings form.

![Figure 13-7](image)

When working from within Microsoft Word, for instance, you will see the same prompts as when using labels if you have checked the “Prompt users” check box shown in Figure 13-7. Otherwise, as with a label, the barcode will be automatically created on the SharePoint side. Figure 13-8 shows the view of a document library displaying the barcode. This is not something you would add to the general view of a document library for obvious reasons. Visually, it does look fairly bad and is used simply to demonstrate the barcode for this example. If you want to view a barcode associated with a document, as in this example, the easier way is to simply use the Document menu to view the properties of the document, and the barcode will be displayed.

![Figure 13-8](image)
Part II: From Desktop to Internet

Auditing

You can also turn on document auditing as part of an information management policy. When you check the Enable Auditing check box in the Information Management Policy, Edit Policy form, a range of auditing options will be available. Figure 13-9 shows the section in the Settings form once this has been done.

![Figure 13-9](image)

The following options are available as part of the auditing process:

- Opening or downloading documents
- Editing items
- Checking out or checking in items
- Moving or copying items to another location in the site
- Deleting or restoring items

When you open an item that is subject to this policy, again in Microsoft Word, you will be informed that the document is covered by a company IMP.

Expiration

This policy allows you to configure how a document is dealt with when it has reached the end of its life as defined by your records management policy and implemented by the information management policy. Using the default SharePoint features, all you can really do with the document at this point is to delete or run a workflow.

In terms of workflow, SharePoint standard workflows are available to you, and one of those, the Disposition workflow, will prove useful in this area. This workflow will not actually send the document to a colleague for action, but it will create a task within a specific list. The idea is that only certain individuals (like a records manager) will have access to this list and be able to take the required action. In order to use this workflow, you will need to enable it at the document library level before you can use it as part of the information management policy. You can also create a specific task list to which the workflow will add tasks related to the disposal of documents. If you don’t do this, the data will be sent to the standard SharePoint task list. Once you create an instance of the workflow within the document library or list, it will become available in the options for the expiration policy. You can of course if it...
meets your requirements simply delete the document. This example will take you through configuring an expiration policy for a SharePoint document library, bearing in mind that you need to set up the Disposition workflow first. To set the expiration policy:

1. Check the Expiration check box in the IMP Settings page.
2. Specify the retention rule for the document, which can be any number of years, months, or days after the document is created or modified.
3. Set the action to either delete the document or apply a SharePoint workflow to the document. For example, you can specify that an email be sent to the records manager or person responsible for the document to have it dealt with. Figure 13-10 shows the options available to you.

![Figure 13-10](image)

Note the selected workflow in the drop-down list shown in Figure 13-10; this is an instance of the Disposition workflow that was created at the document library level and then selected within this form. To create the workflow, go to the settings for the library and select Workflow Settings. Then follow these steps:

1. Select Disposition Approval from the “Select a workflow” template box.
2. Enter a name for this workflow, for example “Dispose of documents.”
3. Accept the default task list shown.
4. Accept the default history list shown.
5. Check the box “Start this workflow when a new item is created.”
6. Click OK to save the new workflow instance.

The new workflow will then be available in the list of workflows shown in Figure 13-10, using the “Start this workflow drop-down.”

In this case, two years after the document creation date the workflow would be fired and a task would be added to the Disposition task list for action. You could also create a custom workflow using SharePoint Designer or, if you can program or have access to a development team, you could use Visual Studio, where workflows really come into their own.
The preceding discussion used the example of a document library to outline some of the information management policy features of SharePoint. However, it is important to point out that IMPs can also be applied to lists within the environment and you are not simply restricted to documents. In the case of associating an information management policy with a list, the process is identical to that used when creating an IMP for a document library. This is one area of records and information management that is often overlooked; there could be a lot of information held in standard SharePoint lists that you may require in your records management system.

**Content Types and Information Management Policy**

When you are working with content types, you can also associate an information management policy directly with the content type itself, meaning that you can have multiple IMPs associated with different types of content in the same document library. If that is the case, when you click on Information Management Policy Settings for the list or library, rather than being taken directly to the settings page, you will be shown a list of the content types, and you can then choose which you would like to associate with a policy. Setting up the information management policy for a content type is exactly the same as it is for a document. Figure 13-11 shows a content type with a custom policy applied.

![Figure 13-11](image)

Now whenever you use the content type, its information management policy will already be defined for you. It is also possible to set the IMP for a content type directly by using the Site Settings menu, which will allow you to work with the content types without actually having to go into each library or list in which they are used. From your top-level site:

1. Click Site Actions, then Site Settings.
2. Under Galleries, select Site Content Types.
3. Select the content type required by clicking on its name.
4. In the settings group, select Information Management Policy Settings.

From this point, you can continue as described previously by creating a new information management policy or applying a site collection policy. Note that you cannot create a policy for a core system content type. You must create a new content type based on the core type and apply the policy to that.

**Creating a General Site Collection Policy**

The previous examples for IMPs can result in a lot of work when you are setting policy at the list, library, or content type level. You can also set up information management policies at the site collection level and then simply apply them as and when required throughout your sites and to the objects within the sites. To create a site collection IMP, you must be a site collection administrator. To continue from within the top site of your SharePoint site collection:
1. Select Site Collection Policies from the Site Collection Administration Group.

2. Click Create.

3. Name the policy Finance Reporting Policy.

4. Enter in the following text as the Administrative Description: “This policy is to be applied to all documents related to Financial Budget Reports stored within the site.”

5. Enter the following text for the policy statement to be displayed to your colleagues: “Please note that this document is subject to the full automatic audit within the system. You are not permitted to save this document to a local drive.”

6. Select the appropriate Information Management policy. In this case, check the Enable Auditing check box.

7. Check all the audit boxes to turn on full audit capability.

8. Click OK to save the policy.

Now that you have created a centrally managed IMP you can apply it as required anywhere within your site. Figure 13-12 shows the new policy in the IMP drop-down for a document library. This approach to information management policies does make more sense in terms of the management of policies across the server as opposed to creating policy on a document or library level. However, the ability to have the granular ability to work with information management policies down to the list or library level is useful. You will apply this policy shortly.
Part II: From Desktop to Internet

In addition to using the auditing feature that you have seen in this chapter, you can also configure auditing for the site collection as a whole, provided that you have the appropriate permissions. If that is the case, then you can configure auditing for a wide range of activities within the system:

- Opening or downloading documents, viewing items in lists, or viewing item properties
- Editing items
- Checking items in or out
- Moving or copying items to other locations within the site
- Deleting or restoring items
- Editing content types or columns
- Searching site content
- Editing users and permissions

Once you have configured auditing either at the site collection or document level, or at the list or content type level, you will of course need a way to view what’s actually being audited. SharePoint provides an extensive range of audit reports, and you can also create custom reports. At the site collection top site level, you will find a link to audit reports that can be run by the administrator of the site. The reports fall into four categories, each of which contains a specific subset of audit reports:

- Content Activity reports
- Custom reports
- Information Management Policy reports
- Security and Site Settings reports

The reports will be output as Microsoft Excel files and contain a lot of detailed information about the selected content. For example, while writing this chapter I created several information management policies, so for this example, I will run the Content Type and Lists report located in the Content Activity group. Figure 13-13 shows the resulting Excel 2007 workbook. If the report contains no records, you will be informed of this and can return to the SharePoint site. The report below shows that there were 26 modifications made to policies and each area a modification was made in. Returning to the site collection information management policy created in the earlier example, you are now going to apply this policy to a document library, and then once you have created some activity within the library, run the audit report. To continue, return to your SharePoint Documents library:

1. Click Settings, and select Document Library Settings.
2. Click Information Management Policy settings in the Permissions and Management category.
3. In the Specify the Policy group, click the radio button “Use a site collection policy.”
5. Click OK to save the settings.

Once the information management policy has been applied, you will need to wait a while until you have created some activity on your library, for example by opening documents, deleting documents, creating
new documents, and other general library actions. Once this is done, you can run the information management policy reports to see the results of your audit policy. An example report is shown in Figure 13-13.

![Policy modifications](image)

Figure 13-13

As you can see, SharePoint has considerable features to assist you with the management of information at various levels within your site, including the built-in auditing capability. However, you can take this one step farther by implementing full-fledged records management.

**Moving on to Full Records Management**

The records management feature is available with Microsoft Office SharePoint Server 2007, and in order to make use of it, you need to create a Records Center. One of the major disadvantages with records management is that it is a manual process in MOSS 2007 (unless you can get some custom development done), and the responsibility for declaring a document as a company record lies with you. Basically, when you declare a document as a company record, you send it to the Records Center, where based on its content type it will be routed to the appropriate area. The other drawback to using MOSS is that the original document will be left behind in the document library, giving you two copies of the document, one of which is the official version held in the Records Center.

**Record Center Structures**

The MOSS 2007 Records Center is the SharePoint site created to manage your entire records management infrastructure. It will generally be created and managed by your corporate records manager with input from others within the organization. When you view your Records Center, several items will already be in place, including the familiar Quick Launch menu. Some lists will already have been created within the center, and you will examine these as you go through the various features of this area.

Within the standard Quick Launch menu several links to records specific lists and libraries will already be in place, including:

- **Unclassified Records**: When you move a record into the center, if it is not classified, it will be placed into this library until you have time to classify it.
- **Record Routing**: This is the instruction to the Records Center about how you would like the various records dealt with that are held within this list. Note that a single routing is available for you immediately.
Part II: From Desktop to Internet

- **Holds:** These are records that you put on hold, that is, records that cannot be touched because they are required for legal proceedings.

- **Tasks:** This is the standard SharePoint task list.

If you click View All Site Content in the Quick Launch, you will see that there are some additional libraries including:

- **Missing Properties:** Used to enter any missing metadata associated with records submitted to the center.

- **Records Pending Submission:** Used to hold records that are missing metadata.

- **Submitted E-mail Records:** Used to store email messages submitted to the Records Center.

**Records Center Process**

This is where your file plan comes into focus again. Within the Records Center, you can create a document library for each of the file types you have identified earlier. You can route all your documents to a single library, but this makes management of the area fairly confusing. Let’s take another example of a finance team site. Assume that, within the team site for the finance department, you have created several different types of document content types, such as financial reports, financial contracts, and financial statements.

To comply with a set of business rules and your legal responsibilities, you will be required to retain these documents for specific periods of time, and you will build this into the Records Center. Based on these content types, you will now build the Records Center features to implement records management. One of the first things to do is to build the records routing tables within the MOSS 2007 Records Center.

**Record Routing**

Each routing record contains the information about how you would like it to deal with the records you submit. You will need to plan the structures of the routing features within MOSS 2007. Figure 13-14 shows the default Record Routing library on the home page of a MOSS 2007 Records Center.

![Figure 13-14](image)

1. To create a new routing, click New.
2. Enter title for the routing. In most cases, it makes sense to add the Content Type name being routed. This makes it easier to manage multiple routing records.
3. Enter a description for this routing record.
4. Enter the document library location for this record type routing. The document library must already exist within the Records Center before you enter the name in this area.

5. Enter one or more aliases for this record type. For example, a financial report could also be known as an annual budget, accounts, or management accounts. Any records using this naming convention will use this routing record.

6. Leave the default blank. All unclassified records should be routed to the existing unclassified records library.

7. Click OK to create the routing record.

In a similar manner, you can create a routing record for each of the content types you have created. At the end of the process, you will have a Records Center document library for each of the content types and a matching Record Routing entry again for each of the libraries and content types. If records that do not meet the criteria within the routing table are submitted to the centers, then they will be added to the Unclassified Records list, and you are then required to manually organize them into the correct area. Figure 13-15 shows the record routing once the items have been created.

<table>
<thead>
<tr>
<th>Record Routing</th>
<th>New</th>
<th>Actions</th>
<th>Settings</th>
<th>Location</th>
<th>Aliases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified Records</td>
<td>Class</td>
<td>Location</td>
<td>Aligned</td>
<td>Document Library</td>
<td>Library: Unclassified Records</td>
</tr>
<tr>
<td>Finance Reports</td>
<td>Library</td>
<td>Location</td>
<td>Aligned</td>
<td>Finance Reports</td>
<td>Accounts/Annual Budgets/Quarterly Management Reports</td>
</tr>
<tr>
<td>Financial Contracts</td>
<td>Company Policies</td>
<td>Location</td>
<td>Aligned</td>
<td>Financial Contracts</td>
<td>financial</td>
</tr>
<tr>
<td>Financial Statements</td>
<td>Company Policies</td>
<td>Location</td>
<td>Aligned</td>
<td>Financial Statements</td>
<td>financial</td>
</tr>
</tbody>
</table>

**Figure 13-15**

To recap, at this point in the process, you will have a set of standard SharePoint document libraries, and each library will contain for this example a single content type. The content type will be associated with an information management policy and will have a matching library and routing record in the Records Center. The process of sending a document to the Records Center is a manual one in this case. To submit a record to the Records Center from within a document library, open the Document menu and select line break Send to Records Center.

The Send To Records Center option (see Figure 13-16) will only be available once this feature of MOSS 2007 has been enabled by your server administrator. The name used for this option in your own environment could also be different.
I should point out that the Records Center in this example has already been created on the SharePoint server and the same will need to be the case on your own SharePoint sites. This is normally the role of your systems administrator or records manager and falls outside the role of a standard SharePoint user.

Once selected using this method, the document will be copied to the Records Center (note the word “copied”), and you will be told the operation has completed. Because the document is copied, your original document is left in place within the document library, and you have no indication that it has been declared a record and copied. Another important point to make is that any associated metadata and version history associated with your document will also be moved into the records area. It is also important to realize that each document library only has one Send To option for the Records Center even though there is nothing to stop an organization from having multiple Record Centers. However, given that a records area is meant to be a single global repository for company data, it is perhaps a better practice to have a single Records Center available across the entire organization as opposed to several spread throughout a company.

From the Records Center side of things, Figure 13-17 shows the results of moving a text file into the Unclassified library. A new folder has been created within the library for the document submitted; the folder name will be a combination of the current date and a unique number. Any metadata or document properties will be copied into a subfolder called Properties.
Returning to the previous example of the Finance content types, Figure 13-18 shows the results of submitting a set of documents from the Finance Report document library to the Records Center. At the top level of the library, a folder is created, and all records of the corresponding content type are placed here. Each record sent to the Records Center is routed, according to the specific routing table, into the correct library. The original file name is retained with a unique reference appended; in addition, a subfolder is created, and each file’s associated properties will be located here with an identical file name to allow easy matching of the document with its properties file.

The Finance Reports document library also contains an information management policy for this content type that will expire the document after two years.

The document library within the Records Center has a couple of different menu items, including the ability to add a document to the Hold library. To add a record to the Hold library:

1. Open the Document menu.
2. Select Manage Holds.
3. Check the radio button “Add to Hold.”
4. Select a Hold library from the drop-down list.
5. Enter a comment for the Hold record.
6. Click Save.

Figure 13-19 shows the Finance Reports document library when a record has been placed on hold. Notice the On Hold status indicator.
At the moment, it is still possible to download the held document within the Records Center, edit it, and send the updated version back to the folder. The Hold feature simply suspends the records management policy on the document as opposed to totally protecting it from updating while it may be the subject of legal proceedings. Hold are managed from the Hold list, where the hold can be released, additional items added to the hold, and a Hold report can be executed.

**Moving Up Market**

The default Records Center within MOSS 2007 can be replaced by downloading a more fully featured, certified records management solution from Microsoft. Recently, MOSS 2007 records management was certified as DOD 5015.2, which is a U.S. Department of Defense standard for records management. This new add-in meets all the required certifications in order to operate as a records management solution for U.S. government agencies. In order to meet the certification standard, several new features had to be added to the out-of-the-box functionality of MOSS 2007 including:

- The ability to build file plans within MOSS 2007.
- The ability to link records together.
- The ability to mark records as vital to an organization.
- The provision of cutoff dates to assist in the disposal of records.
- The creation of global and other time-based periods for the management of records.
- The placement of an entire folder and its contents on hold as opposed to single files within a folder.

It has to be said that the DOD add-in for records management is a totally different type of Records Center than that supplied with SharePoint and will take additional work to set up and implement. Again, planning will be the key to success with records management if you need to use the add-in pack.

If you need the complexities of military-grade records management, then it is worthwhile having a look at the capabilities of the DOD add-in pack for SharePoint. Even if you don’t need it, it is worthwhile to install and compare it with the out-of-the-box SharePoint records management features discussed in this chapter, as there are several features that are worth deploying if your company is serious about records management.
Summary

This chapter looked at the various ways in which Microsoft Office SharePoint Server 2007 helps you to manage information and its security, from working with content types and auditing to operating a full-fledged records management system. It has to be said that if your company is new to records management, then you may find that getting it set up in SharePoint is the easy part. The hard part is the amount of work that could be required planning for records management. Many documents are available on the Microsoft web site (just do a search for “records management”) to assist you in the planning process. For those of you who may not actually have anything to do with the planning side and are users of SharePoint, this chapter will give you some insight into the reasons for these features.
Microsoft Office
Word, Access, and Excel
2003–2007 Command Reference


This reference is an abbreviated version of the Microsoft Office 2003–2007 command references available from Office Online and is used with the permission of Microsoft. I would like to thank Clint Covington and Christopher Mascis at Microsoft for their help in arranging permissions to include this material. It will be a useful resource for those of you new to Office 2007 to have at hand. The full references and interactive guides can be viewed and downloaded from the following URLs:

## Microsoft Word 2003 to 2007 Common Command Reference

<table>
<thead>
<tr>
<th>Word 2003 File Menu</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Office Button</td>
</tr>
<tr>
<td>Close</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Save</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save As</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save As Web Page</td>
<td>In the Save As dialog box, select Web Page in the</td>
</tr>
<tr>
<td></td>
<td>Save As type list.</td>
</tr>
<tr>
<td>Permission</td>
<td>Office Button</td>
</tr>
<tr>
<td>Check Out</td>
<td>Office Button</td>
</tr>
<tr>
<td>Check In</td>
<td>Office Button</td>
</tr>
<tr>
<td>Version History (In a Document Library)</td>
<td>Office Button</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Office Button</td>
</tr>
<tr>
<td>Print</td>
<td>Office Button</td>
</tr>
<tr>
<td>Send To (Recipient using Internet Fax Service)</td>
<td>Office Button</td>
</tr>
<tr>
<td>Send To (Microsoft Office PowerPoint)</td>
<td>Office Button</td>
</tr>
<tr>
<td>Properties</td>
<td>Office Button</td>
</tr>
<tr>
<td>Recently Used Documents</td>
<td>Office Button</td>
</tr>
<tr>
<td>Exit</td>
<td>Office Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2003 Edit Menu</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Redo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Cut</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2003 Edit Menu</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Office Clipboard</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Office Clipboard</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Home</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Paste as Hyperlink</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Paste as Hyperlink</td>
<td>Home</td>
</tr>
<tr>
<td>Select All</td>
<td>Home</td>
</tr>
<tr>
<td>Find</td>
<td>Home</td>
</tr>
<tr>
<td>Replace</td>
<td>Home</td>
</tr>
<tr>
<td>Go To</td>
<td>Home</td>
</tr>
<tr>
<td>Links</td>
<td>Office Button</td>
</tr>
<tr>
<td>Object</td>
<td>Double-click an object to edit it.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2003 Formatting</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Styles and Formatting</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Styles and Formatting</td>
<td>Home</td>
</tr>
<tr>
<td>Style</td>
<td>Home</td>
</tr>
<tr>
<td>Font</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Font</td>
<td>Home</td>
</tr>
<tr>
<td>Font Size</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Font Size</td>
<td>Home</td>
</tr>
<tr>
<td>Bold</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Bold</td>
<td>Home</td>
</tr>
</tbody>
</table>

Continued

*(continued)*

<table>
<thead>
<tr>
<th><strong>Word 2003 Formatting</strong></th>
<th><strong>Word 2007 Menu</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Italic</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Italic</td>
<td>Home</td>
</tr>
<tr>
<td>Underline</td>
<td>Home</td>
</tr>
<tr>
<td>Underline</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Align Left</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Align Left</td>
<td>Home</td>
</tr>
<tr>
<td>Center</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Center</td>
<td>Home</td>
</tr>
<tr>
<td>Align Right</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Align Right</td>
<td>Home</td>
</tr>
<tr>
<td>Justify</td>
<td>Home</td>
</tr>
<tr>
<td>Distributed</td>
<td>Home</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>Home</td>
</tr>
<tr>
<td>Numbering</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Numbering</td>
<td>Home</td>
</tr>
<tr>
<td>Bullets</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Bullets</td>
<td>Home</td>
</tr>
<tr>
<td>Increase Indent</td>
<td>Home</td>
</tr>
<tr>
<td>Borders</td>
<td>Home</td>
</tr>
<tr>
<td>Highlight</td>
<td>Home</td>
</tr>
<tr>
<td>Highlight</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Font Color</td>
<td>Home</td>
</tr>
<tr>
<td>Font Color</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Grow Font</td>
<td>Blog Post</td>
</tr>
<tr>
<td>Superscript</td>
<td>Home</td>
</tr>
<tr>
<td>Subscript</td>
<td>Home</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2003 Insert Menu</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break</td>
<td>Insert</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Insert</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Header &amp; Footer Tools</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Insert</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Header &amp; Footer Tools</td>
</tr>
<tr>
<td>AutoText (AutoText)</td>
<td>Insert</td>
</tr>
<tr>
<td>AutoText (List of AutoText Entries)</td>
<td>Insert</td>
</tr>
<tr>
<td>Field</td>
<td>Insert</td>
</tr>
<tr>
<td>Field</td>
<td>Header &amp; Footer Tools</td>
</tr>
<tr>
<td>Symbol</td>
<td>Insert</td>
</tr>
<tr>
<td>Comment</td>
<td>Review</td>
</tr>
<tr>
<td>Reference (Footnote)</td>
<td>References</td>
</tr>
<tr>
<td>Picture (Clip Art)</td>
<td>Insert</td>
</tr>
<tr>
<td>Picture (Clip Art)</td>
<td>Header &amp; Footer Tools</td>
</tr>
<tr>
<td>Picture (From File)</td>
<td>Insert</td>
</tr>
<tr>
<td>Picture (From File)</td>
<td>Header &amp; Footer Tools</td>
</tr>
<tr>
<td>Picture (From File)</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Picture (WordArt)</td>
<td>Insert</td>
</tr>
<tr>
<td>Picture (Organization Chart)</td>
<td>Insert</td>
</tr>
<tr>
<td>Picture (Chart)</td>
<td>Insert</td>
</tr>
<tr>
<td>Diagram</td>
<td>Insert</td>
</tr>
<tr>
<td>Text Box</td>
<td>Insert</td>
</tr>
<tr>
<td>File</td>
<td>Insert</td>
</tr>
<tr>
<td>Object</td>
<td>Insert</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Insert</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Insert</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2003 Table Menu</th>
<th>Word 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Table</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Draw Table</td>
<td>Home</td>
</tr>
<tr>
<td>Draw Table</td>
<td>Insert</td>
</tr>
<tr>
<td>Draw Table</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Insert (Table)</td>
<td>Insert</td>
</tr>
<tr>
<td>Insert (Columns to the Left)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Insert (Columns to the Right)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Insert (Rows Above)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Insert (Rows Below)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Insert (Cells)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Delete (Table)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Delete (Columns)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Delete (Rows)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Delete (Cells)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Select (Table)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Select (Column)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Select (Row)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Select (Cell)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Merge Cells</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Split Cells</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Split Table</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Table AutoFormat</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Convert (Text to Table)</td>
<td>Insert</td>
</tr>
<tr>
<td>Convert (Table to Text)</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Sort</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Formula</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Show Gridlines</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Table Properties</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Table Properties</td>
<td>Table Tools</td>
</tr>
</tbody>
</table>
# Microsoft Access 2003 to Microsoft Access 2007 Command Reference

<table>
<thead>
<tr>
<th>Access 2003 Database Menu</th>
<th>Access 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>New</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>Open</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
</tr>
<tr>
<td>Save</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>File Search</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Print</td>
<td>Quick Print</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Spelling</td>
<td>Home</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Format Painter</td>
<td>Form Design Tools</td>
</tr>
<tr>
<td>Undo</td>
<td>Database</td>
</tr>
<tr>
<td>Office Links</td>
<td>External Data</td>
</tr>
<tr>
<td>Analyze</td>
<td>External Data</td>
</tr>
<tr>
<td>Code</td>
<td>Form Design Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Database Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Function &amp; View Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>SQL Statement Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Table Tools</td>
</tr>
</tbody>
</table>

*Continued*
### Access 2003 Database Menu vs. Access 2007 Menu

<table>
<thead>
<tr>
<th>Access 2003 Database Menu</th>
<th>Access 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Form Design Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Form Layout Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Report Design Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Report Layout Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Relationships</td>
<td>Database Tools</td>
</tr>
<tr>
<td>New Object</td>
<td>Create</td>
</tr>
<tr>
<td>Import</td>
<td>External Data</td>
</tr>
<tr>
<td>Link Tables</td>
<td>Microsoft Office Button</td>
</tr>
</tbody>
</table>

### Access 2003 File Menu vs. Access 2007 Menu

<table>
<thead>
<tr>
<th>Access 2003 File Menu</th>
<th>Access 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>File</td>
</tr>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>New</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>Open</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Get External Data</td>
<td>External Data</td>
</tr>
<tr>
<td>Get External Data</td>
<td>Import</td>
</tr>
<tr>
<td>Get External Data</td>
<td>Link Tables</td>
</tr>
<tr>
<td>Close</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
</tr>
<tr>
<td>Save</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save As</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save As</td>
<td>Macro Tools</td>
</tr>
<tr>
<td>Save As</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Back Up Database</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Export</td>
<td>External Data</td>
</tr>
<tr>
<td>File Search</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Connection</td>
<td>Microsoft Office Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access 2003 File Menu</th>
<th>Access 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revert</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Load from Query</td>
<td>Home</td>
</tr>
<tr>
<td>Save As Query</td>
<td>Home</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Print Relationships</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Send To</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Database Properties</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Recent File Names</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Exit</td>
<td>Microsoft Office Button</td>
</tr>
</tbody>
</table>

### Access 2003 Relationships

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show Table</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show Table</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Hide Table</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Edit Relationship</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show Direct</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show All</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>New</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>Open</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
</tr>
</tbody>
</table>

*Continued*
(continued)

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>File Search</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Print</td>
<td>Quick Print</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Spelling</td>
<td>Home</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Can’t Undo</td>
<td>Undo</td>
</tr>
<tr>
<td>Can’t Undo</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Show Table</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show Table</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Show Direct</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Show All</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Clear Layout</td>
<td>Relationship Tools</td>
</tr>
<tr>
<td>Database Window</td>
<td>Replaced by the Navigation Pane.</td>
</tr>
<tr>
<td>New Object</td>
<td>Create</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access 2003 Query</th>
<th>Access 2007 Query Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Group By</td>
<td>Function &amp; View Tools</td>
</tr>
<tr>
<td>Group By</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Add Table</td>
<td>Diagram Tools</td>
</tr>
<tr>
<td>Remove</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Show Table</td>
<td>Relationship Tools</td>
</tr>
</tbody>
</table>

392

<table>
<thead>
<tr>
<th>Access 2003 Query</th>
<th>Access 2007 Query Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Table</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Remove Table</td>
<td>Context menu of the table header in Query Design view.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Home</td>
</tr>
<tr>
<td>Select Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Crosstab Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Make-Table Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Update Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Append Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Delete Query</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Select Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Make-Table Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Update Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Append Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Append-Values Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Delete Query</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>SQL Specific</td>
<td>Query Tools</td>
</tr>
<tr>
<td>SQL Specific</td>
<td>Union</td>
</tr>
<tr>
<td>SQL Specific</td>
<td>Pass-Through</td>
</tr>
<tr>
<td>SQL Specific</td>
<td>Data Definition</td>
</tr>
<tr>
<td>Parameters</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>View</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Save</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Save</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>File Search</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Print</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Print</td>
</tr>
</tbody>
</table>

*Continued*

(continued)

<table>
<thead>
<tr>
<th>Access 2003 Query</th>
<th>Access 2007 Query Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Datasheet</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Sort Ascending</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Filter By Form</td>
</tr>
<tr>
<td>Query Datasheet</td>
<td>Grid</td>
</tr>
<tr>
<td>Query Design</td>
<td>View</td>
</tr>
<tr>
<td>Query Design</td>
<td>Save</td>
</tr>
<tr>
<td>Query Design</td>
<td>Save</td>
</tr>
<tr>
<td>Query Design</td>
<td>File Search</td>
</tr>
<tr>
<td>Query Design</td>
<td>Print</td>
</tr>
<tr>
<td>Query Design</td>
<td>Print</td>
</tr>
<tr>
<td>Query Design</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Query Design</td>
<td>Spelling</td>
</tr>
<tr>
<td>Query Design</td>
<td>Cut</td>
</tr>
<tr>
<td>Query Design</td>
<td>Copy</td>
</tr>
<tr>
<td>Query Design</td>
<td>Paste</td>
</tr>
<tr>
<td>Query Design</td>
<td>Paste</td>
</tr>
<tr>
<td>Query Design</td>
<td>Query Type</td>
</tr>
<tr>
<td>Query Design</td>
<td>Run</td>
</tr>
<tr>
<td>Query Design</td>
<td>Show Table</td>
</tr>
<tr>
<td>Query Design</td>
<td>Show Table</td>
</tr>
<tr>
<td>Query Design</td>
<td>Totals</td>
</tr>
<tr>
<td>Query Design</td>
<td>Top Values</td>
</tr>
<tr>
<td>Query Design</td>
<td>New Object</td>
</tr>
</tbody>
</table>
### Access 2003 Records Menu

<table>
<thead>
<tr>
<th>Access 2003 Records Menu</th>
<th>Access 2007 Records Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records</td>
<td>Home</td>
</tr>
<tr>
<td>Filter</td>
<td>Home</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter By Form</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter By Selection</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter Excluding Selection</td>
</tr>
<tr>
<td>Filter</td>
<td>Advanced Filter/Sort</td>
</tr>
<tr>
<td>Filter</td>
<td>Server Filter by Form</td>
</tr>
<tr>
<td>Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort Ascending</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort Descending</td>
</tr>
<tr>
<td>Apply Filter/Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Remove Filter/Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Save Record</td>
<td>Home</td>
</tr>
<tr>
<td>Refresh</td>
<td>Home</td>
</tr>
<tr>
<td>Data Entry</td>
<td>Office Button</td>
</tr>
<tr>
<td>Maximum Records</td>
<td>Office Button</td>
</tr>
</tbody>
</table>

### Access 2003 Filter Menu

<table>
<thead>
<tr>
<th>Access 2003 Filter Menu</th>
<th>Access 2007 Filter Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Home</td>
</tr>
<tr>
<td>Filter By Form</td>
<td>Home</td>
</tr>
<tr>
<td>Filter By Selection</td>
<td>Other Commands</td>
</tr>
<tr>
<td>Filter Excluding Selection</td>
<td>Other Commands</td>
</tr>
<tr>
<td>Advanced Filter/Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Server Filter by Form</td>
<td>Home</td>
</tr>
<tr>
<td>Apply Filter/Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Remove Filter/Sort</td>
<td>Home</td>
</tr>
<tr>
<td>Apply Server Filter</td>
<td>Home</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access 2003 Form/Report Design</th>
<th>Access 2007 Form Design</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Save</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td><strong>File Search</strong></td>
<td>Removed from product.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Quick Print</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td>Print Preview</td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td><strong>Spelling</strong></td>
<td>Home</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Home</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Home</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Home</td>
</tr>
<tr>
<td><strong>Undo</strong></td>
<td>Undo</td>
</tr>
<tr>
<td><strong>Redo</strong></td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td><strong>Field List</strong></td>
<td>Form Design Tools</td>
</tr>
<tr>
<td><strong>Field List</strong></td>
<td>Form Layout Tools</td>
</tr>
<tr>
<td><strong>Field List</strong></td>
<td>Report Design Tools</td>
</tr>
<tr>
<td><strong>Field List</strong></td>
<td>Report Layout Tools</td>
</tr>
<tr>
<td><strong>Field List</strong></td>
<td>Table Tools</td>
</tr>
<tr>
<td><strong>Toolbox</strong></td>
<td>Form Tools</td>
</tr>
<tr>
<td><strong>AutoFormat</strong></td>
<td>Form Layout Tools</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Form Design Tools</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Report Design Tools</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Database Tools</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Diagram Tools</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Function &amp; View Tools</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access 2003 Form/Report Design</th>
<th>Access 2007 Form Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>SQL Statement Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Stored Procedure Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Form Design Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Form Layout Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Report Design Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Report Layout Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>PivotChart Tools</td>
</tr>
<tr>
<td>Properties</td>
<td>PivotTable Tools</td>
</tr>
<tr>
<td>Build</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Build</td>
<td>Macro Tools</td>
</tr>
<tr>
<td>Build</td>
<td>Query Tools</td>
</tr>
<tr>
<td>Database Window</td>
<td>Replaced by the Navigation Pane.</td>
</tr>
<tr>
<td>New Object</td>
<td>Create</td>
</tr>
<tr>
<td>Microsoft Office Access Help</td>
<td>Help</td>
</tr>
<tr>
<td>Microsoft Office Access Help</td>
<td>Microsoft Office Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access 2003 Table Datasheet Menu</th>
<th>Access 2007 Table Datasheet Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
</tr>
<tr>
<td>File Search</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Print</td>
<td>Quick Print</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Home</td>
</tr>
<tr>
<td>Filter By Selection</td>
<td>Microsoft Office Button</td>
</tr>
</tbody>
</table>

Continued

397
### Access 2003 Table Datasheet Menu vs. Access 2007 Table Datasheet Menu

<table>
<thead>
<tr>
<th>Access 2003 Table Datasheet Menu</th>
<th>Access 2007 table Datasheet Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter By Form</td>
<td>Home</td>
</tr>
<tr>
<td>Toggle Filter</td>
<td>Home</td>
</tr>
<tr>
<td>Find</td>
<td>Home</td>
</tr>
<tr>
<td>New Record</td>
<td>Home</td>
</tr>
<tr>
<td>New Record</td>
<td>Home</td>
</tr>
<tr>
<td>Delete Record</td>
<td>Home</td>
</tr>
<tr>
<td>Database Window</td>
<td>Replaced by the Navigation Pane.</td>
</tr>
<tr>
<td>New Object</td>
<td>Create</td>
</tr>
</tbody>
</table>

### Access 2003 Table Design Menu vs. Access 2007 Table Design Menu

<table>
<thead>
<tr>
<th>Access 2003 Table Design Menu</th>
<th>Access 2007 Table Design Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Save</td>
</tr>
<tr>
<td>Save</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>File Search</td>
<td>Removed from product.</td>
</tr>
<tr>
<td>Print</td>
<td>Quick Print</td>
</tr>
<tr>
<td>Print</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Microsoft Office Button</td>
</tr>
<tr>
<td>Spelling</td>
<td>Home</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Format Painter</td>
<td>Home</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Diagram Tools</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Indexes</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Rows</td>
<td>Table Tools</td>
</tr>
<tr>
<td>Delete Rows</td>
<td>Table Tools</td>
</tr>
</tbody>
</table>
# Microsoft Excel 2003 to Microsoft Excel 2007 Command Reference

<table>
<thead>
<tr>
<th>Excel 2003 Standard Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Save</td>
<td>Office Button</td>
</tr>
<tr>
<td>Permission</td>
<td>Office Button</td>
</tr>
<tr>
<td>Email</td>
<td>Office Button</td>
</tr>
<tr>
<td>Print</td>
<td>Office Button</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Office Button</td>
</tr>
<tr>
<td>Spelling</td>
<td>Review</td>
</tr>
<tr>
<td>Research</td>
<td>Review</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Format Painter</td>
<td>Home</td>
</tr>
<tr>
<td>Undo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Redo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Ink Annotations</td>
<td>Review</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Insert</td>
</tr>
<tr>
<td>AutoSum</td>
<td>Home</td>
</tr>
<tr>
<td>AutoSum</td>
<td>Formulas</td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Data</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Data</td>
</tr>
<tr>
<td>Chart Wizard</td>
<td>Insert</td>
</tr>
<tr>
<td>Drawing</td>
<td>These commands are available in the Drawing Tools tabs when you insert or select a shape.</td>
</tr>
<tr>
<td>Zoom</td>
<td>View</td>
</tr>
</tbody>
</table>

*Continued*

(continued)

<table>
<thead>
<tr>
<th>Excel 2003 Standard Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Excel Help</td>
<td>Upper Ribbon</td>
</tr>
<tr>
<td>PivotTable and PivotChartReport</td>
<td>Insert</td>
</tr>
<tr>
<td>Comment</td>
<td>Review</td>
</tr>
<tr>
<td>AutoFilter</td>
<td>Home</td>
</tr>
<tr>
<td></td>
<td>Data</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 Chart Toolbar</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Objects</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Format Selected Object</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Chart Type</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Legend</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Data Table</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Series in Rows</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Series in Columns</td>
<td>Chart Tools</td>
</tr>
<tr>
<td>Angle Clockwise</td>
<td>Home</td>
</tr>
<tr>
<td>Angle Counterclockwise</td>
<td>Home</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 File Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Office Button</td>
</tr>
<tr>
<td>New</td>
<td>Office Button</td>
</tr>
<tr>
<td>Open</td>
<td>Office Button</td>
</tr>
<tr>
<td>Close</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Save As</td>
<td>Office Button</td>
</tr>
<tr>
<td>Save as Web Page</td>
<td>Office Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 File Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Workspace</td>
<td>View</td>
</tr>
<tr>
<td>File Search</td>
<td>Windows Start button</td>
</tr>
<tr>
<td>Permission</td>
<td>Restrict Permission As</td>
</tr>
<tr>
<td>Permission</td>
<td>Restrict Permission As</td>
</tr>
<tr>
<td>Check Out</td>
<td>Office Button</td>
</tr>
<tr>
<td>Check In</td>
<td>Office Button</td>
</tr>
<tr>
<td>Version History</td>
<td>Office Button</td>
</tr>
<tr>
<td>Web Page Preview</td>
<td>Office Button</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Page Layout</td>
</tr>
<tr>
<td>Print Area</td>
<td>Set Print Area</td>
</tr>
<tr>
<td>Print Area</td>
<td>Clear Print Area</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Office Button</td>
</tr>
<tr>
<td>Print</td>
<td>Office Button</td>
</tr>
<tr>
<td>Print</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Properties</td>
<td>Office Button</td>
</tr>
<tr>
<td>Most Recently Used Documents</td>
<td>Office Button</td>
</tr>
<tr>
<td>Exit</td>
<td>Office Button</td>
</tr>
<tr>
<td>Sign out</td>
<td>Removed from product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 Edit Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Redo</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>Cut</td>
<td>Home</td>
</tr>
<tr>
<td>Copy</td>
<td>Home</td>
</tr>
<tr>
<td>Office Clipboard</td>
<td>Home</td>
</tr>
<tr>
<td>Paste</td>
<td>Home</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Home</td>
</tr>
</tbody>
</table>

Continued

(continued)

<table>
<thead>
<tr>
<th>Excel 2003 Edit Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste as Hyperlink</td>
<td>Home</td>
</tr>
<tr>
<td>Fill</td>
<td>Down</td>
</tr>
<tr>
<td>Fill</td>
<td>Right</td>
</tr>
<tr>
<td>Fill</td>
<td>Up</td>
</tr>
<tr>
<td>Fill</td>
<td>Left</td>
</tr>
<tr>
<td>Fill</td>
<td>Across Worksheets</td>
</tr>
<tr>
<td>Fill</td>
<td>Series</td>
</tr>
<tr>
<td>Fill</td>
<td>Justify</td>
</tr>
<tr>
<td>Clear</td>
<td>All</td>
</tr>
<tr>
<td>Clear</td>
<td>Formats</td>
</tr>
<tr>
<td>Clear</td>
<td>Contents</td>
</tr>
<tr>
<td>Clear</td>
<td>Comments</td>
</tr>
<tr>
<td>Delete</td>
<td>Home</td>
</tr>
<tr>
<td>Delete Sheet</td>
<td>Home</td>
</tr>
<tr>
<td>Move or Copy Sheet</td>
<td>Home</td>
</tr>
<tr>
<td>Find</td>
<td>Home</td>
</tr>
<tr>
<td>Replace</td>
<td>Home</td>
</tr>
<tr>
<td>Go To</td>
<td>Home</td>
</tr>
<tr>
<td>Links</td>
<td>Office Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 View Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>View</td>
</tr>
<tr>
<td>Page Break Preview</td>
<td>View</td>
</tr>
<tr>
<td>Task Pane</td>
<td>In some groups, dialog box launchers will display a Task Pane instead of a dialog box. For example, Home</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Standard</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Formatting</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Borders</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Excel 2003 View Menu</th>
<th>Excel 2007 Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars</td>
<td>Chart</td>
</tr>
<tr>
<td>Toolbars</td>
<td>External Data</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Formula Auditing</td>
</tr>
<tr>
<td>Toolbars</td>
<td>List</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Picture</td>
</tr>
<tr>
<td>Toolbars</td>
<td>PivotTable</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Task Pane</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Text To Speech</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Visual Basic</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Watch Window</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Web</td>
</tr>
<tr>
<td>Toolbars</td>
<td>WordArt</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Customize</td>
</tr>
<tr>
<td>Formula Bar</td>
<td>View</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Status Bar is always visible by default.</td>
</tr>
<tr>
<td>Header and Footer</td>
<td>Insert</td>
</tr>
<tr>
<td>Comments</td>
<td>Review</td>
</tr>
<tr>
<td>Custom Views</td>
<td>View</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Excel 2003 Insert Menu</strong></th>
<th><strong>Excel 2007 Menu</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cells</td>
<td>Home</td>
</tr>
<tr>
<td>Rows</td>
<td>Home</td>
</tr>
<tr>
<td>Columns</td>
<td>Home</td>
</tr>
<tr>
<td>Worksheet</td>
<td>Home</td>
</tr>
<tr>
<td>Chart</td>
<td>Insert</td>
</tr>
<tr>
<td>Symbol</td>
<td>Insert</td>
</tr>
<tr>
<td>Page Break</td>
<td>Page Layout</td>
</tr>
<tr>
<td>Reset All Page Breaks</td>
<td>Page Layout</td>
</tr>
<tr>
<td>Function</td>
<td>Formulas</td>
</tr>
<tr>
<td>Name</td>
<td>Define</td>
</tr>
<tr>
<td>Name</td>
<td>Create</td>
</tr>
<tr>
<td>Comment</td>
<td>Review</td>
</tr>
<tr>
<td>Picture</td>
<td>Clip Art</td>
</tr>
<tr>
<td>Picture</td>
<td>From File</td>
</tr>
<tr>
<td>Picture</td>
<td>From File</td>
</tr>
<tr>
<td>Picture</td>
<td>From File</td>
</tr>
<tr>
<td>Picture</td>
<td>Ink Drawing and Writing</td>
</tr>
<tr>
<td>Picture</td>
<td>AutoShapes</td>
</tr>
<tr>
<td>Picture</td>
<td>WordArt</td>
</tr>
<tr>
<td>Picture</td>
<td>Organization Chart</td>
</tr>
<tr>
<td>Diagram</td>
<td>Insert</td>
</tr>
<tr>
<td>Object</td>
<td>Insert</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Insert</td>
</tr>
</tbody>
</table>
Useful SharePoint Links

This appendix is designed to provide you with a quick resource to some of the more useful web sites regarding Microsoft Office SharePoint Server 2007 and Windows SharePoint Services Version 3.

Microsoft

- www.microsoft.com/sharepoint/prodinfo/demos.mspx: A point of entry that provides general SharePoint-related information.
- http://blogs.msdn.com/markarend/archive/2008/02/14/sharepoint-2007-permissions-matrix.aspx: For a single, all-encompassing look at permissions within SharePoint, this blog is about the best there is. Download the permissions matrix available from the home page.
- http://blogs.msdn.com/sharepointdesigner/default.aspx: This official blog of the Microsoft SharePoint Designer team contains many articles for both beginners and advanced users of SharePoint Designer.
- http://office.microsoft.com/en-us/sharepointserver/HA101732171033.aspx: This is the main Microsoft SharePoint web site, where you can access SharePoint-related materials and tutorials.
Appendix B: Useful SharePoint Links

- [http://office.microsoft.com/en-us/sharepointserver/HA102488011033.aspx](http://office.microsoft.com/en-us/sharepointserver/HA102488011033.aspx): From this web site, download and install desktop training material directly from Microsoft. This software will provide you with direct access to many of the Microsoft training materials.

- [http://sharepoint.microsoft.com/blogs/GetThePoint/default.aspx](http://sharepoint.microsoft.com/blogs/GetThePoint/default.aspx): A Microsoft-sponsored SharePoint blog that contains a lot of user information and tutorials. (Full disclosure: I am a guest blogger on this site.)

SharePoint Training Materials


- [www.endusersharepoint.com](http://www.endusersharepoint.com): One of the best end-user sites on the web; contains lots of useful information, and if you register with the site, you will have access to the members’ area from where you can download several PDF “books” of SharePoint training and reference materials.

- [www.graphicalwonder.com](http://www.graphicalwonder.com): Shane Perran’s useful blog dealing with the customization of SharePoint. Shane is also a SharePoint MVP and the author of Wrox’s Beginning SharePoint 2007.

- [www.heathersolomon.com](http://www.heathersolomon.com): Heather Solomon writes the leading blog in terms of how to customize SharePoint sites and pages using SharePoint Designer and code. Heather’s blog contains loads of useful information and downloads to help you come to grips with what can be a tricky subject. Top of the list for downloads is Heather’s CSS Chart, which is one of the most useful tools on the web when it comes to designing sites. Heather’s CSS chart is an interactive design guide that provides both an image of each SharePoint screen area and its associated CSS style. Clicking on a menu image will allow you to copy to your Clipboard the default CSS style applied. You can then simply paste this into SharePoint Designer, add your own edits to the style, and see the changes in the page. This site should be the first port of call for those new to site design and SharePoint 2007.

- [www.sharepoint-screencasts.com](http://www.sharepoint-screencasts.com): A great web site that contains lots of free SharePoint instructional video content.

- [www.tedpattison.net/MOSS_BOOK.aspx](http://www.tedpattison.net/MOSS_BOOK.aspx): Available for free downloading, leading SharePoint developer and trainer Ted Pattison’s free Microsoft Press book examines several areas of SharePoint and is well worth a look.

- [http://weblogs.asp.net/erobillard/default.aspx](http://weblogs.asp.net/erobillard/default.aspx): Eli Robillard is another of the great personalities in the SharePoint world. This blog is a little technical, but it provides some really great insight and ideas not only on SharePoint, but also on computing in general.
Index

A

About Me, 139
Absence Request and Vacation Schedule Management template, 50
ACCDB file type, 204, 206
access
to corporate data, 171
desktop to Internet, 25
MOSS security, 19–21
accessibility
SharePoint and MOSS, 170
SharePoint issues, 22
accounts
My Profile options, 141
Word Blog Ribbon options, 200
Actions
Conditions screen, 351–352
Meeting tool, 308
Actions menu
Datasheet view options, 64–65
picture library, 85
Shared Documents options, 59–60
Active Directory (AD)
audience targeting, 159
defined, 19
social networking and, 137
Active Tasks, 116
adding
colleagues to MySite, 141–142
CSS classes, 340–341
tasks, 194–195
Web Parts, 104–105
Web Parts to MySite, 148–149
workflow to content type, 181–186
workflows, 83
add-ins
commercial Web Parts, 324–329
Excel compatibility, 267–268
free software, 318–323
other useful software, 329
overview, 317–318
records management, 380
administration
blog, 147–148
Excel Services limitations, 272
free Web Parts for, 323
records management. See records management
saving emails to document libraries, 258–260
with SharePoint Designer, 344–346
site administrator templates, 47–50
site collection, 151–155
with Site Settings menu, 32–34
Advanced Contact Details, 107–108
Advanced Search Box Web Part, 127–128
agendas, 308
alerts
contact list options, 215
defined, 14
document library, 84
Groove, 298
Groove discussion, 306–307
Groove workspace, 303
MySite, 163
MySite options, 152
Outlook, 254–255
Shared Documents options, 60
Site Settings menu, 33
aligning images, 109
All Documents view, 67
Alternative Text, 109
Announcements
in Document Center, 44
in document workspace, 39
list, 86–87
Web Part, 112–113
anonymous access, 20
Appearance of contacts, 106
Append Only fields, 206
application templates, 46–53
appointments

appointments
 in Groove calendars, 304–305
 using and linking calendars, 248–250
approval
 Approval Workflow, 80–81
 permissions, 20
 workflow actions, 351
Asset Tracker template, 315
Assistant in My Profile, 140
attachments
 data types, 206
 to Groove discussions, 306
 issues with Access, 242
 new Access features, 204
 saving to database, 204
 saving with Outlook, 258–260
Attendees, 308
audiences
 Contact Detail options, 108
 defined, 17–18
 personalization with, 156–159
 selecting view, 68
 team site personalization, 161–162
auditing
 information management policies and, 365–372
 MySite settings, 154–155
 site collections, 373–375
B
back-end databases
 creating SharePoint application, 226–228
 defined, 225
backing up
 general Access advice, 208
 team sites, 344–345
Bamboo Solutions
 commercial Web Parts, 324, 327–329
 free Web Parts, 323
barcodes
 in document library information policy, 369
 information management with, 11
benefits, employee, 48
Birthday in My Profile, 140
blank forms, 236–237
blank meeting workspace, 41
Blank Site template, 38
blogs
 defined, 11
 My Profile, 149
 MySite, 147–148
SharePoint links, 405–406
templates, 40–41
Word 2007, 198–201
Word menu, 175
browsers
 Excel Service filters, 286–292
 Excel Services limitations, 272
 as information delivery tool, 169–171
 MOSS and, 6
 Office Live in, 201
 SharePoint support, 23–25
 support with RadEditor Lite, 320–321
 using pivot table in, 275–277
 viewing in, 76–77
Budgeting and Tracking Multiple Projects
template, 50
bugs. See also error messages
 Bug-Tracking template, 50
 Site Users Web Part, 112
Business Data, 96
Business Data Actions Web Part, 121–122
Business Data Catalog (BDC)
 access to corporate data, 171
 defined, 18
 Web Parts, 121–123, 329
Business Data Item Web Part, 123
Business Data List Web Part, 122–123
Business Data Related List Web Part, 123
Business Intelligence Web Parts, 121–123
Business Performance Reporting template, 47
businesses
 defining documents, 363
 knowledge management, 168–169
 social networking and, 136–138
C
caching, 214
Calculate Workbook menu, 286
calculated columns, 67
calendars
 Bamboo Web Parts, 327–328
 Calendar List, 35
 Calendar Plus, 324–325
 defined, 12–13
 Groove, 298, 304–305
 mini-calendar Web Part, 323
 My Profile availability, 149
 MySite customization, 155
Content Migration Package (CMP)

Outlook, 248–250
tracking lists, 90–91
Web Part, 113–114
call center template, 50
Cascading Style Sheets (CSS), See CSS
(Cascading Style Sheets)
cascading updates and deletes, 233
case management, 47–48
Catalogs folder, 337–338
Catalogue Icon Image URL, 108
Change Request Management template, 51
charts in Excel, 400
chatting, 312–313
Check In/Out
  document library options, 70
document options, 78–79
documents in Groove, 311–312
  in Excel, 267
  Word document, 189–191
Check Workflow, 349
Choice filter, 124–125
Choose, 121
chrome state, 107
choice type, 107
classes
  adding CSS, 340–341
defined, 333
classifying information, 10
Classroom Management template, 48
cloud computing, 201
CMP (Content Migration Package), 345–346
code
  CSS, 333–335
  HTML, 332–333
Codeplex, 318
colleagues
  inviting to Groove workspace, 302–303
  MySite information, 141–143
  in Quick Launch Menu, 145
  Word 2007 interaction, 195–196
columns
  Access list issues, 241
  adding workflow to content type, 183–184
  Announcements Web Part, 113
  contact list options, 215
  create setting, 60, 65–67
  creating custom content types, 179
document library, 71–72
  new Access features, 204
  security, 327
  Shared Documents library, 58
  Site Settings menu, 32
  workbook display, 285
commands
  Access 2007, 389–398
  Excel 2007, 399–404
  Word 2007, 384–388
commenting
  blog management, 147
  on KPIs, 294
commercial Web Parts, 324–329
communication lists, 86–89
Community Kit, 318
Community Server, 201
comparison conditions, 350
compatibility
  Access database on SharePoint, 226
  Excel, 267–268
  Groove for SharePoint, 309
competitive analysis site, 48
conditions
  defining workflow, 350–351
  screen, 351–352
Configure Links Web Part, 114
conflicts in synchronization, 219–221
connections
  Connect to Outlook, 59
  connecting Excel to SQL Server, 277–280
  Contact Detail options, 107
  Data Form Web Part, 355–359
  data sources, 352–353
  exporting SharePoint list to Excel,
    270–271
  Groove to SharePoint, 309–311
  moving Excel connection to SharePoint,
    281–283
  MySite options, 154–155
contacts
  Contact Details Web Part, 106–108
  creating, 210–215
  list, 87–88
  management template, 51
  Outlook, 253–254
  tool templates for Groove, 315
content
  blog management, 147
  customizing MySite, 144
  structure and, 34
  workflow actions, 351
Content Migration Package (CMP), 345–346
Content Query

Content Query
adding to MySite, 157–159
vs. List Aggregator, 326
Web Part, 131–133

collection types
adding workflow to, 181–186
custom Word, 178–181
customizing Document Information panel, 186–187
defined, 11
information management policy and, 372
overview, 176–177
Site Settings menu, 32
in Word documents, 188–189
Word documents based on, 177–178
copying contacts, 253–254
Core Results Web Part, 129–130
core.css, 341–344
courses, training
links, 406
templates, 48
coworkers. See colleagues
Create a Collect Feedback Workflow, 82
Create a Post, 147
Create Column, 60, 65–67
Create menu, 31–32
Create View, 60, 67–70
Create Web Part Page, 103
Cross List Web Part, 328
cross-browser support
with RadEditor Lite, 320–321
SharePoint issues, 23–25
CSS (Cascading Style Sheets)
customization with, 338–344
SharePoint Designer and, 333–335
SharePoint Designer panes, 335–336
SharePoint Skinner, 321–322
site customization, 54
Current User filter, 125
customization
basic site, 54
content types, 178–181
CSS, 333–335
Document Information panel, 186–187
library column, 71–72
list, 97–98
lists, 268–269
MOSS, 15
MySite, 155–156
MySite home page, 143–146
Send To, 77–78
with SharePoint Designer, 338–344
workflow, 82–83

data
access to corporate, 171
changing in Access and synchronization, 218–221
new Access features, 207
publishing SQL Server to SharePoint, 277–281
SQL Server display, 353–355
viewers, 328–329
Data Connection files, 281–283
Data Connection Library, 86
Data Form Web Parts
creating, 355–359
data sources, 352–353
Data Protection Act, 361
data sources
SharePoint Designer, 352–353
SharePoint Designer panes, 336
workflow conditions, 350
data types
Access database features, 206
Access issues, 241–242
database design, 205
defined, 65–66
exporting Excel lists, 269–270
databases
Access commands, 389–390
connecting Excel to SQL Server, 277–280
creating Access on SharePoint, 225–230
creating in Access, 223–224
displaying SQL Server data, 353–355
moving Access to SharePoint, 230–234
new Access features, 204–206
Datasheet view
document library, 62–65
editing in, 59
date
filtering with, 125–126
moving Access tables to SharePoint and, 233
working with calendars. See calendars
decision meeting workspace, 41
default library items, 58–61
default Quick Launch links, 35–37
Define Your New Workflow screen, 349
DOD (Department of Defense) records management

deletion
Access support with SharePoint, 228
cascading, 233
contact list options, 215
editing documents in, 76
in Groove workspace, 301–302
record expiration, 370–372
Recycle Bin, 37
Site Settings menu, 34
workflow, 83

Department of Defense (DOD) records management, 380

design
Access database, 204–206
Access tip, 225
CSS, 333–335
permissions, 20
SharePoint Skinner, 321–322
site customization, 54
views, 216–217

desktop to Internet, 25, 166–171
Details in MySite, 145
Developer's Toolbar, 334
Directory, Active. See Active Directory (AD)
discussions
boards, 88–89
cross-browser support, 320–321
database template, 48
defined, 12
Forum Web Part, 325
Groove, 298, 305–307
Outlook lists, 261–263
Team Discussion, 36
display
with Data Form Web Parts, 355–359
SQL Server data, 353–355
workbook, 284–285
disposal
record expiration, 370–372
records management, 365

Disputed Invoice Management template, 48

Document Center
defined, 19
template, 44

Document Edit Menu, 74–79

Document Information panel
customization, 186–187
setting availability, 184–185
document libraries
Access views with, 216–217
alerts, 14, 84
columns, 71–72
connecting Groove to, 309–311
custom content types, 180–181
Datasheet view, 62–65
defined, 9–10
Document Library Settings, 70
editing menu, 74–79
Excel Web Part, 283
filtering with, 287–288
form library, 84–85
information policies, 365–369
linking to Outlook, 245–246
management, 72–74
picture library, 85–86
preconfigured templates, 53
Record Center routing, 376–380
RSS settings for, 261
saving emails to, 258–260
Settings menu, 65–67
Shared Documents options, 60
SharePoint Designer workflows, 346–349
template, 51
Tree View Web Part, 319–320
uploading documents to, 61–62
views, 67–70
Word, 175–176
Word check-in/out, 189–191
workflow, 79–83

Document Management task pane
colleagues interaction, 195–196
in Excel, 267–268
Word 2007, 192–194
document-level permissions, 21
documents
customizing MySite, 146
editing in Groove, 311–312
linking to Outlook, 245–246
management, 7
opening in Outlook, 247
records management. See records management
Relevant Documents. See Relevant Documents shared. See Shared Documents
workspace template, 38–39

DOD (Department of Defense) records management, 380
downloading
  Bamboo Web Parts, 327–329
  exporting SharePoint list to Excel, 270–271
  free Web Parts, 323
  Groove, 299–300
  tool templates for Groove, 315

E
  Edit in Datasheet
    Shared Documents options, 59
    working with, 62–63
  editing
    with check out, 189–191
    document libraries, 74–79
    documents in Groove, 311–312
    documents in Outlook, 247
    Excel commands, 401–402
    lists with aggregator, 326–327
    with Master Pages, 338–344
    menu, 32
    RadEditor Lite, 320–321
    SharePoint Designer workflows, 352
    SharePoint lists, 218–221
    tasks in Outlook, 251–253
    Web Parts, 104–106
    Word commands, 384–385
  electronic forms, 84–85
  email
    Groove workspace options, 302
    My Profile options, 141
    Outlook. See Microsoft Outlook 2007
    records management, 376
    saving Outlook, 258–260
    updates, 15
    workflow actions, 351
  employee templates, 48
  EmployeeReference, 185
  Enable Attachments to the List, 90
  Enterprise tab, 43–46
  enterprise-level search, 16
  entities, BDC, 121–123
  equity research template, 48
  error messages
    Contact Detail options, 108
    SharePoint list conflicts, 219–221
    SharePoint site issues table, 228–229
  events
    creating meeting workspace from, 43
    planning template, 51
  using and linking calendars, 248–250

Excel. See Microsoft Excel 2007
  Exchange 2007, 243
  expired records, 370–372
  Explorer View, 115–116
  exporting
    Excel list to SharePoint, 269–270
    lists to Access, 221–222
    Shared Document options, 59
    SharePoint list to Excel, 270–271
    Web Parts, 108

F
  Fax Number in My Profile, 140
  feedback
    collection workflow, 82
    workflow from Word 2007, 197
  feeds, RSS. See RSS
  fields
    Access list issues, 241
    workflow conditions, 350
  file types
    new Access features, 206
    Records Center process, 376
    workflow conditions, 351
  files
    Access commands, 390–391
    core.css, 341–344
    Excel commands, 400–401
    Excel compatibility, 267–268
    Groove and SharePoint, 309–312
    Groove menu, 301–302
    moving connection to SharePoint, 281–283
    Outlook, 244
    plans, 362–363
    publishing Excel, 273–275
    records management. See records management
    SharePoint Designer panes, 335
    uploading, 61–62
    Word commands, 384
  filtering
    Access commands, 395
    commercial Web Parts, 327
    with Content Query, 131–133
    Data Form Web Parts and, 355–359
    documents in Datasheet view, 63–65
    with Excel Services, 286–292
    Web Parts, 8, 124–127
    workbook options, 285
folders
- local Groove, 312
- SharePoint Designer panes, 335
- view options, 69
- working in Folders pane, 336–338

foreign keys
- Data Form Web Parts and, 356
- defined, 207

formats
- Excel compatibility, 267–268
- Word commands, 385–386

forms
- Access, 209
- Access commands, 396–397
- building basic, 236–241
- Contact List, 213–214
- Groove, 298, 315
- InfoPath Form Viewer, 326
- information management, 170
- library, 84–85
- moving Access databases to SharePoint and, 234
- Web Part, 119

Forms Server
- defined, 18
- InfoPath Form Viewer, 326

forms-based authentication, 19

forums. See also discussions
- Lightning Tools Web Parts, 329
- Web Parts, 325

free application templates, 46–53

free software, 318–323

front-end databases, 225

full control permissions, 20

full records management, 375

functions. See Web Parts

Grants Management Solution Accelerator, 328

Group By, 68

group-based permissions
- creating team sites, 29–30
- defined, 19–21

GroupBoard workspace, 52–53

groups
- memberships. See memberships
- Site Users Web Part, 111–112
- Task Web Part, 116

H

Help Mode, 108

help template, 51

hiding Contact Details, 107

hierarchy
- MySite, 154
- Tree View Web Part, 319–320

history
- Append Only fields, 206
- document versions, 191–192
- Groove workspace options, 302
- viewing version in Excel, 267
- workflow, 235

Holds, 376

home pages
- customizing MySite, 143–146
- reporting site, 293
- Word Blog Ribbon options, 199

Home Phone Number in My Profile, 141

horizontal image alignment, 109

HTML (HyperText Markup Language), 332–333

hyperlinks. See links

I

Identify the People You Know, 141

images
- customizing MySite, 146
- This Week in Pictures, 119
- Web Part, 108–109

IMP (information management policies)
- auditing and, 365–372
- content types and, 372

importing
- Contact Detail options, 108
- Excel worksheet to custom list, 268–269
- lists from Access, 224–225
- spreadsheets, 99

G

galleries
- Site Settings menu, 32
- Web Part, 104

gantt views, 68

gereral document library settings, 70

ghosting, 334

global menu, 37

Google Docs, 166

Google Maps, 321

government agencies
- case management for, 47–48
- DOD records management, 380
indexes

indexes, 232–233
InfoPath 2007. See Microsoft InfoPath 2007
information management
defined, 168–171
with document libraries, 10–11
information management policies (IMP)
auditing and, 365–372
content types and, 372
inheritance
content types, 177
Master Pages, 337–338
Initiation, 349
insertion
Excel commands, 404
Word commands, 387
installation
Groove, 299–300
MySite, 136
instant messaging, 298, 312–313
integrity, referential
Access support with SharePoint, 228, 232–233
defined, 226
interactivity, 285
Interests in My Profile, 140
interfaces, 9
Internet, desktop to, 25, 166–171
Internet Explorer
Datasheet view, 63
Developer’s Toolbar, 334
MOSS and, 6
SharePoint support, 23–25
inventory-tracking template, 51
invitations
to Groove workspace, 301, 302–303
planning meetings, 256–257
issue tracking
Access list, 241
building basic forms, 237–238
with Groove, 313–314
list, 93–94
IT Team Workspace template, 51
Item Limit, 69–70
item-level permissions, 90
item-level security, 14

J

Job Requisition and Interview Management template, 51–52

K

key performance indicators (KPIs)
defined, 19
Excel Services and, 293–296
lists, 98–99
keys
Data Form Web Parts and, 356
general Access advice, 207
keywords
search, 153
workflow conditions, 351
Knowledge Base template, 52
Knowledgebase, SharePoint, 328
KPIs (key performance indicators)
defined, 19
Excel Services and, 293–296
lists, 98–99
KWizCom, 324–325

L

labels, 11, 366–367
Launch, Quick. See Quick Launch
Launchbar, 300
laws, records management, 361
layout. See design
Learning Kit, SharePoint (SLK), 318
libraries
adding workflow to content type, 183–184
for content types, 178
default items, 58–61
document. See document libraries
exporting Excel lists to, 269–270
free video from Bamboo, 323
managing alerts from Outlook, 254–255
moving Data Connection files to, 281–283
Outlook, 245
overview, 57
saving emails to, 258–260
Shared Documents, 58
Site Settings menu, 33
summary, 99
Lightning Tools, 324, 329
limited access permissions, 20
linking
contacts to Outlook, 253
creating Access database on SharePoint, 225–230
database to SharePoint server, 223–224
documents to Outlook, 245–246

to lists in Access, 211–215

tasks in Outlook, 251–253

tracking lists, 89–90

links

blog management, 147–148

customizing MySite, 145

default Quick Launch, 35–37

in document workspace, 39

global menu, 37

hyperlinks in lists, 271

Master Page, 338

Records Center, 375–376

targeting, 161

useful SharePoint, 405–406

Web Part, 114–115

List Filter, SharePoint, 126

lists

Access database features, 204–206

Business Intelligence Web Parts, 122–123

changing in Access and synchronization to

SharePoint, 218–221

communication, 86–89

Content Query Web Part, 131–133

creating contact, 210–215

creating database in Access, 223–224

custom, 97–98

exploring default items, 58–61

exporting Excel to SharePoint, 269–270

exporting SharePoint to Excel, 270–271

exporting to Access, 221–222

in Folders pane, 337

importing Excel to custom, 268–269

importing from Access, 224–225

KPI, 98–99

List Aggregator, 326–327

Outlook, 245

Outlook discussion, 261–263

overview, 57

rollup Web Parts, 328–329

SharePoint List Filter, 126

summary, 99

task pane, 217–218

tracking, 89–97

viewing tasks in Outlook, 251–253

local files and folders in Groove, 312

logging, 351

Lookup

adding columns, 66–67

Survey list options, 95

lookup values

Access, 209–210

moving Access tables to SharePoint and,

233–234

M

maintenance Web Parts, 323

management

alert, 254–255

blog, 147–148

document library, 72–74

hierarchy permissions, 20

linked lists from Access, 214–215

MySite, 150–155

records. See records management

style with SharePoint Designer, 336

Word Blog Ribbon options, 200

MashPoint, 328–329

Master Pages

in Catalogs folder, 337–338

customization with, 338–344

Data Form Web Parts and, 356

gallery, 32

matching data types, 242

meeting workspaces

creating, 42–46

defined, 41–42

meetings

Groove tool, 307–309

planning, 256–257

memberships

customizing MySite, 144–145

Groove workspace, 302–303

MySite options, 143

Site Users Web Part, 111–112

menus

Access commands, 389–398

Actions. See Actions menu

contact list options, 214–215

creating as owner, 31–32

customizing with Master Pages, 342–344

discussion lists and Outlook, 262–263

document library editing, 74–79

Excel commands, 399–404

Excel Web Part, 286

global site, 37

Groove workspace, 301–302

managing Quick Launch, 151–152

MySite Quick Launch Menu, 145–146
Microsoft Office
Access commands, 389–398
as desktop application set, 166–167
editing documents in, 76
Excel commands, 399–404
information management, 168–171
integration with SharePoint, 14
SharePoint issues, 22–23
Word commands, 384–388

Microsoft Office Live
Communications Server, 195
information management, 169
using with Outlook calendar, 248
Workspace, 201

Microsoft Office SharePoint Services (MOSS). See MOSS (Microsoft Office SharePoint Services)

Microsoft Outlook 2007
calendars, 12–13, 248–250
connecting to, 59
contacts, 253–254
discussion lists and, 261–263
linking documents to, 245–246
lists and libraries, 245
managing alerts from, 254–255
MySite customization, 155
opening documents in, 247
planning meeting, 256–257
saving emails, 258–260
SharePoint and RSS, 260–261
summary, 263
Survey list options, 97
tasks and, 251–253
Web Parts, 123
what's new, 243–244
workflow and, 257–258

Microsoft Query, 280–281

Microsoft Windows SharePoint Services, 201

Microsoft Word 2007
adding tasks, 194–195
adding workflow to content type, 181–186
blogging with, 198–201
colleague interaction, 195–196
commands, 384–388
custom content types, 178–181
custom Document Information panel, 186–187
document check-in and check-out, 189–191
document libraries and, 175–176
Document Management task pane, 192–194
document versions, 191–192
documents based on content types, 177–178
metadata and content types in documents, 188–189
metadata and workflow, 176–177
new menus, 174–175
Office Live Workspace, 201
overview, 173
workflow from, 196–198

mini-calendars
Bamboo Web Parts, 328
commercial Web Part, 324–325
free Web Part, 323

Missing Contact Details, 107
Minutes, 308

Mobile devices
access, 15
view options, 70

Mobile Phone Number in My Profile, 140

MOSS (Microsoft Office SharePoint Services). See also SharePoint
adding Content Query to MySite, 156–159
desktop to Internet, 25, 166–171
hype, 5–6
issues with, 22–25
MySite 2007, 138–146
MySite audiences, 156–159
overview, 5, 7–16
personalization with audiences, 156–159
records management. See records management
security, 19–21
server, 16–19
site structure, 6–7
useful links, 405–406
using SharePoint, 2–3
Web Parts and, 101–102
vs. WSS, 21–22

multipage meeting workspace, 42
multiple document uploading, 61–62
multi-valued columns, 204, 206
multi-valued data types, 242
multi-valued selections, 67
My Colleagues, 141–143
My Profile
defined, 139–141
editing, 149–150
Quick Launch Menu, 145–146

MySite
adding Web Parts, 148–149
alerts and regional settings, 163
blogs, 147–148
MySite (continued)

MySite (continued)
customization, 155–156
defined, 17
managing, 150–155
MOSS 2007, 138–146
MOSS audiences, 156–159
My Profile, 149–150
overview, 135–136
personalization sites, 162
Site Users bug, 112
social networking, 136–138
summary, 163
team sites, 159–162

Office Communicator, 195
Office Live. See Microsoft Office Live
opening
documents to Outlook, 247
Excel Web Part menu, 286
SharePoint lists in Excel, 270–271
with Windows Explorer, 59
Options menu in Groove, 302
ordering columns, 72
Outlook 2007. See Microsoft Outlook 2007
owners, site. See site owners
Ozzie, Ray, 297

Page Viewer Web Part, 109–110
panels
customizing Document Information, 186–187
document check-in/out, 189–191
Document Information settings, 184–185
panes. See task panes
parameters
publishing Excel files, 274–275
workbook options, 285
parent content types, 177
passwords. See permissions
Past Projects in My Profile, 140
Pattison, Ted, 406
PDF Document Parser, 323
People and Groups, 36
people search
defined, 17
Web Parts, 129
permissions
blog management, 147
connecting Data Form Web Parts, 358
connecting Excel to SQL Server, 277–280
contact list options, 215
creating team sites, 29–30
document library, 72–73
editing document, 74–76
Groove, 13
Groove calendar, 305
Groove discussion, 307
Groove workspace, 303–304
MOSS customization, 15
MOSS security, 19–21
MySite, 136
People and Groups, 36

naming. See also titles
Groove workspace options, 302
KPIs, 294
records, 363
views, 68

navigation
document library options, 70
Groove workspace options, 302
Master Pages, 338
SharePoint issues, 22
team site personalization, 161–162
Tree View Web Part, 319–320
workbook options, 285

networking, social
instant messaging, 298, 312–313
MySite, 136–138

news site template, 46
Northwind 2007
displaying SQL Server data, 353–355
KPIs, 293–296
moving to SharePoint, 230–234
publishing SQL Server data to SharePoint, 277–281
using pivot table in browser, 275–277

Notepad, 315

objects
Access 2007, 208–210
building basic, 235–241
general Access advice, 207–208
keeping in Access, 235

Pattison, Ted, 406
PDF Document Parser, 323
People and Groups, 36
people search
defined, 17
Web Parts, 129
permissions
blog management, 147
connecting Data Form Web Parts, 358
connecting Excel to SQL Server, 277–280
contact list options, 215
creating team sites, 29–30
document library, 72–73
editing document, 74–76
Groove, 13
Groove calendar, 305
Groove discussion, 307
Groove workspace, 303–304
MOSS customization, 15
MOSS security, 19–21
MySite, 136
People and Groups, 36

Ozzie, Ray, 297

Northwind 2007
displaying SQL Server data, 353–355
KPIs, 293–296
moving to SharePoint, 230–234
publishing SQL Server data to SharePoint, 277–281
using pivot table in browser, 275–277

Notepad, 315

objects
Access 2007, 208–210
building basic, 235–241
general Access advice, 207–208
keeping in Access, 235
Quick Launch

Profile, My. See My Profile
project management, 12
Project Status template, 315
Project Tasks list, 93
Project Tracking Workspace template, 52
properties
Access database and object, 208
building basic objects, 236–241
Colleague Tracker, 142
CSS customization, 342–344
customizing Document Information panel, 186–187
Excel Web Part, 283–286
Groove workspace, 303–304
Groove workspace options, 302
keeping objects in Access, 235
managing alerts from Outlook, 255
RSS feed, 260–261
SharePoint Designer panes, 335–336
viewing/editing document, 74
Web Part. See Web Parts
Word document, 191
public MySite view, 138
publishing
blogs. See blogs
Excel files, 273–275
Excel menu, 268
new Word menus, 174
SQL Server data to SharePoint, 277–281
template, 46

Q
Quarterly Management Report workflow, 347–348
queries
Access, 209
Access commands, 392–394
building basic, 238–239
Content Query. See Content Query
KPIs, 293–296
moving Access databases to SharePoint
and, 234
using with Excel, 280–281
vs. views in Access, 229–230
Quick Launch
customizing MySite, 145–146
customizing with Master Pages, 342–344
MySite options, 151–152
overview, 34–37
Records Center, 375–376

Site Settings menu, 32
Site Users Web Part, 111–112
Perran, Shane, 406
personalization of MySite. See MySite
personalization sites
defined, 162
template, 44–45
phone numbers, 140–141
Physical Asset Tracking and Management
template, 52
pictures
customizing MySite library, 146
Groove, 315
library, 85–86
in My Profile, 140
pivot tables
interaction, 285–286
using in browsers, 275–277
planning
events template, 51
meetings with Outlook, 256–257
records management, 362–364
records retention, 364–365
sites and workspaces, 27–29
podcasting kit, 319
policies
information management, 365–372
information management and content types, 365–372
retention plan, 364–365
site collection, 365–372
Portal Site Connection, 154
posting
blog management, 147–148
blogging with Word, 198–201
discussion lists and Outlook, 261–262
presence management
Groove, 298
with MOSS, 19
Presence Pawn icon, 65
previewing
in Outlook, 246
pane, 69
price calculation, 323
primary keys
Data Form Web Parts and, 356
defined, 207
private MySite view, 138
Product and Marketing Requirements Planning
template, 48
Quick Parts

Quick Parts
Word 2007, 188–189
Word Blog Ribbon options, 199

R
RadEditor Lite, 320–321
Rating Scale, 95
read permissions, 20
reading panes, 246
Reassign Workflow Task, 81
Records Center
process, 376
routing, 376–380
structures, 375–376
template, 44
records management
Access commands, 395
center structures and process, 375–376
content types and IMP, 372
creating site collection policy, 372–375
defined, 168
full, 375
IMP and auditing, 365–372
issue tracking, 313–314
moving up market, 380
overview, 361–362
planning, 362–364
retention plan, 364–365
routing, 376–380
summary, 381
Recycle Bin
contact list options, 215
MySite options, 153
Quick Launch menu, 37
referential integrity
Access support with SharePoint, 228,
232–233
defined, 226
refreshing
Access lists, 214–215
Datasheet view, 65
Excel Web Part menus, 286
pivot table interaction, 285
regional settings
administration, 32
MySite, 163
relationships
Access commands, 391–392
database design, 205

Relevant Documents
in Document Center, 44
Web Part, 111
relinking lists, 215
removing workflows, 83
Rename, 302
reporting
Access, 209–210
Access commands, 396–397
auditing, 374–375
basic, 240–241
Business Performance Reporting template, 47
Excel, 292–293
with MOSS, 19
moving Access databases to SharePoint and, 234
Report Center template, 45
Report Library, 86
SharePoint site issues table, 228–229
Site Settings menu, 33
Site Usage Report, 152, 154
viewing workflow, 83
Requisitions and Interview Manager, 328
Reset to Site Definition, 154
Responsibilities in My Profile, 140
restoring sites, 345–346
restricted read permissions, 20
retention, record, 364–365
Review pane, 246
Ribbon
blog options, 199–200
building basic forms, 236–241
general Access advice, 207
new Excel, 266–267
Outlook, 243–244
Robillard, Eli, 406
roles
Groove properties and permissions, 303
Groove workspace options, 302
permissions, 20–21
templates based on, 156
Room and Equipment Reservations template, 52
routing records, 376–380
rows
adding to datasheet, 64
workbook display, 285
RSS
document library settings, 73–74
SharePoint, Outlook and, 260–261
Site Settings menu, 33
viewing feeds, 60
RSS Viewer
customizing MySite, 144
Web Part, 118–119
rules and alerts, 254–255

S
Sarbanes-Oxley, 361
saving
backing up team sites, 344–345
Check Out and, 78–79
Document Library as Template, 72
documents in Groove, 311–312
Groove workspace, 301
Outlook emails, 258–260

Schools in My Profile, 140

scope
content type, 177
search, 128, 153

search center template, 45–46
Search Server Express 2008, 45–46
searching
commercial Web Parts, 327
Groove discussions, 306
with MOSS, 16–17
MySite options, 152–153
Site Settings menu, 33
Web Parts, 127–133

security
column, 327
connecting Excel to SQL Server, 277–280
document libraries and, 9
Groove, 13
item-level, 14
MOSS, 19–21
People and Groups, 36
permissions. See permissions
Send Alerts for These Changes, 84
Send Alerts To, 84
Send To, 77–78

servers
administration templates, 50–52
documents, 193–194
Excel, 267–268
Groove, 298
MOSS, 16–19
new Word menus, 174–175
publishing SQL Server data to SharePoint,
277–281
SQL data display, 353–355

service providers, blogging, 200–201
services, Excel. See Microsoft Excel Services
2007
services, SharePoint. See SharePoint
settings
contact list options, 215
document library, 65–67, 70
document library information policy,
365–369
moving connections to SharePoint, 282
MySite management, 150–155
RSS feed, 260–261
Shared Documents options, 60
Site Settings menu, 32–34

Shared Documents
default items, 58–61
in document workspace, 39
library, 35, 58
Web Part, 115–116

SharePoint
calendars vs. Outlook calendars, 250
changing data in Access and synchronization to,
218–221
creating Access database on, 225–230
creating Access views with, 215–218
creating web pages in, 103–104
desktop to Internet, 166–171
discussions vs. Groove discussions, 306
Excel Services limitations and, 272
exporting Excel lists to, 269–270
exporting lists to Excel, 270–271
features with Groove, 298–299
Groove and, 309–312
importing Excel worksheet to custom list,
268–269
Microsoft Office and, 166
moving Access database to, 230–234
moving Excel connection to, 281–283
MySite. See MySite
Outlook and RSS, 260–261
publishing SQL Server data to, 277–281
reporting site, 292–293
useful links, 405–406
using, 2–3
Web Parts in, 102–103

SharePoint add-ins
commercial Web Parts, 324–329
free software, 318–323
other useful software, 329
overview, 317–318
SharePoint Designer 2007

<table>
<thead>
<tr>
<th>SharePoint Designer 2007</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>connecting Data Form Web Parts, 355–359</td>
<td></td>
</tr>
<tr>
<td>custom workflow activities, 322–323</td>
<td></td>
</tr>
<tr>
<td>customization, 338–344</td>
<td></td>
</tr>
<tr>
<td>data sources, 352–353</td>
<td></td>
</tr>
<tr>
<td>editing workflows, 352</td>
<td></td>
</tr>
<tr>
<td>Folder pane, 336–338</td>
<td></td>
</tr>
<tr>
<td>getting started, 335–336</td>
<td></td>
</tr>
<tr>
<td>overview, 330</td>
<td></td>
</tr>
<tr>
<td>site administration with, 344–346</td>
<td></td>
</tr>
<tr>
<td>skills required, 331–335</td>
<td></td>
</tr>
<tr>
<td>SQL Server data display, 353–355</td>
<td></td>
</tr>
<tr>
<td>summary, 359</td>
<td></td>
</tr>
<tr>
<td>workflows with, 346–352</td>
<td></td>
</tr>
<tr>
<td>SharePoint Knowledgebase, 328</td>
<td></td>
</tr>
<tr>
<td>SharePoint Learning Kit (SLK), 318</td>
<td></td>
</tr>
<tr>
<td>SharePoint List Filter, 126</td>
<td></td>
</tr>
<tr>
<td>SharePoint Sites, 144–145</td>
<td></td>
</tr>
<tr>
<td>SharePoint Skinner, 321–322</td>
<td></td>
</tr>
<tr>
<td>sharing</td>
<td></td>
</tr>
<tr>
<td>MySite, 150</td>
<td></td>
</tr>
<tr>
<td>social networking and, 136–138</td>
<td></td>
</tr>
<tr>
<td>site collections</td>
<td></td>
</tr>
<tr>
<td>administration, 34, 151–155</td>
<td></td>
</tr>
<tr>
<td>creating policy, 372–375</td>
<td></td>
</tr>
<tr>
<td>defined, 6–7</td>
<td></td>
</tr>
<tr>
<td>Site Columns gallery, 32</td>
<td></td>
</tr>
<tr>
<td>Site Content Types gallery, 32</td>
<td></td>
</tr>
<tr>
<td>Site Directory template, 45</td>
<td></td>
</tr>
<tr>
<td>Site Features, 34</td>
<td></td>
</tr>
<tr>
<td>site maps, 120</td>
<td></td>
</tr>
<tr>
<td>site member permissions, 20</td>
<td></td>
</tr>
<tr>
<td>site owners</td>
<td></td>
</tr>
<tr>
<td>overview, 31–34</td>
<td></td>
</tr>
<tr>
<td>permissions, 20</td>
<td></td>
</tr>
<tr>
<td>Site Settings menu, 32–34</td>
<td></td>
</tr>
<tr>
<td>Site Usage Report, 152, 154</td>
<td></td>
</tr>
<tr>
<td>Site Users Web Part, 111–112</td>
<td></td>
</tr>
<tr>
<td>site visitor permissions, 20</td>
<td></td>
</tr>
<tr>
<td>sites</td>
<td></td>
</tr>
<tr>
<td>access security, 14</td>
<td></td>
</tr>
<tr>
<td>blogs and wikis, 11–12</td>
<td></td>
</tr>
<tr>
<td>MOSS structure, 6–7</td>
<td></td>
</tr>
<tr>
<td>Quick Launch menu, 36</td>
<td></td>
</tr>
<tr>
<td>WSS, 9</td>
<td></td>
</tr>
<tr>
<td>Sites, SharePoint, 144–145</td>
<td></td>
</tr>
<tr>
<td>sites and workspaces</td>
<td></td>
</tr>
<tr>
<td>basic customization, 54</td>
<td></td>
</tr>
<tr>
<td>creating meeting, 42–46</td>
<td></td>
</tr>
<tr>
<td>free application templates, 46–53</td>
<td></td>
</tr>
<tr>
<td>global menu, 37</td>
<td></td>
</tr>
<tr>
<td>meeting, 41–42</td>
<td></td>
</tr>
<tr>
<td>owners, 31–34</td>
<td></td>
</tr>
<tr>
<td>planning, 27–29</td>
<td></td>
</tr>
<tr>
<td>Quick Launch, 34–37</td>
<td></td>
</tr>
<tr>
<td>summary, 55</td>
<td></td>
</tr>
<tr>
<td>team, 29–31</td>
<td></td>
</tr>
<tr>
<td>templates, 37–41</td>
<td></td>
</tr>
<tr>
<td>sizing</td>
<td></td>
</tr>
<tr>
<td>database columns/fields, 241</td>
<td></td>
</tr>
<tr>
<td>workflow file conditions, 351</td>
<td></td>
</tr>
<tr>
<td>Sketchpad tool, 315</td>
<td></td>
</tr>
<tr>
<td>Skills in My Profile, 140</td>
<td></td>
</tr>
<tr>
<td>Skinner, SharePoint, 321–322</td>
<td></td>
</tr>
<tr>
<td>SLK (SharePoint Learning Kit), 318</td>
<td></td>
</tr>
<tr>
<td>social meeting workspace, 42</td>
<td></td>
</tr>
<tr>
<td>social networking</td>
<td></td>
</tr>
<tr>
<td>instant messaging, 298, 312–313</td>
<td></td>
</tr>
<tr>
<td>MySite, 136–138</td>
<td></td>
</tr>
<tr>
<td>software add-ins. See add-ins</td>
<td></td>
</tr>
<tr>
<td>Solomon, Heather, 406</td>
<td></td>
</tr>
<tr>
<td>sorting</td>
<td></td>
</tr>
<tr>
<td>view options, 68</td>
<td></td>
</tr>
<tr>
<td>workbook options, 285</td>
<td></td>
</tr>
<tr>
<td>sports league template, 48</td>
<td></td>
</tr>
<tr>
<td>spreadsheets</td>
<td></td>
</tr>
<tr>
<td>Excel Web Access Web Part, 127</td>
<td></td>
</tr>
<tr>
<td>exporting to, 59</td>
<td></td>
</tr>
<tr>
<td>importing, 99</td>
<td></td>
</tr>
<tr>
<td>using filters with Excel Services, 286–292</td>
<td></td>
</tr>
<tr>
<td>workbook display, 284–285</td>
<td></td>
</tr>
<tr>
<td>SPUserPoll, 321</td>
<td></td>
</tr>
<tr>
<td>SQL Servers</td>
<td></td>
</tr>
<tr>
<td>data display, 353–355</td>
<td></td>
</tr>
<tr>
<td>publishing data to SharePoint, 277–281</td>
<td></td>
</tr>
<tr>
<td>status monitoring, 257–258</td>
<td></td>
</tr>
<tr>
<td>storage</td>
<td></td>
</tr>
<tr>
<td>MySite allocation options, 154</td>
<td></td>
</tr>
<tr>
<td>records management. See records management</td>
<td></td>
</tr>
<tr>
<td>SharePoint overview, 6</td>
<td></td>
</tr>
<tr>
<td>structure</td>
<td></td>
</tr>
<tr>
<td>content and, 34</td>
<td></td>
</tr>
<tr>
<td>of MOSS, 6–7</td>
<td></td>
</tr>
<tr>
<td>styles</td>
<td></td>
</tr>
<tr>
<td>CSS. See CSS (Cascading Style Sheets)</td>
<td></td>
</tr>
<tr>
<td>SharePoint Skinner, 321–322</td>
<td></td>
</tr>
<tr>
<td>view options, 68–69</td>
<td></td>
</tr>
<tr>
<td>Submitted E-mail Records, 376</td>
<td></td>
</tr>
<tr>
<td>Summary Links Web Part, 114–115</td>
<td></td>
</tr>
<tr>
<td>Summary View, 116</td>
<td></td>
</tr>
</tbody>
</table>
support
creating Access database on SharePoint, 226
Groove for SharePoint, 309

surveys
defined, 12
lists, 94–97
SPUserPoll, 321

synchronization
Access lists, 214
changing data in Access and, 218–221
Excel compatibility, 267–268
Groove to SharePoint, 310–311

T

Table of Contents Web Part, 120

tables
Access, 208–209
Access commands, 397–398
defining Excel lists as, 269
pivot table interaction, 285–286
using pivot table in browser, 275–277
Word commands, 388
tagging
CSS, 333–335
HTML, 332–333
Web Parts, 327
targeting audiences
Contact Detail options, 108
Content Query, 132
document library options, 70
MySite personalization, 156–159
team site personalization, 161–162
Task List
defined, 36
tracking, 91–93
task panes
Document Management in Excel, 267–268
Document Management in Word, 192–194
List, 217–218
pivot table interaction, 286
reading document content, 246
SharePoint Designer, 335–336
Word 2007 and colleague interaction, 195–196
working in Folders pane, 336–338
tasks
adding, 194–195
in document workspace, 39
Outlook, 243–244, 251–253
reassigning workflow, 81

Records Center, 376
tool templates for Groove, 315
Web Part, 116–117

Team Discussion
defined, 36
Web Part, 118
team sites
backing up, 344–345
creating, 29–31
getting started with SharePoint Designer, 335–336
personalization with, 159–162
restoring, 345–346
template, 38
work template, 49–50
workflow from Word 2007, 196–198

Telerik RadEditor Lite, 320–321
templates
building basic forms, 236–241
Contacts, 213–214
creating custom content types, 178–181
creating database in Access, 223–224
free application, 46–53
Groove tool, 315
meeting workspace, 43–46
role-based, 156
saving document libraries as, 72
sites and workspaces, 37–41
temporary web sites, 9
text filters, 288–292
themes, MySite, 151
third-party add-ins. See add-ins
This Week in Pictures Web Part, 119
Time Tracker template, 315
timecard management template, 48
titles
alerts, 84
document library options, 70
naming columns, 71
URL, 108
workbook display, 285
workflow conditions, 351
toolbars
Excel commands, 400
IE Developer’s, 334
workbook display, 285
working with styles, 341
tools
additional Groove, 315
enterprise-level search, 16
tools (continued)

**tools (continued)**
- Issue Tracking, 313–314
- Meetings tool, 307–309
- MOSS customization, 15
**Top Link Bar, 151**
**Totals view, 68**
- tracking
  - colleagues on MySite, 142–143
  - issues. See issue tracking
  - lists, 89–97
  - tool templates for Groove, 315
**training**
- SharePoint links, 406
- templates, 48
**Translation Management Library, 86**
**Tree View Web Part, 319–320**

**U**

**Unclassified Records, 375**
**unghosting, 334**
**unique indexes, 232–233**
**Upcoming Tasks, 44**

**updates**
- cascading, 233
- Colleague Tracker, 142–143
- email, 15
- Excel Web Part menus, 286
- My Profile, 139–141
- RSS, 260

**uploading**
- Check Out and, 78–79
- documents to libraries, 61–62
- to picture library, 85
- Shared Documents options, 59

**usage reports, 33**
**user permissions. See permissions**
**User Tasks Web Part, 112**

**users**
- alerts, 84, 152
- assigning tasks from Word, 194–195
- Current User filter, 125
- MySite profile, 139–141
- Site Settings menu, 32
- Site Users Web Part, 111–112
- team sites, 29–31

**V**

**validation, 228–229, 233**
**Variables in workflows, 349**

**versions**
- Check Out and, 78–79
- document library options, 70
- viewing history in Excel, 267
- Word document, 191–192

**vertical image alignment, 109**
**video libraries, 323**

**views**
- Calendar Web Part, 113–114
- contact list, 88
- create setting, 60
- creating Access with SharePoint, 215–218
- creating document library, 67–70
- Datasheet, 62–65
- Document Edit Menu, 74–79
- document libraries and, 10
- Excel commands, 402–403
- library column, 72
- menu, 60–61
- My Profile, 149–150
- MySite, 138
- Page Viewer Web Part, 109–110
- picture library, 85–86
- vs. queries in Access, 229–230
- RSS Viewer, 118–119, 144
- Shared Documents Web Part options, 115–116
- SQL Server, 281
- Task Web Part, 116–117
- tasks in Outlook, 251–253
- Tree View Web Part, 319–320
- workflow, 83

**visibility, search, 152**

**W**

**Web 2.0, 136**
**web browsers. See browsers**
**web pages**
- creating SharePoint, 103–104
- Page Viewer Web Part, 109–110
**Web Part Zones, 102**
**Web Parts**
- adding, 104–105
- adding Content Query to MySite, 156–159
- adding to MySite, 148–149
- additional, 123–127
- Announcements, 112–113
- business intelligence, 121–123
- Calendar, 113–114
- Colleague Tracker, 142–143
- commercial, 324–329
Contact Details, 106–108
creating web pages in SharePoint, 103–104
customizing MySite, 143–146
defined, 8
Excel Services, 283–285
filtering using, 288–292
filtering using document library, 287–288
Form, 119
free add-ins, 318–323
Image, 108–109
Links, 114–115
Memberships, 143
My Profile, 149–150
MySite customization, 155–156
overview, 101–102
Page Viewer, 109–110
personalization with team sites, 159–162
Relevant Documents, 111
RSS Viewer, 118–119
search, 127–133
Shared Documents, 115–116
in SharePoint, 102–103
Site Users, 111–112
summary, 133
Table of Contents, 120
Tasks, 116–117
Team Discussion, 118
This Week in Pictures, 119
User Tasks, 112
web sites. See sites
web-based discussions. See discussions
When to Send Alerts, 84
wikis
defined, 11–12
templates, 40
Wiki Plus, 326
Windows Explorer
opening with, 59
views, 67
Windows Live Spaces, 200
Windows SharePoint Services (WSS). See WSS (Windows SharePoint Services)
wizards, workflow, 349–351
Work Email Address in My Profile, 141

workbooks
Excel Web Part, 283–286
publishing to SharePoint, 273–275
using filters with Excel Services, 286–292
workflows
Access 2007, 235
adding to content type, 181–186
Conditions screen, 350–351
contact list options, 215
custom activities, 322–323
document library, 79–83
document library settings, 73
Excel menu, 268
expiration, 370–372
MOSS, 15–16
new Word menus, 174–175
Outlook, 257–258
publishing site with, 46
SharePoint Designer, 346–352
from Word 2007, 196–198
Word 2007 and, 176–177
worksheets
importing Excel to custom list, 268–269
site planning, 28
workspaces. See also sites and workspaces
creating Groove, 300–302
creating meeting, 42–46
Groove properties and permissions, 303–304
instant messaging in, 312–313
meeting, 41–42
Office Live, 201
planning meetings, 256–257
tools, 304–307
Word menu, 175
WSS (Windows SharePoint Services)
defined, 7
Excel Services and, 271
vs. MOSS, 21–22
overview, 9–11
personalization with team sites, 159–162
Web Parts and, 101–102
WSS and MOSS Home Drive, 321–322

Z
Zone, 107
Take your library wherever you go.

Now you can access more than 200 complete Wrox books online, wherever you happen to be! Every diagram, description, screen capture, and code sample is available with your subscription to the Wrox Reference Library. For answers when and where you need them, go to wrox.books24x7.com and subscribe today!
Microsoft Office SharePoint Server (MOSS) 2007 is a wildly popular server product that offers an amazing opportunity to change the way you work. Paired with Microsoft Office 2007, SharePoint allows you to share and collaborate on Word, PowerPoint, Access, and Excel documents and databases; organize workflows; integrate Office documents with business applications; search across all types of documents and data; and provide these tools internally and externally on web sites for end users.

This book is a unique resource that walks you through a potentially overwhelming array of features and clearly shows you how to effectively use the SharePoint 2007 and Microsoft Office 2007 integration features. You'll begin with a review of SharePoint, then look at how it works and discover exactly what is available within SharePoint. You'll examine SharePoint's integration with Office—a topic that is not readily available on the bookshelf. Plus, valuable examples and succinct explanations used throughout the book can be easily applied in real-world situations and will help you take advantage of the extensive features of SharePoint and Office.

**What you will learn from this book**
- How lists and libraries are created and managed and how to create custom lists of your own
- The basic building blocks of SharePoint web sites: Web Parts
- How the My Site feature in SharePoint helps you create your own personal SharePoint sites
- Methods for publishing documents to a Team Site and how to create and manage metadata associated with your documents
- Ways records management can be used in day-to-day projects

**Who is this book for?**
This book is for anyone using Microsoft SharePoint who wants to learn to leverage SharePoint with Office 2007.

**Martin W. P. Reid** is an analyst for The Queens University in Belfast, one of the leading universities in the United Kingdom. Martin is currently working on a large MOSS 2007 project reaching almost 30,000 users. Previously he worked with end users teaching Microsoft Office applications, database design, programming, and web development. Martin contributes frequently to the Microsoft Office SharePoint blog Get the Point (http://sharepoint.microsoft.com/blogs/getthepoint).

**Wrox guides** are crafted to make learning programming languages and technologies easier than you think. Written by programmers for programmers, they provide a structured, tutorial format that will guide you through all the techniques involved.